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About This Book

IBM® Personal Communications for Windows® reference books are comprised of
four volumes: a 3270 Emulator User’s Reference, a 5250 Emulator User’s Reference,
a VT Emulator User’s Reference and an Administrator’s Guide and Reference.
These volumes provide information for using IBM Personal Communications
iSeries™ for Windows operating systems (hereafter called PC400) and IBM Personal
Communications for Windows operating systems. In this book, Windows refers to
Windows 95, Windows 98, Windows Me, Windows NT®, Windows 2000, and
Windows XP. When information is applies only to a specific operating systems, this
is indicated in the text. PC/3270 refers to the 3270 portion of the combined
package. Throughout this book, workstation refers to all supported personal
computers. When only one model or architecture of the personal computer is
referred to, only that type is specified.

Who Should Read This Book
This book is intended for administrators of Personal Communications.

How to Use This Book
This book contains reference information that you might need to refer to when
installing or operating Personal Communications.

Personal Communications is designed to use various communication adapters and
to work with other workstation and host system software. Refer to the appropriate
documentation for the products you use.

Command Syntax Symbols
Parentheses, brackets, ellipses, and slashes have the following meanings or uses:

( ) Parentheses enclose operands that govern the action of certain command
options.

[ ] Brackets indicate an optional command argument. If you do not use the
optional item, the program selects a default.

... Ellipsis after an argument indicates that you can repeat the preceding item
any number of times.

/ For 3270, a slash must precede the Time Sharing Option Extensions
(TSO/E) password. A slash must also precede parameters of DOS
commands entered from the command line. For 5250, a slash must precede
parameters of IBM DOS commands entered from the command line.

\ A backslash is included as part of any directory name. An initial backslash
indicates the first-level directory, and an additional backslash is inserted in
the directory name to indicate another level.

All directives, operands, and other syntax can be typed in either uppercase or
lowercase, unless otherwise indicated.
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Where to Find More Information

Online Help
The help facility describes how to install, configure, and use Personal
Communications. Online help is very extensive and includes information about
every aspect of configuring and using Personal Communications.

Use help to obtain the following information:
v Menu choices
v Operation procedures
v Operations in windows
v Meanings of the terms displayed in windows
v Causes of errors and the corresponding actions to take
v Mouse-based operations
v Operation without a mouse
v Detailed explanations of specific terms
v Further technical information about Personal Communications
v Detailed explanations of operator information area (OIA) messages

To display online help, select choices from the Help menu or press F1.

You can use Personal Communications online help just as you use the online help
for Windows.

Messages and Alerts
Online messages are displayed by Personal Communications, but a message does
not always mean an error occurred. For example, a message might tell you that an
operation is in progress or has been completed. A message can also prompt you to
wait for the completion of an operation.

Messages That Appear in Pop-Up Windows
While using Personal Communications, you may see messages appear in popup
windows, but not necessarily as a direct result of your actions. These messages can
appear for a number of reasons, outlined in the following sections.

System-Fault Messages: For Windows NT, if a message does appear in a pop-up
window, you can paste its contents into the Windows NT clipboard. To do this:
1. Click Details on the pop-up window.
2. Mark the text that you want to copy.
3. Click the marked text with the right mouse button and then click Copy.
4. Start an editor, such as Notepad, and click Paste from the Edit menu.
5. Save the file in case an IBM Service Representative needs this information to

diagnose your problem.

Security-Related Messages: Personal Communications optionally utilizes Secure
Sockets Layer (SSL) or Transport Layer Security (TLS) to establish sessions with
servers; this may require input from you (for example, a password). See Chapter 6,
“Configuring and Using Security for Personal Communications”, on page 61 for
details.

System-Policy-Related Messages: Your Personal Communications workstation
configuration can be controlled centrally using facilities for managing system
policies. See Chapter 5, “System Policy Support”, on page 51 for details.

xiv Personal Communications Administrator’s Guide and Reference



OIA Messages

Personal Communications displays messages in the operator information area
(OIA) or in a pop-up window. Messages from Personal Communications are
displayed in the message window; messages from the host system regarding the
condition of the session are displayed in the OIA of the session window.

The OIA is the bottom line of the session window. An OIA message indicates the
status of Personal Communications as well as information about the workstation,
host system, and attachment method.

All of the OIA indicators, reminders, and messages are described in the online
help. To view this information:
1. Click Index from the Help menu.
2. Select The operator information area messages.

To look up a specific OIA message, select Search. When the Search window
appears, type the letters that appear in the OIA. For example, MACH or PROG. If a
lightning bolt appears, type COMM.

3. Double-click the index entry that matches your search.
4. Scroll through the window until you find the number that appears in your

OIA.

Alerts
Alerts may be generated which correspond to specific Personal Communications
messages. See Appendix D, “Alerts”, on page 371 for more information.

Personal Communications Library
The Personal Communications library includes the following publications:
v CD-ROM Guide to Installation
v Quick Beginnings
v 5250 Emulator User’s Reference
v 3270 Emulator User’s Reference
v VT Emulator User’s Reference
v Administrator’s Guide and Reference
v Emulator Programming
v Client/Server Communications Programming
v System Management Programming
v CM Mouse Support User’s Guide and Reference
v Host Access Class Library
v Configuration File Reference

These books are also available (except in DBCS versions) in PDF format and are
optionally installed or viewed from the CD-ROM.

In addition to the printed books, there are HTML documents provided with
Personal Communications:

Host Access Class Library for Java
This HTML document describes how to write an ActiveX/OLE
2.0–compliant application to use Personal Communications as an
embedded object.

Host Access Beans for Java
This HTML document describes Personal Communications emulator
functions delivered as a set of JavaBeans™.

About This Book xv
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Chapter 1. Personal Communications Highlights

Personal Communications brings the power of personal networking to your
workstation by providing a variety of connectivity options supporting local area
network (LAN) and wide area network (WAN) environments. Whether you need
host terminal emulation, client/server applications, or connectivity, Personal
Communications offers a robust set of communications, networking, and
administrative features.

Personal Communications is a full-function emulator package with an easy-to-use
graphical interface, which includes many useful features such as file transfer and
dynamic configuration, and emulator APIs including the IBM Host Access Class
Library.

Personal Communications also provides a variety of SNA-based client application
programming interfaces (APIs). You can create applications that use the
peer-to-peer client APIs, which are based on LU 6.2 (and provided by Personal
Communications). Using these APIs you can simultaneously access and process
information on peer workstations.

With Personal Communications, you can participate in Advanced Peer-to-Peer
Networking® (APPN®) as an end node, and use the advanced network features,
high-performance routing (HPR), and dependent LU requester (DLUR).

Personal Communications provides the following functions:
v zSeries Connections

LAN LAN via IEEE 802.2
Communications Server for Windows
Telnet3270
3270 via iSeries
APPC 3270 via LAN
Microsoft® SNA client over FMI
Dependent Logical Unit Requester (DLUR)
VT-over-Telnet (TCP/IP)
3174 Peer Communication

COAX SNA Distributed Function Terminal
Non-SNA Distributed Function Terminal

COM port
Telnet 3270
SNA-over-Async
IBM Global Network® (not in Japan)
Home3270
IBM Global Network - SNA-over-Async
Dependent Logical Unit Requester (DLUR) via

SNA-over-Async

Hayes AutoSync
APPC 3270 via SNA-over-Async
APPC 3270 via Hayes AutoSync
VT-over-Async
VT-over-Telnet (TCP/IP)
X.25 Hayes AutoSync
X.25 DLUR via Hayes AutoSync
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X.25 APPC 3270 via Hayes AutoSync
5250 3270 via iSeries

Dependent Logical Unit Requester (DLUR)
SDLC Synchronous Data Link Control

3270 via iSeries (passthru)
APPC 3270 via SDLC
Dependent Logical Unit Requester (DLUR)

SNA/IP
LU 0, 1, 2, 3
APPC 3270
LU 0, 1, 2, 3 via DLUR

IBM ISA/MCA WAC
Synchronous Data Link Control
3270 via iSeries (passthru)
APPC 3270 via SDLC
Dependent Logical Unit Requester (DLUR)
X.25 Qualified Logical Link Control
X.25 3270 via iSeries
APPC 3270 via X.25
X.25 DLUR
Communications Server Client
Communications Server

IBM-EEDLC
LU (0, 1, 2, 3) via DLUR
APPC 3270

OEM LU (0, 1, 2, 3)
3270 via iSeries (passthru)
APPC 3270
Dependent LU Requester (DLUR)

v iSeries Connections
LAN LAN via IEEE 802.2

Telnet5250 over TCP/IP
VT over Telnet
Telnet5250 over IPX/SPX

5250 Twinaxial Data Link Control (APPC)
Twinaxial Data Link Control (Console)

COM port
SNA-over-Async
Hayes AutoSync
SNA-over-Async (Console)
VT over Async
VT over Telnet
Telnet 5250
X.25 Hayes AutoSync

SDLC Synchronous Data Link Control
SNA/IP

5250
IBM ISA/MCA WAC

Synchronous Data Link Control (WAC)
X.25 Qualified Logical Link Control

IBM-EEDLC
5250

OEM APPC 5250
v ASCII Emulator Connections

LAN VT over Telnet
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COM port
VT-over-Async
VT over Telnet

v S/3X Emulator Connections
5250 Twinaxial Data Link Control (Console)

v Client/Server Connections
LAN LAN via IEEE 802.2
Twinaxial

Twinaxial Data Link Control (APPC)
COM port

SNA-over-Async
Hayes AutoSync
X.25

SDLC Synchronous Data Link Control
IBM WAC

Synchronous Data Link Control
X.25

AnyNet® SNA over TCP/IP
APPC

Enterprise Extender
HPR over IP

v Configuration of SNA Node (APPN) Sessions
– Emulator
– Client/server applications

v SNA Node Operations
– Starting and stopping resources
– Deleting resources
– Displaying resource information
– Changing session limits
– Initiation of path switches

v Log Viewer
– View Message Log, Trace Log, and Merged Log files
– Summary and Detail views
– Set default Message Log size and location
– Filter and search Log files
– Message Log entries Help

v Trace Capability
– 3270/5250 emulator data
– APPN and APPC API data
– Connectivity data, such as LAN or SDLC
– User services data, such as node initialization

v APPC Applets
– Display SNA sense data (GETSENSE)
– Transfer files (AFTP and AFTPD)
– Check connection (APING)

v Sample Programs

– Located in \Personal Communications\samples subdirectory
v Installation and Configuration

– Partial installation option
– Program sharing on a network server
– Automatic detection of installed communication adapters
– Dynamic change of communication configurations
– Automatic Dial Facility (Async (IGN), SDLC, Home3270, SNA-A)
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– Silent Installation
– ASCII SNA-node configuration
– Verification of ASCII configuration

v OEM Adaptor Cards

An open API enables vendors and other equipment manufacturers (OEMs) to
provide adapter cards that allow for additional connectivity options, for
example, additional X.25, ISDN, SDLC or twinax support.

v Host Session Function
– Up to 26 sessions
– Variable screen size and automatic font scaling
– Function settings (of the host code page, for example) for each session

v Host Graphics Support
– Built-in vector graphics support for GDDM® and other graphics applications

v File Transfer Function
– Easy operation through graphical user interface (GUI) windows
– Batch transfer of multiple files
– Concurrent file transfer through multiple sessions
– Background file transfer
– File transfer invocation by macro
– OfficeVision/MVS™ Import/Export functions
– VT File Transfer (XModem and YModem)

v Edit (Cut and Paste) Function

You can use the clipboard to cut, copy, and paste a selected areaIn addition, you
can paste data in other applications, such as spreadsheet programs, that support
the PasteLink function.
– Support of spreadsheet data format (Sylk, Biff3, Wk3 formats)
– Copy Append
– Paste Next
– Paste to Trim Rectangle
– Paste Stop at Protected Line

v Graphical User Interface (GUI)
– Customizable 3D iconic tool bar
– 3D-button hotspots
– Pop-up keypad
– Macro function, including record and play
– VBScripts, including record and play
– Keyboard-function setup and remapping
– Mouse-button-function setup and remapping
– Display setup (cursor type, graphics, sound, colors, for example)
– Automatic font size adjustment or fixed font size
– Window-appearance setup
– Menu-bar customization
– 3270 Light Pen emulation by using a mouse
– Status bar with history
– Page setup (Text and Graphics)
– Revised Configuration Dialog
– Online help

v Print Function
– Printer session (for PC/3270: SCS, LU 3, or non-SNA)
– Graphics local print
– Printing with the Windows NT printer drivers
– Print function by printer definition table (PDT)
– Multiple host-print functions in multiple sessions
– Print-job control by SNA bracket timeout
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– PDF-to-PDT conversion tool
– PC400 print function by OS/400® Host Print Transform (HPT)
– PC400 printing supported by the iSeries Advanced Print Support Utility
– ZipPrint

v Programming Interfaces
– 16/32-bit Emulator High-Level Language Application Programming Interface

(EHLLAPI)
– 16/32-bit Dynamic Data Exchange (DDE)
– 32-bit Node Operations Facility (NOF)
– 16/32-bit Personal Communications API (PCSAPI)
– 32-bit Advanced Program-to-Program Communication (APPC)
– 32-bit Common Programming Interface for Communications (CPI-C)
– 32-bit Automation Object API
– 32-bit ActiveX/OLE 2.0
– Host Access Beans for Java™

– ActiveX Controls
v PC400 Client Function

– Data transfer
– PC Organizer
– Text Assist
– Enhanced Programmable Terminal User Interface (ENPTUI)
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Chapter 2. Problem Analysis

This chapter describes the information that will help you analyze problems with
Personal Communications, and ways to report a problem to IBM. For detailed
information about contacting IBM, refer to Quick Beginnings.

For information about Personal Communications and support, refer to the
following Web sites:
v The Personal Communications home page provides access to general product

information, and download services. To view this page, go to the following
Internet address:
http://www.ibm.com/software/network/pcomm

v The Personal Communications support page provides links to code fixes, tips,
newsgroups, support options, and services. To view this page or to submit a
software defect report, go to the following Internet address:
http://www.ibm.com/software/network/pcomm/support

Personal Communications provides several utilities to help you with problem
analysis. They can be invoked by selecting their icons from the Programs → IBM
Personal Communications → Administrative and PD Aids subfolder on the
Windows Start menu.

The following sections describe these utilities and how to use them.

Log Viewer
The Personal Communications log viewer utility enables you to view, merge, sort,
search, and filter information contained in message and trace logs. Use the log
viewer during problem analysis to work with message and trace log entries. The
default name of the message log output file is PCSMSG.MLG; its file extension
must be .mlg. The file extension for trace logs must be .tlg.

To view message or trace logs:
1. From the Administrative and PD Aids subfolder, click Log Viewer; or, from an

active session, click Launch → Log Viewer from the Actions menu.
2. From the list of logged messages, double-click a message to display the

message text.

Note: Only one message log is created per machine. In simultaneous user
environments such as WTS, all user messages are logged into that single
instance of the log file. See Chapter 7, “Using Windows Terminal Services”,
on page 87 for more information about terminal services.

For more information about log viewer functions, see Chapter 10, “Log Viewer
Functions”, on page 101.
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Trace Facility
The Personal Communications trace facility enables you to log trace information
for certain Personal Communications functions.

To start a trace, perform the following steps:
1. From the Administrative and PD Aids folder, click Trace Facility; or, from an

active session, select Launch → Trace Facility from the Actions menu. The
trace status on the title bar displays the current state:

Active Trace data is being collected by the trace facility.

Inactive
No trace data is being collected.

2. From the main dialog box, click Set Up to set the desired trace system
parameters.

3. Click OK to return to the main trace dialog box.
4. From the main trace dialog box, select the type of data you want to trace from

the Function Name, Component Name, and Trace Option list boxes.

Function Name
A specific set of Personal Communications features, such as 3270/5250
Emulator or User Services.

Component Name
The name of a specific part of a function, such as API data (for the
3270/5250 Emulator function) or Node Initialization (for the User
Services function).

Trace Options
The options associated with a particular component, such as EHLLAPI
(for the API component) or API trace (for the Node Initialization
component).

5. Start tracing data by clicking Start, or apply changes to the trace options by
clicking Apply.

6. Run the operation that you want to trace.
7. Optionally, stop the trace by clicking Stop.
8. Save the trace data to your hard disk by clicking Save.
9. Click Format to specify a formatted trace file name and to format the trace

data. The Information Bundler utility should be used immediately after the
trace is complete to ensure that the correct information is gathered.

Note: If you have changed the default path setting for the formatted trace file,
the Information Bundler will not find the trace information. Copy the
trace files to the system-class application data directory.

10. Click OK.
11. Click Clear to clear the trace buffer where you saved a trace.
12. Use the log viewer to view the formatted trace log.
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Information Bundler
The Personal Communications Information Bundler utility gathers system files,
trace and log files, and registry information and creates a self-extracting .EXE file.
This .EXE file is sent using FTP to support personnel for problem resolution. This
utility should be executed immediately after the trace is complete to ensure that
the correct information is gathered. To use the Information Bundler, do the
following:
1. From the PD Aids folder in the Personal Communications program group,

double-click the Information Bundler icon; or, from an active session, click
Launch → Information Bundler from the Actions menu.

2. A .EXE file containing system and Personal Communications information is
created in the Personal Communications system-class application data directory.
By default this file is called X12345.EXE. Refer to the installation documentation
for the location of the system-class application data directory for each Windows
operating system.

Internet Service
The Internet Service utility enables you to send the .EXE file containing diagnostic
data collected by the Information Bundler to an FTP server. This utility will not
work unless TCP/IP is configured and you have a direct connection to the internet.
To use Internet Service:
1. Double-click the Internet Service icon located in the Personal Communications

program group; or, from an active session, click Actions → Launch → Internet
Service.
The Internet Service window contains four data fields that must have valid
values before you can submit your problem report.

2. Verify that the FTP Address field contains the default address
testcase.software.ibm.com. This is the service anonymous FTP server.

3. Type your e-mail address in the field provided.
4. In the Problem Determination Filename field, type the file name and path of

the .EXE file created with the Information Bundler. This file is located in the
Personal Communications installation directory.

5. In the PMR Number field, type the PMR number that you received as a result
of contacting IBM support personnel.

6. When all fields in the window have been filled with valid values, click
Transmit to submit your problem determination information.

Checking for APARs and CSDs
The Product Update Tool allows you to manage CSDs (Corrective Service
Distributions) and APARs (authorized program analysis reports) for Personal
Communications. Authorized users also can use the Product Update Tool to
download, test, and commit APARs. Authorized Program Analysis Reports
(APARs) are single module product fixes for Personal Communications, while
CSDs are full Personal Communications product updates. You must be connected
to the Internet in order to test or commit APARs.

The Product Update Tool uses .vbs files to download the correct APAR package, so
the Windows Scripting Host Service must be running on the machine being
updated.
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To access the Product Update Tool:
1. Select Administrative and PD Aids from the Personal Communications start

menu.
2. Click Product Update Tool.
3. Click Connection Configuration to change connection and proxy options.

Note: If you have difficulty using the Product Update Tool on Windows 95
systems, you may have to test an APAR or check for CSDs using another
platform. Refer to the Personal Communications Readme file for the latest
information.

The following are the major functions available via the Product Update Tool.
v “Test an APAR” on page 13
v “Remove an APAR” on page 14
v “Commit an APAR” on page 14
v “Corrective Service Distributions” on page 15

Connection Configuration
The WebUpdate connection configuration panel automatically appears when the
Product Update Tool is first run after installation. If you have already set up your
Internet connection for your Internet browser, there is no need to fill in any data in
the Connection Configuration window—the data from your Internet browser will
be used. After the initial configuration settings are entered or confirmed, the
update panel does not appear automatically each subsequent time. If changes to
the configuration are necessary, click the Connection Configuration button on the
main panel.

You can specify the following WebUpdate configuration options:

Connection Method
If connecting through a modem, select the dialup connection name from
the drop-down list.

Proxy Connection Settings
During installation, Personal Communications automatically checks the
Internet browser proxy settings and configures WebUpdate to use those
settings. If no proxy settings are available, Personal Communications
defaults the settings to blank (no settings). Select Uses Proxy Connection
to add or change the proxy settings for WebUpdate. If you use an HTTP
proxy server, you can enter the user name and password.

If you are connecting through a SOCKS server, place socks= in front of the
server address.

The Product Update Tool does not support the use of Automatic Configuration
Scripts.

APARs
This option allows you to test an APAR before installing it permanently. When
testing an APAR, you should not attempt any repair of the Personal
Communications installation, or the APAR will be removed. After the APAR is
tested, it should be either removed or committed—an APAR should not be left in
test mode.
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It is recommended that you test an APAR before committing it. When you install a
product using Windows Installer, the .msi file is cached on the machine. During an
APAR test, no changes are made to the Personal Communications .msi file, which
allows the APAR to be removed. Once an APAR is committed, the APAR .msp (a
self-extracting executable Microsoft Patch) file updates the .msi file—the changes
become part of the installed product and no backup copy of Personal
Communications is available. At that point, the APAR cannot be removed. If
Personal Communications is reinstalled on a machine, any prior APARs must be
recommitted.

The .msi file is similar to a database that contains information on all the files that
were installed. When you test an APAR, the .msi file does not get updated with the
updated files information. This allows the removal of the APAR if there were
undesirable effects.

Note: The Personal Communications installation source must be present when you
commit an APAR.

Product Update Tool Options
The Product Update Tool utility has three options for APARs.

Test an APAR: This option allows you to test the APAR before it is installed
permanently onto the Personal Communications product. Testing indicates conflict
between APARs and should be done before the Commit option is used. APARs
that have been tested can be removed using the Remove an APAR option.

When you test an APAR, the Product Update Tool obtains a list of available APARs
for Personal Communications from the IBM support site on the Internet. APARs
that have already been applied to the specific Personal Communications image or
installation are not displayed in the list. You can then select the desired APAR(s)
and apply them.

APAR test and commit packages can be obtained directly from the Internet. Use
the following URL syntax to locate a specific APAR:

http://www6.software.ibm.com/aim/pcL57MMP.exe

where 57 indicates the product version number. The following are variables:

L Specifies one of the following languages:
v m is Multi-Language Support.
v s is Simplified Chinese.
v t is Traditional Chinese.
v k is Korean.

MM Indicates the modification/CSD level. The base level would be 00.

P Indicates the package type.
v t is the test package.
v c is the commit package.

For example, http://www6.software.ibm.com/aim/pcm5700c.exe is the URL for
the Multi-Language Support commit package for the base level of Personal
Communications.
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Remove an APAR: APARs that have been tested can be removed using this
option. When you click Remove an APAR, a list of APARs is displayed, indicating
which ones can be removed. Select the APARs to be removed and click
Next—follow the procedures to remove the APAR.

Commit an APAR: This option allows you to install an APAR permanently. When
you click Commit an APAR, a list with all available APARs is shown, including
those installed for testing. You do not need to test APARs prior to committing
them—however, it is recommended that you test all APARs.

During the commit process, a window might appear, displaying a list of active
tasks that might interfere with the commit process (for example, active Personal
Communications sessions)—the Product Update Tool may be one of the listed
tasks. If so, close the listed tasks, including the Product Update Tool, and click
Retry in the Installer dialog to complete the process. You may also click Cancel to
terminate the update process. If you choose Ignore, you are more likely to be
required to reboot in order for locked files to be updated.

The commit process requires access to the original installation files. If you installed
Personal Communications from the product CD, you must have the CD in the
CD-ROM drive; if you installed Personal Communications off the network, you
must be connected to the network. If the source is not present, you must provide
the location of the source files.

When you choose to commit an APAR, the APAR .msp file is downloaded and
executed. Once you have selected what APARs you would like to commit, the
corresponding .msp file is launched silently. Since the changes are permanent, no
backup copy is made. You can then distribute one or more .msp files across the
network.

If the operating system is Windows 95, 98, or Me, the .msp file is saved in

X:\<drive>\Application Data\IBM\Personal
Communications\APARs\[APAR Name]

where X:\<drive> is the directory in which the operating system resides. For
Windows NT, the .msp file is saved in

X:\<drive>\Profiles\All Users\Application Data\IBM\Personal
Communications\APARs\[APAR Name]

For Windows 2000 and XP, the .msp file is saved in

X:\Documents and Settings\All Users\Application Data\IBM\Personal
Communications\APARs\[APAR Name]

Note: After an APAR has been installed for testing or committed, the file
pcommaparinfo.txt is created in the above application data directories. This
file contains a list of the APARs that have been installed as well as their
status (tested or committed). This file must not be edited or moved, because
it is essential for the proper tracking of APARs.

If you have a .msp file, you can manually commit the maintenance to other
systems by using the following msiexec.exe command:
msiexec.exe /p APAR.msp REINSTALLMODE=em
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where APAR is the name of the APAR file.

Administrative Installation
You can apply APARs to an install image by using the msiexec.exe parameter /p
APAR.msp, where APAR is the name of the APAR. This parameter may be used in
conjunction with the /a parameter, in order to commit an APAR to an
administrative installation. The command line syntax is as follows:
msiexec.exe /a "[absolute path to product .msi file]" /p "[absolute

path to .msp file]" REINSTALLMODE=em

Refer to the CD-ROM Guide to Installation for more information about
administrative installation and command line parameters. For more information
about the REINSTALLMODE property, refer to the Microsoft Developer Network
at http://msdn.microsoft.com.

You should always test an APAR on an administrative installation before pushing
the new image and/or the APAR to other machines. The administrative installation
on which APARs are tested and the administrative install image should always be
synchronized.

Interim Service Builds
An Interim Service Build (ISB) is a cumulative APAR package containing all
currently available APAR fixes. ISBs are tested to ensure that the included APARs
function well together. You can obtain ISBs using the APAR commit option in the
Product Update Tool. or by downloading the .msp file.

When you check for APARs, any available ISBs are also displayed. The
corresponding .msp file is located in the same application data directory as APARs,
with the specific ISB name. You may then be prompted to reboot the system.

To download ISB files, go to the Corrective Service Distribution site—you will find
a link to the latest ISB, a list of included APARs, and installation instructions.

Corrective Service Distributions
CSDs are packages containing a bundle of APARs and possibly new product
options and improvements. For Personal Communications, new CSDs are
cumulative. To check for CSDs, click Check for CSDs in the Product Update Tool.

Installing a CSD is similar to a reinstallation of the product (removing old product
files and installing new files); therefore, there is no test and commit process
available for CSDs. To remove a CSD, your only option is to uninstall the current
Personal Communications product level, then reinstall the prior level.

You can only obtain CSDs if you have purchased a full version of the product. This
is validated by entering a service key, which is included in the original package of
Personal Communications. When you check for CSDs, your Internet browser opens
to the CSD site, where you will prompted to enter your registration data and
service key. Once registration is complete and the service key is entered, you can
select the product, version and language for which you need the CSD update.

Note: A CSD file is usually larger than 100 MB.
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Detect and Repair
The Help → Detect and Repair operation performs a check on the installed
Personal Communications files to determine if the installation has been damaged.
A subsequent repair is performed, if necessary. Users must be authorized in the
System Policy to use this feature. The user may be prompted for the installation
image.

The Restore my shortcuts option will restore the original shortcuts. If the shortcuts
have been modified since the original Personal Communications installation, you
may want to keep shortcuts intact; in that case, do not choose this option.

Note: The Detect and Repair function may interrupt any active sessions or nodes,
without prompting the user. All active sessions and nodes should be closed before
the function is used.

Personal Communications Detect and Repair performs the following operations:
v Reinstalls a file if it is missing or corrupt, or if it is an older version.
v Rewrites all registry settings for the application in the LOCAL_MACHINE

section of the registry.
v Rewrites all registry settings for the application in the CURRENT_USER section

of the registry.
v Reinstalls all shortcuts (optional).

Alternatively, Windows Installer performs the following operations:
v Reinstalls a file if it is missing or corrupt, or if it is an older version. Windows

Installer does not check files for corruption
v Rewrites all registry settings for the application in the LOCAL_MACHINE

section of the registry.
v Rewrites all registry settings for the application in the CURRENT_USER section

of the registry.
v Reinstalls all shortcuts. This function is not optional in Windows Installer.
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Part 2. Advanced Configuration, Management, and Operations

© Copyright IBM Corp. 1989, 2003 17



18 Personal Communications Administrator’s Guide and Reference



Chapter 3. Advanced Configuration

This chapter describes facilities useful for deploying Personal Communications in
large networks. Some of these facilities are handled by features of Personal
Communications itself, while others are provided by external products, augmented
with facilities provided by Personal Communications.

Configuration Files
The following sections describe the advanced configurations that you can make
with the built-in files of Personal Communications. Advanced configurations
enable you to easily configure and distribute common keywords and parameters to
your client base, and include the following:
v Initial Configuration Definitions
v Configuration with Template and Update Files

Initial Configuration Definitions
Personal Communications enables network administrators to create an initial
configuration definitions file that contains common configuration definitions for
their clients. By using an initial configurations file, the administrator can distribute
preconfigured definitions and have them automatically preloaded whenever a new
configuration is created on a client.

The first step is to create a configuration using SNA node configuration, Start or
Configure Sessions, or an ASCII editor. For detailed information on configuring
sessions, refer to Quick Beginnings.

After you create the configurations file, rename the file to the appropriate reserved
name. For SNA node configuration files (*.ACG), the file name is PCSINIT.AC$.
For workstation profiles (*.WS), the file name is PCSINIT.WS$. For emulator
configurations using SNA communication, you should use both a PCSINIT.WS$
and a PCSINIT.AC$ file.

After you rename the files, they can be distributed to client workstations. Put the
files in the configuration files directory. The definitions in the files will be
preloaded whenever a user creates a new configuration.

Note: The initial configuration file does not override parameter defaults for new
definitions in new configurations, but preloads complete definitions into
new configurations. Users can modify these definitions to get custom
parameter values; however, the original initial configuration file remains
unchanged.

Configuration File and Emulator Profile Directories
The default directory for configuration files is specified during installation.
Configuration files can be used for all users or a specific user. Refer to CD-ROM
Guide to Installation for details on specifying the initial default directory.

By default, Personal Communications searches for emulator profiles in the
configuration files directory. You can use the User Preference Manager utility to
indicate a different location for profiles.
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Using Template and Update Files
When creating configurations for a large number of clients to implement, you can
create a template configuration file that represents the common configuration
elements for all clients. Using an update file with only those changes necessary for
each client, you can distribute the template and update file and merge the two to
create the target configuration.

The Personal Communications Server template and update files enable you to
create or modify a configuration using an ASCII editor. You can configure all of the
Personal Communications configuration keywords and parameters with update
files. Both the template and update files have the same format as Personal
Communications configuration (.ACG) files.

Template files can ease the mass distribution of configurations to remote clients. A
template file can specify the keywords which are common to several clients. For
example, if you have multiple clients to configure as SNA clients, many of the
keywords will be identical. You can create a template configuration file that reflects
those common keywords.

You can use update files to add, modify, or delete keywords in a template file. The
original template configuration file is left unchanged. An update file is merged into
a template file by specifying the INCLUDE keyword at the end of the template file.
For example, if an update file is named myconfig.chg, the last line of the template
file that will use the update file is INCLUDE=myconfig.chg. When the template file
and the update file are merged, you can give the resulting configuration file a
name with the .ACG extension that distinguishes it from other .ACG files.

When you create configurations using template and update files, the verification
utility searches directories in the following order:
1. The local directory where the verification utility is being invoked
2. The system-class application data directory

To ensure that the verification utility can locate the template and update files, you
should store them in the system-class application data directory, which is also
where the configuration (.ACG) files are stored.

Key Fields
The key field is the parameter in a keyword that names the keyword and uniquely
identifies it from other keywords of the same type.

Some keywords do not have key fields because they can only be specified once in
a configuration file. An example of a keyword that can only be specified once is
the NODE keyword.

Adding Keywords to a Template File
When using an update file to add a new keyword definition, you must provide the
entire keyword. The key field must be provided along with a unique value. If any
subfields are omitted from the keyword, the defaults for those fields are used. For
example, to add a MODE keyword to the configuration, the update file might
contain the following keyword:
MODE=(

MODE_NAME=MYMODE
COS_NAME=#INTER
CRYPTOGRAPHY=NONE
DEFAULT_RU_SIZE=1
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MAX_NEGOTIABLE_SESSION_LIMIT=128
MAX_RU_SIZE_UPPER_BOUND=4096
MIN_CONWINNERS_SOURCE=15

)

The content of the update file assumes that a MODE keyword with the parameter
of MODE_NAME=MYMODE does not exist in the template. If it does, the
parameters will be updated with the values provided in the update file.

If the MODE_NAME parameter is omitted from the update file, an error will occur
during the configuration verification because the MODE_NAME parameter cannot
be uniquely identified. Not all parameters available for the MODE keyword are
specified in the update file. The remaining parameters use the defaults as specified
in Configuration File Reference. The resulting addition to the configuration will look
like this:
MODE=(

MODE_NAME=MYMODE
AUTO_ACT=0
COMPRESSION=PROHIBITED
COS_NAME=#INTER
CRYPTOGRAPHY=NONE
DEFAULT_RU_SIZE=1
MAX_NEGOTIABLE_SESSION_LIMIT=128
MAX_RU_SIZE_UPPER_BOUND=4096
MIN_CONWINNERS_SOURCE=15
PLU_MODE_SESSION_LIMIT=32
RECEIVE_PACING_WINDOW=1

)

Modifying a Keyword in a Template File
When using the update file to modify an existing keyword definition, the original
keyword should exist in the template file. If it does not exist in the template file,
the update file adds an entry to the new configuration. You must specify the key
parameter in the update file to identify the target keyword. Only those parameters
specified in the update file keyword are updated in the template file’s keyword.
Parameters not specified in the update file are left unchanged. For example, if the
following MODE keyword is in the template file:
MODE=(

MODE_NAME=#INTER
AUTO_ACT=0
COMPRESSION=PROHIBITED
COS_NAME=#INTER
CRYPTOGRAPHY=NONE
DEFAULT_RU_SIZE=1
MAX_NEGOTIABLE_SESSION_LIMIT=256
MAX_RU_SIZE_UPPER_BOUND=4096
MIN_CONWINNERS_SOURCE=128
PLU_MODE_SESSION_LIMIT=256
RECEIVE_PACING_WINDOW=20

)

and the following keyword is specified in the update file:
MODE=(

MODE_NAME=#INTER
AUTO_ACT=10

)

the resulting configuration would have the following MODE keyword definition:
MODE=(

MODE_NAME=#INTER
AUTO_ACT=10
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COMPRESSION=PROHIBITED
COS_NAME=#INTER
CRYPTOGRAPHY=NONE
DEFAULT_RU_SIZE=1
MAX_NEGOTIABLE_SESSION_LIMIT=256
MAX_RU_SIZE_UPPER_BOUND=4096
MIN_CONWINNERS_SOURCE=128
PLU_MODE_SESSION_LIMIT=256
RECEIVE_PACING_WINDOW=20

)

Deleting a Keyword from a Template File
When using the update file to delete a keyword from the template, you must
specify the key parameter and value that identify the keyword, along with the
keyword DELETE. For example, if the template file specifies the following
keyword:
MODE=(

MODE_NAME=#INTER
AUTO_ACT=0
COMPRESSION=PROHIBITED
COS_NAME=#INTER
CRYPTOGRAPHY=NONE
DEFAULT_RU_SIZE=1
MAX_NEGOTIABLE_SESSION_LIMIT=256
MAX_RU_SIZE_UPPER_BOUND=4096
MIN_CONWINNERS_SOURCE=128
PLU_MODE_SESSION_LIMIT=256
RECEIVE_PACING_WINDOW=20

)

and the response file contains the following keyword:
MODE=(

MODE_NAME=#INTER
DELETE

)

the resulting configuration does not contain the #INTER mode definition.

The DELETE keyword can appear after a parameter=value specification or on a line
by itself, either preceding or following the parameter. For example, the following
uses of the DELETE keyword are valid:
MODE=(

MODE_NAME=#INTER
DELETE

)
MODE=(

DELETE
MODE_NAME=#INTER

)

The DELETE keyword cannot appear in front of a parameter=value specification on
the same line. For example, the following uses of the DELETE keyword are not
valid:
MODE=(

DELETE MODE_NAME=#INTER
)

MODE=(
MODE_NAME=#INTER DELETE

)
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To delete all keywords of a particular type, or to delete one keyword that does not
have a key field, only the keyword and the DELETE keyword are necessary. For
example,
MODE=(

DELETE
)

Note: Not all keywords can be deleted; only those which are not listed as required
can be deleted—refer to Configuration File Reference for details.

Applying Updates to Configuration Files
To update or change an existing SNA configuration file using an update file, do the
following:
1. Using a text editor, create an update file that contains keywords to be added,

deleted, or changed in an existing SNA node configuration file.
2. Add an include statement at the bottom of the existing SNA node configuration

or template indicating the name of the update file.
3. Invoke the SNA Configuration Verification utility by typing the following on

the command line:
vacgcon config.acg newconfig.chg

config.acg
The existing configuration file

newconfig.chg
The new configuration file

You must remove the include statement to reuse your template as a
configuration file.

Note: When an update file does not contain a complete, usable configuration, it is
recommended that you use an extension other than .ACG.

Configuring Multiple Links
Many customers must attach to multiple iSeries and zSeries™ mainframe systems.
Personal Communications allows this type of configuration. The following sections
explain how to do this.

Note: You do not need to read this section if you want to create multiple sessions
on the same host.

Configuring a Second 3270 Emulation Link

Recommendation
If you want a second SNA connection (link) to run concurrently, we strongly
recommend that you configure it in the same .ACG file as the first one; this
will avoid any possible conflict of settings.

Perform the following steps to configure a second 3270 emulation link. You can
make the configuration even if the first link is active.
1. Double-click the Start or Configure Sessions icon to start a new session; or

click Configure from the Communication menu.
2. Choose the host, interface, and attachment type, as usual.
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3. Configure the session parameters, then click Configure Link.
4. In the Configure Local System panel, check that the default .ACG file is the

one in which you saved the configuration for the first link. If not, click
Existing and choose the correct file from the list.

5. Check that the settings for the PC Location Name are correct. Click Next.
6. The LAN Device Connection panel appears. Under Device Selection, be sure

that the device used for the first link is displayed. Under Connection
Selection, select New Connection. Notice that the connection name has
changed to show a new link name. Click Next.

7. The Configure LAN Connection panel is displayed. The Destination Address
field will show 400000000000. Enter the Destination Address for the second
link, and change the additional parameters if needed.

8. Click Advanced.
9. The Advanced dialog panel shows the default values for block ID and PU ID.

Change them as necessary to the values for the second link. Click OK.

10. Click Next, then Finish, and save the .ACG file (replace the existing file).
Then click OK until you return to the session window. If you have done
everything correctly, and if the gateway or controller is running, you should
get a connection.

You can add further 3270 links in the same way.

Configuring a Second 5250 Emulation Link
The steps you should follow to configure a second 5250 emulation link are almost
the same as for 3270. You can make the configuration even if the first link is active.
1. Double-click the Start or Configure Sessions icon to start a new session; or

click Configure from the Communication menu.
2. Choose the host, interface, and attachment type, as usual.
3. Configure the session parameters, then click Configure Link.

4. In the Configure Local System panel, check that the default .ACG file is the one
in which you saved the configuration for the first link. If not, click Existing and
choose the correct file from the list.

5. Check that the settings for the first link are correct. Click Next.

6. The Configure Logical Connection panel appears, showing the settings for the
first link. If you are going to connect to a different iSeries, change the System
Location Name. Click Next.

7. The Configure LAN Connection panel appears. If the Link Station Name has
not changed, change it.

8. Change the Destination Address (and the other parameters if necessary). If you
want to change the Local SAP number or the Receive Buffer Count, (which is
unlikely), click Advanced. If not, click Next, then Finish, and save the .ACG
file (replace the existing file), then click OK until you return to the session
window.

You can add further 5250 links in the same way.

Configuring a Second Link of a Different Kind
The procedure for configuring other links is similar to those for the configurations
for 3270 and 5250 link configurations. This procedure applies whether you are
going to configure two (or more) links that use the same connection type, or links
that use different connection types. In this example, assume that you have already
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configured a 3270 connection and now want to add a 5250 connection. As before,
you can make the configuration even if the first link is active.
1. Double-click the Start or Configure Sessions icon to start a new session; or

click Configure from the Communication menu.
2. Choose iSeries, the LAN interface and the IEEE 802.2 attachment type.
3. Configure the session parameters, then click Configure Link.

4. In the Configure Local System panel, check that the default .ACG file is the one
in which you saved the configuration for the 3270 link. If not, click Existing
and choose the correct file from the list. Notice that the PC Location Name is
already there. Click Next.

5. The Configure Logical Connection panel appears. Enter the System Location
Name and click Next.

6. Notice that the Link Station Name has changed. Enter the Destination Address
of the iSeries. Click Next, then Finish, and save the .ACG file (replace the
existing file); then click OK until you return to the session window.

Configuring to Perform 3270 and 5250 Emulation to Multiple
Hosts

To configure Personal Communications to perform 3270 and 5250 emulation to
multiple hosts:
1. Click Actions → Launch → SNA Node Configuration of your active session; or

click SNA Node Configuration from the Program → IBM Personal
Communications folder on the Windows Start menu.

2. Configure the node information:
a. Click Configure Node from the list of Configuration options.
b. Click New.
c. In the Fully qualified CP name field, enter the Network ID and CP name

that is defined for you on the iSeries (APPN.TEST, for example).
Note: If the iSeries is performing automatic configuration, the value you
enter here is ignored. However, it is still necessary to enter a value in the
field to close the panel.

d. Click OK.
3. Configure the device information:

a. Click Configure Devices from the list of Configuration options.

Note: In Windows 2000 and XP, the dialog displays the device adapters
that are installed and indicates whether each adapter is enabled or
disabled.

b. Click LAN from the list of available DLCs.
Note: These instructions are based on the LAN DLC; the field names and
tabs might be slightly different if you are configuring another type of DLC.

c. Click New.
d. Specify the adapter number for the connection.
e. Click OK.

4. Configure the connection information:
a. Click Configure Connections from the list of Configuration options.
b. Click LAN from the list of available DLCs.
c. Click New.
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d. Enter the Link station name (default is LINK0000) and click the LAN
device (for example, LANX_04) that you selected from the list of available
DLCs. This link will be defined for the 5250 session to the iSeries.

e. Enter the LAN destination address of the iSeries.
f. Click the Advanced tab.
g. Verify that Activate at startup is selected
h. Verify that APPN support is selected.
i. If you plan to use 3270 passthrough on this connection, click Solicit SSCP

sessions.
j. Click OK to save the information.

5. Configure the second link for the 3270 session:
a. Click New.
b. Enter the Link station name (default is LINK0001) and select the same

device you used to define the 5250 session (for example, LANX_04). This
link will be defined for the 3270 session to the host.

c. Enter the LAN destination address of the host.
d. Click the Advanced tab.
e. Verify that Activate at startup is selected.
f. Verify that APPN support is selected.
g. Click Solicit SSCP sessions.
h. In the Local Node ID field, enter the Block ID and Physical Unit ID that

identifies the device.
i. Click the Adjacent Node tab.
j. Click HOST-XID3 from the list of Adjacent CP types.
k. Click OK.

6. Configure the Partner LU 6.2 information:
a. Click New.
b. Enter the Partner LU name, such as APPN.S101010. This is the name of the

iSeries; this information can be obtained by running a DSPNETA on the
iSeries.

c. Click OK.
7. Save the configuration information:

a. On the SNA Node Configuration window, click Save As from the File
menu.

b. Enter a file name with a .ACG file extension, such as TEST.ACG. Click Yes
to make this configuration the default.

c. Click Exit on the File menu.
8. Start the 5250 emulator session:

a. Click Program → IBM Personal Communications → Start or Configure
Sessions from the Windows Start menu.

b. Click the iSeries host, the LAN interface, and the IEEE 802.2 attachment.
c. Click Configure.
d. Click Configure Link.
e. Click Existing.
f. Click the configuration you saved in step 7 from the list and click Open.
g. Click Next.
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h. Verify that the System location name matches the name you specified in
step 6. Click Next.

i. In the Device name field, select the device name you defined in step 3.
Click Next.

j. In the Link station name field, select the name you defined in step 4, such
as LINK0000. Click Next.

k. Click Finish.
l. Click Save and then click Yes to overwrite the existing file.
m. Click OK to close the Customize Communication - 5250 Host window and

then click OK to close the Customize Communication window and start
the 5250 session.

9. Save the workstation profile for the 5250 session:
a. Click Save As from the File menu on the emulator window.
b. Enter a file name with a .WS extension and click OK.
c. If you want the ability to start this session separately, click Yes to create an

icon; otherwise, click No.
d. Click OK.

10. Start the 3270 emulator session:
a. Click Program → IBM Personal Communications → Start or Configure

Sessions from the Windows Start menu.
b. Click the zSeries host, the LAN interface, and the IEEE 802.2 attachment.
c. Click Configure.
d. Click Configure Link.
e. Click Existing.
f. Select the configuration you saved in step 7 from the list and click Open.
g. Click Next.
h. In the Device name field, select the device name you defined in step 3.

Click Next.
i. In the Link station name field, select the name you defined in step 5, such

as LINK0001.
j. Click Advanced.
k. Clear APPN support and click OK.
l. Click Next.
m. Click Finish.
n. Click Save and then click Yes to overwrite the existing file.
o. Click OK to close the Customize Communication - 3270 Host window and

then click OK to close the Customize Communication window and start
the 3270 session.

11. Save the workstation profile for the 3270 session:
a. Click Save As from the File menu on the emulator window.
b. Enter a file name with a .WS extension and click OK.
c. If you want to start this session separately, click Yes to create an icon;

otherwise, click No.
d. Click OK.

12. Create a batch file to start both the 5250 session and the 3270 session at the
same time:
a. Close both running emulator sessions.
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b. Click Programs → IBM Personal Communications → Utilities → Multiple
Sessions from the Windows Start menu.

c. From the list of workstation profile files, select the .WS file for the 5250
session (step 9). Click Add.

d. From the list of workstation profile files, select the .WS file for the 3270
session (step 11). Click Add.

e. Click Save As from the File menu and enter a file name with a .BCH
extension to save the batch file. Click OK.

f. Click Yes. Verify that the folder is the DESKTOP and select both check boxes.
Click OK.

g. Click Exit from the File menu.
13. To start the 5250 and 3270 emulator sessions together, double-click the Batch

File icon on your Desktop.

Automatic Device Name Generation (5250 Only)
The Telnet 5250 client function can generate a new and non-arbitrary DEVice
NAME (DEVNAME) for a session without requiring per-session profile (*.WS)
customization or a user exit.

You can use keywords and special characters in the WorkStationID (WID) field (in
the [5250] stanza of the Workstation profile) to cause some or all of the following
information to be substituted into the DEVice NAME value that is sent to the
TN5250 server:
v Computer name or user name
v Short session ID
v Session type ID
v Collision avoidance ID

When specified, the Collision Avoidance ID enables the generation of a new
DEVice NAME if the Telnet server rejects a submitted name (which can occur
when the old name is already in use on the iSeries). The ability to have a variety of
names generated allows multiple sessions to the same iSeries from one or more
clients using just one WorkStation Profile (.WS) file. The definition of the existing
.WS file parameter WorkStationID in the [5250] stanza is extended to accomplish
this.

Substitution Characters
You can use special substitution characters in the WID field to control the
placement of the generated information into the DEVNAME field. One substitution
character is used in the WID for each generated character. This reserves space in
the DEVNAME for each generated character and indicates where each generated
character is to be placed. The three special substitution characters are:

Short Session ID
(value range: A–Z) The special character signifying this in the WID is the
asterisk (*).

Example:
If the WorkstationID is configured as 123* and the short ID of the first
session is A, then the device names generated for the first three sessions
will be 123A, 123B, and 123C.
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Session Type ID
(possible values: S for diSplay or P for Printer) The special character
signifying this in the WID is the percent sign (%).

Example: If the Workstation ID is configured as %123* and the session type
is Printer, then the first three device names generated would be
P123A, P123B, and P123C.

Collision Avoidance ID
(value range: 1–9, A–Z) The Collision Avoidance ID (CAID) is used by the
device name collision (DNC) function (see “Device Name Collision
Processing” on page 30) to generate a new DEVice NAME when the old
name is rejected by the Telnet server as already being in use. The special
character signifying this in the WID is the equals sign (=).

Example: If the Workstation ID is configured as %ABC=, the session type is
Display, and the device name SABC1 is already in use on the
iSeries, then the first generated device name (SABC1) will be
rejected by the server, but the second name (SABC2) will be
accepted.

Client Naming Function
If you specify a Client Naming (CN) substitution keyword in the Workstation ID
(WID) field, then an external name is retrieved and used when generating the
DEVice NAME.

The CN keywords are prefixed with the ampersand character (&), followed by a
five character identifier. Two keywords are supported:

&COMPN
Windows COMPuter Name for the client

&USERN
USER Name specified during logon to the Windows computer where the
emulator executes

A name whose length exceeds the space remaining in the 10 character long
DEVNAME field will have that excess trimmed from the left side by default.
Excess characters can alternatively be trimmed from the right side by prefixing the
CN keyword with a plus sign (+) character (for example, +&COMPN).

Notes:

1. If the specified name cannot be obtained, then the message Unable to get the
local "x" name (where ″x″ is COMPN or USERN) is displayed in the status
bar.

2. If a client naming keyword is specified in the WID, then characters other than
those defined for this feature are ignored.

3. A numeric character in the first position of a DEVNAME is invalid, and may be
converted by the iSeries to the pound (or number) character (#).

Example A: If the Workstation ID is &COMPN* and the name of the local computer is
clientaccess1, then the device names generated for the first three
sessions would be ntaccess1A, ntaccess1B, and ntaccess1C.
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Example B: If the Workstation ID is +&COMPN*% and the name of the USER logon
for the local computer is clientaccess1, then the device names
generated for the first three sessions would be clientaccA, clientaccB,
and clientaccC.

Device Name Collision Processing
Device name collision occurs when a Telnet client sends the Telnet server a virtual
device name, but that device name is already in use on the server. When this
occurs, the Telnet server sends a request to the client asking it to send a different
DEVNAME.

Device name collision (DNC) processing handles requests from the server for a
different DEVNAME. If the collision avoidance ID (CAID) substitution character is
present in the WID, the CAID is incremented and sent as part of the new
DEVNAME to the server.

If the server requests a different DEVNAME and the CAID is not present in the
WID, then the error message Device Name "x" is invalid or already in use on
the server is displayed on the status bar and the session is disconnected.

Commands for Emulator Functions
Personal Communications provides the following commands for managing
Personal Communications sessions:

PCOMSTRT
Start a Personal Communications session

PCOMSTOP
Stop a Personal Communications session

PCOMQRY
Query Personal Communications sessions

Start a Personal Communications Session
The command PCOMSTRT has the following parameters:

/p Name of workstation profile to start (required). The syntax is
/p=workstation-profile. You can specify the workstation profile as either the
path (drive, directory, and file name) or just the file name, in which case
the location of the workstation profile file is the user-class application data
directory.

Note: If multiple /p parameters are given, PCOMSTRT only uses the last
one to start a profile (.WS file).

/s Session letter of the session to start. The syntax is /s=session-letter. This is
optional. If omitted, the first available session letter is used.

/w Session window startup state. The syntax is /w={0|1|2|3}.

0 Hidden

1 Normal (default)

2 Minimized

3 Maximized
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/q Quiet mode. In quiet mode, PCOMSTRT does not write any messages to
stdout.

/nowait
Do not wait for session to start. The /nowait option tells PCOMSTRT to
complete execution without waiting until the emulator session is started.
There is no /wait option; the default is to wait until the session is started.

/? Displays help information.

Returns: DOS Error level is set for use when this command is invoked by a
program. When the command is directly entered, a message indicating the session
is starting is displayed.

Stop a Personal Communications Session
The command PCOMSTOP has the following parameters:

/s Session letter of session to stop. The syntax is /s=session-letter. This is
optional. If omitted, the first available session letter is used.

/all Stops all sessions

/q Quiet mode. In quiet mode, PCOMSTOP does not write any messages to
stdout.

/? Displays help information.

Returns: DOS Error level is set for use when this command is invoked by a
program. When the command is directly entered, a message is displayed indicating
the session is stopping.

Query Personal Communications Sessions
The command PCOMQRY has the following parameters:

/s Session letter of session to query, The syntax is /s=session-letter. This is
optional. If omitted, the first available session letter is used.

/all Queries all sessions.

/q Quiet mode. In quiet mode, PCOMQRY does not write any messages to
stdout.

/nowait
Do not wait for session to query. The /nowait option tells PCOMQRY to
complete execution without waiting until the emulator session is queried.
There is no /wait option; the default is to wait until the session is queried.

/? Displays help information.
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Chapter 4. Attachment Considerations and Adapter Setup
Information

This chapter describes factors you should consider when configuring Personal
Communications for the following attachment types:
v “COAX Attachment”
v “LAN via IEEE 802.2 Attachment” on page 34
v “TCP/IP Connection” on page 34
v “SDLC MPA Attachment” on page 36
v “IBM Global Network - SNA over Async Attachment” on page 37
v “IBM Global Network Connection Attachment” on page 37
v “Home3270 Attachment” on page 38
v “3270 Attachment via the iSeries System” on page 38
v “IBM PC720 Modem Initialization (Japan only)” on page 39
v “3174 Peer Communications Support (LAN over Coax)” on page 39
v “5250 Twinaxial Console” on page 40
v “Twinax Connections through a 5494 Controller to an iSeries” on page 41
v “5250 Asynchronous Console” on page 41

This chapter also contains information about setting up communications adapters
(for example, Coax, Twinax, MPA, SDLC, WAC). See the following topics:
v “Creating and Updating Devices in Windows 2000 and XP” on page 41
v “Using Coax (3270) Adapters” on page 42
v “Twinax Adapters” on page 44
v “MPA Adapters” on page 46
v “WAC Attachments” on page 48
v “OEM Adapters” on page 49

Attachment Information

COAX Attachment
This section describes factors you should consider when configuring Personal
Communications with a coaxial attachment.

Note: The APPC and CPI-C APIs, provided with Personal Communications, do not
support coaxial connections.

Avoiding Machine Check 207
Patch the microcode of the 3174 control unit. The following list shows the
relationship between 3174 control unit microcode levels and patch IDs:

Microcode Level Patch ID

S0503 PCA53D1

S0504 PCA53D2

A0503 PCA53D3
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A0504 PCA53D4

B0200 PCA53D5

B0401 PCA53D6

B0402 PCA53D8

C0101 PCA53D7

In addition, if you have a 3174 with Configuration Support B or higher, you can
set the following parameters:
v 3174 customization Q126 digit 2=1 to change the COAX timeout from 50 to 100

microseconds.
v 3174 customization Q125 digit 4=1 to set command chaining off.

Restrictions
When your workstation is configured to use a DFT attachment, the following
functions and capabilities of the IBM 3174 or 3274 Control Units are not supported:
v Programmed symbols on attached workstations
v Attachment to port 0 on attached workstations
v Database operations
v 3270 Diagnostic Reset Dump
v Patch facility

Configuring a Non-Plug-and-Play Coax Adapter (ISA)
See “Adapter Setup Information” on page 41 for more information on configuring
IBM coax adapters.

LAN via IEEE 802.2 Attachment
Following is a description of preinstallation considerations for installing Personal
Communications for use on a LAN. For more detailed information, refer to the
IBM Local Area Network Technical Reference.

PIU Size
This value is negotiated between your workstation and the host system, unless
XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the
Maximum PIU Size must match the MAXDATA value defined on the host system.

Receive Window Count
This value is negotiated between your workstation and the host system, unless
XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the
Receive Window Count must match the MAXOUT value defined on the host system.

Using a PCMCIA Token-Ring or Ethernet Card
Personal Communications supports the IBM Token-Ring and Ethernet credit card
adapters in the same way as it does the full-size adapters.

TCP/IP Connection
This section provides information, considerations, and restrictions for Personal
Communications TCP/IP connections.

TCP/IP Protocol Driver
You must set up your Windows environment for the TCP/IP network. To verify
that the TCP/IP protocol is installed on your workstation, double-click Network in
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your Control Panel and see if TCP/IP appears in the list of network components.
Double-click TCP/IP to specify your IP address and other TCP/IP properties.

Screen Size
The following four screen sizes are supported for TN3270:

24x80
32x80
43x80
27x132

The following two screen sizes are supported for TN5250:
24x80
27x132

Screen sizes 48x80, 62x160, and 24x132 are supported if your server/host supports
the TN3270E protocol.

Terminal Type to Be Negotiated with TN3270
The terminal type to be negotiated is set to IBM-3278-2-E, IBM-3278-3-E,
IBM-3278-4-E, or IBM3278-5-E according to the screen size that is specified on the
Customize Communication 3270 Host panel. If you need to specify IBM-3279-2-E
or IBM-3279-3-E (for graphics), add the following line to the [Telnet3270] section in
the workstation profile (.WS):

TerminalType=3279

TN3287 and TN3270E Connection
TN3287 (defined in RFC 1646) and TN3270E (defined in RFC 1647) were tested
with following Telnet servers:
v Communications Server for Windows
v Communications Server for OS/2®

v TN3287 Brixton PU2.1 V3.0
– SNA Client Access™ for AIX® Version 1 Release 2
– IBM Communications Server for OS/2 Warp

v TN3270E Brixton PU2.1 V3.0
– SNA Client Access for AIX Version 1 Release 2
– IBM Communications Server for OS/2 Warp

v Microsoft SNA Server

Other TCP/IP Functions

Backup Server/Host with LU Name and Port Number: Personal Communications
enables you to specify up to two backup host or server names to connect to. This
provides easier connections when the primary host or server cannot be reached.
You can also specify a specific LU name or port number unique to that server or
host.

Service Location Protocol: Personal Communications enables connection to SLP
servers that are RFC 2165 compliant. This function eliminates the need for users to
know the name of a network host supporting a specific service. SLP
implementation for a Personal Communications client allows load balancing and
dynamic location of a specific LU or LU pool across a group of servers. IBM
Communications Server for Windows 6.1 currently supports SLP. This support can
be used in conjunction with SSL support.
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TN5250 Enhancements: Personal Communications enables you to emulate a
TN5250 printer session if the Host carries OS/400 V4.2 or higher. A Workstation ID
for display and printer emulation sessions can also be specified.

SDLC MPA Attachment
This section describes factors you should consider when configuring Personal
Communications with an SDLC attachment.

Line Speed
For the SDLC attachment, a line speed up to 28.8 Kbps is supported. However,
actual line speed will vary depending on the carrier speed the modem supports.

V.25bis Autodial
Personal Communications only supports the bit-oriented protocol for V.25bis call
control messages. Modems must support an ASCII-coded character set consisting
of 7-bit coded ASCII characters with odd parity.

Personal Communications supports the following adapters:
v Multiprotocol (MPA) interface compatible adapters, for example:

– IBM Multiprotocol Communications Adapter (73G7099)
– IBM Multiprotocol Adapter/A (645114 or later)
– IBM SDLC/Async Communications Adapter (ASCA) (42H4332)

v IBM SDLC PCMCIA adapter (Japan only)
v IBM SDLC PCMCIA modem (Japan only)
v IBM PCI Multiprotocol Adapter (12J2981)

Performance Considerations
If you use multiple sessions in a high-speed and high-load configuration with an
SDLC attachment, the connection to the host might fail. In this case, set the host’s
timeout value to be greater than that of Personal Communications.
v To change the host timeout value, modify the following NCP parameters:

REPLYTO
The maximum duration in seconds that the host waits for a reply from
the terminal. The default is 1 second.

RETRIES=(m,t,n)
The number of recovery attempts for errors occurring during
transmission over the link. Repetitive retries are called a retry sequence.
The maximum number of retries is specified as m, which can be from 0
to 128. NCP pause (the time between the retry sequences) is specified as
t and can be from 1 to 255 seconds. The maximum number of retry
sequences is specified by n and can be from 1 to 127. For example:

REPLYTO=1, RETRIES=(3,4,5)
(( 1(seconds) x 3(times) + 4(seconds)) x 5(times)
= 35 (seconds)

Note: In this example, the host waits 35 seconds for the terminal to
reply.

For more details, ask your system personnel.
v To change the Personal Communications timeout value, type a new value in the

Inactivity timer field on the Performance page of the Connections property sheet
in SNA Node Configuration.
The value is in seconds and can be from 40 to 160. The default is 80.
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PIU Size: This value is negotiated between your workstation and the host system,
unless XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the
Maximum PIU Size must match the MAXDATA value defined on the host system.

Receive Window Count: This value is negotiated between your workstation and
the host system, unless XID=No is defined on the PU, or the Adjacent CP type has
been changed to Host - XID0 in SNA Node Configuration. If this value is not
negotiated, the Receive Window Count must match the MAXOUT value defined on the
host system.

IBM Global Network - SNA over Async Attachment
IBM Global Network - SNA over Async is supported using 8-bit no parity; SNA
session-level compression and decompression is not supported.

Line Speed
Line speeds up to 115.2 Kbps are supported. However, the maximum usable line
speed depends on the speed of the processor or communication port. If
communication stops or becomes exceedingly slow, reduce the line speed.

Updating Phone List
To update the phone number list for IBM Global Network SNA over Async, do the
following:
1. Click the Use Phone Book button on the Define a Com Port Connection panel.
2. Click the Download Phone Numbers button.

Personal Communications FTPs to the IGN server and downloads the phone
number file and converts it to the correct format.

Note: A Proxy must be configured in order for this procedure to work.

IBM Global Network Connection Attachment

Note: This attachment type is not available in Japan.

IBM Global Network Connection supports only a single communication port.

Line Speed
IBM Global Network Connection supports up to 115.2 kbps as the line speed.
However, the maximum usable line speed depends on the speed of the processor
or communication port. If communication stops or becomes exceedingly slow,
reduce the line speed.

Updating Phone List
To update the phone number list for IBM Global Network SNA over Async, click
the Download Phone Numbers button from the Configuration panel. When this
button is selected, Personal Communications FTPs to the IGN server and
downloads the phone number file and converts it to the correct format.

Note: A Proxy must be configured in order for this procedure to work.

Restrictions
You cannot use the following functions:
v Import/Export
v Host graphics
v Host print
v Server-Requester Programming Interface (SRPI)
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v Concurrent multiple file transfers

Home3270 Attachment
Because Home3270 supports only a single COM port, only one session is available
for use at a time.

Setting the Screen Colors in a Home3270 Session
Because protocol converters translate the 3270 (EBCDIC) data stream into an ASCII
data stream, the original information about the 3270 fields is lost, and all the field
attributes of the 3270 screen are treated as extended attributes. Because of this, you
must select the Extended Color category in order to change the colors of characters
on the screen. Changing base colors will have no effect.

For example, if you want to change the color of characters that appear in green on
a black background, select Extended Color - Green, then click or drag-and-drop
the color you want for the characters (and for the background if you wish). Do not
change the appropriate Base Color because the change will have no effect.

Line Speed: Line speeds up to 115,200 bps are supported. However, characters
might be lost on high-speed lines, depending on the processor speed. If
communication stops or becomes exceedingly slow, reduce the line speed.

Unsupported Character Sequences: The following character sequences are valid
for the Home3270 attachment. However, they perform no function.
v ESC P 1 (Block cursor command)
v ESC P 0 (Underline cursor command)
v DLE DC2 (Printer start command)
v DLE DC4 (Printer end command)

Conditions for Communication Check 50x: Home3270 requires both Data Set
Ready (DSR) and Carrier Detect (CD) to determine the state of the attachment with
the host system. If DSR is not recognized, communication check 501 appears in the
operator information area. When DSR is recognized and CD is not recognized,
communication check 504 appears in the operator information area.

When you select ROLMphone with DCM in the Home3270 configuration,
communication check 504 does not appear.

Home3270 and OIA message COMM 504: If you run Home3270 sessions at a
speed of 28.8 kbps or higher and the session disconnects with a COMM504 in the
OIA, try lowering the port speed to equal the line speed of the Protocol Converter
you are connecting to.

Note: DBCS is not available with this attachment.

Restrictions: The following functions are not available with this attachment:
v Host graphics
v Host print
v Server Requester Programming Interface

3270 Attachment via the iSeries System
This section provides information, considerations, and restrictions for PC/3270
connections through an iSeries system.
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iSeries System Setup
PC/3270 can connect to a host computer through one or more iSeries systems by
using the passthrough function (usable with OS/400 Version 2.2.0 or later).

To use this function, set the following communication configuration descriptions in
the iSeries system to on (Vary On):
v Line description
v Controller description
v Printer description

Error Messages from the iSeries System
When this system is connected to an zSeries host system through the iSeries
system, the following message might appear on the screen.

AS/400 CPI5xxx

The message might appear for the following reasons:
v Line error between the iSeries system and the host system
v Communication configuration description error in the iSeries system
v The communication configuration description in the iSeries system is set to off

(Vary Off)

When this message appears, detailed error information is saved in the iSeries
system operator message queue. Refer to the error message that corresponds to the
number displayed on the screen and then correct the cause of the error.

IBM PC720 Modem Initialization (Japan only)
In the Japanese version of Personal Communications, if you use an IBM PC720 and
connect it via a dial connection, the error message “COMDIA15 Unable to
initialize modem” may appear at startup. To correct this condition, increase the
value of Retries in Initialization to more than 1 by using the Modem Information
panel.

3174 Peer Communications Support (LAN over Coax)
The LAN over Coax function provides peer-to-peer communication for
workstations connected to an IBM 3174 Control Unit through an IBM 3270
communication adapter. It provides support for any NDIS protocol stack capable of
utilizing the IEEE 802.5 (token-ring) frame format, such as IEEE 802.2 (SNA),
NetBIOS, TCP/IP, or LLC2. This function is not supported for Windows 2000 and
XP.

Installing LAN over Coax
Under Windows 95 or Windows 98:
1. On the network Control Panel, choose to install a new adapter.
2. Select the Have Disk option when prompted.
3. Install the program in the XLNCOAX subdirectory in the Personal

Communications installation directory.

For Windows 95 and Windows 98, the .INF file installs the new adapter support
and binds the adapter to all valid protocol stacks. To utilize the new adapter, after
installing and rebooting, configure Personal Communications to utilize a LAN
adapter, and enter the adapter number that corresponds to the 3174 Peer
Communications adapter number found under the LLC Protocol for this adapter.
The 3174 Peer Communications RPQ is also required on the 3174.
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Configuring LAN Over Coax
For Windows 95 and Windows 98, configure by using the Network Control Panel
Properties button for the selected adapter.

Options:

Network Address
Overrides the burned-in adapter address.

Queued Transmits
Number of queued transmit elements to support.

Slot Number
Required for MCA bus systems, not applicable to others; indicates the
adapter to use in a specific MCA slot.

On Micro Channel® workstations, you can use up to four type-B 3270 Connection
Adapters (but only 1 type A). When you configure Personal Communications, you
must specify the physical slot in which each adapter is installed.

System Resources: On ISA Bus systems, the following system resources are used:
v Interrupt Level 2
v IO address 0x2d0 through 0x2df
v Shared memory address 0xce000

These resources are not changeable. On MCA systems, these resources are
configured via the MCA adapter configuration, with the exception for the Interrupt
number, which is Interrupt 2.

Multiple Adapter Coexistence
If you use type-B adapters, you can use one or more for DFT connections
concurrently with 3174 Peer Communications. If you want to do this, the Peer
Communications adapters must be in higher-numbered slots than the DFT
adapters because DFT connections will, by design, use the first adapters they find,
searching from slot 1.

5250 Twinaxial Console
You can configure Personal Communications to act as the console for an iSeries. If
you want to use full-function 5250 emulation, you must not use the console
attachment; you must use Twinaxial Data Link Control (APPC).

Restrictions:
v The Setup API functions of the File menu cannot be used.
v Copy is the only editing function available.
v The file transfer function cannot be used.
v The session type cannot be set to Printer (iSeries).
v Multiple console sessions cannot be used.
v The Enhanced Non-programmable Terminal User Interface (ENPTUI) cannot be

transferred from the host system.
v The PC Organizer cannot be used.
v The screen size is always 24x80, even if 27x132 is specified.
v The cursor position cannot be moved by the mouse.
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Twinax Connections through a 5494 Controller to an iSeries
To set up a twinaxial connection to an iSeries through a 5494 controller:
1. Click Programs → IBM Personal Communications → SNA Node Configuration

from the Windows Start menu.
2. Click Configure Connections from the list of Configuration options and then

click Twinaxial from the list of DLCs.
3. Click an entry from the list of configured twinaxial connections and click

View → Change → Add.
4. Check Link to preferred NN server.
5. Click the Security tab.
6. In the Adjacent CP name field, enter the network ID and CP name of the

5494 controller.
7. Click OK to save the connection information.
8. Click Configure Partner LU 6.2 from the list of Configuration options.
9. Click an entry from the list of Partner LU 6.2 definitions and click View →

Change → Add.
10. In the Partner LU name field, enter the CP name of the iSeries system. The CP

name is also known as the system location name.
11. In the Fully qualified CP name field, enter the network ID and CP name of

the 5494 controller.
12. Click OK to save the Partner LU 6.2 information.
13. Click Save As... from the File menu.
14. Enter a file name with an .ACG file extension, such as CFG5494.ACG. Click Yes

to make this configuration the default.

Note: To enable this configuration, configure the 5494 controller as a network node
(NN).

5250 Asynchronous Console
For the asynchronous console attachment, you must have a 2609 or 2612 adapter
for the Multiple Function I/O Processor (MFIOP) on the iSeries system. This
connection also requires a special cable. The part numbers for the cables are
46G0450 (6m) and 46G0479 (2.5m).

Note: The iSeries Advanced Portable Model P02 does not support the
asynchronous console attachment.

An asynchronous console has the following restrictions:
v Multiple console sessions cannot be used.
v APIs are not supported
v The session type cannot be set to the Printer.
v The file transfer functions is not supported.
v The PC Organizer cannot be used.

Adapter Setup Information

Creating and Updating Devices in Windows 2000 and XP
In Windows 2000 and XP, Personal Communications does not install drivers for
communications adapters (Coax, Twinax, MPA, SDLC, WAC). You have to install
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the drivers and create devices using the Windows Hardware wizard or the Device
Manager. You must use that process for both Plug-and-Play and non-Plug-and-Play
adapters. The drivers and .INF files are located on the Personal Communications
CD-ROM in the \admin\drivers subdirectory.

If you are installing Version 5.7 in Windows 2000 or XP over a previous release of
Personal Communications, and you are using a communications adapter, you
should update the existing driver using the Windows Device Manager.

Not all communications adapters listed here are supported for Windows 2000 and
XP.

Note: For more information about driver installation, updating drivers, and
adapter setup in Windows 2000 and XP, refer to the CD-ROM Guide to
Installation.

Using Coax (3270) Adapters
The configuration of IBM ISA-bus, Micro Channel (MCA), and Plug-and-Play coax
adapters is described in the following sections. However, Micro Channel adapters
are not supported for Windows operating systems.

Polling Feature
Your workstation might have been configured so that an IBM coax adapter cannot
acquire an interrupt request line (IRQ) that it needs in order to function. This
situation occurs because other devices have been configured to use these IRQs, so
that the IRQs are no longer available. This situation can occur in any supported
Windows operating system.

In such a situation, the IBM coax adapter may or may not be able to use another
available IRQ. The IBM 3278/79 Emulation Adapter (ISA bus) can use only IRQ 9.
Other IBM coax adapters, such as the IBM 3270 Credit Card adapter, can use other
IRQs than IRQ 9, but all these other usable IRQs may also have been reserved for
other devices in the system.

If this happens, you can use the polling feature to enable the IBM coax adapter to
function without using an IRQ. To activate the polling feature, add the Poll=Y
parameter to the [CSDFT] or [CNDFT] section of your workstation profile (*.WS)
as follows:
v SNA/DFT attachment

[CSDFT]
Poll=Y <-- add

v Non SNA/DFT attachment
[CNDFT]
Poll=Y <-- add

For an IBM 3270 Credit Card adapter, the polling feature is automatically activated,
without Poll=Y being added to the .WS file.

Plug-and-Play Adapters
You cannot use multiple 3270 PnP adapters, nor can you use a 3270 PnP at the
same time as a 3278/79 Emulation or 3270 Connection Adapter.

Configure Personal Communications in the normal way. The Plug-and-Play radio
button is active and you do not have to configure the buffer address.
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For Windows 95 and 98, the first time that you insert the 3270 Emulation Credit
Card Adapter into a PCMCIA slot or start your PC with the PCI card installed,
Windows will prompt you for the location of the .INF file for the card. The .INF
file is located in the directory where Personal Communications is installed.

Note: Removing the card while you have an active connection will have
unpredictable results.

ISA-Bus Adapters

3278/79 Emulation Adapter: This adapter has a fixed I/O-port address and
interrupt level (IRQ), but you have to set the memory address, which you can do
only through the Personal Communications configuration.

The buffer address must be set. The default is CE000. If you happen to know that
this address is already being used by another device, you should change it, but,
when you first try to connect, Personal Communications will check the registry to
find an available address anyway.

In Windows 2000 and XP, if Personal Communications cannot acquire a system
resource (that is, an IRQ, a memory address, or an I/O address) needed by this
adapter, Personal Communications displays an error panel identifying the
unavailable resource. For an IRQ conflict (this adapter uses IRQ 9 only), Personal
Communications automatically tries to activate the polling feature instead of using
IRQ 9; if this succeeds then no error panel is displayed. For a memory address
conflict, you should use the Personal Communications coax adapter configuration
panel to select another memory address. For an I/O address conflict, you should
reconfigure the device that is using the I/O address to use some other I/O
address.

MicroChannel Adapters

IBM 3270 Connection Adapter: Micro Channel adapters need the same types of
resource as ISA-bus but configuration is much easier because the resources are all
set by the workstation’s hardware configuration and Personal Communications is
able to read them.

Configure Personal Communications in the normal way. The default buffer address
will be the one set in the system configuration. You should not change it.

Note: MicroChannel adapters are not supported for Windows operating systems.

3270 ISA-Bus and MCA Adapters and ROM Shadowing
These adapters use 8KB of workstation memory; the default values for the memory
addresses are as follows:
v Adapter #0 CE000h - CFFFFh
v Adapter #1 D0000h - D1FFFh
v Adapter #2 D2000h - D3FFFh
v Adapter #3 D4000h - D5FFFh

Some types of workstation might use these areas, by default, for ROM shadowing
in BIOS (the IBM PC350 for example). You should check the ROM-shadowing
settings before installing an adapter, and disable the range that will be used by the
adapter that you are going to install.
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Coax Adapters and ROM Shadowing: Personal Communications maps the
shared RAM of the 3270 connection adapter on the PC. The default values for the
adapters as follows:
v Adapter #0 CE000h - CFFFFh
v Adapter #1 D0000h - D1FFFh
v Adapter #2 D2000h - D3FFFh
v Adapter #3 D4000h - D5FFFh

Workstations that support ROM shadowing in BIOS might use these areas for
ROM shadowing by default (IBM PC350 P100, for example). Check the ROM
shadowing settings before installing an adapter and disable the range for the
adapter you are going to install.

Twinax Adapters

Twinax Adapter Types
Personal Communications classifies twinax adapters under five adapter types:
v IBM 5250 Plug-and-Play Adapters

– IBM 5250 Emulation PCMCIA Adapter
– IBM 5250 PCMCIA Adapter (DBCS-unique adapter)
– IBM 5250 Emulation PCI Adapter
– IBM 5250 Express ISA Adapter, when the adapter’s Plug-and-Play BIOS is enabled

– IBM 5250 Express PC Card
– IBM 5250 Express PCI Adapter

v IBM 5250 MicroChannel Adapters
– IBM System36/38 Workstation Emulation Adapter /A (DBCS-unique adapter)
– IBM 5250 Emulation Adapter /A

Note: MicroChannel adapters are not supported for Windows operating
systems.

v IBM 5250 ISA Adapters
– IBM Enhanced 5250 Display Station Emulation Adapter
– IBM 5250 Express ISA Adapter, when the adapter’s Plug-and-Play BIOS is

disabled

v IBM 5250 ISA Adapter (Asia-Pacific)
– IBM ISA-Bus Communication Adapter (DBCS-unique adapter)

v Other Twinax Adapter
– OEM 5250 adapters

Using Twinax (5250) Adapters
The configuration of each IBM adapter type is described in the following sections.
All the IBM adapters are supported; OEM adapters are supported if their
manufacturer has created a device driver that is compatible with the IBM driver.

Plug-and-Play Twinax Adapters
Before you can use one of the IBM 5250 Plug-and-Play adapters, you must first
install a driver for the adapter.

IBM 5250 Plug-and-Play Adapter: In Personal Communications, set the Adapter
Type to IBM 5250 Plug-and-Play Adapter. You do not have to set the Interrupt
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Level, I/O Address, or Memory Address fields; these fields are grayed out.
Personal Communications automatically reads the interrupt level, I/O address, and
memory address from the adapter card.

In Windows 95 and 98, the first time that you insert the 5250 PCMCIA or PC Card
adapter into a PCMCIA slot, or start your PC with the 5250 PCI card or 5250 ISA
Express card (with Plug-and-Play BIOS enabled) installed, Windows prompts you
for the location of the .INF file for the card. The .INF file is located in the directory
where Personal Communications is installed. The file is named IBM5250.INF.

If you experience problems getting a host connection with the 5250 Emulation PCI
Adapter and you have an IBM personal computer, upgrading the BIOS might solve
the problem. You can find the date of your system BIOS by using your system
setup when you boot your personal computer. Then you can look on the Internet
to see if there is a later version for your personal computer. The IBM File Library
Web site that has the latest BIOS upgrade files is located at:
www.pc.ibm.com/listfiles.html

From there you can search for your specific IBM personal computer. If there is a
flash BIOS upgrade date later than that on your personal computer, download the
file to your personal computer and follow the instructions that come with the file.
For non-IBM personal computers, contact the manufacturer of your personal
computer for BIOS upgrade information.

ISA-Bus Twinax Adapters

IBM 5250 ISA Adapter: In Personal Communications, set the adapter type to IBM
5250 ISA Adapter. You must then set the interrupt level, I/O address, and Memory
address to match the values set on the adapter card. For a new configuration,
Personal Communications shows the default settings.

To view or change the settings on the adapter card, use the adapter configuration
utility provided with the adapter. For the IBM Enhanced 5250 Display Station
Emulation Adapter only, change the I/O address using switches on the adapter
itself.

Note: Removing a 5250 PCMCIA card or 5250 PC Card, or stopping a PCMCIA
adapter slot containing a 5250 PCMCIA card or 5250 PC Card, will have
unpredictable results.

IBM 5250 ISA Adapter (Asia-Pacific): In Personal Communications, set the
adapter type to IBM 5250 ISA Adapter (Asia-Pacific). You must then set the
interrupt level and memory address to match the values set on the adapter card.
For a new configuration, Personal Communications shows the default settings. The
I/O Address field is grayed out; you do not need to set this field. Personal
Communications automatically reads the I/O address from the adapter card.

To change the I/O address on the adapter card, use the switches on the adapter
itself. To view the I/O address, or to view or change the interrupt level or memory
address on the adapter card, use the adapter configuration utility provided with
the adapter.

MicroChannel Adapters

IBM 5250 MicroChannel Adapter: In Personal Communications, set the adapter
type to IBM 5250 MicroChannel Adapter. You do not have to set the Interrupt
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Level, I/O Address, or Memory Address fields; these fields are grayed out.
Personal Communications automatically reads the interrupt level, I/O address, and
memory address from the adapter card.

Note: MicroChannel adapters are not supported for Windows operating systems.

MPA Adapters

Preventing Conflicts with Non-PCI MPA Adapters
The multiprotocol adapters use system resources that, in some cases, cannot be
shared. Therefore, you must make sure there are no conflicts with the following
resources:
v DMA level
v I/O addresses (MPA0 uses X'380'–X'38F' and MPA1 uses X'3A0'–X'3AF')
v IRQ level (ISA bus only)

The IBM Multiprotocol interface adapters use the following system resources:
v The ISA-bus SDLC adapters require the use of IRQ3 and DMA channel 1 and

only the MPA0 communication port is supported.
v The MPA for ISA can be supported using mode 4 (IRQ3 and DMA1 channel 1)

or mode A (IRQ4 and DMA channel 1). IRQ level send/receive of 3 or 4 is
supported. The ASCA can be supported using mode 4 (IDQ3 or IRQ5 or IRQ4 or
IRQ7 and DMA channel 1) or mode A (IRQ4 or IRQ7 and DMA channel 1). IRQ
level send/receive or 3, 4, 5, or 7 is supported. The interrupt level setting on the
configuration panel in Personal Communications must match the value on the
adapter card.

Note: When the MPA is configured for mode 4, the device is not allowed to use
the other IRQ even though only one interrupt is claimed.

Personal Communications supports the MPA0 or MPA1 communication ports.
Some sound cards use an I/O address within the range X'380'–X'38F'. MPA1
should be used to avoid a conflict.

v The MPA/A for a microchannel-bus workstation uses IRQ3, and the DMA level
can be configured. Both the MPA0 and MPA1 communication ports can be active
at the same time and the interrupt is claimed as sharable.

IBM SDLC PCMCIA Adapter and Modem (Japan Only)
For Windows 95 and Windows 98: The support uses the Configuration Manager
for Plug-and-Play support, which automatically configures IRQ number, I/O ports,
and memory addresses as required. IBMSDLC.INF (installed in the Personal
Communications installation directory) describes the SDLC PCMCIA cards to the
operating system. When you insert the PCMCIA card, Windows 95 and Windows
98 prompt you for the adapter drivers. You must specify the Personal
Communications installation directory and click OK. To verify that the adapter is
functioning properly, select the appropriate PCMCIA adapter under Other Devices
on the Device Manager property page of the System Windows control panel
applet.

For Windows NT: Plug-and-Play is not supported. During installation the registry
is updated, using default parameters. When the configuration is started and an
incoming or outbound connection is enabled, the device attempts to load, using the
stored parameters from the registry. If a card is found and a conflict is detected,
the registry is updated with values that do not conflict and you are notified to
restart the system.
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Note: The system must be restarted for these values to take effect.

Only one SDLC PCMCIA card can be used at a time. Because a common driver
supports both SDLC PCMCIA and MPA interface cards, an MPA cannot be used
concurrently with SDLC PCMCIA.

For Windows 2000 and XP, see “Creating and Updating Devices in Windows 2000
and XP” on page 41.

IBM SDLC PCMCIA Adapter: The IBM SDLC PCMCIA adapter supports:
v Leased and switched connections
v Speeds up to 19.2 Kbps
v Switched and Constant Request To Send (RTS)
v NRZ and NRZI encoding schemes

The IRQ number on the device page’s adapter property sheet is ignored.

IBM SDLC PCMCIA Modem: The IBM SDLC PCMCIA modem supports:
v Switched V.26bis connections only
v Speeds up to 2400 baud
v Switched RTS only

The configured value on the constant RTS and IRQ level send/receive device
page’s adapter property sheet are ignored.

IBM PCI Multiprotocol Adapter
Refer to the Quick Installation Guide in the PCI Multiprotocol Adapter User’s Guide for
instructions on installing this adapter under Windows 95, Windows 98, and
Windows NT.

Two IBM PCI Multiprotocol Adapters can operate concurrently. The configuration
specifies one adapter with Communication Port MPA0 and the second adapter
with Communication Port MPA1. When the link is activated, MPA0 is the first PCI
Multiprotocol Adapter that the operating system finds and MPA1 is the second
adapter found. If more than one PCI Multiprotocol adapter is installed on a
machine and you are unsure which adapter the operating system will find first,
you may want to perform an isolated test to determine which adapter is connected
to which Communication Port. One suggestion is to disconnect the modems
connected to the adapter from the telephone line and then try to start each link
individually. By watching the modems, you should be able to determine which
modem is connected to which Communication Port. Then the modems can be
attached to the proper network. If a single PCI Multiprotocol Adapter is used, the
configuration file must specify MPA0 as the Communication Port.

Note: If a Personal Communications configuration is using this adapter, and a PCI
MPA adapter is added or removed from the system, Personal
Communications may have to be reconfigured.

An ISA-bus MPA and IBM PCI Multiprotocol Adapter can be used concurrently, as
long as the ISA-bus MPA adapter is configured as MPA1.

The IBM PCI Multiprotocol Adapter supports:
v Leased and switched connections
v Speeds up to 56 kbps
v Switched and Constant Request To Send (RTS)
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v NRZ and NRZI encoding schemes

The IRQ number on the device page adapter property sheet is ignored.

WAC Attachments
This section describes factors you should consider when configuring Personal
Communications to communicate through a Wide Area Connector (WAC) adapter.

EIB Support
All available Electrical Interface Boards (EIBs) are supported for the WAC adapter.

Supported Adapters
The IBM WAC adapters for bus types ISA and MCA are supported.

Note: At this time, the new IBM PCI bus WAC adapter is not supported by
Personal Communications.

Potential Configuration Issues
When configuring both ports (upper and lower) on a single WAC adapter, you
must create two logical devices, using the configuration utility. Be careful to
configure the same Shared Ram Address for both devices, using the same adapter
number. If you do not do this, the Shared Ram Address for the first device
activated will be used for the second device.

For ISA systems, the adapter number is obtained from the interpretation of the
on-board DIP switch settings. Switches 1-3 determine the Interrupt level, and
switches 4-7 (read in reverse order) determine the adapter number. Please consult
the adapter installation publication for additional information. Adapter numbers 0
and 1 are logically the same. This is also true for adapter numbers 8 and 9.

On some IBM ValuePoint systems, intermittent problems can occur. If you are
using one of these systems and are having problems, ensure that the adapter’s DIP
switch settings are such that Interrupt Level 9 is being used.

If you intend to use the WAC adapter in a system and you also plan on using
Hayes AutoSync function, then you might experience problems with your async
connection. To find appropriate Shared Memory values, you should use the
adapter diagnostic disk provided with the adapter.

For MCA systems, the adapter number is the slot number in which the adapter
physically resides. You can easily obtain this number via the MCA Configuration
utility that was provided with your system. For IBM systems, you can determine
this number by looking at the back of the system unit and providing the number
displayed for the selected slot.

System Resources
The Wide Area Connector adapter utilizes the following system resources per each
adapter installed:
v 32 bytes of IO addresses (differs depending upon the adapter number used on

ISA; see Help on the Configuration panel for additional information, or through
MCA adapter configuration)

v Interrupt level (the same level can be used on MCA if all adapters share the
same, ISA adapters must have unique interrupt numbers)

v 16 KB of shared memory
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For ISA adapters, you should consult your WAC installation publication for
information concerning the IRQ used and the adapter number configured, both of
which are configured through the adapter’s DIP switches.

The following sections provide additional information about configuring adapters,
including PCMCIA and PCI cards.

OEM Adapters
Personal Communications has an open API that enables vendors and other
equipment manufacturers (OEMs) to provide adapter cards that allow for
additional connectivity options, for example, additional X.25, ISDN, SDLC, or
twinax support. After installing the OEM adapter, you can begin to configure it in
the usual manner described in Quick Beginnings. However, at some point in the
configuration process you may need to provide information required by the
manufacturer of the OEM adapter card.

OEM Twinax Adapter Cards
Developers of software drivers for OEM twinax cards that are seeking to
implement support for Personal Communications on an OEM twinax adapter
should obtain a copy of the document Twinax OEM Interface Specification for
Windows NT and Windows 95, as well as associated program materials. You can
download these at
www.ibm.com/software/network/pcomm/about/api/twinax.html.

The documented interface does not support the Microsoft Windows Driver Model
(WDM) for Windows 98 and Windows 2000. However, the interface does work
with legacy drivers in Windows 98 and 2000.
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Chapter 5. System Policy Support

System policies allow you to control the actions that a user is permitted to
perform.

A policy can be defined by any application or component. The policy appears in
the administrator user interface; information that you set about the policy migrates
to the local computer’s registry. The application or component that defines a policy
must check the registry to enforce its own policy.

Policy information is typically added to a local registry in the following sequence:
1. Categories, policies, and parts are described in a policy template (*.ADM) file.

Windows 95 ships with an ADMIN.ADM file containing all the policies that the
system supports. The Microsoft Resource Kit and Windows NT Server Version 4.0
and higher include three policy template files: WINNT.ADM, COMMON.ADM,
and WINDOWS.ADM. Applications or components can also provide their own
policy template files.

Note: Personal Communications supplies a policy template for each language
currently supported. The templates are on the installation CD-ROM in
the admin directory. For example, the policy template for the US English
language is named ENUPOL.ADM and the policy template for the
French language is named FRAPOL.ADM.

2. You run the policy editor, which reads one or more policy templates and lists
the available categories and policies. You set up the desired policies, and the
policy editor uses registry functions to save the work to a policy (*.POL) file.
The system policy editor is supplied with Microsoft NT Server; a group policy
editor is provided with Windows 2000 and Windows XP. Documentation about
the use of Microsoft policy editors can be found at http://www.microsoft.com.

3. After the user logs on (and user profiles are reconciled if they are enabled), the
policy downloader determines where to find the file on the network, opens the
policy file, and merges the appropriate computer, user, and user group policies
into the local registry.

Note: When using the group policy editor provided with Windows 2000, the Not
Configured setting allows the same permission or access to features as the
Enabled setting.

IBM Personal Communications provides its own policy template file
(PCSPOL.ADM). It contains one category of type USER.

Within the IBM Personal Communications category are the following policies:

Configuration
Contains policy information related to configuration

Execution
Contains policy information related to execution

Installation
Contains policy information related to uninstallation
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Configuration Policy
Use the configuration policy to define user access to the following configurations:

Communication
Controls the user’s ability to change configuration information pertaining
to communication. This includes both emulator configuration (modified by
selecting the Communication → Configure menu) and the SNA node
configuration utility (PCSCFG.EXE).

Menu Controls the user’s ability to read and change configuration information
pertaining to the menu.

Toolbar
Controls the user’s ability to read and change configuration information
pertaining to the toolbar.

Multiple Sessions
Controls the user’s ability to read, execute, and change configuration
information pertaining to multiple sessions with the multiple sessions
utility (PCSBAT.EXE).

Keyboard
Controls the user’s ability to read and change configuration information
pertaining to the keyboard.

Mouse
Controls the user’s ability to read and change configuration information
pertaining to the mouse.

Change Directory
Controls the user’s ability to select sessions and batch files in directories
other than the application data location, from the Session Manager
window.

Import
Controls the user’s ability to import .WS files from the Session Manager
window.

Communication Configuration
The Communication Configuration drop-down list contains the following options.

Read The user can only read preconfigured communication information.
However, this does not prevent the user from changing the communication
configuration information by manually editing the *.WS file, the *.ACG file,
or both. This is the most restrictive level of control.

Write The user can read preconfigured communication information, and can
make temporary and permanent changes to the communication
configuration information. This is the least restrictive, and is equivalent to
the level of control in which users operate without policy support.

The default for the communication configuration part is Write.

Menu Configuration
The Menu Configuration drop-down list contains the following options.

No Access

The user has no access to menu configuration information; that is, the user
cannot read preconfigured menu configuration information or change
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menu configuration information. This means that any menu configuration
information contained in the .WS file (specifically, in the [Menu] stanza) or
the PCSWIN.INI file (modified by selecting the View → Show → Menu
menu) is ignored, and the user cannot execute the menu bar customization
utility (PCSMENU.EXE).

The difference between this item and the Read item is that this item
ignores updates to the menu configuration information that the user may
have made while manually editing the .WS file or PCSWIN.INI file. This
means that the user can use only the product default menu configuration,
and that you cannot set up modified menu configurations to be used by
users who have No Access. This is the most restrictive level of control.

Read The user can only read preconfigured menu information. This means that
menu configuration information contained in the .WS file (specifically, in
the [Menu] stanza) and the PCSWIN.INI file (modified by selecting
theView → Show → Menu menu) is not ignored, but the user cannot update
the menu by selecting View → Show → Menu or the menu bar
customization utility (PCSMENU.EXE). The difference between this item
and the No Access item is that this item does not prevent the user from
updating the menu configuration information by hand editing the .WS file
or the PCSWIN.INI file. However, unlike the No Access item, this item
allows an administrator to set up modified menu configurations to be used
by users who have Read access. This is less restrictive than No Access.

Write The user can read preconfigured menu information, and can make
permanent changes to the menu configuration information. This is the least
restrictive item, and is equivalent to the level of control in which users
operate without policy support.

The default for the menu configuration part is Write.

Toolbar Configuration
The Toolbar Configuration drop-down list contains the following options.

No Access
The user has no access to toolbar configuration information; that is, the
user cannot read preconfigured toolbar configuration information or
change (temporarily or permanently) toolbar configuration information.
This means that any toolbar configuration information contained in the
*.WS file (specifically, in the [Toolbar] stanza) or the PCSWIN.INI file
(modified by selecting the View → Show → Tool Bar menu) is ignored. The
difference between this item and the Read item (described later) is that this
item ignores updates to the toolbar configuration information that the user
may have made while manually editing the .WS file or the PCSWIN.INI
file. This means that the user can use only the product default toolbar
configuration, and that you cannot set up modified toolbar configurations
to be used by users who have No Access. This is the most restrictive level
of control.

Read The user can only read preconfigured toolbar information. This means that
toolbar configuration information contained in the .WS file (specifically, in
the [Toolbar] stanza) and the PCSWIN.INI file (the results of manipulating
the View → Show → Tool Bar menu) is not ignored, but the user cannot
change (temporarily or permanently) the toolbar configuration information.
The difference between this item and the No Access item is that this item
does not prevent the user from updating the toolbar configuration
information by hand editing the .WS file or the PCSWIN.INI file. However,
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unlike the No Access item, this item allows an administrator to set up
modified toolbar configurations to be used by users who have Read access.
This is less restrictive than No Access.

Write The user can read preconfigured toolbar information, and can make
temporary or permanent changes to the toolbar configuration information.
This is the least restrictive item, and is equivalent to the level of control in
which users operate without policy support.

The default for the toolbar configuration part is Write.

Multiple Sessions Configuration
The Multiple Sessions Configuration drop-down list contains the following options.

No Access
The user has no access to multiple session configuration information; that
is, the user cannot read or execute preconfigured multiple session
configuration information or change multiple session configuration
information. This means that the user cannot execute the multiple sessions
utility (PCSBAT.EXE). This is the most restrictive level of control.

Read The user can only read and execute preconfigured multiple session
information. This means that the user can execute the multiple sessions
utility (PCSBAT.EXE) to read multiple session configuration information, or
execute the multiple sessions utility (PCSBAT.EXE) to execute
preconfigured multiple session information. However, the user cannot save
any changes made to the multiple session configuration information. This
is less restrictive than No Access.

Write The user can read and execute preconfigured multiple session information,
and can make permanent changes to multiple session configuration
information. This is the least restrictive item, and is equivalent to the level
of control in which users operate without policy support. This setting
allows the user access to the Modify function in the Session Manager
window.

The default for the multiple session configuration part is Write.

Keyboard Configuration
The Keyboard Configuration drop-down list contains the following options.

No Access
The user has no access to keyboard configuration information; that is, the
user cannot read preconfigured keyboard configuration information or
change (temporarily or permanently) keyboard configuration information.
This means that any keyboard configuration information contained in the
.WS file (specifically, in the [Keyboard] stanza) is ignored. The difference
between this item and the Read item is that this item ignores updates to
the keyboard configuration information that the user may have made while
manually editing the .WS file or the PCSWIN.INI file. This means that the
user can only use the product default keyboard configuration, and that
your cannot set up modified keyboard configurations to be used by users
who have No Access. This is the most restrictive level of control.

Read The user can only read preconfigured keyboard information. This means
that keyboard configuration information contained in the .WS file
(specifically, in the [Keyboard] stanza) and the PCSWIN.INI file is not
ignored, but the user cannot change (temporarily or permanently) the
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keyboard configuration information. The difference between this item and
the No Access item is that this item does not prevent the user from
updating the keyboard configuration information by manually editing the
.WS file or the PCSWIN.INI file. However, unlike the No Access item, this
item allows an administrator to set up modified keyboard configurations to
be used by users who have Read access. This is less restrictive than No
Access.

Write The user can read preconfigured keyboard information, and can make
temporary or permanent changes to the keyboard configuration
information. This is the least restrictive item, and is equivalent to the level
of control in which users operate without policy support.

The default item for the keyboard configuration part is Write.

Mouse Configuration
The Mouse Configuration drop-down list contains the following options

No Access
The user has no access to mouse configuration information; that is, the
user cannot read preconfigured mouse configuration information or change
(temporarily or permanently) mouse configuration information. This means
that any mouse configuration information contained in the .WS file
(specifically, in the [Mouse] stanza) is ignored. The difference between this
item and the Read item is that this item ignores updates to the mouse
configuration information that the user may have made while manually
editing the .WS file or the PCSWIN.INI file. This means that the user can
use only the product default mouse configuration, and that you cannot set
up modified mouse configurations to be used by users who have No
Access. This is the most restrictive level of control.

Read The user can only read preconfigured mouse information. This means that
mouse configuration information contained in the .WS file (specifically, in
the [Mouse] stanza) and the PCSWIN.INI file is not ignored, but the user
cannot change (temporarily or permanently) the mouse configuration
information. The difference between this item and the No Access item is
that this item does not prevent the user from updating the mouse
configuration information by hand editing the .WS file or the PCSWIN.INI
file. However, unlike the No Access item, this item allows an administrator
to set up modified mouse configurations to be used by users who have
Read access. This is less restrictive than No Access.

Write The user can read preconfigured mouse information, and can make
temporary or permanent changes to the mouse configuration information.
This is the least restrictive item, and is equivalent to the level of control in
which users operate without policy support.

The default for the mouse configuration part is Write.

Change Directory
The Change Directory policy has the following options:

Checked
In the Session Manager window, this setting allows the user to select
session and batch files from a location other than the application data
directory.
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Unchecked
This setting disables the Change Directory feature.

The default is checked (user can change directories).

Import
The Import policy has the following options.

Checked
This setting allows the user to import .WS files in the Session Manager
window.

Unchecked
This setting disables the Import feature.

The default is checked (user can import files).

Execution Policy
Use the execution policy to define the user’s access to the following:

Dynamic Menu Modification
Controls whether or not applications executed by the user are permitted to
dynamically add themselves to the menu of an active session.

Java Applet
Controls the user’s ability to execute Java applets from the Actions → Run
Java Applet menu.

Macro Play/Record
Controls the user’s ability to play and record macros.

Start Session
Controls the user’s ability to start an emulator session from the Session
Manager window.

Delete Session
Controls the user’s ability to delete an emulator session from the Session
Manager window.

Product Update
Controls the user’s ability to start the Product Update Tool.

File Transfer
Controls the user’s ability to receive files from or send files to the host
system.

Detect and Repair
Controls the user’s ability to utilize the Help → Detect and Repair function.

Dynamic Menu Modification
The Dynamic Menu Modification checkbox has the following options:

Checked
Applications executed by the user can dynamically add themselves to the
menu of an active session. This is the least restrictive level of control, and
is equivalent to the level of control in which users operate without policy
support.
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Unchecked
Applications executed by the user cannot dynamically add themselves to
the menu of an active session. This is the most restrictive level of control.

The default for the dynamic menu modification part is Checked.

Java Applet
The Java applet checkbox has the following options:

Checked
The user can execute a Java applet from the Actions → Run Java Applet
menu. This is the least restrictive level of control, and is equivalent to the
level of control in which users operate without policy support.

Unchecked
The user cannot execute a Java applet from the Actions → Run Java Applet
menu. This is the most restrictive level of control.

The default for the Java applet part is Checked.

Macro Play/Record
The Macro Play/Record drop-down list has the following options:

No Access
The user has no access to macros; that is, the user cannot play or record
macros. This is the most restrictive level of control.

Play The user can play macros.

Record
The user can play and record macros.

The default for the macro play/record part is Record.

Start Session
The session execution checkbox has the following options:

Checked
The user can start an emulator session. This is the least restrictive level of
control, and is equivalent to the level of control in which users operate
without policy support.

Unchecked
The user cannot start an emulator session. This is the most restrictive level
of control.

The default for the session execution policy is Checked.

Delete Session
The Delete Session check box has the following options:

Checked
In the Session Manager window, the right-click Delete Session option is
enabled.

Unchecked
In the Session Manager window, the right-click Delete Session option does
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not appear if this policy item is disabled—however, users are still able to
delete batch files from the Session Manager. This is the most restrictive
level of control.

The default is checked (user can delete session).

Product Update
The Product Update check box has the following options:

Checked
The user can utilize the Product Update Tool utility.

Unchecked
Personal Communications returns a system policy restriction dialog when
users attempt to start the Product Update Tool. This is the most restrictive
level of control.

The default is checked.

File Transfer
Use the file transfer option to control the user’s ability to do the following:

Send Controls the user’s ability to send files to the host system.

Receive
Controls the user’s ability to receive files from the host system.

Send
The Send checkbox has the following options:

Checked
The user can send files to the host system.

Unchecked
The user cannot send files to the host system.

The default for send is Checked.

Receive
The Receive checkbox has the following options:

Checked
The user can receive files from the host system.

Unchecked
The user cannot receive files from the host system.

The default for receive is Checked.

Detect and Repair
The Detect and Repair checkbox has the following options:

Checked
The user can utilize the Detect and Repair function from the Help menu.

Unchecked
The user cannot utilize the Detect and Repair function. This is the most
restrictive level of control.

The default is Checked.
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Installation Policy
Use the installation policy to control the user’s ability to do the following:

Uninstall
Controls the user’s ability to uninstall IBM Personal Communications.

The Uninstall checkbox has the following options:

Checked
The user can uninstall IBM Personal Communications.

Unchecked
The user cannot uninstall IBM Personal Communications.
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Chapter 6. Configuring and Using Security for Personal
Communications

Transport Layer Security and Secure Sockets Layer
The Transport Layer Security (TLS) protocol is based on the Secure Sockets Layer
(SSL) protocol. TLS differs from SSL mainly in the initial handshake protocol for
establishing client/server authentication and encryption. It is also more extensible
than SSL. Although TLS and SSL do not operate with each other, TLS provides a
mechanism by which a TLS 1.0 implementation can revert to SSLv3.

The TLS protocol uses public-key and symmetric-key cryptographic technology.
Public-key cryptography uses a pair of keys, one public and one private.
Information encrypted with one key can only be decrypted with the other key. For
example, information encrypted with the public key can be decrypted only with
the private key. Each server’s public key is published, while the private key is
confidential. To send a secure message to the server, the client encrypts the
message by using the server’s public key. When the server receives the message, it
decrypts the message with its private key.

Symmetric-key cryptography uses the same key to encrypt and decrypt messages.
The client randomly generates a symmetric key to be used for encrypting all
session data. The key is then encrypted with the server’s public key and sent to the
server.

TLS provides three basic security services:

Message privacy
Achieved through a combination of public-key and symmetric-key
encryption. All traffic between a client and a server is encrypted using a
key and an encryption algorithm negotiated during session setup.

Message integrity
Ensures that session traffic does not change while in route to its final
destination. TLS and SSL use a combination of public/private keys and
hash functions to ensure message integrity.

Mutual authentication
Exchange of identification through public-key certificates. The client and
server identities are encoded in public-key certificates, which contain the
following components:
v Subject’s distinguished name
v Issuer’s distinguished name
v Subject’s public key
v Issuer’s signature
v Validity period
v Serial number

Certificates
Security is controlled by digital certificates that act as electronic ID cards. The
purpose of a certificate is to assure a program or a user that it is safe to allow the
proposed connection and (if encryption is involved) to provide the necessary
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encryption/decryption keys. They are usually issued by Certificate Authorities
(CAs), which are organizations that are trusted by the industry as a whole and
who are in the business of issuing of Internet certificates. A CA’s certificate, which
is also known as a root certificate, includes the CA’s signature and a validity
period, among other things. Encryption and authentication are performed by
means of a pair of keys, one public and one private. The public key is embedded
in a certificate, known as a site or server certificate. The certificate contains several
items of information, including the name of the Certificate Authority (CA) that
issued the certificate, the name and public key of the server or client, the CA’s
signature, and the date and serial number of the certificate. The private key is
created when you create a self-signed certificate or a CA certificate request and is
used to decrypt messages from clients.

Establishing a Secure Session
A TLS or SSL session is established in the following sequence:
1. The client and the server exchange hello messages to negotiate the encryption

algorithm and hashing function (for message integrity) to be used for the
session.

2. The client requests an X.509 certificate from the server to verify the identity of
the server. Optionally, the server can request a certificate from the client
(known as Client Authentication). Certificates are verified by checking the
certificate format and the validity dates, and by verifying that the certificate
includes the signature of a trusted certificate authority (or is self-signed).

3. The client randomly generates a set of keys to be used for encryption. The keys
are encrypted with the server’s public key and are securely communicated to
the server.

Configuring and Using Secure Sockets Layer
The purpose of basing communications on Secure Sockets Layer (SSL) is to provide
privacy and integrity during communication over an unsecured TCP/IP connection
between a client and a target server. This section briefly describes how to configure
the Personal Communications client to use this mode.

Personal Communications provides two ways to manage certificates:
v “Using Certificate Management” on page 67
v “Using the IKEYCMD Command-Line Interface” on page 73

Preparation for SSL Communication
There is a division of labor for SSL configuration tasks. The configurations of the
client and the server are coordinated to achieve the required compatibility. The
following sections describe the preparation tasks required for client configuration
and server configuration.

Server and Related Client Configuration
The administrator of a target server must have completed at least one of the
following:
v Equip the server with an appropriate class X.509 certificate from a well-known

Certificate Authority (CA). The administrator will have created a public/private
key pair, submitted a request to the CA for a certificate, and received and
activated that server certificate. By definition a well-known CA is one whose root
certificates are already stored in the Personal Communications
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PCommClientKeyDb.kdb database file—see “Configuring SSL for Connecting to
a Server Using a Certificate from a Well-Known CA” on page 68 for a list of
these.

Note: You must also equip the client PCommClientKeyDb.kdb database file with
an X.509 personal certificate from the same certificate authority (CA) to
enable client authentication.

v Equip the server with an appropriate class X.509 certificate from an unknown
CA. The procedure is the same as the step above with the added necessity of
obtaining the root certificate from the unknown CA. Usually the administrator of
the target server will distribute the appropriate root certificate which must then
be added to the PCommClientKeyDb.kdb database file.

Note: You must also equip the client PCommClientKeyDb.kdb database file with
an X.509 personal certificate from the same certificate authority (CA) to
enable client authentication.

v Equip the server with a self-signed X.509 certificate. The administrator of the
target server can do this as an interim measure while waiting for a CA’s
certificate. A copy of that certificate must be added to the client
PCommClientKeyDb.kdb database file. The distribution must be done in a
secure manner to guard the privacy and integrity offered by SSL.

Notes:

1. You must also equip the client PCommClientKeyDb.kdb database file with a
X.509 self-signed personal certificate from the same certificate authority (CA)
to enable client authentication.

2. You must also add a copy of this certificate to the server’s key database.

Client Configuration
The following elements must be configured on the client side to enable SSL:
v PCommClientKeyDb.kdb is a certificate management database that is

automatically created in the user-class application data directory when Personal
Communications is installed. It is password protected. The default password is
pcomm and is generated when PCommClientKeyDb.kdb is initially created by
Personal Communications. To assure the continued integrity of
PCommClientKeyDb.kdb, change the default password to a password or
passphrase that is not easily guessed. See “Changing the Password of a Client’s
Key Database” on page 67 for instructions on changing the password. As
installed, this database contains a list of well known CAs and their root
certificates that will be sufficient for the majority of SSL client users for server
side authentication. If the target server uses a certificate from one of those well
known CAs, the client user does not need to modify the
PCommClientKeyDb.kdb other than to change the default password for server
side authentication. See the notes in “Server and Related Client Configuration”
on page 62.

v PCommClientKeyDb.sth is a password stash file that is automatically created
when Personal Communications is installed. By default, Personal
Communications clients try to use the password stash file at runtime. The
password or passphrase used to protect PCommClientKeyDb.kdb is encrypted
and stored in this stash file for use by Personal Communications. Every time the
password is changed on PCommClientKeyDb.kdb, this stash file must be
regenerated. Otherwise, the SSL-mode will not operate. See “Changing the
Password of a Client’s Key Database” on page 67 for instructions on changing
the password.

Chapter 6. Configuring and Using Security for Personal Communications 63



Notes:

1. The use of a password stash file is strongly discouraged; the protection for
these files is not strong.

2. Using Password for PCommClientKeyDb.kdb instead of
PCommClientKeyDb.sth: Personal Communications allows the option to not
use the PCommClientKeyDb.sth password stash file. In order to operate
without the stash file, erase the PCommClientKeyDb.sth file from the
user-class application data directory; then, during SSL session configuration,
select the Prompt for Password Once radio button from the Advanced
Security Setup property page.

v The Enable Security checkbox must be set in the telnet configuration of Personal
Communications to operate in SSL mode. A client operating in SSL mode cannot
establish a connection with a server that is operating in ordinary Telnet mode.
Likewise, a client operating in ordinary Telnet mode cannot establish a
connection with a server operating in SSL mode. See “Configuring Personal
Communications for SSL Support” on page 65 for information on enabling
security.

v Check the Send Personal Certificate to Server if Requested check box on the
Advanced Security Setup property page for client authentication. If this option
is not checked, only server side authentication is performed. If the server
requests a client certificate and this option is not selected, there will be no active
connection. See “Opening a Key Database and Adding a Root Certificate” on
page 69 for details.

Establishing an SSL-Based Session
Upon establishing a preliminary connection with a target server, the Personal
Communications client is presented a certificate by that server; if you have enabled
client certificate authentication, your certificate is likewise presented to the server.
The digital signature of the CA is authenticated using a published root certificate of
the issuing CA. The client automatically decrypts certain information on the
presented certificate using a public key on the CAs root certificate. This step is
successful only when the presented certificate was encrypted using a well guarded,
unique, and corresponding private key, known only to the CA. This process can
detect (and reject) intentional alterations (forgeries) and the rare garbling that can
occur over data circuits.

Personal Communications also allows users to use self-signed certificates for this
purpose.

Once this certificate-issuer authentication step succeeds, the client and server
negotiate to agree on an encryption key to be used during the ensuing data
exchange session.

Secure Session Icon
When an SSL connection is established, a padlock icon is displayed in the Personal
Communications status bar. Depending on the level of encryption, the icon is
accompanied by a number (0, 40, 56, 128, 168). If the session is not SSL-based, the
icon shows as unlocked.

You can display information about the security aspects of your session by clicking
Security → Client or Security → Server from the Communication menu. This
provides details about the certificates exchanged during SSL negotiations between
client and server.
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Configuring Personal Communications for SSL Support
Whether you are configuring a TN3270, TN5250 or VT session, a single restriction
is that the underlying protocol must be TCP/IP. Once you have selected the
Connection to Host for your configuration, do the following to enable SSL:
1. Start a workstation profile from the Session Manager; or, from an active session,

click Configure from the Communication menu. When the dialog box appears,
click Configure.

2. In the Customize Communication panel, choose the appropriate Type of Host,
Interface and Attachment values for the desired Telnet host.

3. Click Link Parameters

4. Depending on the host type and transport selected, there will be property page
tabs for:

Host Definition

Automatic Host Location

Advanced Security Setup

Host Definition
For the Host Definition property page:
1. Specify the normal host name and LU parameters under Primary.
2. Specify the Port Number under Primary. It is likely that it will not be the

default port value for Telnet. The administrator of the destination server might
have set up a specific port number to handle SSL service.

3. Click Enable Security.

Note: If the Enable Security checkbox is greyed out, then SSL support is not
installed. Check Personal Communications Installation information to see
if an error occurred during product installation.

4. For server authentication only, no additional setup is required. For client
authentication, click on the tab for the Advanced Security Setup property page.
Select the desired radio button for key database password option. Check the
Send Personal Certificate to Server if Requested check box and select the
desired radio button to select or be prompted for the personal certificate. Click
OK.

5. Click OK.
6. Click OK.

The connection will start after a few moments.

Automatic Host Location
For the Automatic Host Location property page:
1. Click Enable SLP.
2. Click Enable Security.

Note: If the Enable Security checkbox is greyed out, then SSL support is not
installed. Check Personal Communications Installation information to see
if an error occurred during product installation.

3. Fill in Scope and LU or Pool Name information, according to instructions from
your network administrator.

4. For server authentication only, no additional setup is required. For client
authentication, click on the tab for the Advanced Security Setup property page.
Select the desired radio button for key database password option. Check the
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Send Personal Certificate to Server if Requested check box and select the
desired radio button to select or be prompted for the personal certificate. Click
OK.

5. Fill out the remainder of the parameters in the standard way.
6. Click OK.
7. Click OK.

The connection will start after a few moments.

Note: The default TCP/IP parameter for packet multicast has changed for
Windows Me and 2000, to disable this function.

To enable SLP support for Windows 2000, the following Value Name needs
to be defined or updated in the system registry:

Key Under HKEY_LOCAL_MACHINE\SYSTEM\,
CurrentControlSet\Services\Tcpip\Parameters

Value Type
REG_DWORD-Boolean

Valid Range
Set the value to 0.

To enable SLP support for Windows Me, the following Value Name needs to
be defined or updated in the system registry:

Key Under HKEY_LOCAL_MACHINE\SYSTEM\,
CurrentControlSet\Services\Class\VxD\MSTCP

Value Type
REG_DWORD-Boolean

Valid Range
Set the value to 0.

Advanced Security Setup
Use the following procedure to set the options on the Advanced Security Setup
tab panel.
1. Use the Security Protocol dropdown list to choose TLS or SSL protocol for

negotation of the secure session. The default selection is TLS.
If you select TLS, Personal Communications attempts to negotiate the secure
session using the TLS protocol. If the server does not support TLS, Personal
Communications steps down to the SSLv3 protocol.
If you select SSL, Personal Communications attempts to negotiate the secure
session utilizing the SSLv3 protocol. If the the server side does not support
SSLv3, Personal Communications steps down to the SSLv2 protocol.

2. In the Key Database Password group box, you can choose whether or not to
use the key database password stash file. Select the Use Password Stash (STH)
File radio button to use key database stash file and not be prompted for the
key database file password. You can use this option with or without the Client
Authentication function.

3. In the Personal Client Certificate from Key database group box, you
determine when and how the client certificate will be chosen for sending to the
server. If you want to enable client authentication and have the personal client
certificate from the key database file sent to the server when requested, check
the Send Personal Certificate to Server if Requested check box. Select the
Send Personal Certificate Trusted by Server radio button if one do not want to
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be prompted to select a Personal Client Certificate from Key Database file.
Personal Communications will send the Personal Client Certificate trusted by
Server.
If you want to choose the personal client certificate, select the Select or Prompt
for Personal Client Certificate radio button; you will be prompted to select a
personal client certificate during session establishment, when the server
requests the client certificate.
To preselect a personal client certificate during configuration, select on the
Select now radio button; the Enter Key Database Password screen is displayed.
Enter the Key Database Password and select from the Personal Certificate
Label drop-down list, and click OK.

4. Click Apply.
5. Click OK.
6. Click OK.

The connection will start after a few moments.

Pop-up Messages
During session establishment, your workstation may display pop-up messages in
order to solicit from you:
v The password for accessing the PCommClientKeyDb.kdb database
v The location of the PCommClientKeyDb.kdb

If you chose to be prompted for personal client certificate information (see
“Advanced Security Setup” on page 66), the Select Client Personal Certificate Label
Name screen is displayed at connection time, when the server requests the client
personal certificate. The Server Certificate Information list box displays the
information about the certificate issued to the server, as well as the issuer.
Information includes common name, organization, locality and e-mail. This is
provided for information purpose only; none of the information can be selected.
The Server Trusted Root List list box displays the information about the trusted
root supported by the server. This is also provided for information purpose only;
none of the information can be selected. Click the Select Personal Certificate Label
Name drop-down list and select the personal certificate to be sent to the server for
client authentication. Click OK after selection.

If you chose to be prompted once for the key database password (see “Advanced
Security Setup” on page 66), the Enter Key Database Password screen is displayed
at connection time, when the server requests the client personal certificate. Enter
the key database password and click OK.

Changing the Password of a Client’s Key Database
The key database file created when Personal Communications is installed has a
default set of root certificates that will handle a majority of server certificates
without modification to the file. This initial file is accessible using certificate
management. The default password pcomm.

Certificates can be managed using Certificate Manager or the IKEYCMD
command-line interface.

Using Certificate Management
To change the password using Certificate Management, do the following:
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1. From the Start → Programs → IBM Personal Communications → Utilities
menu, select Certificate Management.

2. From the Key Database File menu, select Open.
3. Select the PCommClientKeyDb.kdb file from the user-class application data

directory.
4. Click Open.
5. Type the current password for the file in the Password entry field.
6. From the Key Database File menu, select Change Password.

Follow the guidelines issued by your network manager for selecting a
password or passphrase that is not easily guessed.

7. Type the new password in the New Password entry field.
8. Type the new password again in the Confirm New Password entry field.
9. To set a password expiration time, click Set expiration time and enter the

number of days until expiration.
10. Click Stash the password to stash the password of the current database

encrypted.

Note: Personal Communications cannot access the certificates in your file if
this checkbox is not selected.

11. Click OK.

Configuring SSL for Connecting to a Server Using a
Certificate from a Well-Known CA

The following CA signed root certificates are already stored in Personal
Communication’s key database and marked as trusted certificates:
v Thawte Personal Premium CA
v Thawte Personal Freemail CA
v Thawte Personal Basic CA
v Thawte Premium Server CA
v Thawte Server CA
v RSA Secure Server CA
v VeriSign Class 1 Public Primary CA
v VeriSign Class 2 Public Primary CA
v VeriSign Class 3 Public Primary CA
v VeriSign Test CA Root Certificate
v VeriSign Class 1 CA Individual Subscriber-Persona Not Validated
v VeriSign Class 2 CA Individual Subscriber-Persona Not Validated
v VeriSign Class 3 CA Individual Subscriber-Persona Not Validated

Following is a summary of the steps required for connecting to a server using a
certificate issued by a well-known CA:
1. Confirm that the server you want to connect to has a certificate from a

well-known CA.
2. Configure Personal Communications for SSL support. See “Configuring

Personal Communications for SSL Support” on page 65 for details.
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Configuring SSL for Connecting to a Server Using a
Certificate from an Unknown CA

The procedures in this section explain how to configure security for connecting to
a server using a certificate issued by an unknown CA; that is, a CA that is not
already defined in the PCommClientKeyDb.kdb file.

Following is a summary of the steps required:
1. Confirm that the server you want to connect with has a certificate from an

unknown CA.
2. Request the root certificate for the unknown CA from your server

administrator.
3. Open the PCommClientKeyDb.kdb file and add the root certificate to it.
4. For client authentication, obtain a personal certificate from this unknown CA

and add it to the PCommClientKeyDb.kdb file.

Opening a Key Database and Adding a Root Certificate
When you get the root certificate file from your server administrator, make sure
that it is in one of the following formats, based on the normal file extensions:

.ARM Base64-encoded ASCII data (armored 64 format)

.DER Binary DER data

Only a certificate in one of these formats can be added to the keyring database.

Note: In many cases, instead of providing a root certificate file, the server
administrator may create the key database file and password stash file at the
server. After adding the root certificate, the server administrator can copy
the files to each client. If you do this, it is important that the names and
location match as follows:
v Key database file: PCommClientKeyDb.kdb
v Password stash file: PCommClientKeyDb.sth

These files are located in the user-class application data directory.

If the server administrator provided only a root certificate file, use the Certificate
Management utility to open the key database file and add the root certificate.

Using Certificate Management: To use Certificate Management to open a key
database and add a root certificate, do the following:
1. From the Start → Programs → IBM Personal Communications → Utilities

menu, select Certificate Management.
2. From the Key Database File menu, click Open.
3. Select the PCommClientKeyDb.kdb file.
4. Click Open.
5. Type the password in the Password entry field and click OK.
6. Select Signer Certificates from the drop-down listbox.
7. Click Add to receive the certificate.

The Add CA’s Certificate from a File panel appears.
8. Select the format dictated by your server administrator from the Data Type

listbox.
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9. Type the full path to the root certificate file in the Certificate file name entry
field.

10. Click Browse, open the certificate file, and click OK.
11. Enter a label for the certificate and click OK.
12. Click View/Edit.
13. Activate the Set the certificate as a trusted root, and click OK.

Opening a Key Database and Adding a Personal Certificate
When you get the personal certificate file from your server administrator or a CA,
make sure that it is in one of the following formats:
v PKCS12 file
v CMS key database file
v Keyring file
v Base64-encoded ASCII data (armored 64 format)
v Binary DER data

A personal certificate can also be in a cryptographic device (such as a Smart Card
or Fingerprint) or in a browser’s keyring (Windows 2000 and XP only).

Using Certificate Management: To use Certificate Management to open a key
database and add a personal certificate, do the following:
1. From the Start → Programs → IBM Personal Communications → Utilities

menu, select Certificate Management.
2. From the Key Database File menu, click Open.
3. Select the PCommClientKeyDb.kdb file.
4. Click Open.
5. Type the password in the Password entry field and click OK.
6. Select Personal Certificates from the drop-down listbox.
7. Click Import for KDB, DYR and P12 format files to import the certificate.

The Import Key panel appears.
8. Select the format dictated by your server administrator from the Key file

Type listbox.
9. Type the full path to the root certificate file in the Certificate file name entry

field.
10. Click Browse, open the certificate file, and click OK.
11. Enter the Key Label, or accept the default, and click OK.
12. Click Receive for ARM and DER format files.

The Add CA’s Certificate from a File panel appears.
13. Select the format dictated by your server administrator from the Data Type

listbox.
14. Type the full path to the root certificate file in the Certificate file name entry

field.
15. Click Browse, open the certificate file, and click OK.
16. Enter a label for the certificate and click OK.

Obtaining a Personal ID Certificate from a Known Certificate
Authority (CA)
A personal ID certificate uniquely identifies you, and can be obtained from known
certificate authorities. One such certificate authority is VeriSign. To obtain a
Personal ID certificate from VeriSign:
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1. Open the VeriSign web page at http://digitalid.verisign.com/.
2. Select Personal IDs from the page.
3. Follow the instructions on the next web page to install a Digital ID (either

full-service or trial) in your Web browser or on a cryptographic device, if the
device has such capability.

After the certificate has been installed in your browser, you must store it in the key
database. In Windows 2000 and XP, you can use the Certificate Management utility
to open the Microsoft certificate store. For other supported Windows operating
systems, use the following procedure.
1. From the browser, export the certificate into a new key file.
2. Open the Personal Communications client key database file.
3. Click on Export/Import to import the certificate. The Export/Import Key dialog

appears.
4. Click the Key button.

Note: The key file type must be PKCS12 file.
5. Enter the name of the file in the first field, the path to the file in the second

field; click OK.
6. At the password prompt, enter your password and click OK.

Configuring SSL for Connecting to a Server Using a
Self-Signed Certificate

Although using self-signed certificates is not recommended, a server administrator
can use them while waiting on a purchased CA certificate. Once the CA certificate
is available, the server and all clients should be reconfigured to switch from the
self-signed certificate to the purchased one.

Following is a summary of the steps required:
1. Confirm that the server you want to connect with has a self-signed certificate.
2. Request from your server administrator the root certificate for the self-signed

certificate.
3. Open the PCommClientKeyDb.kdb file and add the root certificate to it.

The steps required by a client in this scenario are the same as those for the
Unknown CA scenario. See “Opening a Key Database and Adding a Root
Certificate” on page 69 for the steps involved.

Security References
Personal Communications supports server and client authentication. The following
publications are available on the World Wide Web and provide more information:
v SSL-Talk FAQ Version 1.0.3

http://www.consensus.com/security/ssl-talk-faq.html
v Introduction to SSL

http://www.camb.opengroup.org/~fjh/Papers/cook/ssl_intro.html
v SSL Version 3.0 Specification

http://home.netscape.com/eng/ssl3/index.html
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For an introduction to and a history of public key cryptography and privacy, refer
to Simson Garfinkel, PGP: Pretty Good Privacy, O’Reilly and Associates, 1995; ISBN:
1565920988.

Problem Determination
Following is some information to help you avoid problems that might be related to
SSL configuration.
v With server side authentication, the common name in the sever’s certificate is

always compared to the name you type in the Host Name field on the client.
These names must match exactly. You cannot:
– Type the IP address in one place and the host name in the other
– Type wrt05306 in one place and WTR5306 in the other
– Type wtr05036 in one place and wtr05036.raleigh.ibm.com in the other

Note: This information is available only from the target server administrator.
v Make sure that SSL is enabled in both the Personal Communications client and

the SSL server.
v Makes sure that the port number in the Advanced configuration panel on the

client matches the port number defined in the server.
v For each different server using a self-signed certificate, you must add a copy of

each of the server certificates to your keyring.
v Be sure there is a root certificate of the proper class to correspond with the class

and issuer of the certificate on the server.
v Make sure that the password to your key database has not expired.

Note: Notify your server administrator of any problems prior to contacting IBM
Service.

Smart Card Support
Personal Communications includes Smart Card support. A Smart Card is a small
electronic device that contains electronic memory and can be used to store a
certificate. You can keep the certificate in a local or network accessed file, in
Netscape PKCS#11 format. You can specify the location of the certificate in the
session preferences, or prompt for the personal client certificate. You can control
the timing of prompts for client certificates.

You should have a Smart Card reader installed when working with certificates for
Smart Card. Table 1 displays the supported Smart Card drivers and their filenames.

Table 1. Supported Netscape PKCS#11-compatible Smart Card Drivers

Smart Card Drivers File names

IBM SecureWay® Smartcard w32pk2ig.dll

GemPlus/GemSoft Smartcard w32pk2ig.dll

IBM Netfinity® PSG Chip1 ibmpkcss.dll

Rainbow Ikey 1000 Cryptoki22.dll

Schlumberger Cryptoflex acpkcs.dll or slbck.dll

SCW PKCS 3GI 3-G International 3gp11csp.dll

Data Key Dkck232.dll

Fortezza Module fort32.dll
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Table 1. Supported Netscape PKCS#11-compatible Smart Card Drivers (continued)

Smart Card Drivers File names
1The system boards in some IBM systems are preconfigured with a Promise of Value (POV)
card, a 256-bit encrypted security chip daughtercard attached to the motherboard. If an
attempt is made to remove the POV card from the board and install it into another system,
the cryptographic key material will be erased, rendering it unusable. This security feature
is by design and prevents the cryptographic key migration from one system to another.
Therefore, moving this security chip from one board to another is not a supported option.
If an attempt is made to move the POV card from one system to another, it may hang on
boot and display an error message referring to an invalid machine type and serial number.

Enabling Smart Card Support
Smart Card is only used for the personal certificate—it can only hold one personal
certificate and does not hold the signer certificates. The signer certificate or the root
and any intermediate certificate of the personal certificate on the Smart Card
should be added in the PCommClientKeyDb.kdb file.

To enable Smart Card security using the Certificate Management utility, do the
following.
1. From the Select Key Database File menu, select Open.
2. From the Key database type dropdown, menu, select Crytographic Token

3. Locate the appropriate file or enter the file name and location.

To enable Smart Card support when configuring a session, do the following:
1. Select Enable Security in the Host Definition tab panel.
2. In the Advanced Security Setup tab panel, select Send Personal Certificate to

Server if Requested.
3. Select Cryptographic Support (PKCS#11).
4. In the Cryptographic Support Setup panel, choose the Netscape Compatible

PKCS#11 driver name from the drop-down list. If a driver software provider
was not found by Personal Communications, you must enter a Smart Card
driver name.

5. If the driver loaded successfully, the Cryptographic Token Label list is
displayed. There may be a delay while the certificate labels are loaded.

6. Enter the Cryptographic Token Password for the selected Cryptographic Token
Label; this provides access to the PKCS#11 Cryptographic device. You can then
access the PKCS#11 Certificate Label Names from the drop-down list. If there is
only one Certificate, it will automatically be used.
If PKCS#11 Cryptographic support is enabled and a password for the PKCS#11
cryptographic module is not defined during configuration, you will be
prompted for the password.

Using the IKEYCMD Command-Line Interface
IKEYCMD is a command-line tool that can be used to manage keys, certificates,
and certificate requests. It is functionally similar to Certificate Management
(IKEYMAN) and is intended to be run from the command line without a graphical
interface.

Use IKEYCMD for configuration tasks related to public-private key creation and
management. You can use IKEYCMD to create key database files for the same key
database types that IKEYMAN currently supports. You can also create certificate
requests, import CA signed certificates, and manage self-signed certificates.
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You cannot use IKEYCMD for configuration options that update the server
configuration file httpd.conf. To update the server configuration file, you must use
the IBM Administration Server.

Environment Setup for IKEYCMD Command-Line Interface
Use the following procedure to set the environment variables to use the IKEYCMD
command-line interface.
1. Set or modify the PATH variable to include the location of the Java executables.

This can be done by using the UI, modifying autoexec.bat, or typing the
following in a command window:
set PATH=c:\Program Files\IBM\Personal Communications\jre\bin;%PATH%;

where C:\Program Files\IBM\Personal Communications is the directory where
is Personal Communications installed.

2. Set or modify the PATH variable to include the location of the Java executables.
This can be done by using the UI, modifying autoexec.bat, or typing the
following in a command window:
set CLASSPATH=c:\Program Files\ibm\gsk6\classes\cfwk.zip;C:\Program
Files\IBM\gsk6\classes\gsk6cls.jar;%CLASSPATH%;

Once completed, IKEYCMD should run from any directory.

To run an IKEYCMD command, use the following syntax:
java com.ibm.gsk.ikeyman.ikeycmd <command>

IKEYCMD Syntax
The syntax of the IKEYCMD CLI is
java com.ibm.gsk.ikeyman.ikeycmd <object> <action> [options]

where object is one of the following:

-keydb
Actions taken on the key database (either a CMS key database file, a
WebDB keyring file, or SSLight class).

-cert Indicates that the operation applies to a certificate.

-certreq
Actions taken on a certificate request.

-help Display help for the IKEYCMD invocations.

-version
Display version information for IKEYCMD.

Action is the specific action to be taken on the object, and options are the options
(either required or optional) specified for the object and action pair. Some options
may be required for certain object and action pairs.

Note: The object and action keywords are position-sensitive and must be in the
order indicated in the example. However, options are not position-sensitive
and can be typed in any order, provided that they are entered as an option
and operand pair.

Object-Action Pairs: The following table describes each action that can be
performed on a specified object.
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Table 2. Object-Action Pairs for IKEYCMD

Object Action Description

-keydb -changepw Change the password for a key database.

-convert Convert the key database from one format to another.

-create Create a key database.

-delete Delete the key database.

-stashpw Stash the password of a key database into a file.

-cert -add Add a CA certificate from a file into a key database.

-create Create a self-signed certificate.

-delete Delete a CA certificate.

-details List the detailed information for a specific certificate.

-export Export a personal certificate and its associated private key
from a key database into a PKCS#12 file, or to another
key database.

-extract Extract a certificate from a key database.

-getdefault Get the default personal certificate.

-import Import a certificate from a key database or PKCS#12 file.

-list List all certificates.

-modify Modify a certificate.
Note: Currently, the only field that can be modified is the
Certificate Trust field

-receive Receive a certificate from a file into a key database.

-setdefault Set the default personal certificate.

-sign Sign a certificate stored in a file with a certificate stored in
a key database and store the resulting signed certificate in
a file.

-certreg -create Create a certificate request.

-delete Delete a certificate request from a certificate request
database.

-details List the detailed information of a specific certificate
request.

-extract Extract a certificate request from a certificate request
database into a file.

-list List all certificate requsts in the certificate request
database.

-recreate Recreate a certificate request.

-crypto Indicates a PKCS#11 cryptographic device operation. The
value after -crypto is optional if it is already specified in
the properties file.

-tokenlabel Label of a PKCS#11 cryptographic device.

-help Display help information for the IKEYCMD command.

-version Display IKEYCMD version information.

Command-Line Options: The following table shows each option that can be
present on the command line. The options are listed as a complete group.
However, their use is dependent on the object and action specified on the
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command line.

Table 3. Command-Line Options for IKEYCMD

Option Description

-db Fully qualified path name of a key database.

-default_cert Sets a certificate to be used as the default certificate for client
authentication (yes or no). Default is no.

-dn X.500 distinguished name. This input is a quoted string of the
following format:

v C=country

v CN=common_name

v L=location

v O=organization

v OU=organization_unit

v ST=state, province

Only CN, O, and C are required. See the following example:

CN=weblinux.raleigh.ibm.com,O=ibm,OU=IBM HTTP Server,
L=RTP,ST=NC,C=US

-encryption Strength of encryption used in certificate export command (strong or
weak). Default is strong.

-expire Expiration time of either a certificate or a database password (in days).
Defaults are 365 days for a certificate and 60 days for a database
password.

-file File name of a certificate or certificate request (depending on specified
object).

-format Format of a certificate (either ascii for Base64_encoded ASCII or
binary for Binary DER data). Default is ASCII.

-label Label attached to a certificate or certificate request.

-new_format New format of key database.

-new_pw New database password.

-old_format Old format of key database.

-pw Password for the key database or PKCS#12 file. “Creating a New Key
Database” on page 77on page 27.

-size Key size (512 or 1024). Default is 1024.

-stash Trigger to stash the key database password to a stash file.

-target Destination file or database.

-target_pw Password for the key database if -target specifies a key database. See
“Creating a New Key Database” on page 77.

-target_type Type of database specified by -target operand (see -type).

-trust Trust status of a CA certificate (enable or disable). Default is enable.

-type Type of database. Allowable values are cms (CMS key database), webdb
(keyring), sslight (SSLight .class), or pkcs12 (PKCS#12 file).

-x509version Version of X.509 certificate to create (1, 2, or 3). Default is 3.

IKEYCMD Tasks for Personal Communications
IKEYCMD command-line interface tasks required for Personal Communications are
summarized in the following sections.
v “Creating a New Key Database” on page 77
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v “Storing the Encrypted Database Password in a Stash File” on page 78
v “Creating a New Key Pair and Certificate Request” on page 78
v “Creating a Self-Signed Certificate” on page 79
v “Exporting Keys” on page 79
v “Importing Keys” on page 80
v “Listing CAs” on page 80
v “Storing the CA Certificate” on page 80
v “Showing the Default Key in a Key Database” on page 81

See “Summary of Command-Line Invocations” on page 83 for a summary of
command-line invocation syntax examples.

Creating a New Key Database
A key database is a file that the Personal Communications client uses to store one
or more key pairs and certificates—this is required to enable secure connections
between the Personal Communications client and the telnet server. Before
configuring SSL communication, you need to have the PCommClientKeyDb.kdb
key database file in the Personal Communications application data directory. By
default, this file is installed on your machine with Personal Communications and it
has a default password of pcomm. It is recommended that you change this initial
password the very first time you use Personal Communications. See “Changing the
Database Password” on page 78 for instructions on how to change the key database
password.

To open a key database using the IKEYCMD command-line interface, type the
following command:

java com.ibm.gsk.ikeyman.ikeycmd -keydb -open -db

PCommClientKeyDb.kdb -pw <password> -type cms -expire <days> -stash

where:

<password>
Password is required for each key database operation. The initial password
for PCommClientKeyDb.kdb ispcomm.

-type The PCommClientKeyDb.kdb used by the Personal Communications client
is a CMS database type.

-expire
Number of days before password expires.

-stash Stashes password for key database.

When the -stash option is specified during the key database creation, the
password is stashed in the PCommClientKeyDb.sth file.

The PCommClientKeyDb.kdb key database file holds all the security information
needed by the Personal Communications client. Any additions or changes are
made to the existing PCommClientKeyDb.kdb key database file.

Setting the Database Password: When you create a new key database, specify a
key database password. This password protects the private key. The private key is
the only key that can sign documents or decrypt messages encrypted with the
public key. Change the key database password frequently.

Use the following guidelines when specifying the password:
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v The password must be from the U.S. English character set.
v The password should be at least six characters and contain at least two

nonconsecutive numbers. Make sure the password does not consist of publicly
obtainable information about you, such as the initials and birth date for you,
your spouse, or children.

v Stash the password.

Note: Keep track of expiration dates for the password. If the password expires, a
message is written to the error log. The server will start, but there will not
be a secure network connection if the password has expired.

Changing the Database Password: To change the database password, type the
following command:
java com.ibm.gsk.ikeyman.ikeycmd -keydb -changepw -db PCommClientKeyDb.kdb
-pw <password> -new_pw<new_password> -expire <days> -stash

where:

-new_pw
New key database password. This password must be different than the old
password and cannot be a NULL string.

-expire
Number of days before the password expires.

-stash Stashes password for key database.

Storing the Encrypted Database Password in a Stash File: For a secure network
connection, store the encrypted database password in a stash file.

To store the password while a database is created, type the following command:
java com.ibm.gsk.ikeyman.ikeycmd -keydb -create -db <path_to_db>/<db_name>.kdb
-pw <password> -type cms -expire <days> -stash

To store the password after a database has been created, type the following
command:
java com.ibm.gsk.ikeyman.ikeycmd -keydb -stashpw -db <db_name>.kdb -pw <password>

Registering a Key Database with the Server: The initial configuration setting for
the default key database name is key.kdb. If you use key.kdb as your default key
database name, you do not need to register the database with the server. The
server uses the initial setting on the KeyFile directive in the configuration file. If
you do not use key.kdb as your default key database name, or, if you create
additional key databases, you must register those databases.

Creating a New Key Pair and Certificate Request
To create a public-private key pair and certificate request, do the following:
1. Type the following command:

java com.ibm.gsk.ikeyman.ikeycmd -certreq -create -db PCommClientKeyDb.kdb
-pw <password> -size <1024 | 512>
-dn<distinguished_name>-file <filename> -label <label>

where:

-size Key size of 512 or 1024.

-label Label attached to certificate or certificate request.

-dn Enter an X.500 distinguished name. See Table 3 on page 76 for syntax.
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-file Name of file where the certificate request will be stored. By default,
Personal Communications uses the name certreq.arm and it should be
stored in the application data directory, where the
PCommClientKeyDb.kdb key database is located.

2. Verify that the certificate was successfully created.
a. View the contents of the certificate request file you created.
b. Make sure the key database recorded the certificate request by typing the

following command:
java com.ibm.gsk.ikeyman.ikeycmd -certreq -list -db PCommClientKeyDb.kdb
-pw <password>

You should see the label that you just created in the list of certificates. Send
the newly created file to a certificate authority.

3. Send the newly created file to a certificate authority.

Creating a Self-Signed Certificate
It usually takes two to three weeks to get a certificate from a well-known certificate
authority (CA). While waiting for an issued certificate, use IKEYCMD to create a
self-signed server certificate to enable SSL sessions between clients and the server.
Use this procedure if you are acting as your own CA for a private Web network.

To create a self-signed certificate, type the following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -create -db PCommClientKeyDb.kdb
-pw <password> -size <1024 | 512> -dn <distinguished name>
-label <label> -default_cert <yes or no>

where:

-size Key size 512 or 1024.

-label Enter a descriptive comment used to identify the key and certificate in the
database.

-dn Enter an X.500 distinguished name. See Table 3 on page 76 for syntax.

-default_cert
Type yes if you want this certificate to be the default certificate in the key
database. Otherwise, type no.

Exporting Keys
To export keys to another key database or to export keys to a PKCS12 file, type the
following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -export -db PCommClientKeyDb.kdb -pw
<password> -label <label>-type <cms | sslight> -target <filename>
-target_pw <password> -target_type <cms | sslight | pkcs12>
-encryption <strong | weak>

where:

-label Label attached to the certificate.

-target Destination file or database.

-target_pw
Password for the target key database.

-target_type
Type of the database specified by -target operand.
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-encryption
Strength of encryption. Default is strong.

Importing Keys
To import keys from another key database, type the following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -import -db <filename> -pw <password>
-label <label> -type <cms | sslight> -target <filename> -target_pw <password>
-target_type <cms | sslight>

To import keys from a PKCS12 file, type the following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -import -file <filename> -pw <password>
-type pkcs12 -target <filename> -target_pw <password> -target_type <cms | sslight>

where:

-label Label attached to the certificate.

-target Destination database.

-target_pw
Password for the key database if -target specifies a key database.

-target_type
Type of database specified by -target operand.

Listing CAs
To display a list of trusted CAs in the PCommClientKeyDb.kdb key database, type
the following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -list CA -db PCommClientKeyDb.kdb
-pw <password>-type cms

Storing the CA Certificate

Receiving a CA-signed Certificate: Use this procedure to receive an electronically
mailed certificate from a certificate authority (CA), designated as a trusted CA on
your server. By default, the following CA certificates are stored in the
PCommClientKeyDb.kdb key database and marked as trusted CA certificates:
v IBM World Registry™ CA
v Integrion CA Root (from IBM World Registry)
v VeriSign Class 1 Public Primary CA
v VeriSign Class 2 Public Primary CA
v VeriSign Class 3 Public Primary CA
v VeriSign Class 4 Public Primary C
v VeriSign Test CA
v RSA Secure Server CA (from VeriSign)
v Thawte Personal Basic CA
v Thawte Personal Freemail CA
v Thawte Personal Premium CA
v Thawte Premium Server CA
v Thawte Server CA

The CA may send more than one certificate. In addition to the certificate for your
server, the CA may also send additional Signing certificates or Intermediate CA
Certificates. For example, Verisign includes an Intermediate CA Certificate when
sending a Global Server ID certificate. Before receiving the server certificate, you
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must receive any additional Intermediate CA certificates. See “Storing a CA
Certificate” for instructions on receiving Intermediate CA Certificates.

Note: If the CA who issues your CA-signed certificate is not a trusted CA in the
key database, you must first store the CA certificate and designate the CA as
a trusted CA. Then you can receive your CA-signed certificate into the
database. You cannot receive a CA-signed certificate from a CA who is not a
trusted CA. For instructions, see “Storing a CA Certificate”.

To receive the CA-signed certificate into a key database, type the following
command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -receive -file <filename>
-db PCommClientKeyDb.kdb -pw <password> -format
<ascii | binary> -default_ cert <yes | no>

where:

-format
Certificate Authority might provide CA Certificate in either ASCII or
binary format.

-label Label attached to CA certificate.

-trust Indicates whether this CA can be trusted. Use enable options when
receiving a CA certificate.

-file File containing the CA certificate.

-default_ cert
Type yes if you want to make this key your default key.

Storing a CA Certificate: To store a certificate from a CA who is not a trusted
CA, type the following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -add -db PCommClientKeyDb.kdb
-pw <password>-label <label> -format <ascii> -trust <enable> -file <file>

where:

-label Label attached to certificate or certificate request.

-format
Certificate Authorities might supply a binary ASCII file.

-trust Indicate whether this CA can be trusted (should be yes).

Opening a Key Database
Explicit opening of a key database is not supported. For each command, database
and password options are given—these options are sufficient to operate in a key
database.

Showing the Default Key in a Key Database
To display the default key entry, type the following command:
java com.ibm.gsk.ikeyman.ikeycmd -cert -getdefault -db PCommClientKeyDb.kdb
-pw <password>

Managing a Digital Certificate on a Smart Card
You can manage digital certificates on a Smart Card (or, more generically, on a
PKCS#11 cryptographic device). To do so, you must first use the following
procedure to inform the iKeyman CLI of the name of the module for managing
your Smart Card.
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1. Edit the java.security file in your JDK environment with one of the following
settings stored in the (JAVA_HOME)\jre\lib\security\ directory:
v security.provider.1=sun.security.provider.Sun
v security.provider.2=com.ibm.spi.IBMCMSProvider
v security.provider.3=com.ibm.crypto.provider.IBMJCE

2. Edit the ikmcmd.properties file to set the
DEFAULT_CRYPTOGRAPHIC_MODULE property to the name of the module
for managing your smart card. For example,
DEFAULT_CRYPTOGRAPHIC_MODULE=C:\\Winnt\\System32\\W32pk2ig.dll

The module is normally installed on your system when you install the software
for your Smart Card.

3. Save the ikmcmd.properties file.

Use the following command syntax for PKCS#11 operations:
-crypto <module_name> -tokenlabel <token_label> -pw <password>

For example, to display the certificate contained on your PKCS#11 cryptographic
device, type the following:
java -Dikeycmd.properties=<properties_file> com.ibm.gsk.ikeyman.ikeycmd
-cert -list all -crypto <module_name> -tokenlabel <token_label> -pw <password>

where:

-cert Indicates that the operation applies to a certificate.

-list all
Displays the certificate.

-crypto <module_name>
Specifies PKCS#11 cryptographic device usage, where <module_name> is the
name of the module to manage your smart card. This parameter is optional
if the module name is specified in the ikmcmd.properties file.

-tokenlabel <token_label>
The PKCS#11 cryptographic device token label.

-pw <password>
The password for the PKCS#11 cryptographic device.

Using Microsoft CryptoAPI: If you want to open a cryptographic hardware
device using MS CryptoAPI, use the following procedure.
1. Edit the ikmcmd.properties file. Set the cryptographic service provider (CSP)

name to the DEFAULT_CRYPTOGRAPHIC_MODULE property. For example,
DEFAULT_CRYPTOGRAPHIC_MODULE=Schlumberger Cryptographic Service Provider

The CSP is normally installed on your system when you install the software for
your Smart Card.

2. Save the ikmcmd.properties file.

Use the following command syntax to display the certificate contained on your
cryptographic device:
java -Dikeycmd.properties=<propertiesfile> com.ibm.gsk.ikeyman.ikeycmd -cert
-list all -crypto <CSP_module_name>

where:
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-cert Indicates that the operation applies to a certificate.

-list all
Displays the certificate.

-crypto <CSP_module_name>
Specifies the CSP name.

Managing the Microsoft Certificate Store
You can use the following command to manage the Microsoft Certificate Store
(supported only on Windows 2000, Service Pack 2 or later, and Windows XP):
-db MSCertificateStore

For example, to view the details of a certificate stored in Microsoft Certificate Store,
use the following command syntax:
java com.ibm.gsk.ikeyman.ikeycmd -cert -details -db MSCertificateStore
-label <label>

where:

-cert Indicates that the operation applies to a certificate.

-details
Specifies verbose mode when displaying information.

-db MSCertificateStore
Specifies Microsoft Certificate Store.

-label <label>
The label of the certificate used in the operation.

The password parameter is not needed in -db MSCertificateStore operations.

Using GSK6CMD Batch File
The batch file gsk6cmd provides the same function as the java
com.ibm.gsk.ikeyman command. For example, to store the password after a
database has been created, you can also type the following command:
gsk6cmd -keydb -stashpw -db <db_name>.kdb -pw <password>

Summary of Command-Line Invocations
The following is a list of each of the command-line invocations, with the optional
parameters specified in italics.

Note: The actual Java invocation java com.ibm.gsk.ikeyman,iKeycmd must precede
each of the command examples.

-keydb -changepw -db <filename> -pw <password> -new_pw
<new_password> -stash -expire <days>

-keydb -convert -db <filename> -pw <password> -old_format
<cms | webdb> -new_format <cms>

-keydb -create -db <filename> -pw <password> -type <cms | sslight>
-expire <days> -stash

-keydb -delete -db <filename> -pw <password>

-keydb -stashpw -db <filename> -pw <password>

-cert -add -db <filename> -pw <password> -label <label> -file
<filename> -format <ascii |binary> -trust <enable | disable>

-cert -create -db <filename> -pw <password> -label <label> -dn
<distinguished_name> -size <1024 | 512> -x509version <3 | 1 | 2>
-default_cert <no |yes>

-cert -delete -db <filename> -pw <password> -label <label>
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-cert -details -db <filename> -pw <password> -label <label>

-cert -export -db <filename> -pw <password> -label <label> -type
<cms | sslight> -target <filename> -target_pw <password>
-target_type <cms | sslight | pkcs12> -encryption <strong | weak>

-cert -extract -db <filename> -pw <password> -label <label> -target
<filename> -format <ascii | binary>

-cert -getdefault -db <filename> -pw <password>

-cert -import -db <filename> -pw <password> -label <label> -type
<cms | sslight> -target <filename> -target_pw <password>
-target_type <cms | sslight>

-cert -import -file <filename> -type <pkcs12> -target <filename>
-target_pw <password> -target_type <cms | sslight>

-cert -list <all | personal | CA |site> -db <filename> -pw
<password> -type <cms | sslight>

-cert -modify -db <filename> -pw <password> -label <label> -trust
<enable |disable>

-cert -receive -file <filename> -db <filename> -pw <password>
-format <ascii | binary> -default _cert <no | yes>

-cert -setdefault -db <filename> -pw <password> -label <label>

-cert -sign -file <filename> -db <filename> -pw <password> -label
<label> -target <filename> -format <ascii | binary> -expire
<days>

-certreq -create -db <filename> -pw <password> -label <label> -dn
<distinguished_name> -size <1024 | 512> -file <filename>

-certreq -delete -db <filename> -pw <password> -label <label>

-certreq -details -db <filename> -pw <password> -label <label>

-certreq -extract -db <filename> -pw <password> -label <label>
-target<filename>

-certreq -list -db <filename> -pw <password>

-certreq -recreate -db <filename> -pw <password> -label <label>
-target<filename>

-help

-version

Using Transport Layer Security
The Transport Layer Security (TLS) protocol provides communications privacy over
the Internet. The protocol allows client/server applications to communicate in a
way that is designed to prevent eavesdropping, tampering, or message forgery.
TLS provides SSLv3 backward compatibility.

Personal Communications allows you to negotiate the TLS 1.0 protocol. For
information about TLS encryption and error codes, refer to the online Personal
Communications help.

Configuring for TLS
When configuring a Telnet session, you can choose TLS (default) or SSL only as
your Security Protocol. If the configured host does not support TLS, the host does
one of the following:
v Sends SSLv3 hello to Personal Communications

In this case, Personal Communications will revert to SSLv3 and continue SSLv3
negotiations.

v Sends a fatal error
In this case, Personal Communications does not continue negotiations with the
host.
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If you know that the host does not support TLS, you can select the SSL only
option. In this case, Personal Communications starts with SSL negotiations to
establish a secure connection, and does not attempt TLS negotiations. This option
also enables SSLv2.
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Chapter 7. Using Windows Terminal Services

Windows Terminal Services (WTS) is a feature that allows more than one user to
log onto a Windows NT, 2000, or XP machine. This feature is available as an
add-on to Windows NT; it is included in Windows 2000 Advanced Server and
Windows XP. This functionality is also referred to as simultaneous user environments
or terminal services.

Users can logon to the Windows machine from the console (the screen attached to
the Windows machine) or from a remote desktop client.

On Windows XP, more than one user can logon at the console, although only one
of the logged-on users will be able to see his desktop at any time. This terminal
services function is called fast user switching.

Citrix MetaFrame allows administrators to configure their WTS servers to run
individual applications, and to configure each user to run different applications on
different servers. Thus, instead logging on to a WTS server, a user launches
preconfigured applications from his Citrix environment running on their client
machine. Citrix then logs onto the appropriate WTS server and runs the
application. When the user closes the application, Citrix shuts down the
application, waits for all processes that were started by the application to
terminate, and then logs off from the WTS server.

Notes:

1. A message file log is not maintained for each WTS logon session. Only one
message log file is maintained for the WTS server.

2. When Personal Communications is used in a WTS environment, the maximum
of 26 sessions (A-Z) applies to each WTS logon session. There is not a limit of
26 sessions per WTS server.

Session IDs
In simultaneous user environments such as WTS, each time a user logs on, that
specific logon session is assigned a session ID. When a user logs on at the console,
that session is assigned the session ID 0 (zero)—this is also called the server
console session. When a user logs on from a remote desktop, the assigned session
IDs begin with session 1.

SNA Node Options
Personal Communications has a number of features that allow it to fully function
in simultaneous user environments. In addition, you can use specific features to
control the behavior of SNA nodes in such environments.

Note: You can only have one SNA node configuration file running for each WTS
server. This means that each user cannot start an independent SNA node.

The following features are available in the SNA Node Configuration utility. Refer
to the online help for specific information about option settings.
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Configuration Preferences
The SNA Node Configuration Edit → Preferences dialog displays the following
node options:

Auto Start
This option controls whether and when an SNA node is automatically
started. The settings are as follows:
v None

The SNA node is never automatically started.
v On Boot

The SNA node is started when the workstation is booted up.
v User

The SNA node is started when any user logs onto the workstation.

Auto Stop
This option controls whether and when an SNA node is automatically
stopped. The settings are as follows:
v None

The SNA node is automatically stopped only when the workstation is
shut down or restarted.

v TP User

The SNA node is stopped when the TP user logs off the workstation.
v User

The SNA node is stopped when any user logs off the workstation.
v Last User

The SNA node is stopped when the last logged-on user logs off the
workstation.

TP Context
An SNA Node is responsible for starting Transaction Programs (TPs). This
option controls whether a TP is allowed to access a user’s desktop. The
settings are as follows:
v System

An SNA Node is responsible for starting Transaction Programs (TPs).
The TP Context System value causes TPs to run with SYSTEM authority
and the only workstation that can be accessed is the system console.

v User

The TP Context User value allows a TP to access the TP User’s desktop.

The TP User is defined as the user who starts the SNA node. If that user
logs off the workstation, the TP User becomes the user who has been
logged onto the system the longest. If the SNA node was started on boot
then the TP User becomes the first user who logs on.

Note: The TP context is ignored when a user ID is specified in the Local
LU definition in the active node configuration.

Default SNA Node Configuration
You can specify a default node configuration (.acg) file.
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User ID (Local LU 6.2)
When you configure a Local LU 6.2, you can specify a user ID for this Local LU.
When a Transaction Program is started on a Local LU that has this user ID
defined, the SNA Node attempts to give the TP access to that user’s desktop. If the
user is logged on at the time, the TP context is the user ID entered in this Local LU
6.2 configuration panel.

This user ID field can also be the value SYSTEM (as in the TP Context
configuration option). In that case, the TP is always started with a TP context value
of SYSTEM.

Trace Facility
For simultaneous user environments such as WTS, the APPN and APPC and
Connectivity functions are only available for users logged in as session 0.

Each user can run his own trace facility, which gives information from that user’s
specific WTS logon session. However, there are trace options that enable tracing
from device drivers, which are not associated with any specific WTS logon session.
Thus, those options only appear on the trace facility that is started in the WTS
console session (session 0).
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Chapter 8. ODBC Drivers and Database Access Utility

This chapter contains information about ODBC drivers and the Database Access
utility. Should you require more detailed information, refer to the following guides:
v IBM DB2 Connect Personal Edition Quick Beginnings

v IBM DB2 Connect User’s Guide

You can also find additional information in the online help.

Overview of Open Database Connectivity (ODBC)
ODBC is an industry standard application program interface (API) that provides a
solution to a common problem—how to write programs that access a Database
Management System (DBMS) without making them dependent on specific DBMS
designs. ODBC provides API access to SQL-accessible databases, allowing
application programs to use SQL to access data from many kinds of sources. The
independence of the access method from the original design of the database means
that developers can design and produce a single version of an application that can
work with, for example, DB2 Connect™, Oracle, or Sybase data, without requiring
a separate version for each DBMS. Users simply add database drivers to link the
application to their choice of DBMS.

ODBC is a component of the Windows Open Services Architecture (WOSA).
Personal Communications supports ODBC 2.0, for development of 32-bit
applications for Windows 95, Windows 98, Windows NT, Windows Me, Windows
2000, and Windows XP.

An ODBC driver provides an application program with standard and uniform SQL
access to a DBMS database. An ODBC driver allows the designers and users of the
application program to ignore the SQL differences between various DBMS systems.

Figure 1 shows an overview of the Personal Communications Database Access
utility and the ODBC DB2® drivers.

V3R1 ODBC Server DB2/400
Data Base

DB2/MVS
Data Base

Copy/Paste PC Data Base

MVSAS/400
Host Systems

PC Side
Advanced Program to Program Communication

ODBC Administrator (provided by Microsoft)

Data Base Access Utility (PCSDB.EXE)

Microsoft Excel Lotus 1-2-3
Windows

Application
Program

OEM ODBC Driver

Figure 1. Database Access Overview
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Components of ODBC
There are four components in the ODBC architecture:
v The application component defines and performs the work to be accomplished.

It calls the ODBC API functions that submit SQL statements and retrieve results.
v The driver manager component loads drivers on behalf of an application.
v The driver component processes ODBC function calls, submits SQL requests to a

specific data source, and passes results to the application. The driver transforms
the application’s SQL syntax into the syntax expected by the driver’s associated
DBMS.

v The data source component is the data to be accessed and the means for doing
so, including the associated operating system, DBMS and network platform.

From the application program’s perspective, the driver manager and the driver
appear to be a single unit for processing ODBC function calls. Figure 2 shows the
relationship between the four components:

Application Component
An application using ODBC performs the following tasks:
v Requests a session (connection) with a data source.
v Sends SQL requests to the data source.
v Defines storage areas and data formats for the results of the SQL requests.
v Requests the results of the defined query.
v Processes errors.
v Requests commit or rollback operations for transaction control.
v Terminates the session with the data source.

Any program that accesses a DBMS, such as a spreadsheet, a mail server, or a
report generator, can be designed to use ODBC.

Application

Driver Manager

AS/400
ODBC
Driver

MVS
ODBC
Driver

Other
ODBC
Driver

Data
Source

Data
Source

Data
Source

DB2/400 DB2/MVS other

ODBC Interface

Figure 2. ODBC Components
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Driver Manager
The driver manager is a dynamic link library (DLL), the purpose of which is to
load drivers. It also performs the following functions:
v Maps a data source name to a specific driver DLL.
v Processes ODBC initialization calls.
v Provides the entry points to the ODBC functions for each driver.
v Provides parameter and sequence validation for ODBC calls.

Driver
A driver is a DLL that implements ODBC function calls and interacts with a data
source.

The driver manager loads a driver when the application calls the
SQLBrowseConnect, SQLConnect, or SQLDriverConnect function.

A driver performs the following tasks in response to ODBC function calls from an
application:
v Establishes a connection to a data source.
v Submits requests to the data source.
v Translates data to or from other formats, if requested by the application.
v Returns results to the application.
v Formats errors into standard error codes and returns them to the application.
v Declares and manipulates cursors if necessary. This operation is invisible to the

application unless there is a request for access to a cursor name.
v Initiates transactions of the data source. This operation is invisible to the

application.

Data Source
A data source is an instance of a DBMS product and any remote operating system
and the protocol required to access it.

Database Access
Database Access lets you access host or PC databases and retrieve data, using
ODBC drivers. If you specify the conditions for accessing data in each window, the
desired query can be created automatically. See the online help for extensive
information on using the Database Access utility with the Personal
Communications ODBC drivers.

From Database Access, you can perform any of the following actions:
v You can see and modify the SQL statements that are created automatically.
v You can see available database table lists.
v You can copy spreadsheet data to the clipboard
v You can show data in the grid in the main window spreadsheet, send data to

other applications (for example Lotus® 1-2-3® or Microsoft Excel), or send data
to a printer.

v If you want to know the meaning of items in the windows, you can see an
explanation when you click on the item and then click help.

Accessing an ODBC Data Source
To access an ODBC data source, do one of the following:
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v Click on the Data Source button on the toolbar.

v Select Data Source from the query pull-down menu.

The SQL Data Source window appears.

Select the data source you want to access; then click OK.

Note: Before using Database Access, you must install the 32-bit ODBC
administrator and set up the ODBC data source you wish to use.

Selecting Database Tables
To select database tables, do one of the following:
v Click on the Tables button on the toolbar.

v Select Tables from the Query pull-down.

The Tables window appears.

Joining Conditions for Multiple Tables
To join conditions for multiple tables, do one of the following:
v Click on the Join Conditions button on the toolbar.

v Select Join from the Query pull-down menu.

The Join By window appears.

Selecting Database Columns
To select database columns, do one of the following:
v Click on the Columns button on the toolbar.

v Select Columns from the Query pull-down menu.

The Columns window appears.

Selecting Query Conditions
To select query conditions for the data, do one of the following:
v Click on the Query Conditions button on the toolbar.

v Select Query Conditions from the Query pull-down menu.

The Query Conditions window appears.

Selecting Sort Conditions
To select sort conditions for each column, do one of the following:
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v Click on the Order button on the toolbar.

v Select Order from the Query pull-down menu.

The Order By window appears.

Viewing the Current SQL Statement
To view the current SQL statement, do one of the following:
v Click on the SQL Statement button on the toolbar.

v Select SQL Statement from the Query pull-down menu.
v Click the SQL button in any window selected from the Query pull-down menu.

The SQL Statement window appears.

Database Size Limit
When you use Database Access, the maximum number of each value that can be
displayed in the spreadsheet is as follows:

Number of columns 400
Number of rows 16350
Column length 2048 bytes
Row length 2048 bytes
SQL statement’s length 32766 bytes

Note: The values shown are standard, but your PC’s available resources (such as
memory) can result in other limits.

When you use another application (for example Lotus 1-2-3), refer to the manual
for that application because the limit might be different.
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Chapter 9. Express Logon Feature

The Express Logon Feature allows a Personal Communications Telnet 3270 user to
securely logon to a host application without sending the User ID and password.
One advantage of using this function is that it reduces the time you spend
maintaining host user IDs and passwords. It also reduces the number of user IDs
and passwords that the users have to remember.

To use Express Logon, the host session must be configured for SSL and client
authentication. This means the client must have a valid client certificate. The SSL
connection must be made to one of the supported Telnet 3270 servers.

Using Express Logon
When starting a session using Express Logon, Personal Communications
establishes an SSL client authentication session with the Telnet 3270 server. During
the logon process, a macro with the Express Logon information is played. Once the
session is established, Personal Communications sends the application ID for the
application that the user is accessing to the Telnet 3270 server. This information is
contained in the logon macro. The Telnet 3270 server uses certificate information
from the SSL connection and the application ID received from Personal
Communications, and requests the user ID and passticket (a temporary password)
from the host access control program (such as RACF®).

Personal Communications uses the macro function to put predefined substitute
strings in the user ID and password fields. The Telnet 3270 server substitutes the
user ID and passticket in the appropriate place in the 3270 datastream. The logon
is completed.

After an ELF macro is recorded, it can be distributed to multiple users for playback
without further modification.

Preparing to Configure the Express Logon Feature
Before you configure an Express Logon macro, you need to have the following
information.
v Host application name

Name of the host application the user is logging onto. For example, the name
entered on the USSMSG10 screen.

v Host access application ID
This name must match the RACF PTKTDATA (Passticket Data Profile)
application name that is configured on the OS/390® (V2R10 or later) or z/OS™

host. This name could be the same as the application name that the user is
logging onto (for example, the name on USSMSG10). When creating PTKTDATA
profiles for applications such as TSO, the application name portion of the profile
will most likely not be the same. For example, RACF requires that the
application ID portion of the profile name be TSO+SID. Refer to the OS/390
V2R10.0 SecureWay Security Server RACF Security Administrator’s Guide or the
z/OS V1R1.0 SecureWay Security Server RACF Security Administrator’s Guide to
determine the correct profile naming.

v User ID and password for the application that you are logging on to.
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During macro recording, the actual user ID and password are used. They are not
recorded in the macro; only the predefined substitute strings are recorded in the
macro. The Telnet 3270 server replaces the predefined substitute strings with the
actual user ID and password during the logon process.

v Client Security Certificate
The security certificate for the client must be stored in RACF using the RACF
RACDCERT command.
– For information about using digital certificates with RACF, refer to the

following books:
- For OS/390, refer to OS/390 V2R10.0 SecureWay Security Server RACF

Security Administrator’s Guide and OS/390 V2R10.0 SecureWay Security Server
RACF Command Language Reference.

- For z/OS, refer to z/OS V1R1.0 SecureWay Security Server RACF Security
Administrator’s Guide and z/OS V1R1.0 SecureWay Security Server RACF
Command Language Reference.

– For information about configuring DCAS to use RACF certificates, refer to the
following books:
- For OS/390, refer to OS/390 V2R10.0 IBM Communication Server IP

Migration.
- For z/OS, refer to z/OS V1R1.0 IBM Communication Server IP Migration.

Configuring Express Logon

Recording the Macro
You must record a macro for each host application that you want to access. You
cannot log on to multiple applications with one macro. You do not have to
configure SSL, and client authentication is not required on the telnet servers and
OS/390 or z/OS before recording the logon macro, but you must do this before
you can play the macro.

Manual Configuration of an ELF Macro
You can manually configure an existing Macro format file for ELF use. The
procedure is as follows:
1. From the Action Bar, open the macro file containing the recorded keystrokes by

selecting Edit → Preferences → Macro/Script.
2. Select the macro file you just recorded and then select Customize.
3. Replace the UserID recorded in the macro with two tags: the ELF Application

ID and the ELF UserID placeholder. The Application ID tag consists of three
words, each separated by a blank character: elf, applid, and the identifier of
the host application that will be logged onto. The UserID placeholder is
)USR.ID(.
For example, replace "myUserID with ")USR.ID(.

4. Replace the Password recorded in the macro with the ELF Password
placeholder tag )PSS.WD(.
For example, replace "myPassword with ")PSS.WD(.

Limitations of the Logon Macro
v Automatic insertion of the user ID and password placeholders into the recorded

macro requires that the password be typed into the first non-display input field.
The user ID is assumed to have been entered just prior to the password. The
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Modified Data Tag attribute of each formatted input field is assumed to be ON
only when the field has been modified by the operator.

v There is a short delay while the Telnet 3270 server acquires the passticket from
the host access control facility. The amount of time is probably less than the
usual delay incurred when the user enters a user ID and password. However,
the user can see the macro proceed through the screens during the logon
process.

v Logon Express recording requires that the host program uses 3270 field
attributes to define the password field on the screen.

Problem Determination
If the client logon fails and displays the messages )USR.ID( NOT IN CP DIRECTORY,
INVALID USERID, )USR.ID(, PASSWORD NOT AUTHORIZED or any similar messages,
check the Telnet 3270 server log for details.

Possible reasons for failures are:
v The application ID defined in the macro is not valid.
v The Telnet 3270 server could not connect to DCAS. The host might be down.
v The client certificate is not defined in RACF or it is not valid.
v The passticket has expired and could not be used to log on.
v The Telnet 3270 server completed scanning of data stream without replacing the

user ID or password.
v The Telnet 3270 server or the host does not support the Express Logon Feature.
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Chapter 10. Log Viewer Functions

The Personal Communications log viewer utility enables you to view, merge, sort,
search, and filter information contained in message and trace logs. You can use the
viewer during problem determination to work with message and trace log entries.
The default name of the message log output file is PCSMSG.MLG; its file extension
must be .MLG. The file extension for trace logs must be .TLG. Note that the Help
per Message Log Item functionality is available only for message logs.

Viewing Message and Trace Logs
To view message or trace logs:
1. From the Administrative and PD Aids folder, click Log Viewer; or, from an

active session window, click Actions → Launch → Log Viewer.
2. From the list of logged messages, click on one of the details on the log entry in

the bottom pane.

Note: If the logger device driver determines that the product kernel
driver-generated log is full and cannot log a message, it will create an entry
in the Windows log. The information logged may include which log failed,
as well as the location and reason for the failure.

Changing Message Log Size and Location
The Personal Communications log viewer utility allows you to modify the size and
location of message log files, and change the name of the default message log file.
The size of a log file is counted in kilobytes and can range from a minimum of
4Kb to a maximum limited only by available hard disk space.

To modify the location and size of the log:
1. From the Log Viewer main menu, click Options and then click Configure

Message Log Settings... A Windows common dialog box is displayed.
2. From the dialog box, browse the directory structure and choose the destination

directory and file name for the message log.
3. Using the spin control counter field, use the up and down arrows to increase or

decrease the log file size (in kilobytes).
4. Select OK to save settings and exit the window.

Merging Message and Trace Logs
The Personal Communications log viewer utility allows you to open and merge
message and trace log entries in the same log viewer window. You can merge any
combination of message and trace log files.
v .MLG into .TLG
v .TLG into .TLG
v .TLG into .MLG
v .MLG into .MLG

To merge message and trace log files:
1. From the Log Viewer window, select the message or trace log file window

where the files will be merged.
2. Click the File menu, then click Merge and choose a file to be merged.
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Sorting Message and Trace Logs
The Personal Communications log viewer utility allows you to sort message and
log files in ascending and descending order. To sort files in ascending order, click
the column header one time, or right mouse click the data. Click the column
header, or right mouse click the data a second time to sort in descending order.

Message and logs can also be sorted by selecting the data to be sorted, and right
mouse clicking to display the pop-up menu. Click Sort.

Searching Personal Communications Logs
To search the log files, click Edit → Find on the Main menu.

Type your search string in the provided box. You can refine your search by
checking the Match case check box if your search is to be case-specific. If you want
to limit your search to only complete words, select the Match whole word only
check box.

Clicking Find Next takes you to the next instance where your search string
appears highlighted in the log.

Clicking Cancel will stop the search.

Filtering Personal Communications Logs
Messages can be filtered by component only. Traces can be filtered by component,
by process ID, and by thread ID.

To filter the message or trace record list, do the following:
1. Decide what you want to filter by. For example, in the message log, you may

want to filter your view so that it contains only messages issued by a particular
component. (Filtering by component is the default.)

2. Click the left mouse button to highlight the item that has the value that you
want to filter by.

3. Right click in the appropriate column list area.
4. Click Filter In, Filter Out or Sort.

Filter In allows only those items selected to be in the resulting view. Filter Out
removes the selected items from the resulting view. Sort allows you to sort
entries in ascending or descending order based upon the entry selected. This
function works much like sorting by column header. Filters are cumulative, so
you can filter the results of your first filter.

To restore your original view, click View and then Refresh, or you can press F5.
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Part 3. SNA and AnyNet Topics
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Chapter 11. SNA Client/Server Concepts

Terminology
Advanced Program-to-Program Communication (APPC)

An implementation of the SNA LU 6.2 protocol that allows interconnected
systems to communicate and share the processing of programs.

Advanced Peer-to-Peer Networking (APPN)
An enhancement for Systems Network Architecture (SNA) networks
featuring:
v Dynamic exchange of network topology information that simplifies

connections, route selection, network definition, and reconfiguration
v Automated resource registration and directory lookup
v Greater distributed network control that helps to isolate the effects of

single points of failure

Common Programming Interface for Communications (CPI-C)
Personal Communications provides support for the Common Programming
Interface for Communications (CPI-C) 2.0 industry standard interface from
X/Open. The CPI-C interface enables greater application portability across
different platforms. By using CPI-C 2.0, APPC programming is simplified,
resulting in reduced cycle time, and enhanced client/server computing
capability. This support provides the capability for distributed parts of an
application to converse with one another. The implementation is consistent
with the Conversational function described in the IBM Open Blueprint®.

Logical Unit Address (LUA)
System software and interfaces that supply input/output (I/O) service
routines to support communications that use LU types 0, 1, 2, and 3 SNA
protocols. These protocols support user defined data streams, SNA
character streams, and SNA 3270 data streams. LUA services include only
those services that support data communications. LUA does not supply
any device emulation facilities.

Node An endpoint of a link, or a junction, common to two or more links in a
network. Nodes can be linked to host processors, communication
controllers, cluster controllers, terminals, or workstations.

End Node
Provides directory and routing services for a workstation on an APPN
network.

If the workstation will not be connecting from an end node to a network
node server, you need to define an SNA connection.

APPC Concepts
Personal Communications provides Advanced Peer-to-Peer Networking (APPN)
end node support for workstations, allowing them to communicate more flexibly
with other systems in the network.

Personal Communications provides advanced program-to-program
communications (APPC) to support communications between distributed
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processing programs, called transaction programs (TPs). APPN extends this
capability to a networking environment. The TPs can be located at any node in the
network that provides APPC.

Introducing APPC and CPI-C
Advanced Program-to-Program Communication (APPC), also known as LU 6.2, is
software that enables high-speed communications between programs on different
computers, from portables and workstations to midrange and host computers.
APPC software is available for many different IBM and non-IBM operating
systems, either as part of the operating system or as a separate software package.

APPC serves as an interface between application programs and the network. When
the communications application on your workstation passes information to the
APPC software, APPC takes the information and sends it on to a network
interface, such as a token ring adapter card. The information travels across the
network to another computer, where the APPC software receives the information
from the network interface. APPC puts the information back into its original
format and passes it to the corresponding communications application.

APPC provides a consistent set of functions for program-to-program
communications across different platforms. But, the architecture did not specify a
common application programming interface (API) for implementing these
functions. As a result, each operating system that supports APPC developed its
own API, a set of verbs that closely resemble the operating system itself. These
differences do not pose a problem if you are writing programs for two computers
that use the same operating system. Most client/server applications run on
different types of computers, however, to take advantage of the strengths of each
computer. So, if you are designing programs for different operating systems, you
must learn how to use two or more different sets of verbs.

The Common Programming Interface for Communications (CPI-C) eliminates this
problem. CPI-C provides one standard set of verbs, known as CPI-C calls, for all
systems that support CPI-C. As a result, you learn only one set of calls to write
client/server applications for different systems.

What Is a Transaction Program?
The part of the communications application that initiates or responds to APPC
communications is called a transaction program. A transaction program is not an
entire, stand-alone program. Instead, it is the part of the program that handles
transactions (exchanges of data) with another program.

When people talk with each other, we say that they are having a conversation.
Likewise, the communication between two transaction programs is called a
conversation.

A conversation between two programs is similar to a conversation between two
people. When you have a conversation with another person, you follow unwritten
rules that govern how you begin and end the conversation, take turns speaking,
and exchange information. Similarly, APPC is called a protocol because it provides
the rules that govern how conversations between transaction programs start and
stop, which program “speaks” first, and how data is exchanged. Computers need
complete and rigid rules for conversations between programs. For that reason,
APPC consists of a set of well-defined and thorough rules to cover all possible
communications situations.
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An APPC program may have several conversations active at one time, with the
same transaction program or with different transaction programs.

Every transaction program needs a partner to communicate with. Thus, transaction
programs are developed in pairs called partner transaction programs.

People use different parts of speech to communicate with each other. Transaction
programs are more limited in their communications; they use only verbs to
communicate with each other. The verbs are the programming language you use to
start, stop, and control conversations.

A transaction program consists of APPC and CPI-C verbs such as:

ALLOCATE (CMALLC in CPI-C)
Starts a conversation with another transaction program

SEND_DATA (CMSEND in CPI-C)
Sends data to the partner transaction program

RECEIVE (CMRCV in CPI-C)
Receives data from the partner transaction program

DEALLOCATE (CMDEAL in CPI-C)
Ends a conversation with another transaction program.

The APPC verbs make up the application programming interface (API) for APPC
and CPI-C. In other words, these verbs represent the interface between the
transaction program and the APPC software.

What Is the Difference between APPC and APPN?
APPC is a communications protocol that enables programs on different computers
to “talk to” each other. APPC provides the interface between the programs and the
networking hardware and software and defines the rules that programs use to
exchange information.

Advanced Peer-to-Peer Networking (APPN) is the underlying networking protocol
that routes APPC traffic through intermediate nodes in the network. For instance,
when Program A uses APPC to talk to Program B, APPN finds the node where
Program B is located and directs the APPC traffic through the network.

APPN includes several features that help reduce the amount of configuration
required to set up and maintain a network. These features automate many tasks
that are time-consuming, complicated, and error-prone. For example, if you’re
installing a new workstation that uses APPN, you don’t have to set up
configuration information for every workstation you want to communicate with.
You simply provide the name of the computer and the address of the intermediate
node that handles your traffic. APPN takes care of the rest of the information
needed to route APPC traffic to and from your workstation.

If you connect to an APPN network, you simplify your own configuration and
make it easier for other computers in the network to find you.

Side Information Definitions
Before starting a conversation with a partner program, a CPI-C program requires
the following information:
v The name of the partner program
v The name of the LU on the remote computer
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v The type of session used by the program
v Security information

If the CPI-C partner program uses a blank symbolic destination name, a side
information definition is not necessary.

Improving Productivity Using APPC
The advanced features of APPC help speed the development of robust
client/server applications and keep development costs low.

Client/server applications often prove to be especially challenging to the
programmer. It’s not enough to understand the details about the computer and
operating system that your application uses. If you’re designing client/server
applications, you have to deal with computers used by both sides of the
application, as well as the intervening network. For instance, implementing
effective security measures is more important and more complicated, since you
must ensure security throughout the network. In addition, synchronization and
error reporting are often problematic in a distributed environment, because both
sides of the application must coordinate their work.

One reason that APPC has become so widely used in client/server applications is
that it furnishes a complete set of useful functions like security, synchronization,
and error reporting. If you use other protocols, you must build these functions in
every application you write. For example, if you use NetBIOS, you must design
and implement a strategy for security for each application. Not only does this
approach require additional work, it may result in a number of incompatible
security systems in your network. By contrast, APPC includes a common set of
security services that are consistent across all APPC platforms.

Similarly, most protocols do not include synchronization functions. Synchronization
is required by any program that cannot continue processing data until the data
sent to the partner program has been received and processed. Rather than writing
your own synchronization routine, APPC provides a Confirm call that you can use
to handle synchronization between two programs.

Improving Productivity Using CPI-C
Because many client/server applications are distributed between mainframe
systems and workstations, host programmers and workstation programmers must
work together to develop partner applications. CPI-C bridges the gap between
these programmers by providing a common language for designing the
communications part of the applications. CPI-C also enables you to write the
communications portion of an application without knowing the details of the
operating system. After you write a CPI-C application, you can easily move the
programs from one operating system to another with few changes. So, by using the
CPI-C interface, you can port both your applications and your programming skills
from one system to another, quickly and cost-effectively.

What Is a Logical Unit?
Every TP gains access to an SNA network through a logical unit (LU). An LU is
SNA software that accepts verbs from your programs and acts on those verbs. A
TP issues APPC verbs to its LU. These verbs cause commands and data to flow
across the network to a partner LU. An LU also acts as an intermediary between

108 Personal Communications Administrator’s Guide and Reference



the TPs and the network to manage the exchange of data between TPs. A single
LU can provide services for multiple TPs. Multiple LUs can be active in the node
simultaneously.

LU Types
Personal Communications supports LU types 0, 1, 2, 3, and 6.2. LU types 0, 1, 2,
and 3 support communication between host application programs and different
kinds of devices, such as terminals and printers.

LU 6.2 supports communications between two programs located at type 5 subarea
nodes, type 2.1 peripheral nodes, or both, and between programs and devices.
APPC is an implementation of the LU 6.2 architecture.

Communication occurs only between LUs of the same LU type. For example, an
LU 2 communicates with another LU 2; it does not communicate with an LU 3.

When Personal Communications is configured, your local and partner LUs are
defined once for each machine. When you design programs, you must understand
the capabilities supported by the LU in the particular machines you plan to use.

Dependent and Independent LUs
A dependent LU depends on a system services control point (SSCP) to activate a
session. A dependent LU needs an active SSCP-LU session, which the dependent
LU uses to start an LU-LU session with an LU in a subarea node. A dependent LU
can have only one session at a time with the subarea LU. For communications with
a TP at a subarea node, each dependent LU can have only one conversation at a
time, and each dependent LU can support communications for only one TP at a
time.

An independent LU does not depend on an SSCP to activate a session. An
independent LU supports multiple concurrent sessions with other LUs in a subarea
node, so you can have multiple conversations and support multiple TPs for
communications with subarea TPs. LUs between peripheral nodes also use this
support.

The distinction between a dependent LU and an independent LU is meaningful
only when discussing a session between an LU in a peripheral node and an LU in
a subarea node. Otherwise, dependent and independent LUs both support multiple
concurrent sessions and conversations when communicating between type 2.1
peripheral nodes, for example, between two Windows NT workstations. A Personal
Communications LU can support a single session with a dependent LU or multiple
sessions with an independent LU.

What Is a Session?
Before TPs can communicate with each other their LUs must be connected in a
mutual relationship called a session. A session connects two LUs, so it is called an
LU-LU session. Figure 3 on page 110 illustrates this communication relationship.
Multiple, concurrent sessions between the same two LUs are called parallel LU-LU
sessions.
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Sessions act as conduits that manage the movement of data between a pair of LUs
in an SNA network. Specifically, sessions deal with things such as the quantity of
data transmitted, data security, network routing, and traffic congestion.

Sessions are maintained by their LUs. Normally, your TPs do not deal with session
characteristics. You define session characteristics when you:
v Configure your system
v Use the Session Services function in the Subsystem Management windows
v Use the management verbs

What Is a Conversation?
The communication between TPs is called a conversation. Conversations occur
across LU-LU sessions. A conversation starts when a TP issues an APPC verb or
CPI-C call that allocates a conversation. The conversation style associated with the
conversation indicates the style of data transfer to be used, two-way alternate or
two-way simultaneous. A conversation that specifies a two-way alternate style of
data transfer is also known as a half-duplex conversation. A conversation that
specifies a two-way simultaneous style of data transfer is referred to as a full-duplex
conversation.

When a half-duplex conversation is allocated to a session, a send-receive
relationship is established between the TPs connected to the conversation, and a
two-way alternate data transfer occurs where information is transferred in both
directions, one direction at a time. Like a telephone conversation, one TP calls the
other, and they “converse”, one TP talking at a time, until a TP ends the
conversation. One TP issues verbs to send data, and the other TP issues verbs to
receive data. When it finishes sending data, the sending TP can transfer send
control of the conversation to the receiving TP. One TP decides when to end the
conversation and informs the other when it has ended.

When a full-duplex conversation is allocated to a session, both TPs connected to
the conversation are started in send-and-receive state, and a two-way simultaneous
data transfer occurs where information is transferred in both directions at the same
time. Both TPs may issue verbs to send and receive data simultaneously with no
transfer of send control required. The conversation ends when both TPs indicate
they are ready to stop sending data, and each TP has received the data sent by the
partner. If an error condition occurs, one TP may decide to end both sides of the
conversation abruptly.

Conversations can exchange control information and data. The TP should select the
conversation style best suited for its application.

Figure 3. A Session between Two LUs
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A Conversation between Two TPs
Figure 4 shows a conversation between two TPs as it occurs over a session.

A session can support only one conversation at a time, but one session can support
many conversations in sequence. Because multiple conversations can reuse
sessions, a session is a long-lived connection compared to a conversation. When a
program allocates a conversation and all applicable sessions are in use, the LU puts
the incoming Attach (allocation request) on a queue. It completes the allocation
when a session becomes available.

Two LUs can also establish parallel sessions with each other to support multiple
concurrent conversations. A parallel session occurs when either TP allocates a
conversation, and a session exists but is being used by a conversation. The LU can
request a new session to satisfy the allocation.

Parallel Sessions between LUs
Figure 5 shows three parallel sessions between two LUs; each session carries a
conversation.

SNA Communications
Personal Communications supports Systems Network Architecture (SNA) type 2.1
nodes (including SNA type 2.0 and SNA type 2.1 support for LUs other than SNA
LU 6.2). This support lets you write programs to communicate with many other
IBM SNA products.

You can write programs without knowing the details of the underlying network.
All you need to know is the name of the partner LU; you do not need to know its
location. SNA determines the partner LU location and the best path for routing
data. A change to the underlying network, such as a physical address change, the

Figure 4. A Conversation between Two TPs

Figure 5. Parallel Sessions between LUs
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addition of a new adapter, or the relocation of a machine, does not affect APPC
programs. A program might, however, need to establish link connections over
switched SDLC connections.

When Personal Communications starts, it establishes local LU and logical link
definitions, which are stored in a configuration file. The system management
application programming interface (API) provides functions that control
configuration definition and adapter and link activation.

SNA Node Operations
With SNA Node Operations, either a user or system administrator can display
information or take action on node resources that are known to the active node.

The following tasks are supported:
v Starting and stopping resources
v Deleting resources
v Displaying resource information
v Changing session limits
v Initiating path switches

For more information about SNA node operations, see Chapter 13, “SNA Node
Operations”, on page 135 or refer to the online help.
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Chapter 12. AnyNet SNA over TCP/IP

This chapter describes the AnyNet SNA over TCP/IP function of Personal
Communications.

What Does AnyNet SNA over TCP/IP Do?
SNA over TCP/IP is one of the IBM AnyNet software offerings. AnyNet software
enables application programs to communicate over different transport networks
and across interconnected networks. Using AnyNet, you can reduce the number of
transport networks and therefore reduce operational complexity. These benefits are
gained without modification to your existing application programs or hardware.

The AnyNet function in Personal Communications enables SNA applications to
communicate over an IP network. This includes the Personal Communications
emulators, both 3270 and 5250, as well as APPC and CPI-C applications.

The following network configurations illustrate how SNA over TCP/IP access
nodes and gateways can be used.

Running APPC or CPI-C Applications over a TCP/IP Network
Figure 6 illustrates how you can use the AnyNet SNA over TCP/IP function of
Personal Communications to enable communication between SNA applications
over an IP network. Configuration information for a similar configuration is
provided in Quick Beginnings.

Using AnyNet to Connect SNA Applications on Different
Platforms

Figure 7 on page 114 illustrates some of the many products with AnyNet SNA over
TCP/IP function. AnyNet gateways (Node F) allow SNA applications to
communicate across a combination of TCP/IP and SNA networks.

IP
Network

Node A: Windows 95 Node B: Windows NT

Application A

Personal
Communications

• AnyNet SNA
over TCP/IP

Application B

Personal
Communications

• AnyNet SNA
over TCP/IP

Figure 6. Running APPC or CPI-C Applications over a TCP/IP Network
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Chaining Gateways to Connect Multiple SNA and IP Networks
Chained gateways enable the SNA network to connect multiple IP networks.

Note: While Figure 8 on page 115 shows three networks connected, the number of
networks that can be concatenated is unlimited.

IP

Node A: Windows 95 Node B: OS/2

Application A

Personal
Communications

• AnyNet SNA
over TCP/IP

Application B

Personal
Communications

• AnyNet SNA
over TCP/IP

Node C: OS/400 Node D: AIX

Application C

OS/400

• SNA
• AnyNet SNA

over TCP/IP
• TCP/IP

Application D

Communications
Server for AIX

• AnyNet APPC
over TCP/IP

Communications
Server

• AnyNet SNA
over TCP/IP
Gateway

Node F:
OS/2,
MVS
or AIX

SNA

LU6.2

Node E:

Figure 7. Using AnyNet to Connect SNA Applications on Different Platforms
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5250 Emulation over a TCP/IP Network
Figure 9 illustrates how AnyNet enables 5250 emulation over a TCP/IP network.
Configuration instructions for this example are provided in Quick Beginnings.

APPC3270 Emulation over a TCP/IP Network
AnyNet also enables APPC3270 emulation over a TCP/IP network. See Figure 10
on page 116. Configuration instructions for this example are given in Quick

Beginnings.

IP
Network

Node D:
Windows NT

SNA
Network

IP
Network

Node A:
Windows 95

Application A

Personal
Communications

• AnyNet SNA
over TCP/IP

Communications
Server

AnyNet SNA
over TCP/IP
Gateway

Node B:
OS/2 or

Windows NT

Communications
Server

AnyNet SNA
over TCP/IP
Gateway

Application B

Personal
Communications

• AnyNet SNA
over TCP/IP

IP
Network

Node C:
OS/2 or

Windows NT

Figure 8. Chaining Multiple Gateways to Connect Multiple IP Networks
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• AnyNet SNA
over TCP/IP

Node A: Windows 95

OS/400

• AnyNet SNA
over TCP/IP

• TCP/IP

Node B: AS/400 Host

Figure 9. 5250 Emulation over a TCP/IP Network

Chapter 12. AnyNet SNA over TCP/IP 115



3270 Emulation via DLUR over a TCP/IP Network
Figure 11 illustrates how you can use the AnyNet SNA over TCP/IP function of
Personal Communications to enable 3270 emulation over a TCP/IP network. Node
B, an access node, is defined as a dependent LU requester (DLUR). Configuration
instructions for this example are provided in Quick Beginnings.

3270 Emulation over a TCP/IP Network via an SNA Gateway to
a VTAM® Host on an SNA Network

Figure 12 on page 117 illustrates a configuration that supports dependent LU
communications for downstream workstations to a subarea host. In this example,
Node B is configured for dependent LU communication over AnyNet to a zSeries
host. Configuration instructions for this example are provided in Quick Beginnings.

IP
Network

VTAM

• AnyNet SNA
over TCP/IP

Node A: VTAM

Personal
Communications

• AnyNet SNA
over TCP/IP

Node B: Windows 95

Figure 10. APPC3270 Emulation over a TCP/IP Network
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Network

VTAM

• AnyNet SNA
over TCP/IP

• DLUS

Node A: VTAM

Personal
Communications

• DLUR
• AnyNet SNA

over TCP/IP

Node B: Windows NT

Figure 11. 3270 Emulation via DLUR over a TCP/IP Network

116 Personal Communications Administrator’s Guide and Reference



3270 Emulation over a TCP/IP Network via an SNA Gateway to
a VTAM Host on an APPN Network

Figure 13 illustrates a configuration that supports dependent LU communication
for downstream workstations to an APPN host. The configuration of Node C is the
same as that of Node B in the previous example, but the VTAM host and the OS/2
gateway are connected to an APPN network.

3270 Emulation via an SNA Gateway over a TCP/IP Network
Figure 14 on page 118 illustrates a configuration that supports dependent LU
communication for downstream workstations over a single IP network. All three
machines are running AnyNet SNA over TCP/IP. As in the previous example,
Node A is a dependent LU server (DLUS), and Node B is a dependent LU
requester (DLUR). Configuration instructions for this example are given in Quick
Beginnings.

IP
Network

Node A: OS/2 or Windows NT Node B: Windows 95

SNA

PLU

Communications
Server

• SNA Gateway
• AnyNet SNA

over TCP/IP

VTAM

Personal
Communications

• AnyNet SNA
over TCP/IP

Figure 12. 3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on
an SNA Network
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over TCP/IP
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Personal
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• AnyNet SNA
over TCP/IP

Node A: VTAM

VTAM

• DLUS

Figure 13. 3270 Emulation over a TCP/IP Network via an SNA Gateway to a VTAM Host on
an APPN Network
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How Does SNA over TCP/IP Work?
SNA over TCP/IP uses protocols that bypass the lower transport layers of the SNA
architecture. This process is transparent to the SNA application program. Using a
supported API, an application program passes data to the presentation services of
Personal Communications. This data, in turn, is passed through the SNA
architectural layers and presented to SNA over TCP/IP at the data link control
level. When Personal Communications initiates a session for an application
program, SNA over TCP/IP translates the SNA routing information
(network-qualified name) into IP routing information (IP address) and uses the IP
address to create a TCP connection to the appropriate system.

Figure 15 on page 119 illustrates how an SNA over TCP/IP access node enables
SNA application programs to communicate over IP networks.

IP
Network

Communications
Server

• SNA Gateway
• DLUR
• AnyNet SNA

over TCP/IP

Node B: OS/2 or Windows NT

Personal
Communications

• AnyNet SNA
over TCP/IP

Node C: Windows NT

VTAM

• AnyNet SNA
over TCP/IP

• DLUS

Node A: VTAM

Figure 14. 3270 Emulation via an SNA Gateway over a TCP/IP Network

118 Personal Communications Administrator’s Guide and Reference



The configuration information you define enables SNA over TCP/IP to determine:
v Whether to route the data using SNA or to route the data using IP
v The IP address associated with the network-qualified LU name

SNA over TCP/IP uses both stream (TCP) and datagram (UDP) sockets that are
bound to the well-known port (397). Any information received over this port is
routed to AnyNet.

Mapping SNA Resources to IP Addresses
SNA over TCP/IP access nodes must determine the IP address of the partner
before an SNA session can be established. The SNA identifier of the partner is
mapped to an IP address using the following steps:
1. SNA over TCP/IP receives the SNA identifier from Personal Communications

in one of the following formats:
v For LU names, netid.luname
v For CP names, netid.cpname

2. SNA over TCP/IP takes the identifier and generates a domain name:
v For LU names, luname.netid.snasuffix
v For CP names, cpname.netid.snasuffix

Note: The default value for snasuffix is SNA.IBM.COM. For additional
information on the SNA domain name suffix, refer to the online help.

Figure 16 on page 120 shows examples of domain names generated by SNA
over TCP/IP.

Windows NT

Personal
Communications

CPI-C

APPC LUA

SNA

SNA Application
including

emulation
and print

AnyNet

TCP/IP

Sockets

TCP UDP

IP

DLCs

Figure 15. Structure of SNA over TCP/IP for Personal Communications
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3. SNA over TCP/IP requests that the domain name be translated into an IP
address.

4. TCP/IP uses the HOSTS file or domain name server to translate the domain
name into an IP address (for example, 9.67.192.28).

When the IP network includes SNA over TCP/IP gateways, consider the following
additional address mapping issue:

If the partner LU can be reached through a gateway, the domain name of the
partner must be mapped to the IP address of the gateway. If there are parallel
gateways, the domain name should be mapped to each gateway IP address.

Defining Domain Names and IP Addresses
This section describes the TCP/IP name resolution function, used by AnyNet to
map SNA resources to IP addresses. This function queries both the local HOSTS
file and any domain name servers to convert a domain name (for example,
lu1.neta1.sna.ibm.com) into an IP address (for example, 10.1.1.1).

HOSTS File
You can use TCP/IP HOSTS files to define domain names and IP addresses
for your network. However, as your network becomes larger and
maintaining the HOSTS file on each user workstation becomes too
time-consuming, it is recommended that you use a domain name server.

The HOSTS file lists:
v IP address
v Domain name
v Other aliases for the domain name

Note: For Windows/NT this resides in the drivers\etc subdirectory of
your NT system. For Windows 95 and Windows 98, this is in your
Windows system directory.

For example, if your IP address is 10.1.1.1, network ID is NETA1, SNA
resource name is LUA1, and SNA domain name suffix is the default
(sna.ibm.com), enter the following in your HOSTS file:
10.1.1.1 lua1.neta1.sna.ibm.com

Domain Name Server
Domain names and IP addresses can also be defined in the domain name
server database.

lu1.neta1.sna.ibm.com

netid

domain name

SNA domain name suffixLU name

cp1.neta1.sna.ibm.com

netid

domain name

SNA domain name suffixCP  name

Figure 16. Formats of the Domain Names That SNA over TCP/IP Builds
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Each SNA identifier is mapped to a corresponding IP address by a domain
name server. The location of these servers is configured in the Network
section of the Control Panel.

For more information on HOSTS files and domain name servers, refer to your
TCP/IP documentation. If your workstation is using the TCP/IP support in
Windows 95, Windows 98, Windows NT, Windows Me, Windows 2000, or
Windows XP, refer to the online TCP/IP documentation that is included with the
Windows 95, Windows 98, Windows NT, Windows Me, Windows 2000, or
Windows XP product.

Defining Unique CP Names and Connection Network Names
For configurations that have two or more SNA over TCP/IP gateways connecting
an SNA network with two or more IP networks, you must define a unique SNA
control point (CP) name and a unique SNA connection network name for each IP
network.

All LUs that reside on access nodes in the IP network appear to reside on a node
with this CP name.

Use the reverse data file of the domain name server or the HOSTS file to define
the CP name and the connection network name for a given IP network. Map the IP
address 127.0.0.3 to the CP name and map the IP address 127.0.0.4 to the
connection network name.

The following example shows entries in the reverse data file. For an IP network
with SNA network ID NETA, CP name MYCPNAME, and connection network
name MYCNET, you would define the following entries:
127.0.0.3 NETA.MYCPNAME.
127.0.0.4 NETA.MYCNET.

Notes:

1. A period is required at the end of the name only if the definition is in the DNS
reverse data file. No period is used in HOSTS file definitions.

2. Do not include the SNA domain name suffix.

The AnyNet SNA over TCP/IP function of Personal Communications provides a
default CP name ($ANYNET.$GWCP) and a default connection network name
($ANYNET.$GWCNET). In configurations with one IP network, you can use the
default by not defining a CP name or a connection network name. In
configurations with multiple gateways connecting multiple IP networks, one IP
network can use the default. You must, however, define a unique CP name and
connection network name for all other IP networks.

Figure 17 on page 122 shows how to define the CP name and the connection
network name for a configuration with two IP networks. An example is provided
in Quick Beginnings.
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Setting and Modifying the Routing Preference Protocol
When an SNA application initiates a session, Personal Communications must first
determine which transport to use, either SNA, IP, or a combination of the two.

Personal Communications uses the default routing preference for the session unless
there is a specific routing preference set for the partner LU. Personal
Communications then sets up a session for the partner LU using the preferred
transport.

If the partner is not available through the preferred transport, Personal
Communications can reroute the session request over the other available transport,
depending on the setting in the routing preference table. For example, if the setting
in the routing preference table for the destination LU is nonnative first, Personal
Communications will attempt to set up the session over TCP/IP. If the partner is
not available through TCP/IP, Personal Communications will route the session
over SNA. However, if the setting in the routing preference table for the
destination LU is nonnative only, Personal Communications will attempt to set up
the session over TCP/IP. If TCP/IP is not available, Personal Communications will
not route the session over SNA, because the setting allows only Personal
Communications to use nonnative transport.

The routing preference table is used only for new sessions. Previously existing
sessions use the same transport; they are not brought down and rerouted if the
routing preference table is changed.

You can set or modify the default routing preference to one of the following:

IP Network
CPName =
$ANYNET.$GWCP

Connection network name =
$ANYNET.$GWCNET

IP Network
CPName = NETB.CPB
Connection network name =
NETB.CNETB

SNA

SNA
over TCP/IP
gateway

SNA
over TCP/IP
gateway

Node A

Node B

reverse address table

127.0.0.3

127.0.0.4

NETB.CPB

NETB.CNETB

(no table, default assumed)

Figure 17. Defining a CP Name and a Connection Network Name
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Native first
Requests are routed over SNA. If no SNA route is available, requests are
routed over TCP/IP.

Nonnative first
Requests are routed over TCP/IP. If no TCP/IP route is available, requests
are routed over SNA.

Native only
Requests are routed only over SNA. If no SNA route is available, the
connection will fail.

Nonnative only
Requests are routed only over TCP/IP. If no TCP/IP route is available, the
connection will fail.

Helpful Hints
This section contains helpful hints on tuning, TCP/IP connectivity via SLIP or PPP,
and dynamic IP addresses.

Tuning
If you can access an LU through multiple SNA over TCP/IP gateways, and you
have mapped that LU name to multiple IP addresses, increase the Connection retry
duration and Connection wait time limit when configuring the AnyNet base
parameters. This ensures that TCP attempts to connect to all possible adapters and
gateways. It can take as long as 90 seconds for a TCP connection to fail to an
inactive IP address.

Connecting to iSeries
If you are unable to connect to iSeries using SNA over TCP/IP, use the following
procedure:
1. Make sure that the ANYNET support on the iSeries is activated. Issue the

command DSPNETA on the iSeries and make sure the ANYNET status is yes.
2. Edit the HOSTS file on the PC, mapping the IP address to the CP name of the

iSeries.
3. Reboot the PC; the SNA over TCP/IP connection is then activated.

Dynamic IP Addresses
Generally, AnyNet SNA over TCP/IP depends on SNA resources (for example, LU
names, CP names, or idblk/num) being statically mapped to IP addresses.
However, depending on your configuration and how your connections are
initiated, you might be able to use AnyNet SNA over TCP/IP in environments
where IP addresses are dynamically assigned (for example, DHCP).

APPC or CPI-C Applications
An SNA over TCP/IP access node with a dynamically assigned IP address may
always initiate sessions to another SNA over TCP/IP access node or gateway with
a static IP address.

The only way an SNA over TCP/IP access node or gateway with a static IP
address (node A) can initiate a session to a partner with a dynamic IP address
(node B) is:
v Node B initiated a session to or through node A first.
v The session initiated in Step 1 is still active.
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Dependent LU Applications

Note: The information in this section applies to LU 0, 1, 2, 3, or dependent 6.2
applications.

SNA over TCP/IP access nodes with dynamically assigned IP addresses can
support dependent LU communications if the following criteria are met.
v Dependent LU communication is occurring through an SNA gateway either

through:
– Communications Manager/2 V5 or later
– Communications Server for Windows 5.0 or later

v The SNA over TCP/IP access node with a dynamically assigned IP address
initiates connections to an SNA gateway with a static IP address.

Dependent LU communication through DLUS/DLUR over AnyNet SNA over
TCP/IP is not supported if the DLUR node has a dynamically assigned IP address.

AnyNet Configuration Examples
This section includes examples of AnyNet running SNA over IP connections.The
following configuration instructions are complete only for the Windows NT and
Windows 95 operating systems. In all examples, the SNA domain name suffix is
SNA.IBM.COM.

Notes:

1. In the following examples, Windows 95 is shown; Windows 98 can be treated
the same.

2. Windows NT is shown; Windows 2000 can be treated the same.

For more information about AnyNet as part of Personal Communications, refer to
the 3270 Emulator User’s Reference or 5250 Emulator User’s Reference.

Example 1. 5250 Emulation Over a TCP/IP Network

Follow these steps to establish communication between the Windows 95
workstation (Node A) and the iSeries host (Node B).

CP name: NETA.CPNAME2
IP address: 10.2.1.1

IP
Network

Personal
Communications

• AnyNet SNA
over TCP/IP

Node A: Windows 95

CP name: NETA.CPNAME1
IP address: 10.1.1.1

OS/400

• AnyNet SNA
over TCP/IP

• TCP/IP

Node B: AS/400 Host

Figure 18. 5250 Emulation Over a TCP/IP Network
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For Windows 95 Node A, do as follows:
1. Add the following entries to the local HOSTS file:

10.1.1.1 CPNAME1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: iSeries

v Interface: AnyNet

v Attachment: TCP/IP 5250

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.CPNAME2

On the Configure Logical Connection Windows, enter:
System Location Name: NETA.CPNAME1

f. Save your workstation profile.

For iSeries Node B, add the following entry to the local HOSTS file:
10.2.1.1 CPNAME2.NETA.SNA.IBM.COM

Example 2. Running APPC or CPI-C Applications over a
TCP/IP Network

Follow these steps to establish communication between a Windows NT node and a
Windows 95 node. Note that in this example, the CP names are used as LU names.

For Windows 95 Node A, do as follows:
1. Add the following entry to the local HOSTS file:

172.25.11.2 CP2.NETA.SNA.IBM.COM

LU name: NETA.CP1
IP address: 172.25.11.1

IP
Network

Node A: Windows 95

LU name: NETA.CP2
IP address: 172.25.11.2

Node B: Windows NT

Application A

Personal
Communications

• AnyNet SNA
over TCP/IP

Application B

Personal
Communications

• AnyNet SNA
over TCP/IP

Figure 19. Running APPC or CPI-C Applications over a TCP/IP Network
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2. Create a configuration using the Personal Communications configuration tool:
a. Click the SNA Node Configuration icon; or click Actions → Launch → SNA

Node Configuration. The Personal Communications SNA Node
Configuration window is displayed.

b. In the Configuration Options list, choose Configure Node and click New.
c. On the Define the Node window on the Basic tab, enter:

Fully qualified CP name: NETA.CP1

Click OK to complete node configuration.
d. Choose Configure Devices. In the DLCs list, choose AnyNet SNA/IP and

click New.
e. On the Define an AnyNet SNA over TCP/IP Device window on the Basic

tab, enter:
SNA domain name suffix: SNA.IBM.COM

f. Click the Routing Preferences tab:
Default Routing Preference: Nonnative only
Click OK to complete configuration of the AnyNet device.

g. From the Personal Communications SNA Node Configuration window, click
File. Click Save as... and enter the desired file name to save.

For Windows NT Node B, do as follows:
1. Add the following entry to the local HOSTS file:

172.25.11.1 CP1.NETA.SNA.IBM.COM

2. Create a configuration using the Personal Communications configuration tool:
a. Click the SNA Node Configuration icon; or click Actions → Launch → SNA

Node Configuration. The Personal Communications SNA Node
Configuration window is displayed.

b. In the Configuration Options list, choose Configure Node and click New.
c. On the Define the Node window on the Basic tab, enter:

Fully qualified CP name: NETA.CP2

Click OK to complete node configuration.
d. Choose Configure Devices. In the DLCs list, choose AnyNet SNA/IP and

click New.
e. On the Define an AnyNet SNA over TCP/IP Device window on the Basic

tab, enter:
SNA domain name suffix: SNA.IBM.COM

f. Click the Routing Preferences tab:
Default Routing Preference: Nonnative only
Click OK to complete configuration of the AnyNet device.

g. From the Personal Communications SNA Node Configuration window, click
File. Click Save as... and enter the desired file name to save.

3. Start Personal Communications on each machine.
4. Start your applications (for example APING).

Example 3. APPC3270 Emulation over a TCP/IP Network
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Follow these steps to establish communication between the VTAM host (Node A)
and the Windows 95 (Node B).

For VTAM Node A, add the following entry to the local HOSTS file:
10.2.1.2 LUNAME2.NETA.SNA.IBM.COM

For Windows 95 Node B, do as follows:
1. Add the following entry to the local HOSTS file:

10.1.1.1 LUNAME1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: APPC3270

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.LUNAME2

f. On the Configure Logical Connection window, enter:
v System location name: NETA.LUNAME1

v Routing Preference: Nonnative only
g. On the Configure AnyNet Connection window, enter:

SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

Example 4. 3270 Emulation via DLUR over a TCP/IP Network

IP
Network

VTAM

• AnyNet SNA
over TCP/IP

Node A: VTAM

Personal
Communications

• AnyNet SNA
over TCP/IP

Node B: Windows 95

LU name: NETA.LUNAME1
IP address: 10.2.1.1

LU name: NETA.LUNAME2
IP address: 10.2.1.2

Figure 20. APPC3270 Emulation over a TCP/IP Network
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Follow these steps to establish communication between the VTAM Host (Node A)
and the Windows 95 workstation (Node B).

For VTAM Node A, add the following entry to the HOSTS file:
192.168.7.10 CP2.NETA.SNA.IBM.COM
192.168.7.10 DEPLU1.NETA.SNA.IBM.COM

For Windows 95 Node B, do as follows:
1. Add the following entry to the local HOSTS file:

192.168.7.8 CP1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click on the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.CP2

f. On the Configure DLUR window, enter:
v DLUS name: NETA.CP1

v Routing Preference: Nonnative only
g. On the Configure AnyNet Connection window, enter:

SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

CP name: NETA.CP1
IP address: 192.168.7.8

IP
Network

VTAM

• AnyNet SNA
over TCP/IP

• DLUS

Node A: VTAM

CP name: NETA.CP2
IP address: 192.168.7.10
Dependent LU name: NETA.DEPLU1

Personal
Communications

• DLUR
• AnyNet SNA

over TCP/IP

Node B: Windows 95

Figure 21. 3270 Emulation via DLUR over a TCP/IP Network
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Example 5. 3270 Emulation over a TCP/IP Network via a SNA
Gateway to a VTAM Host on a SNA Network

For OS/2 (or Windows NT) Node A, add the following entry to the HOSTS file:
172.16.5.6 CP1.NETA.SNA.IBM.COM

Follow these steps to establish communication between the Windows 95
workstation (Node B) and the VTAM host.

For Windows 95 Node B, do as follows:
1. Add the following entry to the local HOSTS file:

172.16.3.4 CP2.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click on the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.CP1

f. On the Configure AnyNet Connection window, enter:
v SNA domain name suffix: SNA.IBM.COM

v Fully qualified CP name: NETA.CP2

g. Save your workstation profile.

CP name: NETA.CP2
IP address: 172.16.3.4

IP
Network

Communications
Server

• SNA Gateway
• AnyNet SNA

over TCP/IP

Node A: OS/2 or Windows NT

CP name: NETA.CP1
IP address: 172.16.5.6

Personal
Communications

• AnyNet SNA
over TCP/IP

Node B: Windows 95

SNAVTAM

PLU

Figure 22. 3270 Emulation over a TCP/IP Network via a SNA Gateway to a VTAM Host on
an SNA Network
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Example 6. 3270 Emulation via an SNA Gateway over a TCP/IP
Network

Follow these steps to establish communication between the Windows 95
Workstation (Node C) and the VTAM host (Node A).

For VTAM Node A, add the following entry to the HOSTS file:
10.1.1.2 CP2.NETA.SNA.IBM.COM
10.1.1.2 DEPLU1.NETA.SNA.IBM.COM

For OS/2 (or Windows NT) Node B, add the following entry to the HOSTS file:
10.1.1.3 CP1.NETA.SNA.IBM.COM
10.1.1.1 CP3.NETA.SNA.IBM.COM

For Windows 95 Node C, do as follows:
1. Add the following entry to the local HOSTS file:

10.1.1.2 CP2.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.CP1

f. On the Configure AnyNet Connection window, enter:
v SNA domain name suffix: SNA.IBM.COM

v Fully qualified CP name: NETA.CP2

g. Save your workstation profile.

CP name: NETA.CP2
IP address: 10.1.1.2

IP
Network

Communications
Server

• SNA Gateway
• DLUR
• AnyNet SNA

over TCP/IP

Node B: OS/2 or Windows NT

CP name: NETA.CP1
IP address: 10.1.1.3
Dependent LU name: NETA.DEPLU1

Personal
Communications

• AnyNet SNA
over TCP/IP

Node C: Windows 95

CP name: NETA.CP3
IP address: 10.1.1.1

VTAM

• AnyNet SNA
over TCP/IP

• DLUS

Node A: VTAM

Figure 23. 3270 Emulation via an SNA Gateway over a TCP/IP Network
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Example 7. 3270 Emulation over a TCP/IP Network via an
AnyNet SNA/IP Gateway to a VTAM Host on an APPN Network

Follow these steps to establish communication between the OS/2 (or Windows NT)
workstation (Node B) and the Windows 95 workstation (Node C).

For OS/2 (or Windows NT) Node B, add the following entries to the HOSTS file:
192.168.1.2 CP2.NETA.SNA.IBM.COM
127.0.0.2 DEPLU1.NETA.SNA.IBM.COM
192.168.1.2 DEPLU1.NETA.SNA.IBM.COM

For Windows 95 Node C, do as follows:
1. Add the following entry to the local HOSTS file:

192.168.1.1 CP1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.CP2

f. On the Configure DLUR window, enter:
v DLUS name: NETA.CP1

v Routing Preference: Nonnative only
g. On the Configure AnyNet Connection window, enter:

SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

IP address: 192.168.1.1

IP
Network

Communications
Server

• AnyNet SNA
over TCP/IP
Gateway

Node B: OS/2 or Windows NT

CP name: NETA.CP2
IP address: 192.168.1.2
Dependent LU name:

NETA.DEPLU1

Personal
Communications

• AnyNet SNA
over TCP/IP

• DLUR

Node C: Windows 95

CP name: NETA.CP1

VTAM

• DLUS

Node A: VTAM

SNA
(APPN)

PLU

Figure 24. 3270 Emulation over a TCP/IP Network via an AnyNet SNA/IP Gateway to a
VTAM Host on an APPN Network
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Example 8. 3270 Emulation from a Windows NT Workstation
and a Windows 95 Workstation on Different IP Networks

Follow these steps to establish communication from the Windows NT workstation
(Node A), and from Windows 95 (Node D), to the VTAM Host (Node E).

For Windows NT Node A, do as follows:
1. Add the following entries to the local HOSTS file:

10.2.4.8 CP5.NETB.SNA.IBM.COM
127.0.0.4 IPNET1.GWCNET
127.0.0.3 IPNET1.CP1

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click on the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

PLU
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IP address: 10.2.4.8
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Figure 25. 3270 Emulation on Different IP Networks
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c. Click on Configure.
d. Click on Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETA.CP1

f. On the Configure DLUR window, enter:
v DLUS name: NETB.CP5

v Routing Preference: Non-native only
g. On the Configure AnyNet Connection window, enter:

SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

For OS/2 (or Windows NT) Node B, add the following entries to the HOSTS file:
10.2.4.6 CP1.NETA.SNA.IBM.COM
127.0.0.2 DEPLU1.NETA.SNA.IBM.COM
10.2.4.6 DEPLU1.NETA.SNA.IBM.COM
127.0.0.4 IPNET1.GWCNET
127.0.0.3 IPNET1.CP1

For OS/2 (or Windows NT) Node C, add the following entries to the HOSTS file:
172.20.1.2 CP4.NETC.SNA.IBM.COM
127.0.0.2 DEPLU2.NETC.SNA.IBM.COM
172.20.1.2 DEPLU2.NETC.SNA.IBM.COM
127.0.0.4 IPNET2.GWCNET
127.0.0.3 IPNET2.CP2

For Windows 95 Node D, do as follows:
1. Add the following entry to the local HOSTS file:

172.20.1.1 CP5.NETB.SNA.IBM.COM
127.0.0.4 IPNET2.GWCNET
127.0.0.3 IPNET2.CP2

2. Create a workstation profile using the Personal Communications configuration
tool:
a. Click the Start/Configure Session icon; or click Configure from the

Communication menu. The Customize Communication window is
displayed.

b. Select the following options:
v Host: zSeries

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click Configure.
d. Click Configure Link.
e. On the Configure Local System window, enter:

PC Location Name: NETC.CP4

f. On the Configure DLUR window, enter:
v DLUS name: NETB.CP5

v Routing Preference: Nonnative only
g. On the Configure AnyNet Connection window, enter:

SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.
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Chapter 13. SNA Node Operations

SNA Node Operations enable you to display information and manage the node for
certain Personal Communications resources, which can be useful when operating
the SNA node. The following tasks are supported:
v Starting and stopping resources
v Deleting resources
v Displaying resource information
v Changing session limits
v Initiating path switches

The configuration information for an SNA Node is stored in an ASCII file, with the
extension .ACG. You can edit the file by launching SNA Node Configuration. To
ensure that your new configuration is correct, use the Verification tool.

You can display information or take action on resources if you start 3270, 5250, or
any client/server sessions with one of the following attachment types:

zSeries Connections
LAN LAN via IEEE 802.2

3270 via iSeries
APPC 3270 via LAN
Dependent Logical Unit Requester (DLUR)
3174 Peer Communication

COM port
SNA-over-Async
IBM Global network — SNA-over-Async
Dependent Logical Unit Requester (DLUR) via:

SNA-over-Async

Hayes AutoSync
APPC 3270 via:

SNA-over-Async

Hayes AutoSync

X.25 Hayes AutoSync

X.25 DLUR via Hayes AutoSync

X.25 APPC 3270 via Hayes AutoSync
5250 3270 via iSeries

Dependent Logical Unit Requester (DLUR)
SDLC Synchronous Data Link Control

3270 via iSeries (passthru)
APPC 3270 via SDLC
Dependent Logical Unit Requester (DLUR)

SNA/IP
LU 0, 1, 2, 3
APPC 3270
LU 0, 1, 2, 3 via DLUR

IBM ISA/MCA WAC
Synchronous Data Link Control
3270 via iSeries (passthru)
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APPC 3270 via SDLC
Dependent Logical Unit Requester
X.25 Qualified Logical Link Control
X.25 3270 via iSeries
APPC 3270 via X.25
X.25 DLUR

IBM-EEDLC
LU (0, 1, 2, 3) via DLUR)
APPC 3270

OEM LU (0, 1, 2, 3)
3270 via iSeries (passthru)
APPC 3270
Dependent Logical Unit Requester (DLUR)

iSeries Connections
LAN LAN via IEEE 802.2
5250 Twinaxial Data Link Control (APPC)
COM port

SNA-over-Async
Hayes AutoSync
X.25 Hayes AutoSync

SDLC Synchronous Data Link Control
SNA/IP

5250
IBM ISA/MCA WAC

Synchronous Data Link Control (WAC)
X.25 Qualified Logical Link Control

IBM-EEDLC
5250

OEM APPC 5250

Client/Server Connections
LAN LAN via IEEE 802.2
Twinaxial

Twinaxial Data Link Control (APPC)
COM port

SNA-over-Async
Hayes AutoSync
X.25

SDLC Synchronous Data Link Control
IBM WAC

Synchronous Data Link Control
X.25

AnyNet SNA over TCP/IP
APPC

Enterprise Extender
HPR over IP

SNA resources that can be displayed or managed include the following:

Connection Networks
Allows APPN nodes in a LAN to have direct links with each other without
requiring logical link definitions at each node.

Connections
Link stations to the adjacent nodes.

SNA Node Operations
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CPI-C Side Information
Associate a set of parameters with a specified symbolic destination name.

Data Link Controls
How data is formatted for transmission on the physical connection.

Devices
Parts of the workstation hardware, such as adapters, that are used to
transmit and receive data.

DLUR PUs
A dependent logical unit requester (DLUR) physical unit (PU) is a PU in
an APPN end node that owns dependent LUs, but requests that a
dependent LU server provide the SSCP services for those dependent LUs.

Focal Points
A system that provides centralized network management services.

Local LU 0 to 3
A local logical unit (LU) type 0, 1, 2, or 3 is a dependent LU on the
workstation that provides services for 3270 terminal and printer emulation
applications.

Local LU 6.2
A local logical unit (LU) type 6.2 is an independent or dependent LU that
provides APPC services.

LU 6.2 Sessions
Transports data between two partner LU 6.2s. Conversations between
transaction programs use LU 6.2 sessions.

Mode The name used by the initiator of a session to designate the characteristics
desired for the session, such as traffic pacing values, message-length limits,
sync point and cryptography options, and the class of service (COS) within
the transport network.

Node The control point that manages the node and its associated resources. The
local node provides APPN services.

Partner LU 6.2
A remote computer that communicates through an APPC session with local
LU 6.2s.

RTP Connections
In high-performance routing (HPR), a rapid transport protocol (RTP)
connection is the connection established between the endpoints of the route
to transport session traffic.

Transaction Programs
A transaction program (TP) is a program that processes transactions in an
SNA network. There are two kinds of TPs: application transaction
programs and service transaction programs.

Starting Node Operations
To start Node Operations, click the SNA Node Operations icon in the Personal
Communications folder; or, from an active session window, click Actions → Launch
→ SNA Node Operations.

Using the Menu Bar
From the menu bar of the SNA Node Operations utility, click one of the following:

SNA Node Operations
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Operations
To start or stop a SNA node.

To start a node, select the configuration file you want to use.

To change session limits (CNOS).

To apply a new configuration file, select the configuration file you want to
use.

Launch
To launch to other Personal Communications programs, such as Log
Viewer, Trace Facility, or SNA Node Configuration.

View To modify the layout of your Personal Communications window (Tool bar
or Status bar).

To select resource attributes, which allows you to customize the display of
SNA resource attributes.

To view frequently used resources, such as:
v Node
v Connections
v Local LU 0 to 3
v Partner LUs
v LU 6.2 sessions

Window
To modify the layout of your Personal Communications window.

Help To view the Personal Communications online help.

Displaying a Resource
To display a resource, select a resource from the pull-down list on the toolbar.

Starting a Resource
To start a resource:
1. Select a resource from the pull-down list on the toolbar.
2. Select the first column of the item, and right mouse click to display the pop-up

menu.
3. Click Start to start the resource. A started (active) resource can be stopped, but

not deleted.

Stopping a Resource
There are two ways of stopping a resource:

Normal Stop
Performs clean up and then stops the resource.

Abnormal Stop
Immediately stops the resource.

To stop a resource:
1. Select a resource from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select Normal Stop or Abnormal Stop to suspend the resource. If a resource is

stopped (inactive), it can be deleted or redefined.

SNA Node Operations
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Deleting a Resource
To delete a resource:
1. Select a resource from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select Delete to delete the resource.

You should stop a resource (make it inactive) before redefining it. You do not need
to delete the resource before redefining it.

Changing an HPR Path Switch
To perform a high performance routing (HPR) path switch:
1. Select RTP connections from the pull-down list on the tool bar.
2. Select the first column of the item, and right mouse click to display the pop-up.
3. Select HPR path switch to change the path for the data on this RTP connection.

Updating SNA Resources Dynamically
It is not necessary to delete an SNA resource before redefining it. A resource must
be inactive, however, when you redefine it.

If a redefinition is rejected for a reason other than that the resource is active, a
STATE_CHECK return code is returned as well as a specific secondary return code,
as listed in the NOF specification. Most rejections are due to inconsistencies in the
configuration, such as one of the following:
v Attempting to define an LS with the adjacent CP name set to the local CP name.
v Attempting to define two link stations on a non-switched port with the same

destination address.

Such rejections occur regardless of whether you are defining a resource for the first
time or redefining it.

Keep in mind the following when redefining resources:
v You cannot change the ls_role of a port that has link stations defined on it. The

link stations must be deleted before the port role can be changed (because an LS
may default to the port ls_role).

v You cannot change the type of a named DLC. The DLC definition must be
deleted before the same name can be reused for a DLC of a different type.

Command-Line Utilities
Another way to perform SNA Node operations is to use the command line. Five
command line programs are available to perform basic operations for the SNA
Node.

CSSTART [ -a | -d | -m | -h ] [ -p | -q ] [ cfgfile ]

Use the CSSTART command to start the SNA Node with a specified
configuration. The -a flag enables automatic start up after rebooting the
machine. The -d flag sets the default SNA node configuration file. The -m
flag stands for manual start which disables automatic start up after
rebooting the machine. If the -p flag is used, all messages are shown in a
message box pop-up. Messages are written to stdout by default. The -q flag

SNA Node Operations
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suppresses all output. The -h flag summons the help data for this
command. The cfgfile parameter is the name of the configuration file you
want to use to start the product. If no cfgfile parameter is specified, the
default configuration file is used. If no default configuration file has been
set, an error is reported. If the node is successfully started, CSSTART
returns zero, otherwise a nonzero value is returned.

CSSTOP [ -p | -q ][ -h ]

Use the CSSTOP command to stop the SNA Node. The flags have the same
meaning as for CSSTART. If the node is successfully stopped then CSSTOP
returns zero, otherwise a nonzero value is returned.

CSQUERY [ -p | -q ][-h ]

Use the CSQUERY command to query the status of the SNA Node. The
flags have the same meaning as for CSSTART. Along with the status, the
default and active configuration file names are shown. If the node is
running, then CSQUERY returns zero; otherwise a nonzero value is
returned.

CSDSPY {resource [object_id] [/D#]} | [ -h ]
Displays information about SNA node resources, where:

resource
One of the following:

AIL AnyNet IP to LU mapping

CNT Connection networks

CON Connections

CPS CPI-C side information

DLC Data link controls

DEV Devices

DPU DLUR PUs

FPT Focal Points

LU0 Local LU 0 to 3

L62 Local LU 6.2

L6S LU 6.2 sessions

MOD Modes

NOD Nodes

PLU Partner LU 6.2

RTP RTP connections

TRP Transaction programs

object_id
Specifies a case-sensitive value (for example, LU001 or LINK001) to
search for. Only objects whose first attribute matches this value are
displayed. The object_id must be spelled correctly, including case
(upper and lower). An incorrect object_id will result in nothing
being displayed.
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/D# Specifies the level of detail to display. # has the value 1, 2, or 3,
where 1 displays the least level of detail and 3 shows all
information. 2 is the default.

CSMODIFY {resource object_id action} | [ -h ]
Enables you to control SNA node resources, where:

resource
Is one of the following:

CON Connections. You can start, stop, or delete this resource.

CPS CPI-C side information. You can delete this resource.

DLC Data link controls. You can start, stop, or delete this
resource.

DEV Devices. You can start, stop, or delete this resource.

DPU DLUR DPUs. You can start or stop this resource.

LU0 Local LU 0 to 3. You can delete this resource unless the LU
is in use.

L62 Local LU 6.2. You can delete this resource.

RTP RTP connections. You can switch the path of this resource.

object_id
Specifies a case-sensitive value (for example, LU001 or LINK001) to
search for. Only objects whose first attribute matches this value are
displayed. The object id must be spelled correctly, including case
(upper and lower). An incorrect object id will result in an error
being displayed.

action One of the following:

SN Normal stop

SI Immediate stop

ST Start

DL Delete

PS Path switch

[-h] This switch is used to summon help data for this command.
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Chapter 14. SNA Cryptography Support

SNA session-level encryption (SLE) enables secure data transfer between nodes
running SNA applications. The request units (RUs) for all the SNA traffic across
the selected session are encrypted. Software encryption/decryption is implemented
with the Application Manager for Data Security (AMDSEC) utility. AMDSEC is a
software implementation of the Common Cryptographic Architecture verbs used
by SNA Session Level Encryption (SLE). A subset of these verbs are implemented
and they are the ones required to allow data confidentiality.

Because this is a complete software implementation, it will be slower than the
conventional hardware-based encryption. SNA SLE is only supported for Windows
NT, 2000, and XP platforms. Some of the supported environments are as follows:
v 3270 emulation
v APPC/CPI-C client-server applications
v APPC over TCP/IP
v Sockets over SNA: Encrypted transport sessions

The key-encrypting keys can be added or accessed using the command-line utility
amdsec.exe, which is available in the Personal Communications installation
directory.

Enabling and Using Session-Level Encryption

Configuring Proper Key-Encrypting Keys
Enter the key-encrypting keys before performing any operation. KEKs are shared
between the LUs that are going to be involved. KEKs reside in key storage (.kek
file) and are used to protect data (session) keys when they are sent to the partner
node or Logical Unit (LU).

The following commands are available to add or modify these keys:

amdsec clear
This command clears the AMDSEC key storage. All key-encrypting keys
are discarded.

amdsec pass <new passphrase>
This command sets the AMDSEC passphrase. Using this passphrase, the
key-encrypting keys are secured before they go to the storage file (by
encryption). The default passphrase is amdsec security

amdsec addkey <label> <key value> <key form> <option>
amdsec adds a key-encrypted key to key storage.
v <label> is the key label for this KEK (up to 5 key label tokens of 8 bytes

each). See “Naming Labels for KEKs” on page 144 for further details.
v <key value> is the KEK value. It must be 16 bytes in hexadecimal (32

hex digits), optionally separated by the - (hyphen) character.
v <key form> is the value importer or exporter.
v <option> is the value translate. Specify this option to have the translate

attribute for this key.
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This parameter is optional. Data key translate is required only when you
are running APPN encryption.

Example:
amdsec addkey cm@lu@im.netid.cpnam1.netid.lunam2

8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f importer

amdsec addkey cm@lu@ex.netid.cpnam2.netid.lunam1
8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f exporter

When entering KEKs, it is often easier to edit the commands in a batch
(.bat) file and then execute the command to enter your keys in key storage.

amdsec repkey <label> <key value> <key form> <option>
amdsec replaces a key-encrypted key in key storage.
v <label> is the key label for this KEK (up to 5 key label tokens of 8 bytes

each). See “Naming Labels for KEKs” for further details.
v <key value> is the KEK value. It must be 16 bytes in hexadecimal (32

hex digits), optionally separated by the - (hyphen) character.
v <key form> is the value importer or exporter.
v <option> is the value translate. Specify this option to have the translate

attribute for this key.
This parameter is optional. Data key translate is required only when you
are running APPN encryption.

Example:
amdsec repkey cm@lu@im.netid.cpnam1.netid.lunam2

8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f importer

amdsec repkey cm@lu@ex.netid.cpnam2.netid.lunam1
8182-d4e7-836a-4d6f-8182-d4e7-830a-4d6f exporter

amdsec list
amdsec lists your KEK labels in key storage.

Example:
amdsec list

Naming Labels for KEKs

Key Labels for Dependent LU Encryption
The key label when implementing session level encryption for dependent LU
sessions uses the the following naming convention:
CM@LU@IM.mynet1.cpnamea.puname.locaddr

v CM is a constant prefix
v @ is a constant delimiter
v LU identifies an LU key-encrypting key
v IM identifies an importer key-encrypting key
v netid1.cpname1 is the fully qualified name of the local node where the

key-encrypting key will be used
v puname is the PU name of the subarea or DLUR PU, as configured in

Communications Server
v locaddr is the network addressable unit address or local address of the

dependent LU. It has to be of the form nnn with possible values from 1 to 255
(for example, 001, 002, 003, . . ., 255)
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Note: For encryption of dependent LU sessions you only need importer KEKs in
the Communications Server node, because LUA sessions are always
secondary.

Key Labels for APPC Encryption
The following key labels are used for the key-encrypting keys:
CM@LU@IM.netid1.cpname1.netid.luname

CM@LU@EX.netid1.cpname1.netid.luname

v CM is a constant prefix
v @ is a constant delimiter
v LU identifies an LU key-encrypting key
v IM identifies an importer key-encrypting key
v EX identifies an exporter key-encrypting key
v netid1.cpname1 is the fully qualified name of the local node where the

key-encrypting key will be used
v netid.luname is the fully qualified name of the partner LU

Note: In APPC, an independent LU can initiate a session (primary LU) or it can be
secondary when the partner LU initiates the LU 6.2 session. If the LU
initiates a session, an exporter KEK is required in key storage. Otherwise, an
importer KEK will be used.

Enabling Cryptography in SNA Node Configuration
Open the SNA Node Configuration utility (pcscfg.exe). In the Connection
Configuration section of the LU you are planning to use, select the Use
Cryptography option.

Note: For LU 6.2, a mode has to be defined with Use Cryptography enabled in the
Configure Modes → Advanced panel. That mode has to be used while
connecting to the peer LU
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Part 4. National Language Support
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Chapter 15. Multiple-Language Support

Personal Communications multiple-language support provides the capability to
allow users to interact with more than a single language on their workstations.
Prior versions allowed for different languages to be displayed in emulator sessions;
now, the Windows graphical user interface elements of the Personal
Communications user interface can be tailored to the languages of users, allowing
more flexibility in configuring and using Personal Communications.

This chapter provides a basic description of these facilities. Refer to Quick
Beginnings for a description of the procedures for changing your configured user
interface language. The particulars of installing the support are described in the
CD-ROM Guide to Installation.

Overview
There are two system-related factors which govern the usage of multiple languages
by Personal Communications users:

System Locale
This is set in the Windows Regional Settings (Regional Options in
Windows 2000 and Regional and Language Options in Windows XP)
control panel applet; it determines what system user interface languages
can be viewed.

Language Groups
Each system locale is associated with a language group; some groups have
only one language; others support several, allowing for simultaneous
viewing of applications in more than one language.

System Locale
When you choose a language on the Regional Settings (or Options) screen, a
system locale is established as the basis for interacting with the system; Windows
interactions of certain applications (such as Personal Communications) are
governed by this setting.

In Windows 2000, you can change the system locale in the Regional Options →
General → Set Default... → Select System Locale dialog. For Windows XP, Personal
Communications uses the settings specified in Regional and Language →
Advanced → Language for non-Unicode programs.

Notes:

1. Windows common dialogs, such as file open and print, may not change to
match the system locale; they will be displayed in the language chosen when
Windows was installed.

2. The actions needed to switch system locales depend on the languages installed
and the version of Windows. Refer to your Windows documentation for details.

Language Groups
The system locale set when Windows is started determines which Windows/ANSI
code page is used by applications; in turn, this code page determines which
language group an application can use. The language groups and languages
supported for Personal Communications user interface are:
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Cyrillic
Russian

Japanese
Japanese

Latin 1

v Brazilian-Portuguese
v Danish
v Dutch
v English
v Finnish
v French
v German
v Italian
v Norwegian
v Portuguese
v Spanish
v Swedish

Latin 2

v Czech
v Hungarian
v Polish
v Slovenian

Turkish
Turkish

Notes:

1. For Windows XP, most language groups are installed by default. You can
specify supplemental language support.

2. English text can be displayed for any system locale without significant
corruption. Therefore, English is an implicit member of each language group.

3. There are additional languages supported for host emulation sessions; these
groups only concern user interface language.

Personal Communications User Interface Languages
It is important to understand how Personal Communications uses the capability
for supporting multiple languages. Like other applications, Personal
Communications can use any language within the language group for which the
current system locale is set. As an administrator, you have the ability to change
that locale, using the Windows Regional Settings control panel applet.

There are several considerations to keep in mind:
v There is a default Personal Communications user interface language; this is set

at installation, and applies to every user of the Windows system.

Note: This default is set to match the Windows user default locale.
v The Personal Communications user interface language is a preference that is

stored per user; thus, a shared workstation can support users of different
languages.
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v If a user does not have a user interface language preference defined, Personal
Communications uses the Personal Communications default language for that
machine.

v If the user’s language preference cannot be displayed (because of a language
group mismatch) the user interface is in the Personal Communications default
language; a warning is displayed.

v If the Personal Communications default language is incompatible with the
system language, English is used as the default.

v Each user in a client/server or Windows Terminal Server (WTS) environments
can have his own Personal Communications user interface language.

Multiple Sessions
It is possible to open multiple Personal Communications emulation sessions
simultaneously; in previous versions of Personal Communications these sessions
could interact with hosts of different languages.

With Version 5.7 it is also possible to have simultaneous sessions with different
user interface languages; this is only possible for languages within a language
group. In order to do this, you start a session in one language, then change the
Personal Communications configuration to another language; when you then start
a new session, it will use the newly selected language.

Other Considerations
To prevent the generation of log files in several languages the Personal
Communications log file is recorded in the default Personal Communications user
interface language.

Some of the Personal Communications components (such as LLC2 drivers) do not
require multiple-language support; they only use the default Personal
Communications language.

Some Personal Communications components (the keyboard customizer, keypad,
play/record, copy/paste and macro components, for example) record, store, and
insert language-sensitive text into Personal Communications sessions. It should be
noted that text created in one language group may be corrupted and meaningless
when inserted in a session running under another language group. For instance,
keyboard customizer text created on a Japanese Personal Communications
configuration will not be readable on a French configuration.
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Chapter 16. Country Codes and Character Sets

This chapter contains information useful in providing national language support
for a network station or a gateway.

Table 4. Supported Keyboard Types

Keyboard Type
(Characteristics) Figure

Space Saving (single row of
function keys; no numeric
keypad)

Enhanced and Microsoft
Natural (single row of
function keys; numeric
keyboard)

5576-001 (Japanese keyboard
with double row of function
keys; numeric keypad)

5576-002 (Japanese keyboard
with single row of function
keys; numeric keypad)

5576-003 (Japanese keyboard
with single row of function
keys; no numeric keypad)

5576-A01 (Japanese keyboard
with single row of function
keys; numeric keypad)
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Keyboard Country ID and Shift Support
Table 5 shows the keyboard country ID and shift support for each country.

Table 5. Keyboard Country ID and Shift Support

Keyboard
Country Enhanced Keyboard ID

Enhanced
Keyboard-Lock
Mode

Arabic-speaking 238, 239, 240, 253, 254 C

Austria 129 S

Baltic
Estonia
Latvia
Lithuania

442
463
449

C
C
C

Belgium 120 S

Brazil 275 C

Canada (Bilingual) 058 C

Canada (445) 445 C

Cyrillic
Bulgaria
Belarus
FYR Macedonia
Russia (441)
Russia (443)
Serbia / Montenegro
Ukraine

442
463
449
441
443
450
465

C
C
C
C
C
C
C

Denmark 159 C

Finland 153 C

France (120) 120 C

France (189) 189 S

Germany 129 S

Greece 319 C

Iceland 197 C

Israel 115 C

Italy (141) 141 C

Italy (142/293) 142 C

Japan – C

Laos 466 C

Latin America (Spanish) 171 C

Latin 1 (Open Systems) 1047 697

154 Personal Communications Administrator’s Guide and Reference



Table 5. Keyboard Country ID and Shift Support (continued)

Keyboard
Country Enhanced Keyboard ID

Enhanced
Keyboard-Lock
Mode

Latin 2
Bosnia / Herzegovina (Latin)
Croatia
Czech Republic
Hungary
Poland

Romania (Moldavia)
Slovakia
Slovenia

234
234
243
208

457, 214
446
245
234

C
C
C
C
C
C
C
C
C

Netherlands 143 C

Norway 155 C

Portugal 163 C

Spain 173 C

Sweden 153 C

Switzerland (French) 150F C

Switzerland (German) 150G C

Turkey (179/402) 179 C

Turkey (440) 440 C

U.K. (166) 166 C

U.K. (168) 168 C

U.S. (English) 101G C

Vietnam 461 C

Note:
– Not selectable
S Shift lock on key 30
C Caps lock on key 30
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IBM Japanese Character Set (2-Byte Codes)
The IBM Japanese character set defines characters that consist of 2-byte codes.

Character Types
The following characters are included in this character set:
v Basic kanji set
v Basic non-kanji set: alphabet, numerals, Katakana, Hiragana, symbols, and space
v Extended kanji set
v New extended kanji set
v New extended non-kanji set
v Extended non-kanji set: Roman numerals, Greek alphabet, and Russian alphabet

In addition to these characters, you can define up to 1880 (6205 for extended
Unicode subset) user-defined characters.

Character Size
A kanji character is displayed on the screen using the area of two SBCS characters;
it is usually enclosed with the shift characters hex 0E and hex 0F. Similarly, when a
kanji character is printed, it uses the area of two SBCS printed characters. This size
is equivalent to double the area used by alphabetic, numeric, and Katakana
characters when they are displayed or printed.

IBM Kanji Codes
The following tables show the relationship between kanji and IBM kanji codes.

Table 6. IBM Japanese Character Set and IBM Kanji Codes

1st byte (hex) 2nd byte (hex)

40 41... ...FE

40 space Reserved area

41 Extended non-kanji set 134 characters

42...
44

Basic kanji set (includes
space)

416 characters

45...
55

Basic kanji set 3226 characters

56...
68

Extended kanji set 3487 characters

69...
7F

User-defined characters 1880 characters

80...
FE

Reserved area
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Table 7. IBM Japanese Character Set and IBM Kanji Codes (Extended for Unicode Subset)

1st byte (hex) 2nd byte (hex)

40 41... ...FE

40 space Reserved area

41 Extended non-kanji set 134 characters

42...
44

Basic kanji set (includes
space)

416 characters

45...
55

Basic kanji set 3226 characters

56...
68

Extended kanji set 3478 characters

69...
B7

User-defined characters 6205 characters

B8...
A5

New extended kanji set 5522 characters

A6...
E9

New extended non-kanji set 2035 characters

EA...
FE

Reserved area

Note: These tables do not show that all characters have a kanji code assigned.
Each kanji character has a kanji number is addition to the IBM kanji code A
kanji number is a decimal number up to five digits in length, which is used
for entering a kanji-like symbol from keyboards that do not have “YOMI”.

Following is the relationship between IBM kanji codes and kanji numbers:
kanji number = converted value of ((IBM kanji code) - x’4000’)

All kanji characters can be entered using kanji numbers.

IBM Traditional Chinese Character Set
Table 8. IBM Traditional Chinese Host Code

Number of
Characters Code Range Low-Byte Range

DBCS Space 1 X'4040'

DBCS Symbols 1003 X'4141' - X'4959' X'41' - X'FD',
skipping X'7F'

Primary Chinese 5402 X'4C41' - X'68CB' X'41' - X'FD',
skipping X'7F'
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Table 8. IBM Traditional Chinese Host Code (continued)

Number of
Characters Code Range Low-Byte Range

Secondary Chinese 7654 X'6941' - X'91C7' X'41' - X'FD',
skipping X'7F'

User-Defined Area 6204 X'C241' - X'E2FD' X'41' - X'FD',
skipping X'7F'

IBM Simplified Chinese Character Set, GBK Code
Table 9. IBM Simplified Chinese Character Set, GBK Code

Number of
Characters Host Code Range PC Code Range

DBCS Space 1 X'4040' X'A1A1'

GB 2312-80
Non-Chinese Character
Set

(GBK/1)

X'4141'-X'47FE' (737) X'A1A1'-X'A9FE'
(846)

GB 2312-80 Chinese
Character Set

(GBK/2)

X'4841'-X'6CFE'
(6763)

X'B0A1'-X'F7FE'
(6768)

ISO 10646-1 CJK unified
ideographs

(GBK/3)

6080 X'8141'-X'A0FE',
X'A141'-X'A181'

X'8140'-X'A0FE'
(Note 1)

ISO 10646-1 CJK unified
ideographs ISO 10646-1
CJK compatibility

(GBK/4)

8160 X'A182'-X'A1FE',
X'A241'-X'CCFE',
X'CE41'-X'CEFE'

X'AA40'-X'FEA0'
(Note 1)

Big-5 Symbol
Compatibility
Ideographic Structure
Symbols

(GBK/5)

X'CD41'-X'CDFE'
(148)

X'A840'-X'A9A0'
(192) (Note 1)

User Definable
Characters Area

(UDC 1 to 3)

1894 X'7641'-X'80FE' X'AAA1'-X'AFFE',
X'F8A1'-X'FEFE',
X'A140'-X'A7A0'
(Note 1)

Note 1: X'7F' of second byte is excluded.

IBM Hangeul Character Set
Table 10. IBM Hangeul Host Code (833)

Number of
Characters Code Range Low-Byte Range

DBCS Space 1 X'4040'

DBCS Symbols 939 X'4141' - X'4BFD' X'41' - X'FD',
skipping X'7F'
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Table 10. IBM Hangeul Host Code (833) (continued)

Number of
Characters Code Range Low-Byte Range

Hanja Set 5265 X'5041' - X'6C45' X'41' - X'FD',
skipping X'7F'

Hangeul and Jamo
Set

2672 X'8441' - X'D3B7' X'41' - X'FD',
skipping X'7F'

User-Defined Area 1880 X'D441' - X'DDFD' X'41' - X'FD',
skipping X'7F'

Table 11. IBM Hangeul Host Code (1364)

Number of
Characters Code Range Low-Byte Range

DBCS Space 1 X'4040'

Non-Hangeul/Hanja
Set

1181 X'4141' - X'4E92' X'41' - X'FE'

Hanja Set 5265 X'5041' - X'6C45' X'41' - X'FE'

Hangeul and Jamo
Set

11224 X'8441' - X'D3BD' X'41' - X'FE'

User-Defined Area 1880 X'D441' - X'DDFD' X'41' - X'FE'

Thai Language Support

Thai Display Mode Selection
Select Appearance → Thai Compose Mode on emulator session.

Switching Keyboard between Thai and Latin
Press either Alt+left Shift or Alt+right Shift to toggle the keyboard between Thai
and Latin.

Language Shift Status
The status line of each emulator session shows a language shift indicator. If
keyboard is in Thai language shift, an indicator TH will appear in the status line.

Thai Display Composed Mode
Mode 1: Non-compose mode

No character composition occurs in this mode.

Mode 2: Composed mode
Thai characters are auto-composed in this mode. No column realignment is
performed.

Mode 3: Composed with space alignment
In this mode of composing, three consecutive spaces cause column
realignment. The realignment occurs whenever composing routine finds
three consecutive spaces. Thus if all fields have at least three trailing
spaces, then all fields of all records will be properly aligned.

Mode 4: Composed with EOF alignment
In this mode of composing, the EOF character (Hexadecimal ’EA’) also
causes column realignment. Whenever the composing routine finds a single
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EOF, it deletes the EOF and performs column realignment. If two
consecutive EOFs are found, no realignment occurs, one EOF is deleted,
and one EOF is treated as data.

Mode 5: Composed with space and EOF alignment
This mode of composing performs the column realignment function of
both mode 3 and mode 4.

Printer Space Adjustment
If your printer needs space adjustment for Thai printing, add the following
statement to PCSWIN.INI, which resides in the user-class application data
directory:
[Thai]
PrintAdjust=x

The value of x can be:

0 no adjustment (same as no PrintAdjust statement)

1 Perform adjustment when found three consecutive spaces

2 Perform adjustment when found EOF character

3 Perform adjustment when found three consecutive spaces or EOF character
(combine 1 and 2)

Thai Scalable (Truetype) Font Support on Printers
Personal Communications provides a Thai Truetype font, ThaiPhuket. To print Thai
characters, you can install a Thai scalable (Truetype) font as follows:
1. Open the Control Panel Folder.

a. Click Start on the task bar.
b. Move pointer to Settings and click Control Panel.

2. Open the Fonts Folder (Double-click the Fonts icon).
3. On the file menu, select Install New Font.
4. Click the drive and folder where Personal Communications is installed.
5. Double-click on ThaiPhuket.
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Chapter 17. Bidirectional Language Support (Arabic and
Hebrew)

Considerations for Printing
PDT printing mode requires the IBM 864 code page font to be installed for Arabic
printing, and the IBM Hebrew 862 code page font for Hebrew printing.

Printing in Arabic

Using the Windows Printer Driver
To set up your printer to use a Windows printer driver, do the following:
1. In the session window, click File → Printer Setup. The Printer Setup dialog lists

the supported printers.
2. Select the desired printer driver from the Printer list. The default value is the

Windows default printer.
3. Confirm that the Use PDT option is clear and click OK.

Page Setup: For 5250 printer sessions, click the Advanced Options tab in the
Page Setup dialog. Set the Printer Font Code Page to 1008.

For 3270 sessions, click the Text tab in the Page Setup dialog. Set the Font to
Typing Arabic.

Using Printer Definition Table (PDT) Files
To set up your printer to use a PDT file, do the following:
1. In the session window, click File → Printer Setup. The Printer Setup dialog lists

the supported printers.
2. Select the desired port from the Printer list.
3. Select the Use PDT box and click Select PDT.
4. Select a PDT file to be used and click OK.

Page Setup: For 5250 printer sessions, click the Advanced Options tab in the
Page Setup dialog. Set the Printer Font Code Page to 864.

Creating an Arabic PDT file for an Arabic printer: If none of the predefined
PDTs are acceptable, you can create a new one. To create a PDT, you must create a
printer definition file (PDF) and then compile it to create a PDT.

You should understand a PDF’s structure and the types of statements. See
Chapter 20, “Building a Printer Definition Table (PDT) for PC400”, on page 191 for
information about building a PDT.

To customize an existing PDF file for Arabic, do the following:
1. In the macro definition dialog, define a macro containing a printer command

that selects the Arabic printer font.
Define the escape sequences of the fonts that you want to use. For example,
/* Naseem ( 1 0 V ( s 0 p 1 5 h 9 v 0 s 0 b 3 T */
NSM EQU 1B 28 31 30 56 1B 28 73 30 70 31 35 68 39 76 30 73 30 62 33 54
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Note: You can get the font escape sequences by printing out the font names
from the printer menus.

2. Add this macro to the START_JOB escape sequence in the Control Code section
of the PDF. For example,
START_JOB=CUL CBP NSM /* Switch to Arabic Font */

3. Save your new PDF file and copy it to the pdfpdt directory in the Personal
Communications program directory.

4. In the Printer Setup → Select PDT file dialog, click Convert PDF.
5. Select the PDF file that you modified, and click Convert.
6. In the Select PDT file dialog, select the converted PDT file

Using Host Print Transform (5250 only)
When configuring an Arabic 5250 printer session, the Host Print Transform (HPT)
mode can be selected. This mode requires that the 864 font be installed on the
printer.

To use HPT, do the following:
1. Select Printer session type in the Session Parameters – 5250 Host panel. Click

the Advanced tab.
2. Select the Host Print Transform=Yes option.

In the iSeries screen, do the following:
1. Specify that Host Print Transform will be used in the device description of a

printer:
Host print transform . . . . . . TRANSFORM (*YES)

2. Specify your printer type and model:
Manufacturer type and model . . MFRTYPMDL (*___________)

3. Ensure that the character identifier parameter is capable of handling Arabic:
Character identifier: CHRID

Graphic character set . . . . 235
Code page . . . . . . . . . . . . 420

Page Setup: Click the Advanced Options tab in the Page Setup dialog. Set the
Printer Font Code Page to 864.

DAT File for 5250 Arabic
For Arabic 5250 print sessions, selecting the 420 host code page prompts Personal
Communications to load the PCSPDA.DAT file. This file ensures that the
host-specified fonts map properly to the Typing Arabic print font.

If the 037 (U.S.) host code page is selected in a Win32 OS session, the PCSPD.SAM
file is loaded automatically. This file replaces the Courier font with Courier New.
For 5250 sessions in OS/2, Personal Communications uses the original PCSPD.DAT
file, since Euro support is implemented in Courier in OS/2, not in Courier New (as
in Windows).

The user can specify the DAT file using the .ws parameter
DATFILE=xxxx

where xxxx is the name of the preferred DAT file.
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Bidirectional Arabic Support

Limitations
The Bidirectional Text Assist Function is not supported in the Personal
Communications iSeries component. As a result, the user cannot run Bidirectional
OfficeVision/400™.

Installation Tips
To set up an Arabic workstation, do the following:
1. Select 420 Arabic Speaking as the host code page in the Customize

Communication panel.
2. Select Arabic Speaking as the keyboard layout.
3. In the Select Display Font panel, choose ARB3270 at the Automatic Sizing list

box or at the Fixed size font selection.
4. In the API Settings panel, select 1256 as the DDE/EHLLAPI PC code page.
5. Choose Typing Arabic as the font in the Page Setup panel.

Note: For Personal Communications for Windows 95 you can also select
ARB3270 for printers with drivers that allow bitmap fonts. For example,
printing through PDT requires the IBM Arabic 864 font to be available
on the printer.

To set up for Numeric Swapping or Symmetric Swapping:
1. Select Display Setup from the Edit → Preferences → Appearance pull-down list.
2. Select Swapping from the list box at the left, where the settings for numerics

and symmetric characters is displayed. Changes are immediately reflected on
the active session.

Note: Numeric Swapping is a 3270-only feature. This function will not be
selectable if the session is an iSeries session.

The supported Arabic fonts are:
v ARB3270, which is found in the PCSANSIA.FON, or MFIANSIA.FON. To use

the MFIANSIA.FON:
1. Rename the file PCSANSIA.FON to PCSANSIA.ORG.
2. Copy MFIANSIA.FON to PCSANSIA.FON.

v Typing Arabic, which is found in the file TYPEARB.TTF.

The Arabic font files are located on the product CD-ROM in the FONT
subdirectory.

Bidirectional Keyboard Functions for 3270
The keys unique to Bidirectional 3270 are:
v Language selection: This function is activated by the key combination Alt+Shift

and allows you to change the language layer. If the language layer is Latin,
pressing the Alt+RightShift key combination changes the language layer to
Arabic. If the language layer is Arabic, pressing the Alt+LeftShift key
combination changes the language layer to Latin.

v Screen Reverse: This function is activated by the key combination Alt+NewLine
and reverses the screen image. If the screen orientation is left-to-right, pressing
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this key combination reverses the screen image right-to-left. If the screen
orientation is right-to-left, pressing this key combination reverses the screen
image to left-to-right.
Note that the operator information area is not reversed by this operation.
When the screen orientation is changed, the language layer is changed to the
default language of the new screen orientation. If the screen is reversed to
right-to-left, then the language is changed to Arabic. If the screen is reversed to
left-to-right, then the language is changed to one using Latin characters.
If the swapping of symmetric characters is enabled, the inversion of the screen
causes directional characters to be replaced by their counterparts.
If the swapping of numeric characters is enabled, the inversion of the screen
causes Hindi numerals to be replaced by their Arabic counterparts and the
Arabic numerals to be replaced by their Hindi counterparts.

v Field Reverse: This function is activated by the key combination Alt+NumLock
and toggles the field orientation to either opposite to or the same as the screen
orientation. The text in the field is not inverted. The cursor orientation is set
equal to the new field orientation and the language layer is selected accordingly.
If the cursor is in the first logical position of a field or line, when you select the
field reverse function, the cursor skips to the other side of that field or line,
which becomes the first logical position. If the cursor was not in the first
position of the field or line, when selecting the field reverse function, the cursor
remains in its position and allows natural and correct editing of existing text.

v Auto Field Reverse: This function is activated by the key combination
Alt+NumPad5, which toggles the auto field reverse mode for the current screen
orientation.
Auto field reverse affects the automatic selection of the field orientation of
unprotected fields:
– When auto field reverse is disabled, upon initial entry to a field (whether

numeric or alphanumeric), the field orientation is always set equal to the
screen orientation.

– When auto field reverse is enabled, upon initial entry to an alphanumeric
field, the field orientation will be set to right-to-left (for both left-to-right and
right-to-left screen orientations).

– When auto field reverse is enabled, upon initial entry to a numeric field, the
field orientation will be set to left-to-right (for both left-to-right and
right-to-left screen orientations).

v Push/End Push: This function is activated by the key combination
Shift+NumLock and allows the entering and editing of text whose direction is
opposite from the field direction. When this function is activated, the cursor
orientation is reversed, the language layer is changed accordingly, and a push
segment is created.
The PUSH function has two secondary modes:
– Boundary mode: This mode is activated upon entering push mode. In this

mode, the cursor remains in its position, and the typing of additional
characters pushes the text in the direction opposite from the field direction. To
indicate this boundary mode, the cursor has a block shape.

– Edit mode: This mode is activated when the cursor is moved from its
boundary position into the PUSH SEGMENT area. In this mode, you can edit
the text within the PUSH segment, while typing in the field’s natural
direction.
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END PUSH, activated by the Shift+NumLock key sequence, terminates the push
mode.

Note: In Windows mode, END PUSH is activated by the Shift+Numpad/ key
sequence.

The cursor jumps to the end of the PUSH segment, and its direction changes to
the original direction. You can also perform END PUSH by pressing any field
exit keys (for example, Cursor Up or Cursor Down) or an AID key (for example,
Enter)

v AutoPush: This function is activated by the key combination Alt+NumPad/ and
assists the terminal operator in typing mixed left-to-right and right-to-left text.
When enabled, reversed segments are automatically initiated and terminated,
according to the entered character or the selected language layer. This mode
relieves the operator from manually pressing Push, as it is automatically
invoked.
– In right-to-left fields, typing a digit or a Latin letter causes the automatic

initiation of Push, without language change. Further Latin letters or digits
will continue the push mode; any other character automatically terminates
push mode. This feature allows you to type Arabic text with imbedded
numbers or Latin words without using Push/End Push.

– In left-to-right fields, typing an Arabic character or special character causes
the automatic initiation of Push, without language change. Typing any digit
or Latin character causes the automatic termination of the mode. This allows
the user to type Latin text with imbedded Arabic words using language layer
selection rather than Push/End Push.

Arabic Character Shape Selection Functions
There are five shape selection keys: one for Contextual Shape Determination (CSD),
and 4 for Specific Shaping modes (Base/Isolated, Initial, Middle, Final). The default
Shaping Mode is CSD.

The keys unique to Bidirectional 3270 are:
v Contextual Shape Determination (CSD) key: Pressing this key sets the shaping

mode to Contextual Shape Determination (CSD), which is the default. Note that
contextual shape determination is performed only for right-to-left text entered or
modified by the operator. This key toggles between CSD and Base mode.
Pressing any of the Specific shape selection keys disables CSD.
The character Alef-Madda

in the operator information area indicates that CSD is selected.

This function is initiated by the key combination Alt+NumPad4.
v Specific Shape Selection keys:

– Base/Isolated: initiated by the key combination Alt+NumPad2
– Initial: initiated by the key combination Alt+NumPad1
– Final: initiated by the key combination Alt+NumPad7
– Middle: initiated by the key combination Alt+NumPad8

Pressing one of the above keys disables CSD, and sets shaping mode to the
selected value. Arabic letters typed from then on will have the selected shape.

Chapter 17. Bidirectional Language Support (Arabic and Hebrew) 165



Note: Some Arabic characters do not have middle, initial, or final shapes. In this
case, if the user enters one of those characters where the requested shape
does not exist, then the closest shape is selected according to the
following rules:
– Instead of initial, isolated is selected.
– Instead of final, isolated is selected.
– Instead of middle, final (if it exists) or isolated is selected.

The selected Shaping Mode is shown in the operator information area:
– Isolated GHEIN

indicates Base/Isolated Shaping Mode
– Initial GHEIN

indicates Initial Shaping Mode
– Middle GHEIN

indicates Middle Shaping Mode
– Final GHEIN

indicates Final Shaping Mode
v Field Shape key: Pressing the key combination Alt+NumPad+ causes the

shaping of the Arabic data present in the current field or line. The cursor
position remains unchanged.

v Field De-Shape key: The key combination Alt+NumPad Enter de-shapes the
Arabic data present in the current field or line. All Arabic letters are converted
to their Base/Isolated shapes.

Personal Communications iSeries
The keys unique to Bidirectional PC400 are:
v Language selection: This function is activated by the key combination Alt+Shift

and allows the changing of the language layer. If the language layer is Latin, by
pressing the Alt+RightShift key combination, the language layer will change to
Arabic. If the language layer is Arabic, by pressing the Alt+LeftShift key
combination, the language layer will change to Latin.

v Screen Reverse: This function is activated by the key combination Alt+NewLine
and reverses the screen image. If the screen orientation is left-to-right, by
pressing this key combination the screen image will be reversed to right-to-left.
If the screen orientation is right-to-left, pressing this key combination reverses
the screen image to left-to-right.
Note that the operator information area is not reversed by this operation.
When the screen orientation is changed, the language layer is changed to the
default language of the new screen orientation. If the screen is reversed to
right-to-left, the language is changed to Arabic. If the screen is reversed to
left-to-right, the language is changed to one using Latin characters.
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The inversion of the screen causes directional characters to be replaced by their
counterparts.

v Field Reverse: This function is activated by the key NumLock and toggles the
field orientation to either left-to-right or right-to-left. The text in the field is not
inverted. The cursor orientation is set equal to the new field orientation and the
language layer is selected accordingly.
If the cursor is in the first logical position of a field or line, when selecting field
reverse function, the cursor skips to the other side of that field or line, which
now becomes the first logical position. If the cursor was not in the first position
of the field or line, when selecting field reverse function, the cursor remains in
its position and allows natural and correct editing of existing text.

v Close: This function is activated by the key combination NumPad/ and is
provided so that the data entered in one keying direction can be concatenated
with the data that was previously entered in the opposite direction. It operates
as follows:
– All embedded nulls are removed from the current line.
– Concatenated text is moved to the right boundary of the field (if the field

direction is right-to-left) or to the left boundary (if the field direction is
left-to-right).

– The cursor direction is set to the field direction.
– The language layer is set to the default for the field direction.
– If the screen orientation is now left-to-right, the cursor is positioned at the

first null to the right of the concatenated text.
– If the screen orientation is now right-to-left, the cursor is positioned at the

first null to the left of the concatenated text.
v Base: This function is activated by the key combination Ctrl+Home; it is a toggle

key that activates or deactivates the Automatic Shape determination function for
Arabic RTL text. It is valid only when processing RTL Arabic text. If it is pressed
in an LTR field, an operator error 0027 results.

Bidirectional Hebrew Support
The Bidirectional Hebrew support in 3270 enables the program to emulate an
English/Hebrew 3270 display terminal. Special Language and Bidirectional
functions are added to the list of standard functions supported by the emulation
program.

Bidirectional Functions for 3270
Table 12. Bidirectional Key-Combinations for 3270

Function Combination

Hebrew Language Alt+RightShift

English Language Alt+LeftShift

Screen Reverse Alt+Enter

Field Reverse Alt+NumLock

Auto Field Reverse Alt+NumPad5

Push Shift+NumLock

End Push Shift+NumPad/

Autopush Alt+NumPad/
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The 3270 host system can run as a native Windows application. The layout and
user interface functions in the Windows-based product conform to the IBM user
interface standard (SAA/CUA®); they are similar to the layout and functions
implemented in other IBM products (for example, OS/2).
v Language Selection: The key combination Alt+Shift allows you to change the

language layer. If the language layer is Latin, pressing Alt+RightShift changes
the language layer to Hebrew. If the language layer is Hebrew, pressing
Alt+LeftShift changes the language layer to Latin.

v Screen Reverse: This function, activated by the Alt+Enter key sequence, reverses
the screen image. If the screen direction is left-to-right, the screen image is
inverted and displayed from right-to-left. Pressing this hotkey again returns the
screen to its original direction, left-to-right. When the screen orientation is
changed, the language layer is changed to the default language of the new
screen orientation. If the screen is changed to right-to-left, the language changes
to Hebrew. If the screen is changed to left-to-right, the language changes to
Latin.
Note that the status line (OIA) never reverses. It always displays from left to
right.

v Field Reverse: In most cases, the field direction is the same as the general screen
direction. However, sometimes it is necessary to have a field whose direction is
the opposite of the screen direction. The Field Reverse function, activated by the
Alt+NumLock key sequence, allows such transitions. When this function is
activated, the typing direction is reversed, but the existing text in the field and
the screen image does not change. This function creates a temporary change
which stays in effect as long as the cursor remains within the field, or until Field
Reverse is activated again.
If the function is activated while the cursor is at the beginning of a line or field,
the cursor jumps to the end of the line or field, so that the reversed field begins
logically from that position. Otherwise, the cursor remains in its position and
allows natural and correct editing of existing texts whose direction is the
opposite of the screen direction.

v Auto Field Reverse: This function sets the field orientation for you, when you
are entering data for mixed applications (Hebrew and English). This is done by
automatically activating the Field Reverse function. The Auto Field Reverse
mode is activated by the Alt+NumPad5 key sequence, and can be applied
independently for each screen orientation, left-to-right or right-to-left.
– If the Auto Field Reverse option is activated on a right-to-left screen, the Field

Reverse function is automatically activated every time the cursor moves to a
numeric field. The cursor then jumps to the leftmost position of the numeric
field, to allow left-to-right typing of numbers.

– If the Auto Field Reverse option is activated on a left-to-right screen, the Field
Reverse function is automatically activated only when the cursor moves to an
alphanumeric field. The cursor then jumps to the rightmost position of the
field, to allow right-to-left typing of Hebrew.

Initially, the Auto Field Reverse option is enabled when the screen direction is
right-to-left, and is not enabled when the screen direction is left-to-right. To
terminate the Auto Field Reverse mode, press Alt+NumPad5 again.

v Push and End Push: These functions allow you to type or edit text whose
direction is the opposite of the field direction. When this function is activated
the cursor orientation is reversed, the language layer is changed accordingly, and
a push segment is created.
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The Push function is activated by the Shift+NumLock key sequence. The Push
function has two secondary modes:
– Boundary Mode: This mode is activated upon entering the Push mode. In this

mode, the cursor remains in its position, and the typing of additional
characters pushes the text in the direction opposite to the field direction. To
indicate this boundary mode, the cursor shape is changed.

– Edit Mode: This mode is activated when the cursor is moved from its
boundary position into the Push Segment area. In this mode, you can change
the text within the Push segment, while typing in the text’s natural direction.

End Push, activated by the Shift+NumPad/ key sequence, terminates the
temporary mode. The cursor jumps to the end of the Push segment, and its
direction reverts to that of the field.

v Autopush: The Autopush mode makes work easier and more efficient when
typing Hebrew and English mixed text. When this mode is enabled, reverse
segments initiate and terminate automatically, according to the entered character
or the selected language layer. It relieves the operator from manually selecting
Push and End Push. Autopush is especially useful for typing digits in Hebrew
fields (right-to-left fields). The Autopush mode is activated by the Alt+NumPad/
key sequence; it can be applied independently to fields whose direction is
left-to-right or right-to-left. In this mode, the Push and End Push functions are
automatically activated according to the language of the text being typed. There
is no need to worry about activating and terminating the Push mode manually.
– In right-to-left fields, typing a digit or a Latin letter causes the automatic

initiation of Push, without language change. Additional Latin letters or digits
will continue the push mode; any other character automatically terminates
push mode. This feature allows you to type Hebrew text with imbedded
numbers or Latin words without using Push/End Push.

– In left-to-right fields, typing a Hebrew character causes the automatic
initiation of Push. Typing any digit or Latin character causes the automatic
termination of the mode. This allows the user to type Latin text with
imbedded Hebrew words by using language layer selection rather than
Push/End Push.

Keyboard Layout
Two Hebrew keyboard templates (Bulletin and Old Code) are supplied with the
product. The Old-Code template is similar to the Bulletin template, with the
following exceptions:
v Shift of ″6″ (s-6) produces the Greek Delta symbol (ASCII 235, hex EB),

representing the old Israeli Lira, instead of the regular Cent symbol.
v Shift of ″7″ (s-7) does not produce anything (the Ampersand symbol is not

available in Old Code).
v In English language mode, unshifted English letters produce uppercase letters

(A-Z), rather than lower case letters (a-z), whether Caps Lock is ON or OFF.

Configuration
To set up a Hebrew workstation, do the following:
1. Select 424 Hebrew (Bulletin Code) or 803 Hebrew (Old Code) as the host code

page in the Customize Communication panel.
2. Select Hebrew (Bulletin Code) or Hebrew (Old Code) as the keyboard layout.
3. Select Transfer from the Edit → Preferences pull-down menu.
4. From the General tab, select 862, 916, or 1255 from the PC Code-Page list.
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5. In the API Settings panel, select 862, 916, or 1255 as the DDE/EHLLAPI PC
code page.

6. In the Select Display Font panel, choose HEB3270 at the Automatic Sizing list
box or at the Fixed size font selection.

7. Select Page Setup from the File pull-down menu.
8. In the Text tab, choose (Courier Heb) printer font.

Font
If you are accustomed to a traditional Display Station such as IBM InfoWindow®

3472, you may not prefer the Personal Communications font. You can try an
alternative font by changing the font files as follows:
1. Rename PCSANSIH.FON file to BASANSIH.FON
2. Copy ALTANSIH.FON to PCSANSIH.FON

In order to use the ALTANSIH.FON file, you must order the needed diskette
separately.

File Transfer with 862 Code Page
PC code page 862 is the IBM number for the Hebrew code page. Microsoft
Windows (Hebrew) uses a code page based on (but not identical to) the ISO code
page, and quite different from code page 862.

Apart from the differences in code points, Microsoft Windows for Hebrew works
with logical text. This means that Windows applications are expected to store text
in logical order (that is, the same order as typed but not as displayed).
Accordingly, the text that is displayed on the screen is different from the text that
is processed by the application.

Therefore, when transferring files with translation to and from code page 862, there
may be unexpected results (such as a different order of Hebrew text), in some
cases. To overcome such problems, it is recommended after conversion of EBCDIC
text to code page 862 to consider using the CONVERT program, provided as part
of Microsoft Windows, which is capable of converting between logical text and
visual text.

Bidirectional Functions for 5250
Table 13. Bidirectional Key-Combinations for 5250

Function Combination

Hebrew Language Alt+RightShift

English Language Alt+LeftShift

Reverse NumLock

Close NumPad/

Screen Reverse Alt+Enter

v Hebrew Language: same meaning as in “Bidirectional Functions for 3270” on
page 167

v English Language: same meaning as in “Bidirectional Functions for 3270” on
page 167

v Reverse: Pressing this key allows the operator to reverse the current cursor
direction. It functions as follows:
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– The cursor is repositioned according to the current cursor direction. When
right-to-left, the cursor is placed at the current left boundary location. When
left-to-right, the cursor is placed at the current right boundary location.

– The cursor direction is then reversed; the Keyboard Layer you get depends on
the new cursor direction.

– Insert mode is reset.
v Close: By pressing this key, data entered in one key direction is joined with data

that was previously entered in the opposite direction:
– All embedded null characters are removed from the current line (or field, if

the field is contained on one line).
– Joined text is moved to the right boundary of the field if the field direction is

right-to-left, or to the left boundary if the field direction is left-to-right.
– The remainder of the line (or the field, if contained on one line) is padded

with null characters.
– The cursor direction is set to the field direction.
– If the cursor direction is now left-to-right, the cursor is positioned at the first

null character to the right of the joined text. If the cursor direction is now
right-to-left, the cursor is positioned at the first null character to the left of the
joined text.

– Insert mode is reset.
v Screen Reverse: same meaning as in “Bidirectional Functions for 3270” on

page 167

Bidirectional Support for VT
The bidirectional support in VT enables the program to emulate English/Arabic or
English/Hebrew VT 340 7-bit, VT 340 8-bit, VT 100, VT 52, and VT ANSI display
terminals. Special language and bidirectional functions are added to the list of
standard functions supported by the emulation program.

Configuring VT Emulation for Arabic or Hebrew
To set up an Arabic or Hebrew workstation for VT emulation, do the following:
1. Click Configure from the Communication pull-down menu.
2. Select ASCII for the host type.
3. Click the Session Parameters button.
4. Select the National host code page type.
5. Select the host code page

v If configuring for Arabic, choose Arabic ASMO 708 for 8-bit code page or
Arabic ASMO 449 for 7-bit code page.

v If configuring for Hebrew, choose Hebrew ISO or Hebrew NRCS.
6. Select the font by going to the Edit pull-down menu and selecting Preferences

→ Appearance → Font.
7. Select Face Name.

v If configuring for Hebrew, select HEB3270.
v If configuring for Arabic, select AVT3270.

File Transfer
Automatic code page conversion occurs during file transfer. However, this is only
valid for 8-bit code pages.

For Arabic workstations, the conversion is from Arabic ASMO 708 to 1256 when
sending. The code page conversion is reversed when receiving.
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For Hebrew workstations, the conversion is from Hebrew ISO to 1255 when
sending. The code page conversion is reversed when receiving.

Copy and Paste
Automatic code page conversion occurs during copy and paste operations. For
Arabic, the conversion is from the current host code page to 1256, and vice versa.
For Hebrew, the conversion is from the current host code page to 1255, and vice
versa.

Print Screen
To print a screen in an Arabic or Hebrew session, do the following:
1. Click Page Setup from the File menu.
2. For an Arabic session, select the Typing Arabic VT font. For a Hebrew session,

select the Courier Heb font.

Remapping BiDi Keys
You can customize the keyboard to map BiDi functions. The following functions
are available for a VT BiDi session:
v Screen Reverse (for Logical sessions only)
v National Keyboard Layer
v Latin Keyboard Layer
v Set/reset right-to-left cursor direction (for Hebrew session and visual text type

only)
v Toggle between 7-bit and 8-bit character set modes (for Hebrew session only)
v Adjust the column heading (for Arabic session only)

Bidirectional Functions for VT
Table 14. Bidirectional Key-Combinations for VT

Function Combination

Language Selection (Hebrew or Arabic) Alt+RightShift

English Language Alt+LeftShift

Screen Reverse (Hebrew Logical Text Mode
and Arabic only)

Alt+NewLine

Adjust Column Heading (Arabic only) Alt+K

Toggle Cursor Direction (Visual Hebrew
only)

Alt+D

Toggle 7–bit and 8–bit Character Set Modes
(Hebrew only)

Alt+B

v Language Selection: Same meaning as in “Bidirectional Functions for 3270” on
page 167

v English Language: Same meaning as in “Bidirectional Functions for 3270” on
page 167

v Screen Reverse: Same meaning as in “Bidirectional Functions for 3270” on
page 167

v Adjust Column Heading: Column Heading mode causes blanks between
columns of text to break insertions. Thus, the English titles for columns of data
maintain their correct position.
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v Toggle Cursor Direction: If current cursor direction is left-to-right, pressing
Alt+D changes it to right-to-left, and back again. When the cursor direction is set
to right-to-left, this does not affect cursor addressing , moving, inserting, and
deleting characters, erasing in line or erasing in display.
The following functions are affected by the right-to-left cursor direction setting:
– Backspace (the cursor moves one position to the right)
– Carriage return (the cursor moves to the rightmost position on the current

line)
– Line feed (the cursor moves to the rightmost position of the next line)
– Typing in the auto wrap mode (current line is continued from rightmost

position of the next line)
v Toggle 7–bit and 8–bit Character Set Modes: This function allows switching

between 7-bit and 8-bit character sets. If the current character set is ISO Hebrew
(8-bit), pressing Alt+B changes the character set to Hebrew NRCS (7-bit).

Arabic Support for ASMO 449 7-bit Code Page
The following Control Sequences are supported for ASMO 449 7-bit code page.

Table 15. Control Sequences for Arabic VT Support

Control Sequence Description

Arabic Mode and State Controls

DECSABM v Arabization disabled

v BiDi with Text Controls

v BiDi without Text Controls

DDECSNL Start new Arabic/Latin language

DECVTCM v Invisible Text Controls

v Visible Text Controls

DECSAPV Numerals displayed in Arabic/Hindi,
according to context

Arabic Imaging Controls

DECBDOCPD Set the direction of the screen (Document
Presentation Direction)

Arabic Text Controls

SLR Start LTR direction

SRL Start RTL direction

SDD SDD start default direction
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Chapter 18. Unicode Support

For Windows NT and 2000, Personal Communications Version 5.7 supports
Unicode for Hindi and 1390/1399 Japanese code pages.

For a description of the procedure for configuring Personal Communications Hindi
support, refer to Quick Beginnings. Installation information is described in the
CD-ROM Guide to Installation.

1390/1399 Code Pages
The following features are supported in Unicode for 1390/1399 Japanese character
processing.
v Print Screen
v Record and play macros
v Data and file transfer
v Copy, Cut, and Paste
v EHLLAPI. Refer to Emulator Programming for information about 1390/1399

transfer APIs.
v Keyboard Customization

See the following list for more information about specific 1390/1399 support issues.

DBCS Translation Table
Personal Communications maps 1390/1399 code pages as follows:
v 1390-->UCS2
v UCS2-->1390
v 1399-->UCS2
v UCS2-->1399
v 1399-->943
v 943-->1390

Personal Communications loads a different translation table for display.

Personal Communications handles the Unicode printing both for GDI
mode and PDT mode.

Data and File Transfer
File transfer uses the EBCDIC<-->UNICODE (or EBCDIC<-->ASCII )
translation for Host to PC. The user can save as an ASCII file or as a
Unicode file.

User Defined Area (UDA) Support
Personal Communications handles EBCDIC<-->UNICODE (UDC), which is
different from EBCDIC <--> ASCII. The DBCS UDA mapping table editor
handles UNICODE<--> EBCDIC UDA.
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Hindi Support
The following features are supported in Unicode for Hindi.
v Print Screen
v Data transfer. File transfer is not supported.
v Copy, Copy Append, Cut, and Paste. Copy Link is not supported.
v EHLLAPI. Refer to Emulator Programming for information about Hindi data

transfer APIs.
v Trace

See the following list for more information about specific Hindi support issues.

Code Page
The host code page for Hindi is 1137. The Unicode PC code page is 1200.
Personal Communications uses a predefined translation table to map these
code pages.

Record and Play Macros
Hindi enablement is limited to macro scripts only. Customization of the
macro file is disabled in Hindi sessions. VB scripts are not supported.

Fonts Only True Type Fonts are used for Hindi for display and printing. The TTF
file is enumerated by Personal Communications and is displayed in the
Page Setup pull-down menu. This font file has to be selected for printing
the characters in Hindi. The Hindi font file is installed along with other
font files.

Keyboard
The English keyboard layout is mapped to the Hindi layout. This is
accomplished by loading the two key mapping tables corresponding to
Hindi from the PCSKBD.DLL file. The first table maps the Windows virtual
key number to the IBM key number. The second key mapping table maps
the IBM key number to the Unicode value of the corresponding character.

Keyboard Customization
When a key is selected in the Keyboard Customization dialog, the edit
control window displays the corresponding Hindi character. The user can
change the mapping by selecting a new character from the list box. If the
user attempts to directly edit the edit control window, the characters from
the current input character set appear.

Copy/Move/Swap and Find keys
The function of these keys is similar to that of the existing SBCS languages.
The only difference is that the Hindi characters are stored as Unicode
characters instead of single-byte characters.

Switching from Hindi to English
Hindi language support also includes toggling between Hindi and English
using the ALT+left Shift key.

OIA Display
The Operator Information Area displays functions differently for Windows
NT, and Windows 2000 and XP.

Windows NT
When a user is working in the Hindi compose mode, HI is
displayed in columns 36 and 37 of the OIA display; when working
in English compose mode, E is displayed. The user can toggle
between Hindi and English using ALT+left Shift key.
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Windows 2000 and XP
In Windows 2000 and XP, HI is displayed in the OIA when
working in Hindi mode. There is no display when the user shifts
from Hindi mode.
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Part 5. Building a Printer Definition Table (PDT)
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Chapter 19. Building a Printer Definition Table (PDT) for
PC/3270

This chapter, in combination with Chapter 20, “Building a Printer Definition Table
(PDT) for PC400”, on page 191, explains how to customize a printer definition table
(PDT file) for PC/3270. Chapter 20, “Building a Printer Definition Table (PDT) for
PC400”, on page 191 contains basic information about creating and changing PDTs;
this chapter contains specific information about creating PC/3270 PDTs. PDTs for
PC/3270 and PC400 differ only slightly; if you use a common PDT (used for both
PC/3270 and PC400), the additional statements for PC400 are ignored for PC/3270
processing. Similarly, statements unique to PC/3270 are ignored for PC400
processing.

ASCII_PASSTHRU? and EBCDIC_PASSTHRU?
The ASCII_PASSTHRU? and EBCDIC_PASSTHRU? PDF statements are new
options available for PC/3270. See “Transparent Print Capability” on page 196 for
details.

Supplemental Explanation of PDF Statements for PC/3270
The following PDF statements have functions that differ from those for PC400. All
statements are listed in “Field Names of Printer Definition Files” on page 208.

MAXIMUM_PAGE_LENGTH
Printed lines per page. If you change this value, you must change the
value in the SET_PAGE_LENGTH=SFL value statement (see “Session
parameters” on page 193) to be the same.

MAXIMUM_PRINT_POSITION
Printed characters per line.

COMPRESS_LINE_SPACING?
(For LU 3 only) Whether blank or null lines are to be printed if all
characters on that line are nulls.

FORM_FEED_ANY_POSITION?
Whether a form feed is to be valid in any position. If NO, a form feed will
be valid only in the following positions:
v First print-position of the buffer
v After a valid new line operation
v First print-position of a line

OVERRIDE_FORMATTED_PRINT?
Whether nulls are to be printed as blanks.

INTERV_REQ_TIMER
This statement is ignored.

INTERV_TIMER_ON_PE_ONLY?
This statement is ignored.

RESELECT_TIME_EXCPT_5204
This statement is ignored.

ESC/P_LINE_FEED?
If YES, the line feed (LF) function is emulated when the line feed
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command is received. This is useful when you do not want a line feed
accompanied by a carriage return (CR) on a printer using the ESC/P
printer language. If NO, the value defined in the LINE_FEED statement is
sent to the printer.

IGNORE_FORM_FEED_AT_FIRST_POS?
If YES, the form feed (FF) function is ignored at the first position (for LU 2,
LU 3, and non-SNA sessions) or at the beginning of the print job (for LU 1
sessions). Using this option eliminates extra blank pages at the beginning
of each print job.

FORM_FEED_TAKES_POSITION?
If YES, the form feed (FF) function is effective if followed by data (LU 2,
LU 3, and non-SNA sessions only).

KANJI_CODE?
If YES, kanji codes (JIS or SHIFT_JIS) have been used. This value cannot be
changed.

ZENKAKU_SPACE
The size (adjustment unit) of a user-defined character and a HANKAKU
character. This value cannot be changed.

SBCS_FONT_LOAD
Registration of a HANKAKU GAIJI. This value cannot be changed.

DBCS_FONT_LOAD
Registration of a ZENKAKU GAIJI. This value cannot be changed.

SET_LOCAL_FONT
Set a font set of user-defined characters. Remove it when user-defined
characters are not loaded to a printer.

RESET_LOCAL_FONT
Reset a font set of user-defined characters. Remove it when user-defined
characters are not loaded to a printer.

KANJI_ON
Set kanji mode.

KANJI_OFF
Reset kanji mode.

ATTRIBUTE_GRID_LINE
Set to grid-line print. This value cannot be changed.

START_DOUBLE_WIDTH_CHARACTER
Set a double-width character.

END_DOUBLE_WIDTH_CHARACTER
Reset a double-width character.

Notes:

1. When using IBM5577.PDF, change FORM_FEED=EJC to FORM_FEED in the
file when a continuous form job does not feed correctly.

2. When using ESC_P.PDF, DBCS (2-byte) characters are placed to the left of the
character box, not in the center. To place DBCS characters in the center of the
character box, change the IBM-supplied values in ESC_P.PDF:

P10 EQU 1B 50 1B 20 00 1C 53 00 0C 1C 54 00 00
P12 EQU 1B 4D 1B 20 00 1C 53 00 06 1C 54 00 00
P13 EQU 1B 67 1B 20 01 1C 53 00 03 1C 54 00 01
P15 EQU 1B 67 1B 20 00 1C 53 00 00 1C 54 00 00
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to the following:
P10 EQU 1B 50 1B 20 00 1C 53 06 06 1C 54 00 00
P12 EQU 1B 4D 1B 20 00 1C 53 03 03 1C 54 00 00
P13 EQU 1B 67 1B 20 01 1C 53 02 01 1C 54 00 01
P15 EQU 1B 67 1B 20 00 1C 53 00 00 1C 54 00 00

SCS TAB Setting
A PC/3270 printer session LU type 1 can accept any number of tab positions, and
the host printer session can send any number of tabs to the printer session.
However, the workstation printer you are using might support fewer tab positions
than the host application sets; for example, the IBM Proprinter supports 27 tab
positions.

If the number of tab positions that the host application sets exceeds the maximum
number of positions that the printer supports, your printed output will not look as
you expect it to. You can avoid this situation by modifying the PDF file and
reconfiguring PC/3270 as follows:
1. Modify the SET_HORIZONTAL_TABS statement as follows:

SET_HORIZONTAL_TABS=number

2. Save the file under a new name.
3. Convert the PDF file (with the procedure described in Chapter 20, “Building a

Printer Definition Table (PDT) for PC400”, on page 191).
4. Select the new PDT file created in Step 2.

Printer Color Mixing
Some printers, such as the IBM 5182, compose certain colors by mixing colors.
Colors are mixed by printing the text in one color and then printing over the same
text in another color on a second pass.

PC/3270 will compose a color if the color is not defined in the printer definition
table of a color printer that is capable of mixing colors. Therefore, if you are using
a printer that composes some colors by mixing two colors, leave the definition of
the composed colors blank in the printer definition file. Only the composite colors
defined in Table 16 are created by double-printing the primary colors.

Table 16. Color Mixes

Composite Color Primary Colors

Red yellow, magenta

Green yellow, cyan

Blue magenta, cyan

For example, to create red, you must define yellow and magenta. The primary
colors must be defined in the printer definition table.

Printer Session Data Stream Support
There are two types of host-directed print data streams supported by PC/3270: the
3270 data stream and the SNA character string (SCS) data stream.
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3270 Data Stream
The 3270 data stream is a buffer-oriented data stream. The print data is formatted
as if it were going to be displayed on a screen. The host system sends commands
to format the presentation space. These commands can change the presentation
space in any location at any time. Once the host system completes formatting the
presentation space, it issues a START PRINT command and the presentation space
is printed as accurately as the printer hardware allows. The 3270 data stream can
be sent to PC/3270 workstations over an SNA LU 3 session or a non-SNA DFT
printer session.

Table 17 lists the commands that can be sent in the 3270 data stream.

Table 17. 3270 Data Stream Commands

Command Meaning

W Write

EW Erase/Write

EWA Erase/Write Alternate

RB Read Buffer

RM Read Modified

RMA Read Modified All

EAU Erase All Unprotected

WSF Write Structured Field

The RB, RM, and RMA commands cannot be used with an SNA attachment.

Table 18 lists the orders that can be sent in the 3270 data stream.

Table 18. 3270 Data Stream Orders

Order Meaning

SBA Start Buffer Address

SF Start Field

IC Insert Cursor

PT Program Tab

RA Repeat to Address

EUA Erase Unprotected to Address

SFE Start Field Extended

SA Set Attribute

MF Modify Field

The last three orders in the preceding table manage the color, extended
highlighting, and programmed symbols attributes for fields and individual
characters. The programmed symbols attribute is not supported by PC/3270.

In addition to the commands and orders in the two preceding tables, there are
special printer formatting control codes that can be included in the 3270 data
stream.
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The following table lists the control codes that can be sent in the 3270 data stream.

Table 19. 3270 Data Stream Format Control Codes

Code Description

NL New Line control code moves the print position to the left margin and
down one line.

CR Carriage Return control code moves the print position to the left
margin.

EM End of Message control code ends the print operation.

FF Form Feed control code moves the print position to the left margin at
the top of the next page.

Note: NL, CR, and EM are valid only if a line-length format specified by the WCC
is not used. The FF code is valid in any buffer position.

PC/3270 printer support interprets each 3270 attribute and printer control code
and translates them into a sequence of one or more workstation printer control
codes. For more information about the 3270 data stream, refer to IBM 3270
Information Display Data Stream Programmer’s Reference.

SCS Data Stream
The SCS data stream is a sequential data stream that is oriented toward line
printers. The characters are translated according to the host system code page and
printed according to the attributes and formatting specified by the control
commands. The way in which SCS characters are printed depends only on the
control codes that precede them. Therefore, it is not necessary to buffer the
characters before they are printed. The SCS data stream flows across the SNA LU 1
session only.

The valid SCS control codes supported by PC/3270 are listed in Table 20.

Table 20. Supported SCS Control Codes

Code Value Command

NL X'15' New Line

LF X'25' Linefeed (Index)

CR X'0D' Carriage Return

FF X'0C' Form Feed

BS X'16' Backspace

BEL X'2F' Bell Function

IRS X'1E'
Interchange-Record
Separator

SA X'28' Set Attribute

TRN X'35' Transparent

NUL X'00' Null

HT X'05' Horizontal Tab

VT X'0B' Vertical Tab

SHF X'2B C1' Set Horizontal Format

SVF X'2B C2' Set Vertical Format
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Table 20. Supported SCS Control Codes (continued)

Code Value Command

SLD X'2BC 6' Set Line Density

SPD X'2BD2 xx29' Set Print Density

VCS X'04 xx' Vertical Channel Select

ENP X'14' Enable Presentation

INP X'24' Inhibit Presentation

GE X'08' Graphic Escape

PPM X'2BD2 xx48' Page Presentation Media

SO X'0E' Shift Out

SI X'0F' Shift In

RNL X'06' Required New Line

RCR X'06' Required Carriage Return

SPS X'09' Superscript

WUS X'23' Word Underscore

IR X'33' Index Return

PP X'34' Presentation Position

EBS X'36' Expanded Backspace

NBS X'36' Numeric Backspace

SBS X'38' Subscript

IT X'39' Indent Tab

RFF X'3A' Required Form Feed

RPE X'3A' Required Page End

RSP X'41' Required Space

NSP X'E1' Numeric Space

ESP X'E1' Expandable Space

SH X'CA' Syllable Hyphen

Note: The ENP and INP commands are accepted, but are ignored, in an LU 1
session.

For more information about the SCS printer data stream, refer to IBM Systems
Network Architecture - Sessions Between Logical Units.

Delimiting Print Jobs
Many print jobs can be sent over a single PC/3270 printer session. PC/3270 allows
multiple sessions and applications to share a single workstation printer on a
between-jobs basis. PC/3270 needs to know when each print job starts and ends so
that printers can be shared properly and begin and end job strings can be sent at
the appropriate times. The emulator recognizes a number of different methods of
delimiting print jobs:

By Session
PC/3270 printer support assumes, by default, that all print jobs are
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delimited by sessions. That is, in the absence of all other indicators,
PC/3270 assumes that a print job begins when a printer session is started
and ends when it is reset.

Time-Out Interval
On non-SNA DFT sessions, print jobs can be delimited by a user-specified
timeout interval. A print job on a non-SNA DFT printer session begins
when the first host-outbound data for that job is received, and ends when
no host-outbound data is received for a period of time exceeding the
user-specified non-SNA DFT timeout interval. For PC/3270, this interval is
specified during configuration.

By Brackets
On an SNA session with an LU 1 or LU 3 host application, PC/3270 can
use bracket indicators to delimit print jobs. The emulator opens the printer
when it receives the begin bracket, then it processes and prints data. The
emulator closes the printer after it receives an end bracket.

When the emulator receives another begin bracket, it again opens a printer
and begins processing a print job.

Structured Fields
The host can use structured fields to indicate to the device that a new file
is beginning or that the current file is completed. PC/3270 delimits print
jobs with Begin of File and End of File structured fields (SF) to perform
host-directed printing. Structured fields are described in “Structured
Fields”.

Structured Fields
The host uses Begin of File and End of File structured fields to indicate to a device
that a file is beginning or ending.

Begin/End of File Query Reply
The Begin/End of File query reply indicates that a device supports Begin of File
and End of File to delineate print jobs. The PC/3270 sends a query reply, as shown
in Table 21, to the host in response to a Read Partition General query.

Table 21. Begin/End of File Query Reply Format

Byte Contents Description

0–1 X'0005' The length of this structure

2 X'81' Query reply

3 QCODE X'9F' Begin/End of File

4 FLAGS Reserved; must be set to 0’s

Begin/End of File Structured Fields
Begin/End of File structured fields are accepted on either LU 1 or LU 3 sessions.
Table 22 shows the format of the Begin/End of File structured fields.

Table 22. Begin/End of File Structured Field Format

Byte Bit Contents Description

0–1 X'0007' The length of this structure

2–3 X'0F85' Begin/End of File
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Table 22. Begin/End of File Structured Field Format (continued)

Byte Bit Contents Description

4 PID Partition ID

5
0–1

2–7

FLAG1¹ B'00' B'01'
B'10' B'11' Reserved

End of File is being sent
Begin of File is being sent
Reserved
Reserved

6 FLAG2 Reserved; must be set to 0’s.

:

¹This byte indicates whether Begin of File or End of File is being sent

Processing Begin or End of File Structured Fields
When the Begin or End of File structured fields are used with brackets or non-SNA
timeout intervals, the Begin or End of File SFs take precedence over the brackets or
timeout intervals in determining when a print job begins or ends. See the following
examples:
v Begin or End of File structured fields overriding brackets:

Begin Bracket, Begin of File Structured Field, ...Data...,
End Bracket

The device will wait indefinitely until the End of File structured field is received
before ending the print job.

v Begin or End of File structured fields overriding non-SNA timeout intervals:
Begin of File structured fields, ...Data..., pause > timeout value

The device will wait indefinitely until the End of File structured fields is
received before ending the print job.

v Inconsistent use of Begin or End of File structured fields and brackets:
Begin Bracket, ...Data1...,
Begin of File Structured Fields,...Data2..,
End of File Structured Fields, ...Data3...,
End Bracket

When you use the Begin of File and End of File structured fields inconsistently
with brackets, the results are unpredictable. In the preceding example, the device
might process Data1, Data2, and Data3 as separate jobs or combine two or more
of them into one file.

For predictable results, each data block must be enclosed by a Begin of File
structured field and an End of File structured field. The following example shows
three print jobs all delimited by Begin or End of File structured fields:
Begin Bracket, Begin of File Structured Field, ...Data1...,
End of File Structured Field,(job1)
Begin of File Structured Field, ...Data2..., End of File Structured Field, (job2)
Begin of File Structured Field, ...Data3..., End of File Structured Field,
End Bracket(job3)

PC/3270 always keeps track of brackets and timeout intervals. After the emulator
receives a Begin of File structured field, it takes no action on Begin Brackets, End
Brackets, or timeout until it receives an End of File structured field. After a valid
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End of File SF is processed, the emulator defaults to delimiting jobs by brackets or
timeout intervals until it receives the next Begin of File structured field.

Begin or End of File Structured Field Error Conditions
PC/3270 does not accept transmission of data belonging to two separate print jobs
in the same chain. To be accepted by the emulator, Begin of File structured fields
must be the first structured field of a chain and End of File structured fields must
be the last structured field of a chain.

PC/3270 rejects transmission in the following instances:
v The emulator receives an End of File structured field without first receiving a

Begin of File structured field.
v The emulator receives a second Begin of File structured field without receiving

an intervening End of File structured field.
v The emulator receives a Begin of File structured field that is not the first

structured field following a write structured field command (LU 2, LU 3, and
non-SNA sessions) or a Function Management Header 1 (LU 1 sessions).

v The emulator receives an End of File structured field that is not the last
structured field following a write structured field command (LU 2, LU 3, and
non-SNA sessions) or a Function Management Header 1 (LU 1 sessions).

Processing SCS Data Streams
When processing an SCS data stream, PC/3270 treats Begin or End of File
structured fields as follows:
v A Begin of File structured field indicates that all SCS data in the same

transmission until an End of File structured field is received is part of a new
print job.

v An End of File structured field indicates that any SCS data received in the same
chain as the End of File structured field is the last data of the current print job.

Processing 3270 Data Streams
When processing a 3270 data stream, PC/3270 treats Begin or End of File
structured fields as follows:
v A Begin of File structured field indicates that the next presentation space print

(initiated by a write type command with the start print bit turned on in the
write control character) is the first in a print job.

v An End of File structured field indicates that the last presentation space print
was the last of the current print job. The emulator immediately sends a
terminate string to the printer to close the printer session.

If PC/3270 receives a Begin of File structured field and an End of File structured
field without at least one presentation space separating them, it ignores the
structured fields.
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Chapter 20. Building a Printer Definition Table (PDT) for
PC400

This chapter explains how to create and change the printer definition table (PDT
file) used for PC400. Chapter 19, “Building a Printer Definition Table (PDT) for
PC/3270”, on page 181 contains specific information about creating PC/3270 PDTs.
PDTs for PC/3270 and PC400 differ only slightly; if you use a common PDT (used
for both PC/3270 and PC400), the additional statements for PC400 are ignored for
PC/3270 processing. Similarly, statements unique to PC/3270 are ignored for
PC400 processing.

The PDT file is created by converting the printer definition file (PDF file). The PDF
and PDT define the transmission of characters and control codes to the printer and
the format of printer output. To change an existing PDF (the recommended
method) or create a new one, use a text editor that can produce or update an
ASCII file.

Using the Printer Definition Table (PDT) File
To use the PDT file:
1. Select File from the menu bar of the workstation window.
2. Select Printer Setup from the File menu.

The Printer Setup window appears.
3. Select the Use PDT file check box and Select PDT.

The Select PDT file window appears.

To build the PDT file (required only if the PDF has been changed or created):
1. Select Convert PDF. Select the PDF file to be converted from the list in the

Convert PDF to PDT window; then select Convert. The PDF File Converter
window appears. After the file has been converted, click on Close, then click
Close in the Convert PDF to PDT window.

2. Click OK in the Select PDT file window.
3. Click OK on the Printer Setup window.

After printer setup is complete, the Printer Setup window is closed.

Printer Definition File (PDF File) Format
A PDF contains 3 main sections:
v Macro definitions
v Formatting controls
v Character definitions using EBCDIC_xx keywords

Macro Definitions
This section of a PDF contains user-defined macros. A macro is a single mnemonic
that stands for a control code or a sequence of control codes. A mnemonic
simplifies defining control sequences for PC printers and makes it easier to read
the information in the PDF.
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The following table shows the structure of a macro definition statement. A macro
definition is composed of four parts:

1 2 3 4

name EQU PC Printer Control Codes Comments

For example:
FFF EQU 0C /* Form Feed */

The first part is the user-defined mnemonic or macro name. This name must be
exactly three characters long and must not begin with a number. It is helpful to
define a meaningful mnemonic, such as P17 for 17.1 pitch.

The second part, EQU, stands for equate and must be coded as EQU.

The third part is the hexadecimal control code, which is specific to a PC printer.
Each PC printer manufacturer can define different control codes for the same
printer function. For example, the IBM 4019 LaserPrinter uses control codes
defined by the IBM Personal Printer Data Stream (PPDS). Hewlett-Packard printers
use control codes defined by the Hewlett-Packard Printer Control Language (PCL).
These control codes are usually defined in the manual that comes with the printer.

Some PC printer manuals describe control sequences as a string of ASCII symbols,
such as ESC J 1 K: others use hexadecimal numbers, such as 1B 57 01; while others
use decimal values, such as 27 28 1. The printer definition table compiler accepts
any of these formats.

The control codes in the macro definitions section can be any of the following:
v Single characters that are interpreted as their ASCII value
v Two-digit numbers that are interpreted as hexadecimal values
v Three-digit numbers that are interpreted as decimal values

If you leave the control code section blank or if you delete it, the character or
control code is interpreted as a null string. If a character or control code is defined
more than once in the file, the last definition is used.

The fourth part is the comment section. The symbols /* indicate the beginning of a
comment and the symbols */ indicate the end of a comment. Comments can be
coded at any point in the printer definition file and are ignored by the printer
definition table compiler.

The following is an example macro definition statements that are specific to the
IBM 4019 LaserPrinter.
LFF EQU 0A /* Line Feed */
VTB EQU 0B /* Vertical Tab */
FFF EQU 0C /* Form Feed */
CRR EQU 0D /* Carriage Return */
P05 EQU 1B 57 01 /* 5 Pitch-Characters/inch */
P10 EQU 12 /* 10 Pitch-Characters/inch */
CDW EQU 1B 57 00 /* Cancel Double Wide contin. */
P17 EQU 12 0F /* 17.1 Pitch-Character/inch */
LL8 EQU 1B 41 09 1B 32 /* Set line length 8 lines/inch*/
P12 EQU 1B 3A /* 12 Pitch-characters/inch */
RES EQU 1B 5B 4B 07 00 05 31 01 A4 00 00 90

/* The above macro resets the */
/* printer using the factory */
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/* defaults. See the IBM Laser*/
/* Printer Technical Reference */
/* manual. */

To illustrate how macros are coded, consider this example. To have the host print
job printed in double-wide characters, you must know what control code turns on
double-wide printing on your PC printer. On the IBM 4019 LaserPrinter, the
control code to turn on double-wide printing is X’1B5701’. This would be coded as:
BDW EQU 1B 57 01

where BDW stands for Begin Double Wide.

This alone would not cause 3270 host print to send this control to the printer. The
mnemonic would have to be included in a control code statement, such as
START_JOB which is described in the control codes section of the file.

Note: The IBM 4019 LaserPrinter printer definition file that comes with IBM
Personal Communications already has this control code defined as the P05
macro. See line 9 of the sample IBM 4019 LaserPrinter Macro Definition
Statements (“IBM4019.PDF File Contents” on page 198).

Macro Name Examples
The following are example mnemonics or macros. The control codes are for the
IBM 4019 LaserPrinter:

LND EQU 1B 26 6C 31 4F /* LANDSCAPE */
POR EQU 1B 26 6C 30 4F /* PORTRAIT */
P12 EQU 1B 28 73 31 32 2E 30 30 48 /* PITCH_12.00 */
T10 EQU 1B 28 73 31 30 2E 30 56 /* POINT_10.0 */
LTR EQU 1B 26 6C 32 41 /* LETT_PAPER */
G66 EQU 1B 26 6C 36 36 50 /* PG_LENGTH_66 */

Formatting Controls
The controls section of a PDF contains the following:
v Session parameters
v Control codes
v Color specifications
v Highlight specifications

Session parameters
MAXIMUM_PAGE_LENGTH, MAXIMUM_PRINT_POSITION, and
SET_PAGE_LENGTH

The parameter to the left of the equal sign is a keyword and must be coded exactly
as shown. The keyword is used to define a statement. The values to the right of
the equal sign are macros or control codes. Because the values to the right of the
equal sign can be both macros and control codes, they will sometimes be referred
to as parameters.

The MAXIMUM_PAGE_LENGTH, MAXIMUM_PRINT_POSITION, and
SET_PAGE_LENGTH parameters specify the dimensions of the output job. The
number specified in the MAXIMUM_PAGE_LENGTH parameter is used in the
SET_PAGE_LENGTH parameter and is substituted for the value keyword. In other
words, if SET_PAGE_LENGTH and MAXIMUM_PAGE_LENGTH are coded as
follows:
MAXIMUM_PAGE_LENGTH=066 /* Printed lines per page */
SET_PAGE_LENGTH=SFL 066
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The results would be:

SET_PAGE_LENGTH=SFL 066

Because SFL is coded as X’1B 43’ in the macro section, the actual control code that
would be sent to the printer to set the maximum page length is:

X'1B 43 42'

where X'42' is decimal 66.

Note: Setting MPL=255 causes suppression of form feeds (FFs).

Control Codes
The control codes section of a PDF is used by the PDT function to determine what
specific PC printer control code is to be sent to the PC printer when an SCS control
code is received. Some of the statements used by Communications Manager are
shown in the following example.
START_JOB=SEL CDW CDL CUL CDS CP8 CS2
END_JOB=CAT CDW CDL CUL CDS CP4 FFF
SET_PAGE_LENGTH=SFL value
SET_VARIABLE_LINE_DENSITY=ESC A value ESC 2
SET_10_CHARACTERS_PER_INCH=P10

Note: The above example lines come from the IBM 4019 LaserPrinter PDF.

START_JOB and END_JOB

The control codes associated with START_JOB are sent at the start of each host
print job. It is best to set all printer options to a known or desired state at the
beginning of each host print job. The PC printer changes its state or changes the
options selected only when instructed to do so by control codes. Therefore, the
previous PC application could have left the printer in portrait mode with a Courier
font selected, and unless your job changed them, these would be the printer
options used.

Even though the START_JOB and END_JOB control codes are the ones shipped
with the IBM4019.PDF, many users change them to be more like the ones below:

START_JOB=RES P12 LL8
END_JOB=RES

In this example, the RES, P12 and LL8 macros are used on the START_JOB
statement (these macros are defined in “IBM4019.PDF File Contents” on page 198).
This translates into the following control codes being sent to the printer at the
beginning of your print job:

X'1B 5B 4B 07 00 05 31 01 A4 00 00 90 1B 3A 1B 41 09 1B 32'

This sequence of control codes:
v Resets the printer to the IBM PPDS factory default settings (RES)
v Begins printing in 12 pitch (P12)
v Begins printing at 8 lines per inch (LL8)

The END-JOB statement sends the following control code to the printer at the end
of your job:
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X'1B 5B 4B 07 00 05 31 01 A4 00 00 90'

This control code resets the printer to IBM PPDS factory default settings (RES).

SET_VARIABLE_LINE_DENSITY

The SET_VARIABLE_LINE_DENSITY statement is used in combination with the
panel where you can select the number of lines per inch (LPI), which can be either
6 or 8.

The PDT process uses whatever is selected in the lines per inch field, and
substitutes this number for the value keyword in the
SET_VARIABLE_LINE_DENSITY parameter. In other words, if lines per inch is set
to 8, the SET_VARIABLE_LINE_DENSITY parameter is
SET_VARIABLE_LINE_DENSITY=ESC A 09 ESC 2

where the 09 comes from 72/8. The number of typographic points in 1 inch is 42;
thus a value of 12 points would indicate six lines to an inch.

The control code that is sent to the printer to set the line density is:
X’1B 41 09 1B 32’
SET_10_CHARACTERS_PER_INCH

On most printers, the default pitch is 10 characters per inch. In most PDTs,
Personal Communications uses this same convention and sends the control code
found on the SET_10_CHARACTERS_PER_INCH statement. This is usually coded
in the PDF as:
SET_10_CHARACTERS_PER_INCH=P10

where P10 is coded in the macro definition section as:
P10 EQU 12

Printing More than One Screen on a Page
If you want to print two or more screens per page, use the BEL command in the
PDF to specify the number of blank lines to insert (instead of a Form Feed between
two successive screens). You must coordinate this modification with the usage of
the LPI and MPL parameters in the PDF (see “Field Names of Printer Definition
Files” on page 208).

Note: This specific use of the BEL command is applicable only for printing screens
using the Print Screen Collection function.

Setting the value BEL=FF will send a Form Feed, while the value BEL=00 does not
insert a Form Feed or a Line Feed.

Values between 00 and FF send that number of blank lines between successive
screens. For example, BEL=02 inserts two blank lines between two successive
screens. Thus, more than one screen can be printed on a single page.

Chapter 20. Building a Printer Definition Table (PDT) for PC400 195



Transparent Print Capability

ASCII_PASSTHRU? Keyword Support
If you add the following line to your PDF, Personal Communications will send
host data without any translation:

ASCII_PASSTHRU? = YES

This option is for special host applications that generate PC printer control codes
directly.

Even if ASCII_PASSTHRU? is set, control codes defined START_JOB and END_JOB
are sent to the printer at the start and the end of a print job respectively. To
remove those commands, you need to rebuild the PDT file after removing the PDF
keyword definitions for START_JOB and END_JOB.

If ASCII_PASSTHRU? is set, all character definition lines, for example, EBCDIC_xx,
are ignored.

If both ASCII_PASSTHRU? and EBCDIC_PASSTHRU? are set, ASCII_PASSTHRU?
has priority.

EBCDIC_PASSTHRU? Keyword Support
If you add the following line to your PDF, Personal Communications will ignore
all SCS commands and send data to the printer after EBCDIC-to-ASCII translation:

EBCDIC_PASSTHRU? = YES

For example, the default EBCDIC-ASCII translation table used for U.S. English host
code page 037 is as follows:

Hex | 0 1 2 3 4 5 6 7 8 9 A B C D E F
-----+----------------------------------------

0 | 2020 2020 2020 2020 2020 2020 2020 2020
10 | 2020 2020 2020 2020 2020 2020 2020 2020
20 | 2020 2020 2020 2020 2020 2020 2020 2020
30 | 2020 2020 2020 2020 2020 2020 2020 2020
40 | 20FF 8384 85A0 C686 87A4 BD2E 3C28 2B7C
50 | 2682 8889 8AA1 8C8B 8DE1 2124 2A29 3BAA
60 | 2D2F B68E B7B5 C78F 80A5 DD2C 255F 3E3F
70 | 9B90 D2D3 D4D6 D7D8 DE60 3A23 4027 3D22
80 | 9D61 6263 6465 6667 6869 AEAF D0EC E7F1
90 | F86A 6B6C 6D6E 6F70 7172 A6A7 91F7 92CF
A0 | E67E 7374 7576 7778 797A ADA8 D1ED E8A9
B0 | 5E9C BEFA B8F5 F4AC ABF3 5B5D EEF9 EF9E
C0 | 7B41 4243 4445 4647 4849 F093 9495 A2E4
D0 | 7D4A 4B4C 4D4E 4F50 5152 FB96 8197 A398
E0 | 5CF6 5354 5556 5758 595A FDE2 99E3 E0E5
F0 | 3031 3233 3435 3637 3839 FCEA 9AEB E9FF

You can modify this code page using EBCDIC_xx keywords. Note that the
EBCDIC_PASSTHRU? line precedes any EBCDIC_xx lines in your PDF file because
Personal Communications reinitializes the EBCDIC-to-ASCII translation table when
it finds that EBCDIC_PASSTHRU? is set.

Even if EBCDIC_PASSTHRU? is set, control codes defined START_JOB and
END_JOB are sent to the printer at the start and the end of a print job respectively.
To remove those commands, you need to rebuild the PDT file after removing PDF
keyword definitions for START_JOB and END_JOB.
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EBCDIC_xx Keyword Support
EBCDIC_xx keywords are used to remap entries of EBCDIC-to-ASCII translation
table for printer sessions that receive SNA character string (SCS) data streams. For
example, if you want to print host space characters using ASCII X’1B’, add the
following line to your PDF file and recompile to update the PDT file:
EBCDIC_40 = 1B

You can specify two or more characters for one EBCDIC character. The following
definition:
EBCDIC_F1 = 1 2 3

translates EBCDIC X’F1’ into ″123″ in ASCII.

You can also remap EBCDIC code points (X’00’-X’3F’) which are normally assigned
to SCS control characters. The following line:
EBCDIC_15 = 0C

overrides the SCS new line function with X’0C’, which normally works as a form
feed function. If you remap a code point that is not used for a SCS command (for
example, X’27’) Personal Communications sends the defined code to the printer
and does not send SNA sense data to the host. The following example
EBCDIC_27 = 1B

defines EBCDIC code point X’27’ as ASCII X’1B’, which is used as an escape
character on most personal computer printers.

If you do not need to use any SCS command processing but still need
EBCDIC-to-ASCII translation, the EBCDIC_PASSTHRU? is a better solution. If you
do not need any SCS command processing or EBCDIC-to-ASCII translation,
ASCII_PASSTHRU? is an easier solution.

Printer Definition Tables
Standard printer definition table file names are of the form IBMnnnnn.PDT, and
PDT’s ASCII-to-ASCII character definitions are of the form PRNnnnnn.PDT, where
nnnnn is a machine type. See character definition descriptions for more details.

See the help panel or the specific 5250, 3270, or VT emulator user’s reference for a
list of the PDT files provided by Personal Communications.

The PDT files contained in the PC400 installation diskette can be used as is.
However, you might want to do special formatting by changing the definitions of
some fields. To do so, copy an existing PDF file, modify it, and then convert it to a
new PDT file.

Example PDF files are shown in ″Example Printer Definition Files″. Do not attempt
to change the statements in a field for which modification is specifically prohibited.
If you use a PDT file created from a changed PDF file, the results of printing
cannot be guaranteed.

Example Printer Definition Files
The following examples are annotated versions of printer definition files for the
IBM LaserPrinter 4019 (for SBCS sessions) and for the IBM 5577 Printer (for DBCS
sessions). These are examples only; the actual files may differ.
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IBM4019.PDF File Contents
/**********************************************************************/
/* */
/* PRINTER SESSION DEFINITION FILE FOR: LaserPrinter 4019/4019-E */
/* */
/**********************************************************************/
/**********************************************************************/
/* Macro Definitions */
/* Define values here that will be used commonly throughout your */
/* definitions. Then use the left hand side of the equate as you */
/* define your characters and control strings. The printer compiler */
/* will substitute the right hand side of the equate for each */
/* occurrence of the left hand side throughout the file. */
/* */
/* Macro names must be at least three characters long and may not */
/* begin with a number. */
/* */
/* Format */
/* A Macro Name is associated with a value or string of values by the */
/* EQU statement. The right hand side of an EQU statement must be a */
/* string of zero or more two digit hexadecimal numbers. If a macro */
/* definition is more than one line long, you may extend it to the */
/* next line by ending the first line with a comma. In this manner */
/* you may define a macro which is many lines long by terminating each*/
/* line except the last with a comma. No macro names are allowed on */
/* right hand side. */
/**********************************************************************/
BEGIN_MACROS
/* The following values are standard for most printers. Check your */
/* printer manual to verify that these are correct for your printer */
NUL EQU 00 /* Nul character */
BEL EQU 07 /* Beeper */
BAK EQU 08 /* Back Space */
TAB EQU 09 /* Tab */
LFF EQU 0A /* Line Feed */
VTB EQU 0B /* Vertical Tab */
FFF EQU 0C /* Form Feed */
CRR EQU 0D /* Carriage Return */
P05 EQU 1B 57 01 /* 5 Pitch-Characters/inch */

/* Same as Double Wide */
SEL EQU 11 /* Select Printer */
P10 EQU 12 /* 10 Pitch-Characters/inch */
CDW EQU 1B 57 00 /* Cancel Double Wide contin. */
CDL EQU 14 /* Cancel Double Wide line */
ESC EQU 1B /* Escape */
CAN EQU 18 /* Cancel Data */
SPA EQU 20 /* Space */
P17 EQU 12 0F /* 17.1 Pitch-Characters/inch */
CS2 EQU 1B 36 /* Select Character Set 2 */
CS1 EQU 1B 37 /* Select Character Set 1 */
P12 EQU 1B 3A /* 12 Pitch-characters/inch */
SVT EQU 1B 42 /* Set Vertical Tabs */
SFL EQU 1B 43 00 /* Set Form Length */
SHT EQU 1B 44 /* Set Horizontal Tabs */
SDS EQU 1B 47 /* Start Double Strike */
CDS EQU 1B 48 /* Cancel Double Strike */
SSP EQU 1B 4E /* Set skip perforation */
CSP EQU 1B 4F /* Cancel skip perforation */
CAT EQU 1B 52 /* Cancel all tabs Clears VT */

/* and sets HT every 8 position */
CSS EQU 1B 54 /* Cancel Subscript or Superscript */
SSO EQU 1B 53 00 /* Set Superscript over */
SSU EQU 1B 53 01 /* Set Subscript under */
SUL EQU 1B 2D 01 /* Start Underline */
CUL EQU 1B 2D 00 /* Cancel Underline */
SCP EQU 1B 5B 54 04 00 00 00 /* ESC T - select code page */
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CP8 EQU 1B 5B 54 04 00 00 00 03 52 /* select code page 850 */
CP4 EQU 1B 5B 54 04 00 00 00 01 B5 /* select code page 437 */
LL2 EQU 1B 41 24 1B 32 /* Setline length 2 lines/inch */
LL3 EQU 1B 41 18 1B 32 /* Setline length 3 lines/inch */
LL4 EQU 1B 41 12 1B 32 /* Setline length 4 lines/inch */
LL6 EQU 1B 41 0C 1B 32 /* Set line length 6 lines/inch */
LL8 EQU 1B 41 09 1B 32 /* Set line length 8 lines/inch */
LL0 EQU 1B 41 07 1B 32 /* Set line length 10 lines/inch */

/* actually 7/72 inch */
SD1 EQU 1B 5B 46 05 00 00 01 01 00 00 /* Select Drawer 1 */
SD2 EQU 1B 5B 46 05 00 00 01 02 00 00 /* Select Drawer 2 */
ENV EQU 1B 5B 46 05 00 00 02 00 00 00 /* Select Envelope */
FRM EQU 1B 64 /* Forward Relative Movement */
VLF EQU 1B 4A /* Vertical Line Feed 1/216 inch units */
SPO EQU 1B 6B /* Set Portrait Orientation */
SLO EQU 1B 6C /* Set Landscape Orientation */
SFG EQU 1B 5B 49 08 00 /* Set Font Global */
END_MACROS
/* Session Parameters */
/* These parameters determine the way in which output will be */
/* formatted for your printer. */
/* Numeric Parameters */
/* These parameters should be defined with a two digit hex number */
/* or a three digit decimal number. The range of the number is zero */
/* to 255 (decimal). */
MAXIMUM_PAGE_LENGTH=066 /* Printed lines per page */
MAXIMUM_PRINT_POSITION=080 /* Printed characters per line */
INTERV_REQ_TIMER=001
RESELECT_TIME_EXCPT_5204=001
INTERV_TIMER_ON_PE_ONLY?=NO
HORIZONTAL_PEL=120
VERTICAL_PEL=216
LINE_SPACING_RATIO=072
PAGE_LENGTH_TYPE?=INCH /* SET_PAGE_LENGTH "value" is */

/* values */
/* YES/NO Parameters */
/* These parameters should be defined with either "YES" or "NO" on the*/
/* right hand side of the ’=’ */
COMPRESS_LINE_SPACING?=NO /* Should blank or null lines */

/* be printed? */
FORM_FEED_ANY_POSITION?=YES /* Should the form feed be */

/* valid in any position? */
OVERRIDE_FORMATTED_PRINT?=YES /* Should nulls be printed as */

/* blanks? */
AUTO_NEWLINE_AT_MAX_POS?=NO
/* Control Codes */
/* These definitions tell the emulator what control strings to send to*/
/* your printer to issue control commands. */
/* */
/* Format */
/* The name of the control command should always be at the beginning */
/* of a line followed by a ’=’ and then a definition string. */
/* A Definition String is any combination of macro names, hexadecimal */
/* numbers, and characters separated by blanks. A macro must have */
/* previously defined in the macro definitions section above. A */
/* hexadecimal number must be two digits (0,..,F) long. and a */
/* character must be preceded and followed by a blank. If a */
/* definition string will not fit on a line, it may be continued */
/* as many lines as you wish by ending each line except the last with */
/* a comma; ’,’. You made add any comments you wish to by including*/
/* them between a slash* and a *slash where slash is the symbol /. */

/* START_JOB is the control string which will be sent to your printer */
/* at the beginning of each print job. */
START_JOB=SEL CDW CDL CUL CDS CP8 CS2
/* END_JOB is the string which will be sent to your printer at the end*/
/* of each print job. */
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END_JOB=CAT CDW CDL CUL CDS CP4 FFF
BACKSPACE=BAK
BEL=BEL
CARRIAGE_RETURN=CRR
NEW_LINE=CRR LFF
LINE_FEED=LFF
FORM_FEED=FFF
HORIZONTAL_TAB=TAB
VERTICAL_TAB=VTB
START_SUBSCRIPT=SSU
END_SUBSCRIPT=CSS
START_SUPERSCRIPT=SSO
END_SUPERSCRIPT=CSS
DUP=*
FIELD_MARK=;
/* The following commands specify control codes for which most PC */
/* printers require command strings which contain a variable value */
/* or values somewhere in the middle of the string. */
/* Place the word "value(s)" in the position of your definition */
/* string where the Personal Communications 5250 should fill in */
/* the hexadecimal value(s) indicated. */
/* For example, on the IBM Proprinter, the SET_HORIZONTAL_TABS */
/* definition is: */
/* SET_HORIZONTAL_TABS=ESC D values NUL */
SET_HORIZONTAL_TABS=SHT values NUL /* "values" are the tab stops */

/* in column numbers */
SET_VERTICAL_TABS=SVT values NUL /* "values" are the tab stops */

/* in line numbers */
SET_HORIZONTAL_MARGINS=
SET_PAGE_LENGTH=SFL value /* "value"=inch of the page */
SET_AUTO_PERFORATION_SKIP=SSP value

/* "value"=number of lines to */
/* skip over the perforation */
/* between pages. Used to set */
/* top and bottom margins. */

SET_VARIABLE_LINE_DENSITY=ESC A value ESC 2
/* "value"=number of points. */
/* A point is */
/* 1/(LINE_SPACING_RATIO) inch.*/

SET_CHARACTER_SET=
/*SET_CHARACTER_SET=ESC I NULL selects the normal font */
/*SET_CHARACTER_SET=ESC I 02 selects the NLQ (near letter quality) */
/*SET_CHARACTER_SET=ESC I 04 selects the normal downloaded font */
/*SET_CHARACTER_SET=ESC I 06 selects the NLQ downloaded font */
/*SET_CHARACTER_SET=CS1 selects the Character set 1 */
/*SET_CHARACTER_SET=CS2 selects the Character set 2 */

/* These control codes set the printer lines per inch and characters */
/* per inch to fixed amounts. */
/* If your printer does not support setting the line density in points*/
/* then you can enter control strings for the following commands. */
/* When Personal Communications 5250 gets a command from the host to */
/* set the lines per inch, it will round it to the closest line per */
/* inch setting that you provide. Note that if you provide a command */
/* for the SET_VARIABLE_LINE_DENSITY command above that it will be */
/* used and any control strings you provide for the set lines per inch*/
/* commands below will not be used. */

SET_2_LINES_PER_INCH=LL2
SET_3_LINES_PER_INCH=LL3
SET_4_LINES_PER_INCH=LL4
SET_6_LINES_PER_INCH=LL6
SET_8_LINES_PER_INCH=LL8
SET_10_LINES_PER_INCH=LL0 /* 7/72 inch or 9/96 inch */
SET_10_CHARACTERS_PER_INCH=P10
SET_12_CHARACTERS_PER_INCH=P12
SET_13_CHARACTERS_PER_INCH= /* */
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SET_15_CHARACTERS_PER_INCH= /* The proprinter does not */
/* support 15 pitch except in */
/* graphic mode */

SET_17_CHARACTERS_PER_INCH=P17 /* Condensed mode */
SET_20_CHARACTERS_PER_INCH=
START_DOUBLE_WIDTH_CHARACTERS=P05
END_DOUBLE_WIDTH_CHARACTERS=CDW

/* These control codes are used to select the source drawer number */
/* when your printer has the dual drawer sheetfeed option. */
SELECT_DRAWER1=SD1
SELECT_DRAWER2=SD2
SELECT_DRAWER3=
SELECT_ENVELOPE=ENV /* Envelope */

/* These control codes select the print mode (quality of print). */
SELECT_DRAFT_QUALITY=
SELECT_LETTER_QUALITY=
SELECT_ENHANCED_QUALITY=
SELECT_SETUP_QUALITY=

/* These control codes */
SET_DUPLEX=
SET_DUPLEX_TUMBLE=
RESET_DUPLEX=

/* These control codes set page orientation */
SET_PORTRAIT_ORIENT=SPO
SET_LANDSCAPELEFT_ORIENT=SLO
SET_PORTRAITUPDWN_ORIENT=SPO
SET_LANDSCAPERGHT_ORIENT=SLO

/* These control codes move the print position (Horizontal/Vertical) */
FORWARD_HORIZONTAL_SKIP=FRM word-value(LH)
FORWARD_VERTICAL_STEP_FEED=VLF byte-value

/* These control codes select the printer font via global font ID */
SET_FONT_GLOBAL=
SET_GFID_0003=SFG 00 03 00 90 01 01 03 52 CDW /* OCR-B.10 */
SET_GFID_0005=SFG 00 05 00 90 01 01 03 52 CDW /* Orator.10 */
SET_GFID_0011=SFG 00 0B 00 90 01 01 03 52 CDW /* Courier.10 */
SET_GFID_0012=SFG 00 0C 00 90 01 01 03 52 CDW /* Prestige.10 */
SET_GFID_0013=SFG 00 0B 00 90 01 01 03 52 CDW /* Artisan.10 */
SET_GFID_0018=SFG 00 12 00 90 01 01 03 52 CDW /* Courier.Italic.10 */
SET_GFID_0019=SFG 00 13 00 90 01 01 03 52 CDW /* OCR-A.10 */
SET_GFID_0020=SFG 00 14 00 90 01 01 03 52 CDW /* Pica.10 */
SET_GFID_0030=SFG 00 1E 00 90 01 01 03 52 CDW /* Math-Symbol.10 */
SET_GFID_0038=SFG 00 26 00 90 01 01 03 52 CDW /* Orator.Bold.10 */
SET_GFID_0039=SFG 00 27 00 90 01 01 03 52 CDW /* Gothic.Bold.10 */
SET_GFID_0040=SFG 00 28 00 90 01 01 03 52 CDW /* Gothic-Text.10 */
SET_GFID_0041=SFG 00 29 00 90 01 01 03 52 CDW /* Roman-text.10 */
SET_GFID_0042=SFG 00 2A 00 90 01 01 03 52 CDW /* Serif-text.10 */
SET_GFID_0043=SFG 00 2B 00 90 01 01 03 52 CDW /* Serif-text.Italic.10*/
SET_GFID_0044=SFG 00 2C 00 90 01 01 03 52 CDW /* Katakana-gothic.10 */
SET_GFID_0045=SFG 00 2D 00 90 01 01 03 52 CDW /* APL.10 */
SET_GFID_0046=SFG 00 2E 00 90 01 01 03 52 CDW /* Courier.Bold.10 */
SET_GFID_0050=SFG 00 32 00 90 01 01 03 52 CDW /* Shalom.10 */
SET_GFID_0066=SFG 00 42 00 78 01 01 03 52 CDW /* Gothic-text.12 */
SET_GFID_0068=SFG 00 44 00 78 01 01 03 52 CDW /* Gothic-text.Italic.12*/
SET_GFID_0069=SFG 00 45 00 78 01 01 03 52 CDW /* Gothic.Bold.12 */
SET_GFID_0070=SFG 00 46 00 78 01 01 03 52 CDW /* Serif-text.12 */
SET_GFID_0071=SFG 00 47 00 78 01 01 03 52 CDW /* Serif-text.Italic.12*/
SET_GFID_0072=SFG 00 48 00 78 01 01 03 52 CDW /* Serif.Bold.12 */
SET_GFID_0080=SFG 00 73 00 78 01 01 03 52 CDW /* Math-Symbol.12 */
SET_GFID_0084=SFG 00 54 00 78 01 01 03 52 CDW /* Script.12 */
SET_GFID_0085=SFG 00 55 00 78 01 01 03 52 CDW /* Courier.12 */
SET_GFID_0086=SFG 00 56 00 78 01 01 03 52 CDW /* Prestige.12 */
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SET_GFID_0087=SFG 00 57 00 78 01 01 03 52 CDW /* Letter-gothic.12 */
SET_GFID_0091=SFG 00 70 00 78 01 01 03 52 CDW /* Light.Italic.12 */
SET_GFID_0107=SFG 00 55 00 78 01 01 03 52 CDW /* Courier.12 */
SET_GFID_0110=SFG 00 6E 00 78 01 01 03 52 CDW /* Letter-Gothic.Bold.12*/
SET_GFID_0111=SFG 00 6F 00 78 01 01 03 52 CDW /* Prestige-Elite.Bold.12*/
SET_GFID_0112=SFG 00 70 00 78 01 01 03 52 CDW /* Prestige.Italic.12 */
SET_GFID_0115=SFG 00 73 00 78 01 01 03 52 CDW /* Math-Symbol.12 */
SET_GFID_0155=SFG 00 9B 00 78 02 01 03 52 CDW /* Boldface.Italic.PSM*/
SET_GFID_0158=SFG 00 9E 00 78 02 01 03 52 CDW /* Modern.PSM */
SET_GFID_0159=SFG 00 9F 00 78 02 01 03 52 CDW /* Document.PSM */
SET_GFID_0160=SFG 00 A0 00 78 02 01 03 52 CDW /* Essay.PSM */
SET_GFID_0162=SFG 00 A2 00 78 02 01 03 52 CDW /* Essay.Italic.PSM */
SET_GFID_0163=SFG 00 A3 00 78 02 01 03 52 CDW /* Essay.Bold.PSM */
SET_GFID_0168=SFG 00 A8 00 78 02 01 03 52 CDW /* Barak.PSM */
SET_GFID_0173=SFG 00 AD 00 78 02 01 03 52 CDW /* Essay.Light.PSM */
SET_GFID_0175=SFG 00 AF 00 78 02 01 03 52 CDW /* Document.PSM */
SET_GFID_0176=SFG 00 B0 00 78 02 01 03 52 CDW /* Boldface.PSM */
SET_GFID_0177=SFG 00 9B 00 78 02 01 03 52 CDW /* Boldface.Italic.PSM*/
SET_GFID_0193=SFG 00 73 00 78 01 01 03 52 CDW /* Math-Symbol.12 */
SET_GFID_0198=SFG 00 1E 00 90 01 01 03 52 CDW /* Math-Symbol.10 */
SET_GFID_0204=SFG 00 CC 00 6C 01 01 03 52 CDW /* Gothic-text.13 */
SET_GFID_0221=SFG 00 DD 00 60 01 01 03 52 CDW /* Prestige.15 */
SET_GFID_0222=SFG 00 E6 00 60 01 01 03 52 CDW /* Gothic-text.15 */
SET_GFID_0223=SFG 00 DF 00 60 01 01 03 52 CDW /* Courier.15 */
SET_GFID_0225=SFG 00 E1 00 60 01 01 03 52 CDW /* Math-symbol.15 */
SET_GFID_0229=SFG 00 E5 00 60 01 01 03 52 CDW /* Serif-text.15 */
SET_GFID_0230=SFG 00 E6 00 60 01 01 03 52 CDW /* Gothic-text.15 */
SET_GFID_0245=SFG 00 2E 00 90 01 01 03 52 P05 /* Courier.Bold.5 */
SET_GFID_0252=SFG 00 FC 00 54 01 01 03 52 CDW /* Courier.15 */
SET_GFID_0253=SFG 00 FD 00 54 01 01 03 52 CDW /* Courier.Bold.17 */
SET_GFID_0254=SFG 00 FE 00 55 01 01 03 52 CDW /* Courier.17 */
SET_GFID_0280=SFG 01 18 00 48 01 01 03 52 CDW /* APL.20 */
SET_GFID_0281=SFG 01 19 00 48 01 01 03 52 CDW /* Gothic-text.20 */
SET_GFID_0290=SFG 01 22 00 36 01 01 03 52 CDW /* Gothic-text.27 */
SET_GFID_0751=SFG 11 37 00 A0 01 03 03 52 CDW /* Sonoran-serif.8pt */
SET_GFID_1051=SFG 11 37 00 C8 01 03 03 52 CDW /* Sonoran-serif.10pt */
SET_GFID_1053=SFG 11 4B 00 C8 01 03 03 52 CDW /* Sonoran-serif.bold.10pt*/
SET_GFID_1056=SFG 11 B7 00 C8 01 03 03 52 CDW /* Sonoran-serif.italic.10pt*/
SET_GFID_1351=SFG 11 37 00 F0 01 03 03 52 CDW /* Sonoran-serif.12pt */
SET_GFID_1653=SFG 11 4B 01 40 01 03 03 52 CDW /* Sonoran-serif.Bold.16pt*/
SET_GFID_2103=SFG 11 4B 01 E0 01 03 03 52 CDW /* Sonoran-serif.Bold.24pt*/

/* Color Specifications */
START_COLOR_BLUE=
END_COLOR_BLUE=
START_COLOR_GREEN=
END_COLOR_GREEN=
START_COLOR_CYAN=
END_COLOR_CYAN=
START_COLOR_RED=
END_COLOR_RED=
START_COLOR_MAGENTA=
END_COLOR_MAGENTA=
START_COLOR_YELLOW=
END_COLOR_YELLOW=
START_COLOR_BLACK=
END_COLOR_BLACK=
START_COLOR_WHITE=
END_COLOR_WHITE=

/* Highlight Specifications */
/* These definitions will determine how things which are sent by the */
/* host to be displayed or printed as underlined, reverse video, or */
/* blinking will be highlighted on your printer. */

START_HIGHLIGHT_INTENSE=SDS /* This is double strike */
END_HIGHLIGHT_INTENSE=CDS
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START_HIGHLIGHT_UNDERLINE=SUL
END_HIGHLIGHT_UNDERLINE=CUL
START_HIGHLIGHT_REVERSE_VIDEO=
END_HIGHLIGHT_REVERSE_VIDEO=
START_HIGHLIGHT_BLINK=
END_HIGHLIGHT_BLINK=

/* Character Definitions */
SPACE=SPA
EXCLAMATION_POINT=21
QUOTATION_MARKS=22
NUMBER_SIGN=23
DOLLAR_SIGN=24
PERCENT_SIGN=25
AMPERSAND=26
APOSTROPHE=27
LEFT_PARENTHESIS=28
RIGHT_PARENTHESIS=29
ASTERISK=2A
PLUS_SIGN=2B
COMMA=2C
HYPHEN=2D
PERIOD=2E
SLASH=2F
ZERO=0
ONE=1
TWO=2
THREE=3
FOUR=4
FIVE=5
SIX=6
SEVEN=7
EIGHT=8
NINE=9
COLON=3A
SEMICOLON=3B
LESS_THAN_SIGN=3C
EQUAL_SIGN=3D
GREATER_THAN_SIGN=3E
QUESTION_MARK=3F
AT_SIGN=40
A_CAPITAL=A
B_CAPITAL=B
C_CAPITAL=C
D_CAPITAL=D
E_CAPITAL=E
F_CAPITAL=F
G_CAPITAL=G
H_CAPITAL=H
I_CAPITAL=I
J_CAPITAL=J
K_CAPITAL=K
L_CAPITAL=L
M_CAPITAL=M
N_CAPITAL=N
O_CAPITAL=O
P_CAPITAL=P
Q_CAPITAL=Q
R_CAPITAL=R
S_CAPITAL=S
T_CAPITAL=T
U_CAPITAL=U
V_CAPITAL=V
W_CAPITAL=W
X_CAPITAL=X
Y_CAPITAL=Y
Z_CAPITAL=Z
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LEFT_BRACKET=5B
BACKSLASH=5C
RIGHT_BRACKET=5D
CIRCUMFLEX_ACCENT=5E
UNDERLINE=5F
GRAVE_ACCENT=60
A_SMALL=a
B_SMALL=b
C_SMALL=c
D_SMALL=d
E_SMALL=e
F_SMALL=f
G_SMALL=g
H_SMALL=h
I_SMALL=i
J_SMALL=j
K_SMALL=k
L_SMALL=l
M_SMALL=m
N_SMALL=n
O_SMALL=o
P_SMALL=p
Q_SMALL=q
R_SMALL=r
S_SMALL=s
T_SMALL=t
U_SMALL=u
V_SMALL=v
W_SMALL=w
X_SMALL=x
Y_SMALL=y
Z_SMALL=z
LEFT_BRACE=7B
VERTICAL_BAR=7C
RIGHT_BRACE=7D
TILDE_ACCENT=7E
C_CEDILLA_CAPITAL=80
U_DIAERESIS_SMALL=81
E_ACUTE_SMALL=82
A_CIRCUMFLEX_SMALL=83
A_DIAERESIS_SMALL=84
A_GRAVE_SMALL=85
A_OVERCIRCLE_SMALL=86
C_CEDILLA_SMALL=87
E_CIRCUMFLEX_SMALL=88
E_DIAERESIS_SMALL=89
E_GRAVE_SMALL=8A
I_DIAERESIS_SMALL=8B
I_CIRCUMFLEX_SMALL=8C
I_GRAVE_SMALL=8D
A_DIAERESIS_CAPITAL=8E
A_OVERCIRCLE_CAPITAL=8F
E_ACUTE_CAPITAL=90
AE_DIPTHONG_SMALL=91
AE_DIPTHONG_CAPITAL=92
O_CIRCUMFLEX_SMALL=93
O_DIAERESIS_SMALL=94
O_GRAVE_SMALL=95
U_CIRCUMFLEX_SMALL=96
U_GRAVE_SMALL=97
Y_DIAERESIS_SMALL=98
O_DIAERESIS_CAPITAL=99
U_DIAERESIS_CAPITAL=9A
O_SLASH_SMALL=9B
POUND_SIGN=9C
O_SLASH_CAPITAL=9D
MULTIPLY_SIGN=9E
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A_ACUTE_SMALL=A0
I_ACUTE_SMALL=A1
O_ACUTE_SMALL=A2
U_ACUTE_SMALL=A3
N_TILDE_SMALL=A4
N_TILDE_CAPITAL=A5
ORDINAL_INDICATOR_FEMININE=A6
ORDINAL_INDICATOR_MASCULINE=A7
QUESTION_MARK_INVERTED=A8
REGISTERED_TRADEMARK_SYMBOL=A9
LOGICAL_NOT=AA
ONE_HALF=AB
ONE_QUARTER=AC
EXCLAMATION_POINT_INVERTED=AD
LEFT_ANGLE_QUOTES=AE
RIGHT_ANGLE_QUOTES=AF
A_ACUTE_CAPITAL=B5
A_CIRCUMFLEX_CAPITAL=B6
A_GRAVE_CAPITAL=B7
COPYRIGHT_SYMBOL=B8
CENT_SIGN=BD
YEN_SIGN=BE
A_TILDE_SMALL=C6
A_TILDE_CAPITAL=C7
INTERNATIONAL_CURRENCY_SYMBOL=CF
ETH_ICELANDIC_SMALL=D0
ETH_ICELANDIC_CAPITAL=D1
E_CIRCUMFLEX_CAPITAL=D2
E_DIAERESIS_CAPITAL=D3
E_GRAVE_CAPITAL=D4
I_DOTLESS_SMALL=D5
I_ACUTE_CAPITAL=D6
I_CIRCUMFLEX_CAPITAL=D7
I_DIAERESIS_CAPITAL=D8
VERTICAL_LINE_BROKEN=DD
I_GRAVE_CAPITAL=DE
O_ACUTE_CAPITAL=E0
SHARP_S_SMALL=E1
O_CIRCUMFLEX_CAPITAL=E2
O_GRAVE_CAPITAL=E3
O_TILDE_SMALL=E4
O_TILDE_CAPITAL=E5
MICRO_SYMBOL=E6
THORN_ICELANDIC_SMALL=E7
THORN_ICELANDIC_CAPITAL=E8
U_ACUTE_CAPITAL=E9
U_CIRCUMFLEX_CAPITAL=EA
U_GRAVE_CAPITAL=EB
Y_ACUTE_SMALL=EC
Y_ACUTE_CAPITAL=ED
OVERLINE=EE
ACUTE_ACCENT=EF
SYLLABLE_HYPHEN=F0
PLUS_OR_MINUS_SIGN=F1
THREE_QUARTERS=F3
PARAGRAPH_SYMBOL=F4
SECTION_SYMBOL=F5
DIVIDE_SIGN=F6
CEDILLA=F7
DEGREE_SYMBOL=F8
DIAERESIS=F9
MIDDLE_DOT_ACCENT=FA
ONE_SUPERSCRIPT=FB
THREE_SUPERSCRIPT=FC
TWO_SUPERSCRIPT=FD
REQUIRED_SPACE=SPA
/**********************************************************************/
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/* PC5250 Internal Data Area. */
/* Do not change these statements. */
/**********************************************************************/
TOP_MARGIN=
LEFT_MARGIN=
DYNAMIC_START_JOB=00 00 00 00 00 00 00 00 00 00 00
DYNAMIC_END_JOB=00 00
DYNAMIC_SET_PAGE_LENGTH=00 00 00
PRINTER_ID=40 19
/* End of Definition File */

IBM5577.PDF File Contents
/**********************************************************************/
/* PDF FILE (PRINTER DEFINITION FILE) FOR: PS/55 Printer */
/**********************************************************************/
BEGIN_MACROS
NUL EQU 00
BEL EQU 07
BAK EQU 08
TAB EQU 09
LFF EQU 0A
VTB EQU 0B
FFF EQU 0C
CRR EQU 0D
SEL EQU 11
DC3 EQU 13
ESC EQU 1B
CAN EQU 18
SPA EQU 20
P10 EQU 1B 7E 02 00 01 32
P12 EQU 1B 7E 02 00 01 3C
P13 EQU 1B 7E 02 00 01 43
P15 EQU 1B 7E 02 00 01 4B
SDW EQU 1B 7E 0E 00 01 09
EDW EQU 1B 7E 0E 00 01 0A
SVT EQU 1B 7E 19
SHT EQU 1B 7E 18
CSS EQU 1B 7E 0E 00 01 0F
SSO EQU 1B 7E 0E 00 01 0D
SSU EQU 1B 7E 0E 00 01 0E
SUL EQU 1B 7E 11 00 01 01
CUL EQU 1B 7E 11 00 01 00
LL2 EQU 1B 7E 03 00 01 14
LL3 EQU 1B 7E 03 00 01 1E
LL4 EQU 1B 7E 03 00 01 28
LL6 EQU 1B 7E 03 00 01 3C
LL7 EQU 1B 7E 03 00 01 4B
LL8 EQU 1B 7E 03 00 01 50
SPL EQU 1B 7E 04 00 03 00
INZ EQU 1B 7E 01 00 00
EJC EQU 1B 7E 0E 00 01 06
END_MACROS
/**********************************************************************/
/* Session Parameters */
/**********************************************************************/
MAXIMUM_PAGE_LENGTH=066
MAXIMUM_PRINT_POSITION=132
DEFAULT_CPI?=010
DEFAULT_LPI?=006
COMPRESS_LINE_SPACING?=NO
FORM_FEED_ANY_POSITION?=YES
OVERRIDE_FORMATTED_PRINT?=YES
HORIZONTAL_PEL=180
VERTICAL_PEL=120
UNITS_OF_DRAW_LINE=
KANJI_CODE?=SHIFT_JIS
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ZENKAKU_SPACE=
PAGE_LENGTH_TYPE?=6INCH
/**********************************************************************/
/* Control Codes */
/**********************************************************************/
START_JOB=INZ SEL LL6 P10
END_JOB=INZ
BACKSPACE=BAK
BEL=BEL
CARRIAGE_RETURN=CRR
NEW_LINE=CRR LFF
LINE_FEED=LFF
FORM_FEED=EJC
HORIZONTAL_TAB=TAB
VERTICAL_TAB=VTB
DESELECT=DC3
START_SUBSCRIPT=SSU
END_SUBSCRIPT=CSS
START_SUPERSCRIPT=SSO
END_SUPERSCRIPT=CSS
DUP=*
FIELD_MARK=;
SET_HORIZONTAL_TABS=SHT length(HL)-values
SET_VERTICAL_TABS=SVT length(HL)-values
SET_HORIZONTAL_MARGINS=
SET_PAGE_LENGTH=SPL word-value(HL)
SET_2_LINES_PER_INCH=LL2
SET_3_LINES_PER_INCH=LL3
SET_4_LINES_PER_INCH=LL4
SET_6_LINES_PER_INCH=LL6
SET_7.5_LINES_PER_INCH=LL7
SET_8_LINES_PER_INCH=LL8
SET_10_CHARACTERS_PER_INCH=P10
SET_12_CHARACTERS_PER_INCH=P12
SET_13.4_CHARACTERS_PER_INCH=P13
SET_15_CHARACTERS_PER_INCH=P15
START_DOUBLE_WIDTH_CHARACTERS=SDW
END_DOUBLE_WIDTH_CHARACTERS=EDW
IMAGE_TRANSMISSION=1B 25 31 length(HL)-images
FORWARD_HORIZONTAL_SKIP=1B 25 33 word-value(HL)
FORWARD_VERTICAL_STEP_FEED=1B 25 35 word-value(HL)
SET_FONT_SIZE=1B 7E 20 00 03 word-value(HL) 02
SET_TATEGAKI_MODE=1B 7E 0E 00 01 0B
RESET_TATEGAKI_MODE=1B 7E 0E 00 01 0C
SBCS_FONT_LOAD=1B 7E 81 00 28 F0 40 00 18 byte-values F0 40
DBCS_FONT_LOAD=1B 7E 81 00 4C F0 40 02 18 byte-values F0 40
SELECT_DRAWER=
SET_LOCAL_FONT=
RESET_LOCAL_FONT=
ABS_HORIZONTAL_COLUMN_SKIP=1B 7E 1C 00 02 00 byte-value
REL_HOR_COLUMN_SKIP_TO_RIGHT=1B 7E 1C 00 02 01 byte-value
SET_SOLID_LINE_TYPE=
SET_DOTTED_LINE_TYPE=
SET_LINE_WIDTH_THIN=
SET_LINE_WIDTH_BOLD=
DRAW_LINE=
KANJI_ON=
KANJI_OFF=
ATTRIBUTE_GRID_LINE=1B 7E 16 length(HL)-values
/**********************************************************************/
/* Highlight Specifications */
/**********************************************************************/
START_HIGHLIGHT_INTENSE=ESC 7E 0E 00 01 17
END_HIGHLIGHT_INTENSE=ESC 7E 0E 00 01 18
START_HIGHLIGHT_UNDERLINE=1B 7E 11 00 01 01
END_HIGHLIGHT_UNDERLINE=1B 7E 11 00 01 00
/**********************************************************************/
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/* Internal Data Area. */
/* Do not change these statement. */
/**********************************************************************/
TOP_MARGIN=
LEFT_MARGIN=
DYNAMIC_START_JOB=00 00 00 00 00 00 00 00 00 00 00
DYNAMIC_END_JOB=00 00
DYNAMIC_SET_PAGE_LENGTH=00 00 00
PRINTER_ID=55 77
/* End of Definition File */

Field Names of Printer Definition Files
Table 23 lists the field names of the printer definition files (PDF files) and their
meanings:

Table 23. Field Names of PDF Files

Field Name Meaning Remarks

MAXIMUM_PAGE_LENGTH Default MPL Default is 66

MAXIMUM_PRINT_POSITION Default MPP Default is 132

DEFAULT_CPI? Default CPI Default is 10

DEFAULT_LPI? Default LPI Default is 6

COMPRESS_LINE_SPACING? Specifies whether to print a line containing
only space characters or nonprint
characters.

FORM_FEED_ANY_POSITION? Specifies whether to validate the FF control
code on the first line.

Do not change this field.

OVERRIDE_FORMATTED_PRINT? Specifies whether to print NULL characters
as blanks.

Do not change this field.

HORIZONTAL_PEL FORWARD_HORIZONTAL_SKIP length
unit

VERTICAL_PEL FORWARD_VERTICAL_SKIP length unit

IMAGE_HORIZONTAL_PEL IMAGE_TRANSMISSION horizontal length
unit

IMAGE_VERTICAL_PEL IMAGE_TRANSMISSION vertical length
unit

LINE_SPACING_RATIO SET_VARIABLE_LINE_DENSITY length
unit

PAGE_LENGTH_TYPE? SET_PAGE _LENGTH page length
parameter type

FIRST_LEFT_POSITION Distance from left paper edge

FIRST_TOP_POSITION Distance from top paper edge

DRAWER1_ORIENTATION Default page orientation for drawer 1 Default is COR

DRAWER2_ORIENTATION Default page orientation for drawer 2 Default is COR

AUTOMATIC_ORIENTATION Specifies whether to calculate the page
orientation.

START_JOB Printer control code sent to a printer to start
printing

If the control code
specifying LPI/CPI is
defined, also change
DEFAULT_CPI,
DEFAULT_LPI.
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Table 23. Field Names of PDF Files (continued)

Field Name Meaning Remarks

END_JOB Printer control code sent to a printer when
printing ends

BACKSPACE Backspace control code

BEL Bell control code Specifies the number of
blank lines to send in
Print Screen Collection
mode

CARRIAGE_RETURN Carriage return control code

NEW_LINE New line (CR/LF) control code

LINE_FEED New line control code

FORM_FEED Form feed (FF) control code

HORIZONTAL_TAB Horizontal tab control code

VERTICAL_TAB Vertical tab control code

DESELECT Device control 3 control code

START_SUBSCRIPT Subscript character specification

END_SUBSCRIPT Subscript character specification release

START_SUPERSCRIPT Superscript character specification

END_SUPERSCRIPT Superscript character specification release

DUP Character used for printing DUP codes

FIELD_MARK Character used for printing FIELD MARK
characters

SET_HORIZONTAL_TABS Horizontal tab setup Do not change this field.

SET_VERTICAL_TABS Vertical tab setup Do not change this field.

SET_HORIZONTAL_MARGINS Right and left margin setup Do not change this field.

SET_PAGE_LENGTH Page length setup Assign the unit used for
the defined control code
page length to the
PAGE_LENGTH_TYPE
field. When single sheets
are to be used, delete this
field.

SET_VARIABLE_LINE_DENSITY Line density setup Assign the unit used for
the control code length
defined to
LINE_SPACING_RATIO
field.

SET_2_LINES_PER_INCH New line pitch (2LPI) setup

SET_3_LINES_PER_INCH New line pitch (3LPI) setup

SET_4_LINES_PER_INCH New line pitch (4LPI) setup

SET_6_LINES_PER_INCH New line pitch (6LPI) setup

SET_8_LINES_PER_INCH New line pitch (8LPI) setup

SET_10_LINES_PER_INCH New line pitch (10LPI) setup

SET_10_CHARACTERS_PER_INCH Character pitch (10CPI) setup

SET_12_CHARACTERS_PER_INCH Character pitch (12CPI) setup
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Table 23. Field Names of PDF Files (continued)

Field Name Meaning Remarks

SET_13_CHARACTERS_PER_INCH Character pitch (13CPI) setup

SET_15_CHARACTERS_PER_INCH Character pitch (15CPI) setup

SET_17_CHARACTERS_PER_INCH Character pitch (17CPI) setup

SET_20_CHARACTERS_PER_INCH Character pitch (20CPI) setup

IMAGE_TRANSMISSION Image data setup (vertical 24-dot image)

SELECT_DRAWER1 Page tray (Primary) setup

SELECT_DRAWER2 Page tray (Alternate) setup

SELECT_ENVELOPE Envelope tray setup

SELECT_DRAFT_QUALITY Draft print quality setup

SELECT_LETTER_QUALITY Letter print quality setup

SELECT_ENHANCED_QUALITY Enhanced print quality setup

SET_DUPLEX Duplex printing setup

SET_DUPLEX_TUMBLE Duplex (tumble) printing setup

RESET_DUPLEX Duplex printing release

SET_PORTRAIT_ORIENT Page orientation (Normal portrait (upright))
setup

SET_LANDSCAPELEFT_ORIENT Page orientation (Landscape left (270 degree
clockwise rotation of text)) setup

SET_PORTRAITUPDWN_ORIENT Page orientation (Portrait upside down (180
degree clockwise rotation of text)) setup

SET_LANDSCAPERGHT_ORIENT Page orientation (Landscape right (90
degree clockwise rotation of text)) setup

FORWARD_HORIZONTAL_SKIP Variable skip (relative position/dot unit) Assign the unit of the
defined control code
length to the
HORIZONTAL_PEL field.

FORWARD_VERTICAL_STEP_FEED Variable line feed (relative position/dot
unit)

Assign the unit of the
defined control code
length to the
VERTICAL_PEL field.

SET_FONT_GLOBAL Global font ID setup Do not change this field.

SET_GFID_0003 GFID 3 (OCR-B) setup

SET_GFID_0005 GFID 5 (Orator) setup

SET_GFID_0011 GFID 11 (Courier 10) setup

SET_GFID_0012 GFID 12 (Prestige Pica) setup

SET_GFID_0013 GFID 13 (Artisan 10) setup

SET_GFID_0018 GFID 18 (Courier Italic 10) setup

SET_GFID_0019 GFID 19 (OCR-A) setup

SET_GFID_0020 GFID 20 (Pica) setup

SET_GFID_0030 GFID 30 (Math Symbol 10) setup

SET_GFID_0038 GFID 38 (Orator Bold) setup

SET_GFID_0039 GFID 39 (Gothic Bold 10) setup

SET_GFID_0040 GFID 40 (Gothic Text 10) setup
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Table 23. Field Names of PDF Files (continued)

Field Name Meaning Remarks

SET_GFID_0041 GFID 41 (Roman Text 10) setup

SET_GFID_0042 GFID 42 (Serif Text 10) setup

SET_GFID_0043 GFID 43 (Serif Italic 10) setup

SET_GFID_0044 GFID 44 (Katakana 10) setup

SET_GFID_0045 GFID 45 (APL 10) setup

SET_GFID_0046 GFID 46 (Courier Bold 10) setup

SET_GFID_0050 GFID 50 (Shalom 10) setup

SET_GFID_0066 GFID 66 (Gothic Text 12) setup

SET_GFID_0068 GFID 68 (Gothic Italic 12) setup

SET_GFID_0069 GFID 69 (Gothic Bold 12) setup

SET_GFID_0070 GFID 70 (Serif Text 12) setup

SET_GFID_0071 GFID 71 (Serif Italic 12) setup

SET_GFID_0072 GFID 72 (Serif Bold 12) setup

SET_GFID_0080 GFID 80 (Math Symbol 12) setup

SET_GFID_0084 GFID 84 (Script 12) setup

SET_GFID_0085 GFID 85 (Courier 12) setup

SET_GFID_0086 GFID 86 (Prestige Elite) setup

SET_GFID_0087 GFID 87 (Letter Gothic 12) setup

SET_GFID_0091 GFID 91 (Light Italic 12) setup

SET_GFID_0110 GFID 110 (Letter Gothic Bold 12) setup

SET_GFID_0111 GFID 111 (Prestige Elite Bold) setup

SET_GFID_0112 GFID 112 (Prestige Elite Italic) setup

SET_GFID_0115 GFID 115 (Math Symbol 12) setup

SET_GFID_0155 GFID 155 (Boldface Italic) setup

SET_GFID_0158 GFID 158 (Modern) setup

SET_GFID_0159 GFID 159 (Boldface) setup

SET_GFID_0160 GFID 160 (Essay) setup

SET_GFID_0162 GFID 162 (Essay Italic) setup

SET_GFID_0163 GFID 163 (Essay Bold) setup

SET_GFID_0168 GFID 168 (Barak PSM) setup

SET_GFID_0173 GFID 173 (Essay Light) setup

SET_GFID_0175 GFID 175 (Document) setup

SET_GFID_0176 GFID 176 (Boldface) setup

SET_GFID_0177 GFID 177 (Boldface Italic) setup

SET_GFID_0193 GFID 193 (Math Symbol 12) setup

SET_GFID_0198 GFID 198 (Math Symbol 10) setup

SET_GFID_0204 GFID 204 (Gothic Text 13) setup

SET_GFID_0221 GFID 221 (Prestige 15) setup

SET_GFID_0222 GFID 222 (Gothic Text 15) setup

SET_GFID_0223 GFID 223 (Courier 15) setup
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Table 23. Field Names of PDF Files (continued)

Field Name Meaning Remarks

SET_GFID_0225 GFID 225 (Math Symbol 15) setup

SET_GFID_0229 GFID 229 (Serif Text 15) setup

SET_GFID_0230 GFID 230 (Gothic Text 15) setup

SET_GFID_0245 GFID 245 (Courier Bold 5) setup

SET_GFID_0252 GFID 252 (Courier 17) setup

SET_GFID_0253 GFID 253 (Courier Bold 17) setup

SET_GFID_0254 GFID 254 (Courier 17 (sub/super)) setup

SET_GFID_0280 GFID 280 (APL 20) setup

SET_GFID_0281 GFID 281 (Gothic Text 20) setup

SET_GFID_0290 GFID 290 (Gothic Text 27) setup

SET_GFID_0751 GFID 751 (Sonoran-Serif 8-pt Roman
Medium) setup

SET_GFID_1051 GFID 1051 (Sonoran-Serif 10-pt Roman
Medium) setup

SET_GFID_1053 GFID 1053 (Sonoran-Serif 10-pt Roman
Bold) setup

SET_GFID_1056 GFID 1056 (Sonoran-Serif 10-pt Italic
Medium) setup

SET_GFID_1351 GFID 1351 (Sonoran-Serif 12-pt Roman
Medium) setup

SET_GFID_1653 GFID 1653 (Sonoran-Serif 16-pt Roman
Bold) setup

SET_GFID_2103 GFID 2103 (Sonoran-Serif 24-pt Roman
Bold) setup

START_HIGHLIGHT_INTENSE Highlight printing setup

END_HIGHLIGHT_INTENSE Highlight printing release

START_HIGHLIGHT_UNDERLINE Underline setup

END_HIGHLIGHT_UNDERLINE Underline release

TOP_MARGIN Default top margin Do not change this field.

LEFT_MARGIN Default left margin Do not change this field.

DYNAMIC_START_JOB Printer control code sent to a printer to start
printing (internal use)

Do not change this field.

DYNAMIC_END_JOB Printer control code sent to a printer to stop
printing (internal use)

Do not change this field.

DYNAMIC_SET_PAGE_LENGTH Page length setup control code sent to a
printer at the start of printing (internal use)

Do not change this field.

PRINTER_ID Printer ID Do not change this field.

KANJI_CODE? Used kanji codes (JIS or SHIFT_JIS) Do not change this field.

ZENKAKU_SPACE The size (adjustment unit) of a user-defined
character and a HANKAKU character

Do not change this field.

SBCS_FONT_LOAD Registration of a HANKAKU GAIJI Do not change this field.

DBCS_FONT_LOAD Registration of a ZENKAKU GAIJI Do not change this field.
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Table 23. Field Names of PDF Files (continued)

Field Name Meaning Remarks

SET_LOCAL_FONT Set a font set of user-defined characters Remove this field when
user-defined characters
are not loaded to a
printer.

RESET_LOCAL_FONT Reset a font set of user-defined characters Remove this field when
user-defined characters
are not loaded to a
printer.

KANJI_ON Set kanji mode

KANJI_OFF Reset kanji mode

ATTRIBUTE_GRID_LINE Grid-line print Do not change this field.

START_DOUBLE_WIDTH_CHARACTER Set a double-width character

END_DOUBLE_WIDTH_CHARACTER Reset a double-width character

Notes:

1. When using IBM5577.PDF, change FORM_FEED=EJC to FORM_FEED in the
file when a continuous form job does not feed correctly.

2. When using ESC_P.PDF, DBCS (2-byte) characters are placed to the left of the
character box, not in the center. To place DBCS characters in the center of the
character box, change the IBM-supplied values in ESC_P.PDF:

P10 EQU 1B 50 1B 20 00 1C 53 00 0C 1C 54 00 00
P12 EQU 1B 4D 1B 20 00 1C 53 00 06 1C 54 00 00
P13 EQU 1B 67 1B 20 01 1C 53 00 03 1C 54 00 01
P15 EQU 1B 67 1B 20 00 1C 53 00 00 1C 54 00 00

to the following:
P10 EQU 1B 50 1B 20 00 1C 53 06 06 1C 54 00 00
P12 EQU 1B 4D 1B 20 00 1C 53 03 03 1C 54 00 00
P13 EQU 1B 67 1B 20 01 1C 53 02 01 1C 54 00 01
P15 EQU 1B 67 1B 20 00 1C 53 00 00 1C 54 00 00

The following table lists the session parameter field names and their effective
values:

Table 24. Effective Values for PDF File Field Names

Field Name Effective Value

MAXIMUM_PAGE_LENGTH 001 to 255

MAXIMUM_PRINT_POSITION 001 to 255

DEFAULT_CPI? 010/012/015

DEFAULT_LPI? 004/006/008

COMPRESS_LINE_SPACING? YES/NO

FORM_FEED_ANY_POSITION? YES/NO

OVERRIDE_FORMATTED_PRINT? YES/NO

HORIZONTAL_PEL FORWARD_HORIZONTAL_SKIP length
unit

VERTICAL_PEL FORWARD_VERTICAL_ STEP_FEED length
unit

IMAGE_HORIZONTAL_PEL IMAGE_TRANSMISSION horizontal unit
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Table 24. Effective Values for PDF File Field Names (continued)

Field Name Effective Value

IMAGE_VERTICAL_PEL IMAGE_TRANSMISSION vertical unit

LINE_SPACING_RATIO SET_VARIABLE_LINE_DENSITY length unit

PAGE_LENGTH_TYPE? LINE/INCH/6INCH*

FIRST_LEFT_POSITION 000 to 1440 in units of 1/1440 inch

FIRST_TOP_POSITION 000 to 1440 in units of 1/1440 inch

DRAWER1_ORIENTATION LANDSCAPE/PORTRAIT/COR

DRAWER2_ORIENTATION LANDSCAPE/PORTRAIT/COR

AUTOMATIC_ORIENTATION YES/NO

* 6/INCH indicates that page length should be specified in units of 1/6 inch.

Notes:

1. If one of the desired CPI/LPI settings is not exactly supported by the printer,
set the nearest value. The results of printing might not be as desired.

2. If the units used to specify the control code length defined in
FORWARD_HORIZONTAL _SKIP and FORWARD_VERTICAL _STEP_FEED
are not the same as the units used to specify the HORIZONTAL_PEL and
VERTICAL_PEL, the desired output will not be obtained.

3. If the units used to specify the control code length defined in
SET_VARIABLE_LINE_DENSITY are not the same as the units used to specify
the LINE_SPACING_RATIO, the desired output will not be obtained.

4. When FIRST_LEFT_POSITION and FIRST_TOP_POSITION are specified, their
values are regarded as specifying the unprintable area in the page of the
printer. These values are included in the top margin and the left margin
specified by the iSeries printer control code.

Symbols of Printer Definition Files
The following table lists the symbols that are defined for printer definition files.

Table 25. Printer Symbol Definitions

Field Name Symbol

SPACE

EXCLAMATION_POINT !

QUOTATION_MARKS "

NUMBER_SIGN #

DOLLAR_SIGN $

PERCENT_SIGN %

AMPERSAND &

APOSTROPHE ’

LEFT_PARENTHESIS (

RIGHT_PARENTHESIS )

ASTERISK *

PLUS_SIGN +

COMMA ,
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Table 25. Printer Symbol Definitions (continued)

Field Name Symbol

HYPHEN -

PERIOD .

SLASH /

ZERO 0

ONE 1

TWO 2

THREE 3

FOUR 4

FIVE 5

SIX 6

SEVEN 7

EIGHT 8

NINE 9

COLON :

SEMICOLON ;

LESS_THAN_SIGN <

EQUAL_SIGN =

GREATER_THAN_SIGN >

QUESTION_MARK ?

AT_SIGN @

A_CAPITAL A

B_CAPITAL B

C_CAPITAL C

D_CAPITAL D

E_CAPITAL E

F_CAPITAL F

G_CAPITAL G

H_CAPITAL H

I_CAPITAL I

J_CAPITAL J

K_CAPITAL K

L_CAPITAL L

M_CAPITAL M

N_CAPITAL N

O_CAPITAL O

P_CAPITAL P

Q_CAPITAL Q

R_CAPITAL R

S_CAPITAL S

T_CAPITAL T
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Table 25. Printer Symbol Definitions (continued)

Field Name Symbol

U_CAPITAL U

V_CAPITAL V

W_CAPITAL W

X_CAPITAL X

Y_CAPITAL Y

Z_CAPITAL Z

LEFT_BRACKET [

BACKSLASH \

RIGHT_BRACKET ]

CIRCUMFLEX_ACCENT ^

UNDERLINE _

GRAVE_ACCENT

A_SMALL a

B_SMALL b

C_SMALL c

D_SMALL d

E_SMALL e

F_SMALL f

G_SMALL g

H_SMALL h

I_SMALL i

J_SMALL j

K_SMALL k

L_SMALL l

M_SMALL m

N_SMALL n

O_SMALL o

P_SMALL p

Q_SMALL q

R_SMALL r

S_SMALL s

T_SMALL t

U_SMALL u

V_SMALL v

W_SMALL w

X_SMALL x

Y_SMALL y

Z_SMALL z

LEFT_BRACE {

VERTICAL_BAR │
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Table 25. Printer Symbol Definitions (continued)

Field Name Symbol

RIGHT_BRACE }

TILDE_ACCENT

C_CEDILLA_CAPITAL Ç

U_DIAERESIS_SMALL ü

E_ACUTE_SMALL é

A_CIRCUMFLEX_SMALL â

A_DIAERESIS_SMALL ä

A_GRAVE_SMALL à

A_OVERCIRCLE_SMALL å

C_CEDILLA_SMALL ç

E_CIRCUMFLEX_SMALL ê

E_DIAERESIS_SMALL ë

E_GRAVE_SMALL è

I_DIAERESIS_SMALL ï

I_CIRCUMFLEX_SMALL î

I_GRAVE_SMALL ì

A_DIAERESIS_CAPITAL Ä

A_OVERCIRCLE_CAPITAL Å

E_ACUTE_CAPITAL É

AE_DIPTHONG_SMALL æ

AE_DIPTHONG_CAPITAL Æ

O_CIRCUMFLEX_SMALL ô

O_DIAERESIS_SMALL ö

O_GRAVE_SMALL ò

U_CIRCUMFLEX_SMALL û

U_GRAVE_SMALL ù

Y_DIAERESIS_SMALL ÿ

O_DIAERESIS_CAPITAL Ö

U_DIAERESIS_CAPITAL Ü

O_SLASH_SMALL ø

POUND_SIGN £

O_SLASH_CAPITAL Ø

MULTIPLY_SIGN ×

A_ACUTE_SMALL á

I_ACUTE_SMALL í

O_ACUTE_SMALL ó

U_ACUTE_SMALL ú

N_TILDE_SMALL ñ

N_TILDE_CAPITAL Ñ

ORDINAL_INDICATOR_FEMININE a
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Table 25. Printer Symbol Definitions (continued)

Field Name Symbol

ORDINAL_INDICATOR_MASCULINE o

QUESTION_MARK_INVERTED ¿

REGISTERED_TRADEMARK_SYMBOL

LOGICAL_NOT ¬

ONE_HALF ½

ONE_QUARTER ¼

EXCLAMATION_POINT_INVERTED ¡

LEFT_ANGLE_QUOTES «

RIGHT_ANGLE_QUOTES »

A_ACUTE_CAPITAL Á

A_CIRCUMFLEX_CAPITAL Â

A_GRAVE_CAPITAL À

COPYRIGHT_SYMBOL ©

CENT_SIGN ¢

YEN_SIGN ¥

A_TILDE_SMALL ã

A_TILDE_CAPITAL Ã

E_CIRCUMFLEX_CAPITAL Ê

E_DIAERESIS_CAPITAL Ë

I_ACUTE_CAPITAL Í

I_CIRCUMFLEX_CAPITAL Î

I_DIAERESIS_CAPITAL Ï

VERTICAL_LINE_BROKEN ¦

I_GRAVE_CAPITAL Ì

O_ACUTE_CAPITAL Ó

O_CIRCUMFLEX_CAPITAL Ô

O_GRAVE_CAPITAL Ò

O_TILDE_SMALL õ

O_TILDE_CAPITAL Õ

MICRO_SYMBOL µ

U_ACUTE_CAPITAL Ú

U_CIRCUMFLEX_CAPITAL Û

U_GRAVE_CAPITAL Ù

ACUTE_ACCENT u

SYLLABLE_HYPHEN -

PLUS_OR_MINUS_SIGN ±

THREE_QUARTERS ¾

PARAGRAPH_SYMBOL ¶

SECTION_SYMBOL §

DIVIDE_SIGN ÷
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Table 25. Printer Symbol Definitions (continued)

Field Name Symbol

DEGREE_SYMBOL °

ONE_SUPERSCRIPT ¹

THREE_SUPERSCRIPT ³

TWO_SUPERSCRIPT ²

REQUIRED_SPACE

INTERNATIONAL_CURRENCY_SYMBOL ¤

ETH_ICELANDIC_SMALL ð

ETH_ICELANDIC_CAPITAL Ð

SHARP_S_SMALL ß

THORN_ICELANDIC_SMALL þ

THORN_ICELANDIC_CAPITAL Þ

Y_ACUTE_SMALL ý

Y_ACUTE_CAPITAL Ý

OVERLINE ‾

CEDILLA q

DIAERESIS ..

MIDDLE_DOT_ACCENT ·

Using Printer Control Codes
This section explains the SNA Character String (SCS) control codes, or Final Form
Text: Document Content Architecture (FFT DCA).

For details of iSeries printer control codes, refer to AS/400 Guide to Programming for
Printing.

Printer Control Code Format
Some printer control codes perform single, specific functions by themselves, while
others perform multiple functions according to the parameters specified after the
control code.

A printer control code with parameters has the following format:

Control Code Count Parameter 1 Parameter 2...

1 or 2 bytes 1 byte 1 or 2 bytes 1 or 2 bytes

A count consists of 1 byte, and indicates the length of the parameters (including
the count) after the control code, in bytes. For example, a count and two 1-byte
parameters is shown as X'03', because the count itself is included. Some control
codes, such as the Printing Position (PP) control code, do not have counts.

A parameter can be 1 or 2 bytes in length. The number of bytes depends on the
control codes. Not all control codes have parameters.
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Note: In this manual, counts and parameters that are actually processed in binary
are all expressed in hexadecimal (0–F) to improve readability.

Parameter Definition of Printer Control Codes
Some printer control codes require that parameters be specified. Pay particular
attention when defining a parameter because how this is done depends on the
parameter type. If the definition method for another type is used, the desired
output will not be obtained.

The following table lists printer control code parameter types and their meanings:

Table 26. Printer Control Code Parameter Types

Parameter Type Meaning

byte-value One-byte parameter.

byte-values Multibyte parameter.
Used if operands are fixed.

word-value(HL) One-word parameter (higher and lower bytes).

word-value(LH) One-word parameter (lower and higher bytes).

length(HL)-values Multibyte parameter requiring operands.
An operand consists of a higher and lower byte.
Used if operands are variable.

length(LH)-values Multibyte parameter requiring operands.
An operand consists of a lower and higher byte.
Used if operands are variable.

length(HL)-images Image data requiring operands.
An operand consists of a higher and lower byte.

length(LH)-images Image data requiring operands.
An operand consists of a lower and higher byte.

decimal-characters Decimal characters parameter.

Supported Control Codes
Personal Communications supports all control codes for the 3812 printer.

Supported SCS Commands
Table 27. Supported SCS Commands

SCS Command Abbreviation Hexadecimal Code Function

Character Attribute

Set Font Size Scaling SFSS 2BFDnn02xxyy Specifies the font-size scaling for
expansion.

Character Set Control

Load Alternate Character

(DBCS only)

LAC 2BFEnnmmee Loads the alternate character font.

Set CGCS1 Through Local
ID

SCL 2BD1nn810B Specifies the character set for each
language.

Set Character Distance SCD 2BD2nn29xxxx Selects the pitch and font.

Set Font ID Through GFID2 SFG 2BD1nn05xxxxyyyyzz Selects the font.
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Table 27. Supported SCS Commands (continued)

SCS Command Abbreviation Hexadecimal Code Function

Set GCSGID3 Through
GCID4

SCG 2BD1nn01xxxxyyyy Specifies the code page.

Set Presentation of Control
Character

SPCC 2BFDnn03xxxx Specifies the treatment of SO and SI.

Shift Out

(DBCS only)

SO 0E Start of DBCS field.

Shift In

(DBCS only)

SI 0F End of DBCS field.

Device Control

Bell BEL 2F Ignored.

Null NUL 00 Ignored.

Repeat RPT 0A Ignored.

Set Exception Action SEA 2BD2nn85p1–pn Specifies the explicit action.

Set Initial Conditions SIC 2BD2nn45xx Sets the environment of the EBCDIC
transform.

Set Print Setup SPSU 2BD2nn4Cp1–pn Ignored.

Switch SW 2A Ignored.

Generation Control

Begin Emphasis BES 2BD1nn8Axx Begins emphasis.

Begin Overstrike BOS 2BD4nn72wwxxyyyyzzzz Begins overstriking.

Begin Underscore BUS 2BD4nn0Axxyy Begins underscoring.

Enable Presentation ENP 14 Ignored.

End Emphasis EES 2BD1nn8Exx Ends emphasis.

End Overstrike EOS 2BD4nn76 Ends overstriking.

End Underscore EUS 2BD4nn0E Ends underscoring.

Inhibit Presentation INP 24 Ignored.

Justify Text Field JTF 2BD2nn03xxxxyy Justifies the following text.

Set Graphic Error Action SGEA 2BC8nnxxyy Specifies how to process a received
unprintable character font.

Set Justify Mode SJM 2BD2nn0Dxxyy Justifies each line of text between the
left and right margins.

Subscript SBS 38 Subscript.

Substitute SUB 3F Synonym for the graphic exception
character.

Superscript SPS 09 Superscript.

Word Underscore WUS 23 Underscore the entire word
immediately preceding the control.

Grid Control

Define Grid Line DGL 2BFDnn00 xxyyG1∼Gn Specifies and prints the grid line

Print Format Control

Form Feed FF 0C Moves the printing position to the next
page.
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Table 27. Supported SCS Commands (continued)

SCS Command Abbreviation Hexadecimal Code Function

Page Presentation Media PPM 2BD2nn48ssssuuvv
wwxxyyzz

Specifies the forms setting, the source
drawer, the quality, and the duplex
function.

Required Form Feed RFF 3A Moves the printing position to the next
page and restores the indent level to
the left margin.

Set Horizontal Format SHF 2BC1nnxxyyzzt1–tn Specifies the maximum print position,
the left and right margins, and the
horizontal tab stops in units of 1
character.

Set Horizontal Margins SHM 2BD2nn11xxxxyyyy Sets the left and right margins in units
of 1/1440 inch.

Set IGC Type SIT 2BFDnn010000 Specifies the pitch of DBCS characters

Set Presentation Page Size SPPS 2BD2nn40xxxxyyyy Specifies the presentation surface
width and depth.

Set Text Orientation STO 2BD3nnF6xxxxyyyy Specifies the page rotation.

Set Vertical Format SVF 2BC2nnxxyyzzt1–tn Specifies the maximum print line, the
top and bottom margins, and the
vertical tab stops in units of 1
character.

Set Vertical Margins SVM 2BD2nn49xxxxyyyy Sets the top and bottom margins in
units of 1/1440 inch.

Printing Position Control

Backspace BS 16 Moves the printing position to the left
one font width.

Carriage Return CR 0D Moves the printing position to the left
margin.

Horizontal Tab HT 05 Moves the printing position right to
the next tab stop.

Indent Tab IT 39 Moves the printing position right to
the next tab stops and sets the indent
level one tab stop further to the right.

Index Return IRT 33 Synonym for “Required New Line.”

Interchange Record
Separator

IRS 1E Synonym for “New Line.”

Line Feed LF 25 Moves the printing position one line
vertically.

New Line NL 15 Moves the printing position to the left
margin of the next line.

Numeric Backspace NBS 36 Synonym for “Backspace.”

Presentation Position PP 34fpxx Moves the printing position.

Release Left Margin RLM 2BD2nn0B Ignored.

Required New Line RNL 06 Moves the printing position to the left
margin of the next line and resets any
pending indent level.

Set Horizontal Tab Stops STAB 2BD2nn01xxt1–tn Specifies the tab stops.

222 Personal Communications Administrator’s Guide and Reference



Table 27. Supported SCS Commands (continued)

SCS Command Abbreviation Hexadecimal Code Function

Set Indent Level SIL 2BD2nn07xx Sets the indent level to the specific tab
stop.

Set Line Density SLD 2BC6nnxx Specifies the line pitch in units of 1/72
inch.

Set Line Spacing SLS 2BD2nn09xx Specifies the number of lines spaced
by a new line control.

Set Single Line Distance SSLD 2BD2nn15xxxx Specifies the line pitch in units of
1/1440 inch.

Unit Backspace UBS 1A Moves the printing position 1/60 inch
to the left.

Vertical Tab VT 0B Moves the printing position down to
the next tab stop.

Transparent Control

ASCII Transparent ATRN 03 Allows printer commands and ASCII
data to be passed to the printer.

Transparent TRN 35nn Allows printer commands and ASCII
data to be passed to the printer.

Note:
1 Coded Graphic Character Set
2 Global Font ID
3 Graphic Character Set Global Identifier
4 Graphic Character set ID

Legend:
nn: Count
fp: Function parameter
ee, gg, hh, il–ix, mm, nn, p1–pn, ss, t1–tn, uu, vv, ww, xx, yy, zz: Numeric parameter

Programming Notes
This section briefly explains how a printer reacts if a partial control code is
received, or if an incomplete control code is sent.

If the transmission of a control code is interrupted, the printer waits for the
remaining part of the code. If the data stream (the series of data units and control
codes) sent after the interruption is consistent with the data stream sent before the
interruption, (that is, if one complete printer control code is restored by chaining),
the control code is processed as is.

If the two parts of the data stream are inconsistent, an error occurs. A negative
response to an “Invalid Printer Parameter” is sent to the host system, or treated as
a no-op (no operation; ignored because of a meaningless code). Detailed
information is not sent to the host system if an error occurs in a control code. After
programming, the data stream must be checked thoroughly by repeating the
printing test.

Restrictions and Notes for iSeries Printer Commands and
Printer Setup

This section provides supplementary notes and explains restrictions for printing.
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Printer Control Codes
Table 28. Printer Control Codes

Printer Control Code If Use PDT file is Selected:
If a Windows Printer Driver
is Used:

SCD — Set the Character
Density

Select the GFID for the valid character distance (CD)
parameter as shown in Table 29.

If the specified font is not
supported, a substitution is
provided. For example, when
15 CPI font is specified but
the font is not supported, the
supported 17 CPI font is
substituted.

See “How to Determine
PC400 Font” on page 225.

SFG — Set Font ID through
GFID

Recognizable GFIDs are restricted. (See “Field Names of
Printer Definition Files” on page 208.) If the specified GFID
is not supported and it is out of the range from 154 through
200, the closest font width from the fonts shown in Table 30
on page 225 is substituted.

If the specified GFID is not supported and it is between 154
and 200, the following font is substituted: Font name:
Document; GFID value:175.

See “How to Determine
PC400 Font” on page 225.

BUS — Begin Underscore The selected font might not
support the underscore.

BES — Begin Emphasis The selected font might not
support the emphasis.

STO — Set Text Orientation The page orientation can be
changed to portrait or
landscape. The direction,
which is up, down, left, or
right on the paper, depends
on the Microsoft Windows
printer driver. If the page
orientation is changed, the
current paper is ejected.

PPM — Page Presentation
Media

The following parameters are supported for PDTs in DBCS
mode:
v Forms Control (FC)
v Source Drawer (SD)
v Duplex (DX)

Other parameters are ignored.

Table 29. SCD Parameter Values

CD Parameter Character Pitch (normal) GFID Value (COR)

000A 10 CPI 13 CPI 204
000B Proportional 13 CPI 175
000C 12 CPI 15 CPI 86
000F 15 CPI 20 CPI 230
00FF 10 CPI 13 CPI 204
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The following table lists only the most commonly used GFIDs. See Table 31 for the
complete list.

Table 30. Commonly Used SFG GFID Values

Font Name GFID value

Courier Bold 5 245
Courier 10 11
Prestige Elite 12 86
Gothic-text 13 204
Gothic-text 15 230
Courier 17 252
Gothic-text 20 281
Gothic-text 27 290

When you use the Windows printer driver, the spooler must be on.

How to Determine PC400 Font
When a print job is created on iSeries, a certain font, identified by font ID (GFID),
is associated with it. Such a font can be specified by the following parameters:
v Font family
v Pitch and family
v Character set
v Width
v Height
v Weight
v Style

System fonts are available with all print drivers, and more flexible device fonts are
unique to each printer and printer driver. These fonts are also more fixed as to
CPI, weight, code pages, and other criteria that can preclude use of it when
matching to the host specified needs.

There are problems associated with mapping an iSeries font to a PC font. When
your PC has all of the fonts that you need, use the following table to determine the
best font to use.

Table 31. iSeries Font Parameters

Entry ID Font
Family

GFID Pitch &
Family

Character
Set

Width Height Weight Style

GFID0003 OCR-B 3 49 0 144 240 400 0

GFID0005 Orator 5 49 0 144 240 400 0

GFID0011 Courier 11 49 0 144 240 400 0

GFID0012 Prestige 12 49 0 144 240 400 0

GFID0013 Artisan 13 49 0 144 240 400 0

GFID0018 Courier
Italic

18 49 0 144 240 400 255

GFID0019 OCR-A 19 49 0 144 240 400 0

GFID0020 Pica 20 49 0 144 240 400 0

GFID0030 Symbol 30 49 2 144 240 400 0
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Table 31. iSeries Font Parameters (continued)

Entry ID Font
Family

GFID Pitch &
Family

Character
Set

Width Height Weight Style

GFID0038 Orator 38 49 0 144 240 400 0

GFID0039 Gothic 39 49 0 144 240 800 0

GFID0040 Gothic 40 49 0 144 240 800 0

GFID0041 Roman 41 49 0 144 240 400 0

GFID0042 Serif 42 49 0 144 240 400 0

GFID0043 Serif 43 49 0 144 240 400 255

GFID0044 Katakana 44 49 0 144 240 400 0

GFID0045 APL 45 49 0 144 240 400 0

GFID0046 Courier
Bold

46 49 0 144 240 800 0

GFID0050 Shalom 50 49 0 144 240 400 0

GFID0066 Gothic 66 49 0 144 240 400 0

GFID0068 Gothic 68 49 0 120 240 400 255

GFID0069 Gothic 69 49 0 120 240 800 0

GFID0070 Serif 70 49 0 120 240 400 0

GFID0071 Serif 71 49 0 120 240 400 255

GFID0072 Serif 72 49 0 120 240 800 0

GFID0080 Symbol 80 49 2 120 240 400 0

GFID0084 Script 84 49 0 120 240 400 0

GFID0085 Courier 85 49 0 120 240 400 0

GFID0086 Prestige 86 49 0 120 240 400 0

GFID0087 Letter-
Gothic

87 49 0 120 240 400 0

GFID0091 Light 91 49 0 120 240 400 255

GFID0107 Courier 107 49 0 120 240 400 0

GFID0110 Letter-
Gothic

110 49 0 120 240 800 0

GFID0111 Prestige 111 49 0 120 240 800 0

GFID0112 Prestige 112 49 0 120 240 400 255

GFID0115 Symbol 115 49 2 120 240 400 0

GFID0155 Boldface 155 18 0 120 240 400 0

GFID0158 Document 158 18 0 120 240 400 0

GFID0159 Boldface 159 18 0 120 240 800 0

GFID0160 Essay 160 34 0 120 240 800 0

GFID0162 Essay 162 34 0 120 240 800 255

GFID0163 Essay 163 34 0 120 240 800 0

GFID0168 Barak 168 18 0 120 240 400 0

GFID0173 Essay 173 34 0 120 240 400 0

GFID0175 Document 175 18 0 120 240 400 0

GFID0176 Boldface 176 18 0 120 240 800 0
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Table 31. iSeries Font Parameters (continued)

Entry ID Font
Family

GFID Pitch &
Family

Character
Set

Width Height Weight Style

GFID0177 Boldface 177 18 0 120 240 800 255

GFID0193 Symbol 193 49 2 120 240 400 0

GFID0198 Symbol 198 49 2 144 240 400 0

GFID0204 Gothic 204 49 0 108 210 400 0

GFID0221 Prestige 221 49 0 96 210 400 0

GFID0222 Gothic 222 49 0 96 210 400 0

GFID0223 Courier 223 49 0 96 210 400 0

GFID0225 Symbol 225 49 2 96 240 400 0

GFID0229 Serif 229 49 0 96 210 400 0

GFID0230 Gothic 230 49 0 96 210 400 0

GFID0245 Courier
Bold

245 49 0 288 240 800 0

GFID0252 Courier 252 49 0 84 240 400 0

GFID0253 Courier
Bold

253 49 0 84 240 800 0

GFID0254 Courier 254 49 0 84 120 400 0

GFID0280 APL 280 49 0 72 120 400 0

GFID0281 Gothic 281 49 0 72 120 400 0

GFID0290 Gothic 290 49 0 54 120 400 0

GFID0751 Sonoran-
serif

751 18 0 54 162 400 0

GFID1051 Sonoran-
serif

1051 18 0 66 198 400 0

GFID1053 Sonoran-
serif

1053 18 0 66 198 800 0

GFID1056 Sonoran-
serif

1056 18 0 66 198 400 255

GFID1351 Sonoran-
serif

1351 18 0 84 240 400 0

GFID1653 Sonoran-
serif

1653 18 0 108 312 800 0

GFID2103 Sonoran-
serif

2103 18 0 162 480 800 0

Notes:

1. Default GFID from host is 011, we use Courier 10 CPI.

2. A print driver will change the font to its default if you ask for a font name that it does not recognize. Some
drivers recognize Gothic, but the DeskJet drivers do not.

3. Most print drivers default to Courier New, instead of Courier. So Courier switched to Courier New works, but
Gothic switched to Courier New changes the font family. Preferably, you should explicitly select Courier New.

4. Special fonts like CourHEB and GRCOUR869 (for Greek) has required them to be added to PCSPD.DAT to
work. Note if the operating system properly or fully supports a language, that font could be the default font
instead of Courier New.
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Avoiding iSeries System Dump
If you are running OS/400 Version 3 Release 1, and you attempt to perform a
Telnet 5250 mode host print operation, you may experience an iSeries system
dump under certain conditions. To prevent this from occurring you should apply
PTF SF35327 on OS/400.

This table matches the iSeries table of fonts. PC400 builds a PC spool file with the
selected font in it. The printer driver picks up the spool file and the font and sends
it to the printer where the expected font is used. Refer to Printer Device
Programming for additional information on other useful tables.

The following factors can produce unexpected results:
v Not all fonts are available on a PC or printer device.

If the font that was selected from the table and incorporated into the spool file
cannot be found on a PC or on a printer, the printer driver determines how to
present the data on a printer. For example, HP printer drivers have the following
order of considerations:
– HP Font Priority Considerations:

1. Symbol Set
2. Spacing
3. Pitch
4. Height
5. Style
6. Stroke Weight
7. Typeface Family
8. Resolution
9. Orientation

– Location: printer ROM, SIMM module ROM, cartridge ROM, printer RAM
Priority of locations:
1. Soft font (lowest ID first)
2. Cartridge Font
3. SIMM Font
4. Internal Font

– 600 dpi has priority over 300 dpi

To avoid this uncertainty, it is recommended that you update the table so that
only the fonts that are available in the given environment are used.

v NLS
The iSeries font has NLS characters in it, which are not part of a corresponding
PC font. The IBM-supplied table does not support character sets other than
ANSI, although it provides a field for them. In this case, PC400 builds a PC
spool file with a font that doesn’t recognize NLS.
To fix the problem, it is recommended that you either change the font names in
the table to the NLS enabled on a PC/printer, or if the font has the same name
as the one in the table, update a Character Set value.

v After you decide to scale a printout which may be a result of CORig or
BesFitting, you usually decrease the distance horizontally as well as vertically
between characters. This can result in overlapping. PC400 attempts to adjust the
given character size to a new one. A problem may occur when a font defined in
the table is not a scalable font. Like GFID011, the most heavily used iSeries font
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is mapped to Courier. Courier is a non-scalable font which has only a limited
number of character box sizes. To avoid possible problems it is recommended
that you use Courier New instead, which is a scalable TTF font.

PFT Migration Utility
The PFT migration utility converts the printer function table (PFT) for the PC
Support/400 workstation feature to a printer definition file (PDF) for PC400.

This section describes the operator interface of the PFT migration utility.

For details about PFT, refer to AS/400 PC Support: DOS and OS/2 Technical Reference.

Using the PFT Migration Utility
The file name of the PFT Migration Utility program is PCSPFC.EXE. It is a
Windows application, and you can execute it by doing the following:
1. Double-click the program name using the Windows Explorer utility.
2. Specify the program name (and parameters) in the Windows Run utility as

follows:

If no parameter is specified, PCSPFC.EXE displays the Convert PFT to PDF
dialog box.
If you omit a drive name and a directory name, PCSPFC.EXE uses the
current drive and the current directory. If you omit an extension,
PCSPFC.EXE adds .PFT to the PFT file name.

3. When you execute the PFT Migration Utility, the Convert PFT to PDF dialog
box appears. On the Convert PFT to PDF dialog box, select a PFT file from the
list box or type a specific PFT file name, and click OK. The PFT Migration
Utility starts the conversion and displays the PFT File Converter dialog box to
show the conversion status.

After the conversion, if you click Save List on the PFT File Converter dialog box,
conversion messages in the dialog box are saved into a list file. The list file is
created in the same directory and with the same name as the PFT file, except the
extension. The extension of the list file is .LS2.

If the conversion was completed successfully, you can click Convert PDF to PDT
from the PFT File Converter dialog box to convert the PDF file to a PDT file. You
can also create a PDT file by selecting Printer Setup from the File pull-down menu
as explained in “Using the Printer Definition Table (PDT) File” on page 191.

Migration Considerations
When the base PDF file already exists, the converted PDF fields are appended to
the end of the base PDF file. The name of the base PDF file is decided as follows:

Table 32. PDF File Name

PFT File Name Base PDF File Name

xxxxxxxx.PFT xxxxxxxx.PDF

xxxxx.MNL MNLxxxxx.PDF

zzzxxxxx.MNL* zzzxxxxx.PDF*

: * “zzz” is not “IBM”.

PCSPFC [ [drive:] [path] PFT-file-name[.extension] ]
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Even if the same fields are already defined in the PDF file, the appended fields are
effective because the last definition is always effective in a PDF file.

If the base PDF file does not exist in the directory, the PFT Migration Utilitycreates
a new PDF file that has only the converted fields from the PFT file. In this case,
you should append this file to an appropriate base file manually, because the fields
converted from the PFT file do not cover all of the necessary PDF fields.

Therefore, it is recommended that you prepare both the PFT file and its base PDF
file in the same directory before the conversion.

Details of Migration
This section describes how the PFT Migration Utility migrates the printer function
table (PFT) to the printer definition file (PDF).

Migration from the Printer Function Table
The following table shows the target fields of the PDF for the data in the PFT.

Table 33. Migration from the Printer Function Table to the Printer Definition File

PFT Field Name

PDF Field Name

Description

INITIALIZATION AND RESET

Initialization

Initialization START_JOB=

When the data is defined in the Initialization field of PFT, the
data is appended to the string START_JOB=.

Filename

Filename None

This field is ignored.

Reset

Reset END_JOB=

When the data is defined in the Reset field of PFT, the data is
appended to the string END_JOB=.

VERTICAL LINE SPACING

6 lines per inch

6 lines per inch SET_6_LINES_PER_INCH=

When the data is defined in the 6 lines per inch field of PFT, the
data is appended to the string SET_6_LINES_PER_INCH=.

8 lines per inch

8 lines per inch SET_8_LINES_PER_INCH=

When the data is defined in the 8 lines per inch field of PFT, the
data is appended to the string SET_8_LINES_PER_INCH=.

Variable line spacing

Control Sequence SET_VARIABLE_DENSITY=

When the data is defined in the control sequence field of the PFT
for the variable line spacing, the data is appended to the string
SET_VARIABLE_DENSITY=. The parameter n in the control
sequence is replaced with the PDF parameter type.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Maximum None

This field is ignored.

Offset None

This field is ignored.

X/Y LINE_SPACING_RATIO=

When the data is defined in the X/Y field of the PFT for the
variable line spacing, the value Y/X is appended to the string
LINE_SPACING_RATIO= as three-digit or four-digit numbers to
indicate the decimal number. For example, when Y/X is 72, the
072 is appended to the string LINE_SPACING_RATIO= and
LINE_SPACING_RATIO=072 is written to the output file. When the
value is greater than 255, the four-digit number is migrated.
When the value is less than 255, the three-digit number is
migrated.

Indexing Functions

Begin Superscript START_SUPERSCRIPT=

When the data is defined in the Begin Superscript field and End
Superscript field of the PFT for the indexing functions, the data
is appended to the string START_SUPERSCRIPT=. If the data for
the End Superscript is not defined, the data for the Begin
Superscript is ignored.

End Superscript END_SUPERSCRIPT=

When the data is defined in the End Superscript field and Begin
Superscript field of the PFT for the indexing functions, the data
is appended to the string END_SUPERSCRIPT=. If the data for
the Begin Superscript is not defined, the data for the End
Superscript is ignored.

Begin Subscript START_SUBSCRIPT=

When the data is defined in the Begin Subscript field and End
Subscript field of the PFT for the indexing functions, the data is
appended to the string START_SUBSCRIPT=. If the data for the
End Subscript is not defined, the data for the Begin Subscript is
ignored.

End Subscript END_SUBSCRIPT=

When the data is defined in the End Subscript field and Begin
Subscript field of the PFT for the indexing functions, the data is
appended to the string END_SUBSCRIPT=. If the data for the
Begin Subscript is not defined, the data for the End Subscript is
ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Reverse 1/2 Index START_SUPERSCRIPT= END_SUBSCRIPT=

The data is appended to the START_SUPERSCRIPT= for all of
the following conditions:
v When the data is not defined in the Begin Superscript field in

the PFT or when the data is not defined in the End Superscript
field in the PFT.

v When the data is defined in the Reverse 1/2 index and
Forward 1/2 index field in the PFT.

The data is appended to END_SUBSCRIPT= for all of the
following conditions:
v When the data is not defined in the Begin Subscript field in

the PFT or when the data is not defined in the End Subscript
field in the PFT.

v When the data is defined in the Reverse 1/2 index and
Forward 1/2 index field in the PFT.

Forward 1/2 Index END_SUPERSCRIPT= START_SUBSCRIPT=

The data is appended to END_SUPERSCRIPT= for all of the
following conditions:
v When the data is not defined in Begin Superscript field in the

PFT or when the data is not defined in End Superscript field
in the PFT.

v When the data is defined in the Reverse 1/2 index and
Forward 1/2 index field in the PFT.

The data is appended to START_SUBSCRIPT= for all of the
following conditions:
v When the data is not defined in the Begin Subscript field in

the PFT or when the data is not defined in the End Subscript
field in the PFT.

v When the data is defined in the Reverse 1/2 index and
Forward 1/2 index field in the PFT.

Reverse Index None

This field is ignored.

HORIZONTAL LINE SPACING

5 pitch

5 pitch None

This field is ignored.

8.55 pitch

8.55 pitch None

This field is ignored.

10 pitch

10 pitch SET_10_CHARACTERS_PER_INCH=

When the data is defined in the 10 pitch field of the PFT for the
horizontal character spacing, the data is appended to the string
SET_10_CHARACTERS_PER_INCH=.

12 pitch
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

12 pitch SET_12_CHARACTERS_PER_INCH=

When the data is defined in the 12 pitch field of the PFT for the
horizontal character spacing, the data is appended to the string
SET_12_CHARACTERS_PER_INCH=.

15 pitch

15 pitch SET_15_CHARACTERS_PER_INCH=

When the data is defined in the 15 pitch field of the PFT for the
horizontal character spacing, the data is appended to the string
SET_15_CHARACTERS_PER_INCH=.

17.1 pitch

17.1 pitch SET_17_CHARACTERS_PER_INCH=

When the data is defined in the 17.1 pitch field of the PFT for the
horizontal character spacing, the data is appended to the string
SET_17_CHARACTERS_PER_INCH=.

Horizontal Motion Index

Control Sequence None

This field is ignored.

Maximum None

This field is ignored.

Offset None

This field is ignored.

X/Y None

This field is ignored.

HORIZONTAL RELATIVE MOVEMENT

Forward Relative Movement

Control Sequence FORWARD_HORIZONTAL_SKIP=

When the data is defined in the Forward Relative Movement
field of PFT, the data is appended to the string
FORWARD_HORIZONTAL_SKIP=. The parameter n in the
control sequence is replaced with the PDF parameter type.

Maximum None

This field is ignored.

Offset None

This field is ignored.

X/Y HORIZONTAL_PEL=

When the data is defined in the X/Y field of the PFT for the
forward relative movement, the value Y/X is appended to the
string HORIZONTAL_PEL= as three-digit or four-digit number
to indicate the decimal number. For example, when Y/X is 120,
120 is appended to the string HORIZONTAL_PEL= and
HORIZONTAL_PEL=120 is written to the output file. When the value
is greater than 255, the four-digit number is migrated. When the
value is less than 255, the three-digit number is migrated.

Backward Relative Movement
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Control Sequence None

This field is ignored.

Maximum None

This field is ignored.

Offset None

This field is ignored.

X/Y None

This field is ignored.

HIGHLIGHTING

Begin Emphasis

Begin Emphasis START_HIGHLIGHT_INTENSE=

When the data is defined in the Begin Emphasis of PFT, the data
is appended to the string START_HIGHLIGHT_INTENSE=.

End Emphasis

End Emphasis END_HIGHLIGHT_INTENSE=

When the data is defined in the End Emphasis of PFT, the data is
appended to the string END_HIGHLIGHT_INTENSE=.

Begin Underline

Begin Underline START_HIGHLIGHT_UNDERLINE=

When the data is defined in the Begin Underline of PFT, the data
is appended to the string START_HIGHLIGHT_UNDERLINE=.

End Underline

End Underline END_HIGHLIGHT_UNDERLINE=

When the data is defined in the End Underline of PFT, the data
is appended to the string END_HIGHLIGHT_UNDERLINE=.

Begin Quality Print

Begin Quality Print None

This field is ignored.

End Quality Print

End Quality Print None

This field is ignored.

PAPER HANDLING

Bottom Tray Feed
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Bottom Tray Feed SELECT_DRAWER2=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control of the portrait orientation. For this,
the PFT Migration Utility divides this control sequence into two
parts and migrates the control sequence for the drawer select and
paper feed. The control sequence of the portrait orientation is
migrated to SET_PORTRAIT_ORIENT=. If no data is defined in
any fields for LANDSCAPE PAPER HANDLING, the PFT
Migration Utility migrates this control sequence to the
SELECT_DRAWER2=. (See “Definition of PAPER HANDLING
Migration” on page 250.)

Top Tray Feed

Top Tray Feed SELECT_DRAWER1=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control of the portrait orientation. For this,
the PFT Migration Utility divides this control sequence into two
parts and migrates the control sequence for the drawer select and
paper feed. The control sequence of the portrait orientation is
migrated to SET_PORTRAIT_ORIENT=. If no data is defined in
any fields for LANDSCAPE PAPER HANDLING, the PFT
Migration Utility migrates this control sequence to
SELECT_DRAWER1=. (See “Definition of PAPER HANDLING
Migration” on page 250.)

Envelope Feed

Envelope Feed SELECT_ENVELOPE=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control of the portrait orientation. For this,
the PFT Migration Utility divides this control sequence into two
parts and migrates the control sequence for the drawer select and
paper feed. The control sequence of the portrait orientation is
migrated to SET_PORTRAIT_ORIENT=. If no data is defined in
any fields for LANDSCAPE PAPER HANDLING, the PFT
Migration Utility migrates this control sequence to
SELECT_ENVELOPE=. (See “Definition of PAPER HANDLING
Migration” on page 250.)

Manual Feed

Manual Feed SELECT_DRAWER3=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control of the portrait orientation. For this,
the PFT Migration Utility divides this control sequence into two
parts and migrates the control sequence for the drawer select and
paper feed. The control sequence of the portrait orientation is
migrated to SET_PORTRAIT_ORIENT=. If no data is defined in
any fields for LANDSCAPE PAPER HANDLING, the PFT
Migration Utility migrates this control sequence to
SELECT_DRAWER3=. (See “Definition of PAPER HANDLING
Migration” on page 250.)
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Continuous Feed

Continuous Feed None

This field is ignored.

Ignore Paper End Sensor

Ignore Paper End
Sensor

None

This field is ignored.

Enable Paper End Sensor

Enable Paper End
Sensor

None

This field is ignored.

Eject Automatic Cut Sheet

Eject automatic Cut
Sheet

None

This field is ignored.

Eject Manual Cut Sheet

Eject Manual Cut Sheet None

This field is ignored.

Collate

Collate None

This field is ignored.

PAPER POSITIONING

Continuous Forms

Dist. from Top Paper
Edge

None

This field is ignored.

Dist. from Left Paper
Edge

None

This field is ignored.

Location of First Print
Column

None

This field is ignored.

Manual Feed

Dist. from Top Paper
Edge

None

This field is ignored.

Dist. from Left Paper
Edge

None

This field is ignored.

Location of First Print
Column

None

This field is ignored.

Automatic Feed

Dist. from Top Paper
Edge

None

This field is ignored.

Dist. from Left Paper
Edge

None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Location of First Print
Column

None

This field is ignored.

SET PAGE LENGTH (INCHES)

Control Sequence PAGE_LENGTH_TYPE?=INCH SET_PAGE_LENGTH=

When the data is defined in the control sequence for SET PAGE
LENGTH (INCHES) and if any of the data is not defined in the
control sequence for SET PAGE LENGTH (LINES), this field is
migrated.

Maximum None

This field is ignored.

Offset None

This field is ignored.

X/Y None

This field is ignored.

Top Margin Size None

This field is ignored.

Bottom Margin Size None

This field is ignored.

SET PAGE LENGTH (LINES)

Control Sequence PAGE_LENGTH_TYPE?=LINE SET_PAGE_LENGTH=

When the length is defined in the control sequence for SET PAGE
LENGTH (LINES), this field is migrated.

Maximum None

This field is ignored.

Offset None

This field is ignored.

X/Y None

This field is ignored.

Top Margin Size None

This field is ignored.

Bottom Margin Size None

This field is ignored.

SET LEFT MARGIN (INCHES)

Control Sequence None

This field is ignored.

Maximum None

This field is ignored.

Offset None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

X/Y None

This field is ignored.

SET LEFT MARGIN (COLUMNS)

Control Sequence SET_HORIZONTAL_MARGIN=

When the data is defined in the control sequence field for SET
LEFT MARGIN (COLUMNS), this field is migrated.

Maximum None

This field is ignored.

Offset None

This field is ignored.

CARRIER RETURN/LINE FEED

Continuous Forms

Carrier Return
(Continuous Forms)

CARRIAGE_RETURN=

This field is migrated for the following cases:

v Case 1
– The data is defined in the Carrier Return field for the

Continuous Forms.
– Any of the data in the Carrier Return field is not defined for

the Manual Feed and Automatic Feed.

v Case 2
– The data is defined in the Carrier Return field for the

Continuous Forms.
– The same data is defined in the Carrier Return field for the

Manual Feed.
– Any of the data in the Carrier Return field is not defined for

the Automatic Feed.

v Case 3
– The data is defined in the Carrier Return field for the

Continuous Forms.
– The same data is defined in the Carrier Return field for the

Automatic Feed.
– Any of the data in the Carrier Return field is not defined for

the Manual Feed.

v Case 4
– The data is defined in the Carrier Return field for the

Continuous Forms.
– The same data is defined in the Carrier Return field for the

Automatic Feed and Manual Feed.

238 Personal Communications Administrator’s Guide and Reference



Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Line Feed (Continuous
Forms)

LINE_FEED=

This field is migrated for the following cases:

v Case 1
– The data is defined in the Line Feed field for the

Continuous Forms.
– Any of the data in the Line Feed Line field is not defined

for the Manual Feed and Automatic Feed.

v Case 2
– The data is defined in the Line Feed field for the

Continuous Forms.
– The same data is defined in the Line Feed field for the

Manual Feed.
– Any data is not defined in the Line Feed field for the

Automatic Feed.

v Case 3
– The data is defined in the Line Feed field for the

Continuous Forms.
– The same data is defined in the Line Feed field for the

Automatic Feed.
– Any data is not defined in the Line Feed field for the

Manual Feed.

v Case 4
– The data is defined in the Line Feed field for the

Continuous Forms.
– The same data is defined in the Line Feed field for the

Automatic Feed and Manual Feed.

Manual Feed
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Carrier Return (Manual
Feed)

CARRIAGE_RETURN=

This field is migrated for the following cases:

v Case 1
– The data is defined in the Line Feed field for the Manual

Feed.
– Any of the data in the Line Feed Line field is not defined

for the Continuous Forms and Automatic Feed.

v Case 2
– The data is defined in the Line Feed field for the Manual

Feed.
– The same data is defined in the Line Feed field for the

Continuous Forms.
– Any data is not defined in the Line Feed field for the

Automatic Feed.

v Case 3
– The data is defined in the Line Feed field for the Manual

Feed.
– The same data is defined in the Line Feed field for the

Automatic Feed.
– Any data is not defined in the Line Feed field for the

Continuous Forms.

v Case 4
– The data is defined in the Line Feed field for the Manual

Feed.
– The same data is defined in the Line Feed field for the

Automatic Feed and Continuous Forms.

Line Feed (Manual
Feed)

LINE_FEED=

This field is migrated for the following cases:

v Case 1
– The data is defined in the Line Feed field for the Manual

Feed.
– Any of the data in the Line Feed Line field is not defined

for the Continuous Forms and Automatic Feed.

v Case 2
– The data is defined in the Line Feed field for the Manual

Feed.
– The same data is defined in the Line Feed field for the

Continuous Forms.
– Any data is not defined in the Line Feed field for the

Automatic Feed.

v Case 3
– The data is defined in the Line Feed field for the Manual

Feed.
– The same data is defined in the Line Feed field for the

Automatic Feed.
– Any data is not defined in the Line Feed field for the

Continuous Forms.

v Case 4
– The data is defined in the Line Feed field for the Manual

Feed.
– The same data is defined in the Line Feed field for the

Automatic Feed and Continuous Forms.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Automatic Feed

Carrier Return
(Automatic Feed)

CARRIAGE_RETURN=

This field is migrated for the following cases:

v Case 1
– The data is defined in the Carrier Return field for the

Automatic Feed.
– Any of the data in the Carrier Return field is not defined for

the Continuous Feed and Manual Feed.

v Case 2
– The data is defined in the Carrier Return field for the

Automatic Feed.
– The same data is defined in the Carrier Return field for the

Continuous Forms.
– Any of the data in the Carrier Return field is not defined for

the Manual Feed.

v Case 3
– The data is defined in the Carrier Return field for the

Automatic Feed.
– The same data is defined in the Carrier Return field for the

Manual Feed.
– Any of the data in the Carrier Return field is not defined for

the Continuous Forms.

v Case 4
– The data is defined in the Carrier Return field for the

Automatic Feed.
– The same data is defined in the Carrier Return field for the

Manual Feed and Continuous Forms.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Line Feed (Automatic
Feed)

LINE_FEED=

This field is migrated for the following cases:

v Case 1
– The data is defined in the Line Feed field for the Automatic

Feed.
– Any of the data in the Line Feed Line field is not defined

for the Continuous Forms and Manual Feed.

v Case 2
– The data is defined in the Line Feed field for the Automatic

Feed.
– The same data is defined in the Line Feed field for the

Continuous Forms.
– Any data is not defined in the Line Feed field for the

Manual Feed.

v Case 3
– The data is defined in the Line Feed field for the Automatic

Feed.
– The same data is defined in the Line Feed field for the

Manual Feed.
– Any data is not defined in the Line Feed field for the

Continuous Forms.

v Case 4
– When the data is defined in the Line Feed field for the

Automatic Feed.
– The same data is defined in the Line Feed field for the

Manual Feed and Continuous Forms.

MULTIPLE COPIES

Print without Clearing Page from

Top Tray None

This field is ignored.

Bottom Tray None

This field is ignored.

Envelope Tray None

This field is ignored.

Manual Tray None

This field is ignored.

Clear Page Buffer None

This field is ignored.

Multiple Copies Variable Control

Control Sequence None

This field is ignored.

Maximum None

This field is ignored.

Offset None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

LANDSCAPE PAPER HANDLING

Bottom Tray Feed

Bottom Tray Feed SET_LANDSCAPELEFT_ORIENT=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control sequence for the landscape
orientation. For this, the PFT Migration Utility divides the control
sequence into two parts. The control sequence for the drawer
select and paper feed is ignored because this control sequence is
migrated when the data for PAPER HANDLING is processed.
The control sequence for landscape orientation is migrated to
SET_LANDSCAPE_ORIENT=. (See “Definition of PAPER
HANDLING Migration” on page 250.)

Top Tray Feed

Top Tray Feed SET_LANDSCAPELEFT_ORIENT=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control sequence for the landscape
orientation. For this, the PFT Migration Utility divides the control
sequence into two parts. The control sequence for the drawer
select and paper feed is ignored because this control sequence is
migrated when the data for PAPER HANDLING is processed.
The control sequence for landscape orientation is migrated to
SET_LANDSCAPE_ORIENT=. (See “Definition of PAPER
HANDLING Migration” on page 250.)

Envelope Feed

Envelope Feed SET_LANDSCAPELEFT_ORIENT=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control sequence for the landscape
orientation. For this, the PFT Migration Utility divides the control
sequence into two parts. The control sequence for the drawer
select and paper feed is ignored because this control sequence is
migrated when the data for PAPER HANDLING is processed.
The control sequence for landscape orientation is migrated to
SET_LANDSCAPE_ORIENT=. (See “Definition of PAPER
HANDLING Migration” on page 250.)

Manual Feed

Manual Feed SET_LANDSCAPELEFT_ORIENT=

If the data is defined in some fields for LANDSCAPE PAPER
HANDLING, the PFT Migration Utility assumes that this control
sequence includes the control sequence for the landscape
orientation. For this, the PFT Migration Utility divides the control
sequence into two parts. The control sequence for the drawer
select and paper feed is ignored because this control sequence is
migrated when the data for PAPER HANDLING is processed.
The control sequence for landscape orientation is migrated to
SET_LANDSCAPE_ORIENT=. (See “Definition of PAPER
HANDLING Migration” on page 250.)

TYPESTYLE DEFINITION
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Default Typestyle Definition

PC Character Set None

This field is ignored.

Initial Control Sequence None

This field is ignored.

Ending Control
Sequence

None

This field is ignored.

Individual Typestyle Definition

Typestyle number SET_GFID_

This number is appended as a four-digit number after the string
SET_GFID_. For example, when the typestyle number 9 is
defined, 0009 is appended after the string SET_GFID_ and
SET_GFID_0009= is migrated. And the numbers supported by
PC400 are migrated. The numbers not supported by PC400 are
ignored.

PC Character Set None

This field is ignored.

Initial Control Sequence SET_GFID_xxxx=

This control sequence is appended after the string
SET_GFID_xxxx=, where xxxx is the four-digit number defined in
the typestyle number field.

Ending Control
Sequence

None

This field is ignored.

Characters None

This field is ignored.

Initial Control Sequence None

This field is ignored.

Ending Control
Sequence

None

This field is ignored.

Symbols None

This field is ignored.

Initial Control Sequence None

This field is ignored.

Ending Control
Sequence

None

This field is ignored.

Group Typestyle Definition

Group Identifier None

This field is ignored.

Group Identifier
Comment

None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Typestyle number SET_GFID_

This number is appended as a four-digit number after the string
SET_GFID_. For example, when the typestyle numbers 1, 2, 3,
and 4 are defined, 0001, 0002, 0003, and 0004 are appended after
the string SET_GFID_ and SET_GFID_0001=, SET_GFID_0002=,
SET_GFID_0003=, and SET_GFID_0004= are migrated because
the PC400 does not have the group typestyle definition. The
typestyle numbers that are not supported by the PC400 are not
migrated.

PC Character Set None

This field is ignored.

Initial Control Sequence SET_GFID_xxxx=

This control sequence is appended after the string
SET_GFID_xxxx=, where xxxx is the four-digit number defined in
the typestyle number field.

Ending Control
Sequence

None

This field is ignored.

Characters None

This field is ignored.

Initial Control Sequence None

This field is ignored.

Ending Control
Sequence

None

This field is ignored.

Symbols None

This field is ignored.

Initial Control Sequence None

This field is ignored.

Ending Control
Sequence

None

This field is ignored.

Character Set Number

Character Set Number None

This field is ignored.

SLOT SELECTION

Slot 1 Sequence

Slot 1 Sequence None

This field is ignored.

Slot 2 Sequence

Slot 2 Sequence None

This field is ignored.

Slot 3 Sequence

Slot 3 Sequence None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Stop Sequence

Stop Sequence None

This field is ignored.

USER DEFINED CONTROL

Parameters of SET ENVELOP SIZE Command

Control Number: 984 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.

ESC Sequence of SET ENVELOP SIZE Command

Control Number: 985 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.

Parameters of SET PAGE SIZE Command

Control Number: 986 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.

ESC Sequence of SET PAGE SIZE Command

Control Number: 987 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.

Printer Data Stream

Control Number: 988 None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Control Sequence SET_FONT_GLOBAL=1B 5B 49 word-value(LH) word-value(HL)
word-value(HL) byte-value word-value(HL)

When 04 is defined in this field, SET_FONT_GLOBAL=1B 5B 49
... word-value(HL) is migrated. When the other value is defined,
this field is ignored. 04 means IBM Personal Printer Data Stream
Level 2 or higher. When the migration is done for PAPER
HANDLING, use this information. (See “Definition of PAPER
HANDLING Migration” on page 250.)

Control Sequence File
Name

None

This field is ignored.

Duplex long edge

Control Number: 989 None

This field is ignored.

Control Sequence SET_DUPLEX=

When the data is defined in the control sequence for the duplex
long edge, the data is appended to the string SET_DUPLEX=.

Control Sequence File
Name

None

This field is ignored.

Duplex short edge

Control Number: 990 None

This field is ignored.

Control Sequence SET_DUPLEX_TUMBLE=

When the data is defined in the control sequence for the duplex
short edge, the data is appended to the string
SET_DUPLEX_TUMBLE=.

Control Sequence File
Name

None

This field is ignored.

Simplex

Control Number: 991 None

This field is ignored.

Control Sequence RESET_DUPLEX=

When the data is defined in the control sequence for the simplex,
the data is appended to the string RESET_DUPLEX=.

Control Sequence File
Name

None

This field is ignored.

Jog the output tray

Control Number: 992 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Normal portrait orientation

Control Number: 993 None

This field is ignored.

Control Sequence SET_PORTRAIT_ORIENT=

When the data is defined in the control field for the normal
portrait orientation, the data is appended to the string
SET_PORTRAIT_ORIENT=.

Control Sequence File
Name

None

This field is ignored.

Landscape left

Control Number: 994 None

This field is ignored.

Control Sequence SET_LANDSCAPELEFT_ORIENT=

When the data is defined in the control field for the landscape
left, the data is appended to the string
SET_LANDSCAPELEFT_ORIENT=.

Control Sequence File
Name

None

This field is ignored.

Portrait upside down orientation

Control Number: 995 None

This field is ignored.

Control Sequence SET_PORTRAITUPDWN_ORIENT=

When the data is defined in the control field for the portrait
upside down orientation, the data is appended to the string
SET_PORTRAITUPDWN_ORIENT=.

Control Sequence File
Name

None

This field is ignored.

Landscape right

Control Number: 996 None

This field is ignored.

Control Sequence SET_LANDSCAPERGHT_ORIENT=

When the data is defined in the control field for the landscape
right, the data is appended to the string
SET_LANDSCAPERGHT_ORIENT=.

Control Sequence File
Name

None

This field is ignored.

COR in 10 pitch

Control Number: 997 None

This field is ignored.

Control Sequence None

This field is ignored.
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Table 33. Migration from the Printer Function Table to the Printer Definition File (continued)

PFT Field Name

PDF Field Name

Description

Control Sequence File
Name

None

This field is ignored.

COR in 12 pitch

Control Number: 998 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.

COR in 15 pitch

Control Number: 999 None

This field is ignored.

Control Sequence None

This field is ignored.

Control Sequence File
Name

None

This field is ignored.

FUNCTION SELECTION TEST RESPONSES

Superscript
/Subscript

None

This data is ignored.

Underline None

This data is ignored.

Emphasis (Bold) None

This data is ignored.

Form Feed None

This data is ignored.

Back Space BACKSPACE=

This field is migrated when you type YES or NO in response to
the prompt during the Backspace Function Selection Test.

Mid-line pitch change None

This data is ignored.

Horizontal Character
spacing

None

This data is ignored.

First character position None

This data is ignored.

PSM None

This data is ignored.

Cursor Draw None

This data is ignored.
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Note: When you migrate IBM3812.PFT and IBM3812.MNL, the following fields are
added to IBM3812.PDF:
v FORWARD_VERTICAL_STEP_FEED=1B 5B 43 03 00 E3 word-value(LH)
v VERTICAL_PEL=240

Definition of PAPER HANDLING Migration
The PFT Migration Utility migrates the data for PAPER HANDLING and
LANDSCAPE PAPER HANDLING as follows:
1. The PFT Migration Utility checks whether the LANDSCAPE PAPER

HANDLING controls are defined.
2. If the LANDSCAPE PAPER HANDLING controls are defined, the PFT

Migration Utility assumes that the PAPER HANDLING control sequences
include controls to set the page orientation to portrait. Each LANDSCAPE
PAPER HANDLING control sequence has the controls to set the page
orientation to landscape in addition to the tray select and feed controls.

3. If the LANDSCAPE PAPER HANDLING controls are not defined, the PAPER
HANDLING controls do not have the controls to set the page orientation to
portrait. If a personal printer supports normal portrait, landscape left, portrait
upside down, and landscape right orientation, the page orientation controls are
defined in the appropriate user-defined controls.

If the LANDSCAPE PAPER HANDLING controls are not defined: When the
PAPER HANDLING controls are not defined, the controls are migrated as follows:

PFT Fields

Bottom
Top
Envelope
Manual

Tray
Tray
Tray

Select & Feed
Select & Feed
Select & Feed
Select & Feed

SELECT_DRAWER2=
SELECT_DRAWER1=
SELECT_ENVELOPE=
SELECT_DRAWER3=

PDF Fields

If the LANDSCAPE PAPER HANDLING controls are defined: When the PAPER
HANDLING controls are defined, these controls have the controls to set the page
orientation to portrait. The LANDSCAPE PAPER HANDLING controls have the
controls to set the page orientation to landscape. The PFT Migration Utility
migrates the controls as follows:
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Length of the
control in the
corresponding
field of PAPER
HANDLING with
LANDSCAPE PAPER
HANDLING

Length of the
control in the
corresponding
field of
LANDSCAPE PAPER
HANDLING
with PAPER
HANDLING

(Length1) ==0

(Length2) ==0

(Length2) > 0

Length1 != Length2

CASE 4

Length1 == Length2

CASE 5

CASE 1

CASE 3

CASE 2

(Length1) > 0

v CASE 1

Since both of the fields are not defined, no data is migrated.
Example: No data is migrated to SELECT_DRAWER2= under the following
conditions. For this example, SELECT_DRAWER2= is not written in the output
file.
– No data is defined in the bottom tray select and feed for PAPER HANDLING.
– No data is defined in the bottom tray select and feed for LANDSCAPE

PAPER HANDLING.
v CASE 2

Since no data is defined in the field for PAPER HANDLING, the PFT Migration
Utility cannot compare the data in the corresponding field with the data for
LANDSCAPE PAPER HANDLING. The data for LANDSCAPE PAPER
HANDLING is migrated to the drawer selection field of PDF regardless,
including control of the landscape orientation.
Example: The control of the top tray select and feed for LANDSCAPE PAPER
HANDLING is migrated to SELECT_DRAWER1= under the following
conditions.
– No data is defined in the top tray select and feed for PAPER HANDLING.
– The control is defined in the top tray select and feed for LANDSCAPE PAPER

HANDLING.
v CASE 3

Since no data is defined in the field for LANDSCAPE PAPER HANDLING, the
PFT Migration Utility cannot compare the data in the corresponding field with
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the data for PAPER HANDLING. The data for PAPER HANDLING is migrated
to the drawer selection field of PDF regardless, including the control of the
portrait orientation.
Example: The control of the manual select and feed for PAPER HANDLING is
migrated to SELECT_DRAWER3= under the following conditions.
– The control is defined in the manual select and feed for PAPER HANDLING.
– No data is defined in the top tray select and feed for LANDSCAPE PAPER

HANDLING.
v CASE 4

Since the length is different, no data is migrated.
Example: No data is migrated to SELECT_DRAWER2= under the following
conditions. For this example, SELECT_DRAWER2= is not written in the output
file.
– The data is defined in the bottom tray select and feed for PAPER

HANDLING and the length is 8.
– The data is defined in the bottom tray select and feed for LANDSCAPE

PAPER HANDLING and the length is 10.
v CASE 5

The PFT Migration Utility compares the data for PAPER HANDLING with the
data for LANDSCAPE PAPER HANDLING as follows:
– If a different value is found in the data, search the control backward for the

escape character X'1B'.
– If the escape character is found in the middle of the control, divide the

control into two parts. The PFT Migration Utility assumes that the first part is
the control for the tray select and feed, and the second part is the control for
the page orientation. The PFT Migration Utility migrates the first part of the
PAPER HANDLING control into the tray select and feed, the second part of
the PAPER HANDLING control into the SET_PORTRAIT_ORIENT=, and the
second part of the LANDSCAPE PAPER HANDLING control into
SET_LANDSCAPELEFT_ORIENT=.

– If the escape character is found at the top of the control and 03 (= HP PCL) is
defined in the user-defined control 988, the PFT Migration Utility assumes
that the controls are combined. For this, the control begins with the escape
character and the two shared characters. For this, the PFT Migration Utility
assumes that the last character of the first part is a lowercase letter and
converts it to an uppercase letter to indicate that it is a terminating character.
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The PFT Migration Utility divides the controls into the two parts as follows:

Migrated into SET_PORTRAIT_ORIENT=

Migrated into SET_LANDSCAPELEFT_ORIENT=

ESC

ESC

shared character

shared character

oo oo oo oo

oo oo oo oo

XX

XX

Different value

Different value

Converted uppercase

Migrated into the tray select and feed

< Control for LANDSCAPE PAPER HANDLING >

< Control for the PAPER HANDLING >

– If the escape character is found, but the data stream is not HP PCL, the PFT
Migration Utility displays the error message to indicate that the PFT
Migration Utility cannot migrate the data.

– If the escape character is not found, the PFT Migration Utility displays the
error message to indicate that the PFT Migration Utility cannot migrate the
data.

– If a different value is not found, the same control is defined for PAPER
HANDLING and LANDSCAPE PAPER HANDLING.

The PFT Migration Utility migrates the data in the following order:
1. Top Tray Select and Feed
2. Bottom Tray Select and Feed
3. Manual Select and Feed
4. Envelope Tray Select and Feed

The migration stops for the page orientation, SET_PORTRAIT_ORIENT= and
SET_LANDSCAPELEFT_ORIENT=, when the controls for the page orientation are
found. For example, the controls for the page orientation are found when the data
is migrated for the Bottom Tray Select and Feed. The PFT Migration Utility does
not care about the page orientation when migrating the data Manual Select and
Feed, and Envelop Tray Select and Feed.
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Part 6. Appendixes
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Appendix A. Keyboard Layouts

This appendix describes keyboard layouts supported by the host system. The
keyboards are selected during installation or customization procedures. You can
use keyboard layouts to locate character positions on the keyboard.

Different characters can appear in different key positions, depending on the
country language selected. This appendix shows only U.S. keyboards. The function
keys located across the top of the keyboard are not shown. Shaded areas show
keys that are not available on some U.S. keyboards. Refer to your Windows
documentation for more information about the country and code page options.
Ask your system administrator for information about host code pages.

Personal Communications includes .KMP keyboard map files for 3270 and 5250
sessions that map the standard Win32 hotkeys for Cut, Copy, and Paste to Ctrl+X,
Ctrl+C and Ctrl+V, respectively.

For 5250 sessions, the default .KMP file is pcswinkb5.kmp. In this map file, the
5250 key values for the following functions have also been changed: Enter and
New Line. The user can utilize the new keyboard map file, or may add these new
key values to an existing map file. The remapping is given in the following table.

Table 34. New Keyboard Map Functions for a 5250 Layout

Function of Key Key

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Enter Enter

New Line Right Ctrl

The PF7 and PF8 remain mapped to Roll Up and Roll Down, respectively.

For 3270 sessions, the default .KMP file is pcswinkb3.kmp. In this map file, the
3270 key values for the following functions have also been changed: Page Up, Page
Down, Enter and New Line. The user may utilize the new keyboard map file, or
may add these new key values to an existing map file. The remapping is given in
the following table.

Table 35. New Keyboard Map Functions for a 3270 Layout

Function of Key Key

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Page Up PF7

Page Down PF8

Enter Enter

New Line Right Ctrl
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For keys with three or four characters shown, use the key combinations in Table 36
to produce the desired upper-right and lower-right characters. Lower-left
characters require no additional keys. Use the shift key for upper-left characters.

Table 36. Key Combinations for Upper-Right and Lower-Right Characters

Country
Lower-Right Character
Enhanced Template¹

Upper-Right
Character All
Templates

Denmark AltGr Ctrl

Finland AltGr Ctrl

Norway AltGr Ctrl

Sweden AltGr Ctrl

All others AltGr None

Note:

¹ Alt and AltGr keys produce the same character on the Enhanced keyboard in DOS
mode.

Local Edit Keys
Table 37 shows the keys used by local editing. These keys behave differently
between the local editing mode and the interactive editing (ECHO) mode.

Table 37. Local Edit Keys

VT Key Mnemonics Local Edit Function Action in Local Edit Mode

VT Find Home Cursor Moves the cursor to the top left position
on a page in memory.

VT Insert Insert/Override Selects whether new characters typed
displace existing characters to the right,
or replace existing characters.

VT Remove Clear Clears an unprotected field of all
characters. Press in conjunction with the
SHIFT key to clear all unprotected fields
in the scrolling region.

VT Select Edit Press in conjunction with the SHIFT key
to enter or exit local edit mode. The
status line shows the current state.

VT Prev PrevPage Moves the cursor to the beginning of
the previous page.

VT Next NextPage Moves the cursor to the beginning of
the next page.
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Table 37. Local Edit Keys (continued)

VT Key Mnemonics Local Edit Function Action in Local Edit Mode

VT PF1 Tab Advances the cursor to the first
occurrence of:

v A tab stop at the beginning of an
unprotected field

v An unprotected field

v The end of the scrolling region

Pressing SHIFT with this key moves the
cursor back to the first occurrence of:

v The previous tab stop

v The beginning of the current
unprotected field

v The beginning of the previous
unprotected field

v The beginning of the scrolling region

VT PF2 Insert Line Adds a blank line on the screen and
moves the following lines down. This
key cannot be selected on a line
containing a protected field.

VT PF3 DeleteLine Deletes a line from the screen and
moves the following lines up. This key
cannot be selected on a line containing a
protected field.

VT PF4 DeleteChar Deletes an unprotected character at the
cursor.

VT Numpad Enter
Newline

Transmit Sends a block of edited text to the host.
Works like the Transmit key, if you
select Line Transmit.

Keyboard Layouts
This section describes the keyboards supported by the host systems and Personal
Communications. Refer to the online help for more information on keyboards. The
function keys have the following shift statuses.

Following are some abbreviations for the keys.
AltCur

Alternate Cursor
AltView

Alternate View
BackSp

Back Space
BackTb

Backtab

-Status-
BASE
SHIFT
CTRL
ALT
ALTGR
CTRLSFT

BASE
SHIFT
CTRL
ALT
ALTGR
CTRLSFT

: Normal shift
Up shift by pressing Shift
Control shift by pressing Ctrl
Alternate shift by pressing Alt
Shift by pressing Ctrl+Alt
Shift by pressing Ctrl+Shift

:
:
:
:
:
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BgnOLn
Begin of Line

BotOPg
Bottom of Page

BtbWord
Backtab Word

CarRtn
Carrier Return

ChgFmt
Change Format

ChgScrn
Change Screen

ChrAdv
Character Advance

Ctrl Control
CurBlink

Cursor Blink
CurSel

Cursor Select
DelWord

Delete Word
DevCan

Device Cancel
DspTxC

Display TextCode
Dup Duplicate
EditCop

Edit Copy
EditPst

Edit Paste
EditUnd

Edit Undo
EndFld

End of Field
EndOLn

End of Line
ErEOF Erase EOF
ErFld Erase Field
ErInp Erase Input
Fld- Field-
Fld+ Field+
FldColor

Field Color
FldExt Field Exit
FldHigh

Field Highlight
FldMark

Field Mark
FldTrns

Transparency Field Inherit
FastDn

Fast Down
FastDow

Fast Down
FastUp

Fast Up
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FieldCol
Field Color

GrpCsr
Graphic Cursor

HostPr
Host Print

JmpNext
Jump Next

JumpNxt
Jump Next

MarkLef
Mark Left

MkDown
Mark Down

MkLeft
Mark Left

MkRight
Mark Right

MrkUp
Mark Up

MarkDow
Mark Down

MarkRig
Mark Right

MoveDow
Move Down

MoveLef
Move Left

MoveRig
Move Right

MvDown
Move Down

MvLeft
Move Left

MvRight
Move Right

MvUp Move Up
NewLin

New Line
ReqBSp

Required Backspace
ReqTab

Required Tab
RolDwn

Roll Down
RollDow

Roll Down
RolUp Roll Up
Rst/Ctrl

Reset/Ctrl
RPause

Record/Play Pause
SOSI SOSI Display
SOSI/G

SOSI Generate
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SysAttn
System Attention

SysReq
System Request

TabFld
Tab Field

TopOPg
Top of Page

TransOp
Transparency Opaque

TrnfldI
Transparency Field Inherit

TrnOp Transparency Opaque
TstReq

Test Request
Turquois

Turquoise
UnderSc

Underscore
UndScr

Underscore
WdWrap

Word Wrap
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Enhanced Keyboard, Microsoft Natural Keyboard (3270 Only)

Segment A assignment:

Segment B assignment:

A

B C D

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Doc
Doc
Red

PF2
PF14
-----
WdWrap
WdWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

TabFld
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
SUB

-----
-----
-----

-----
-----
CAN

-----
-----
-----

-----
-----
ETX

-----
-----
-----

-----
-----
SYN

-----
-----
-----

-----
-----
STX

-----
-----
-----

-----
-----
SO

-----
-----
-----

-----
-----
CR

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
SOH

-----
-----
-----

-----
-----
DC3

-----
-----
-----

-----
-----
EOT

-----
-----
-----

-----
-----
ACK

-----
-----
-----

-----
-----
BEL

-----
-----
-----

-----
-----
BS

-----
-----
-----

-----
-----
LF

-----
-----
-----

-----
-----
VT

-----
-----
-----

-----
-----
FF

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
DC1

-----
-----
-----

-----
-----
ETB

-----
-----
-----

-----
-----
ENQ

-----
-----
-----

-----
-----
DC2

-----
-----
-----

-----
-----
DC4

-----
-----
-----

-----
-----
EM

-----
-----
-----

-----
-----
NAK

-----
-----
-----

-----
-----
HT

-----
-----
-----

-----
-----
SI

-----
-----
-----

-----
-----
DLE

-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
ESC

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
US

-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
BackSp
-----

-----
-----

EditUnd

-----
-----
-----
-----
-----
-----

PF3
PF15
-----
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turq

PF7
PF19
RPause
-----
-----
White

PF8
PF20
-----
APL
APL

PF9
PF21
-----
CurSel
CurSel
-----

PF11
PF23
RTM
AltCur
AltCur
-----

PF12
PF24
-----
+Cr
+Cr
-----

PF10
PF22
-----

-----

CurBlink
CurBlink

FldColor

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FM
Rule
PA2
PA2
-----

Up
Mkup
Mvup
FastUp
FastUp
-----

Down
MkDown
MvDown

-----

Left
MkLeft
MvLeft

-----

Right

-----

FastDn
FastDn

BtbWord
BtbWord

MkRight
MvRight
TabWord
TabWord

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
TrnOp

-----
-----
-----

-----

ErEOF
ErFld
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----
MyLeft
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

UndScr
UndScr
-----

MyRight

EndFld
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----

-----
-----
-----
-----
-----

Esc J
-----
-----

-----

Up
-----
MvUp
FastUp
FastUp

Down
-----
MvDown

-----

FldTrns

FldHigh
FldHigh

DelWord
DelWord
DelWord

TrnFldI

FastDn
FastDn

-----
TabFld
-----
-----
-----
-----

Enter
Enter
-----
-----
-----
-----

-----
PA3

-----

-----

-----
-----
-----

Dup

EditCut

PA1
PA1

EditCop

DelWord
DelWord
DelWord

ChgScrn
JmpNext
JmpNext

Reverse
Reverse

EditPst
Test

EditPst

-----

75

76

80

83

8479 89

90 10595 100

81 91

92 97 102

93

99 104

96

98

101

103

106

108

85

86
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Enhanced Keyboard, Microsoft Natural Keyboard (5250 Only)

Segment A assignment:

Segment B assignment:

A

B C D

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Help
-----
-----

PF2
PF14
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

TabFld
BackTb
ReqTab
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

FldExt
NewLin
CarRtn
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
BackSp
ReqBSp
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
-----
-----
-----
-----

Clear
-----
HostPr
TstReq
-----
-----

PF4
PF16
-----
-----
-----
-----

PF5
PF17
Record
-----
-----
-----

PF6
PF18
Play
-----
-----
-----

PF7
PF19
RPause
-----
-----
-----

PF8
PF20
SOSI/G
-----
SOSI/G

PF9
PF21
-----
-----
-----
-----

PF11
PF23
-----
AltCur
AltCur
-----

PF12
PF24
-----
TestReq
TestReq
-----

PF10
PF22
-----

-----

CurBlink
CurBlink

FieldCol

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FM

Rule
-----
-----
-----

Up
Mkup
Mvup
FastUp
FastUp
-----

Down
MkDown
MvDown

-----

Left
MkLeft
MvLeft

-----

Right

-----

FastDn
FastDn

BtbWord
BtbWord

MkRight
MvRight
TabWord
TabWord

-----
-----
-----
-----
-----
-----

Fld-
Fld-

CarRtn
Fld-
Fld-
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

ErEOF
-----
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----
BgnOLn
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

UndScr
UndScr
-----

EndOLn

ErEOF
-----
-----
-----
-----
-----

Ins
-----
-----
-----
-----
-----

Delete
-----

-----

RolDwn
-----
-----
-----
-----
-----

RolUp
-----
-----
-----
-----
-----

Up
-----
TopOPg
FastUp
FastUp
-----

Down
-----
BotOPg

-----

DelWord
DelWord
DelWord

FastDn
FastDn

Fld+
Fld+

CarRtn
Fld+
Fld+
-----

FldExt
FldExt
-----
-----
-----
-----

RolDwn
RolDwn
-----
JmpNxt
JmpNxt
-----

RolUp

-----
-----
-----
-----

Dup

EditCut

-----
-----

EditCop

DelWord
DelWord
DelWord

EditPst

EditPst

-----

75

76

80

83

8479 89

90 10595 100

81 91

92 97 102

93

99 104

96

98

101

103

106

108

85

86
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Enhanced Keyboard, Microsoft Natural Keyboard (Combined
3270 and 5250)

Segment A assignment:

Segment B assignment:

A

B C D

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Doc
Doc
Red

PF2
PF14
-----
WdWrap
WdWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

TabFld
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
SUB

-----
-----
-----

-----
-----
CAN

-----
-----
-----

-----
-----
ETX

-----
-----
-----

-----
-----
SYN

-----
-----
-----

-----
-----
STX

-----
-----
-----

-----
-----
SO

-----
-----
-----

-----
-----
CR

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
SOH

-----
-----
-----

-----
-----
DC3

-----
-----
-----

-----
-----
EOT

-----
-----
-----

-----
-----
ACK

-----
-----
-----

-----
-----
BEL

-----
-----
-----

-----
-----
BS

-----
-----
-----

-----
-----
LF

-----
-----
-----

-----
-----
VT

-----
-----
-----

-----
-----
FF

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
DC1

-----
-----
-----

-----
-----
ETB

-----
-----
-----

-----
-----
ENQ

-----
-----
-----

-----
-----
DC2

-----
-----
-----

-----
-----
DC4

-----
-----
-----

-----
-----
EM

-----
-----
-----

-----
-----
NAK

-----
-----
-----

-----
-----
HT

-----
-----
-----

-----
-----
SI

-----
-----
-----

-----
-----
DLE

-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
ESC

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
US

-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
ChrAdv
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
-----
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turq

PF7
PF19
RPause
-----
-----
White

PF8
PF20
-----
APL
APL

PF9
PF21
-----
CurSel
CurSel
-----

PF11
PF23
RTM
AltCur
AltCur
-----

PF12
PF24
-----
+Cr
+Cr
-----

PF10
PF22
-----

-----

CurBlink
CurBlink

FldColor

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FM

Rule
PA2
PA2

-----

Up
Mkup
Mvup
FastUp
FastUp
-----

Down
MkDown
MvDown

-----

Left
MkLeft
MvLeft

-----

Right

-----

FastDn
FastDn

BtbWord
BtbWord

MkRight
MvRight
TabWord
TabWord

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
TrnOp

-----
-----
-----

Reverse
Reverse
-----

ErEOF
ErFld
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----
MvLeft
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MvRight
UndScr
UndScr
-----

EndFld
-----
-----
-----
-----
-----

Delete
-----

-----

-----
-----
-----
-----
-----

Fldtrns

ESC J
-----
-----
FldHigh
FldHigh
-----

Up
-----
MvUp

FastUp
FastUp
TrnFldI

Down
-----
MvDown
FastDn
FastDn
-----

DelWord
DelWord
DelWord

Field+
TabFld
-----
-----
-----
-----

Enter
Enter
-----
-----
-----
-----

RolDwn
PA3
ChgScr
JmpNxt
JmpNxt
-----

RolUp

Test
-----
-----
-----

Dup

EditCut

PA1
PA1

EditCop

DelWord
DelWord
DelWord

EditPst

EditPst

-----

75

76

80

83

8479 89

90 10595 100

81 91

92 97 102

93

99 104

96

98

101

103

106

108

85

86

Insert
-----
-----
-----
-----
-----
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Enhanced Keyboard, Microsoft Natural Keyboard (VT
Keyboard Layout)

Note: This keyboard layout does not include Personal Communications local
function (for example, edit copy, edit paste, etc.).

110
ESC
ESC
-----
-----
-----
-----

112
HldScrn
F13
-----
-----
-----
UsrF13

5
4
$
-----
-----
-----
-----

19
e
E
ENQ
-----
-----
-----

33
d
D
EOT
-----
-----
-----

48
c
C
ETX
-----
-----
-----

9
8
*
-----
-----
-----
-----

23
u
U
NAK
-----
-----
-----

37
j
J
LF
-----
-----
-----

52
m
M
CR
-----
-----
-----

13
=
+
-----
-----
-----
-----

27
[
{
ESC
-----
-----
-----

41
'
"
-----
-----
-----
-----

1
`
ansi7e
-----
-----
-----
-----

29
ansi 5c
|
FS
-----
-----
-----

43
Newline
Newline
-----
-----
-----
-----

57
-----
-----
-----
-----
-----
-----

64
-----
-----
-----
-----
-----
-----

116
Break
F17
-----
-----
-----
UsrF17

120
F9
-----
UsrF9
-----
-----
-----

124
-----
-----
-----
-----
-----
-----

113
Compose
F14
-----
-----
-----
UsrF14

6
5
%
-----
-----
-----
-----

20
r
R
DC2
-----
-----
-----

34
f
F
ACK
-----
-----
-----

49
v
V
SYN
-----
-----
-----

62
-----
-----
-----
-----
-----
-----

10
9
(
-----
-----
-----
-----

24
i
I
HT
-----
-----
-----

38
k
K
VT
-----
-----
-----

53
,
<
-----
-----
-----
-----

28
]
}
GS
-----
-----
-----

2
1
!
-----
-----
-----
-----

16
Tab Field
Backtab
-----
-----
-----
-----

30
-----
-----
-----
-----
-----
-----

44
-----
-----
-----
-----
-----
-----

117
F6
F18
UsrF6
-----
-----
UsrF18

121
F10
-----
UsrF10
-----
-----
-----

125
-----
-----
-----
-----
-----
-----

114
Help
F15
-----
-----
-----
UsrF15

7
6
^
RS
-----
-----
-----

21
t
T
DC4
-----
-----
-----

35
g
G
BEL
-----
-----
-----

50
b
B
STX
-----
-----
-----

60
-----
-----
-----
-----
-----
-----

11
0
)
-----
-----
-----
-----

25
o
O
SI
-----
-----
-----

39
l
L
FF
-----
-----
-----

54
.
>
-----
-----
-----
-----

15
Backspace
Backspace
-----
-----
-----
-----

3
2
@
NULL
-----
-----
-----

17
q
Q
DC1
-----
-----
-----

31
a
A
SOH
-----
-----
-----

46
z
Z
SUB
-----
-----
-----

61
Space
Space
-----
-----
-----
-----

118
F7
F19
UsrF7
-----
-----
UsrF19

122
F11
-----
UsrF11
-----
-----
-----

126
-----
-----
-----
-----
-----
-----

115
Do
F16
-----
-----
-----
UsrF16

8
7
&
-----
-----
-----
-----

22
y
Y
EM
-----
-----
-----

36
h
H
BS
-----
-----
-----

51
n
N
SO
-----
-----
-----

12
-
_
US
-----
-----
-----

26
p
P
DLE
-----
-----
-----

40
;
:
-----
-----
-----
-----

55
/
?
-----
-----
-----
-----

58
-----
-----
-----
-----
-----
-----

4
3
#
-----
-----
-----
-----

18
w
W
ETB
-----
-----
-----

32
s
S
DC3
-----
-----
-----

47
x
X
CAN
-----
-----
-----

119
F8
F20
UsrF8
-----
-----
UsrF20

123
F12
-----
UsrF12
-----
-----
-----

Segment A assignment:

Segment B assignment:

A

B C D
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Segment C assignment: Segment D assignment:

90
-----
PF1
-----
-----
-----
-----

91
Select
numpd 7
-----
-----
-----
-----

92
Left
numpd 4
-----
-----
-----
-----

93
Find
numpd 1
-----
-----
-----
-----

99
InsertHere
numpd 0
-----
-----
-----
-----

95
-----
PF2
-----
-----
-----
-----

96
Up
numpd 8
-----
-----
-----
-----

97
-----
numpd 5
-----
-----
-----
-----

98
Down
numpd 2
-----
-----
-----
-----

100
-----
PF3
-----
-----
-----
-----

101
PrvScn
numpd 9
-----
-----
-----
-----

102
Right
numpd 6
-----
-----
-----
-----

103
NxPg
numpd 3
-----
-----
-----
-----

104
Remove
numpd .
-----
-----
-----
-----

105
-----
PF4
-----
-----
-----
-----

106
numpd —
numpd ,
-----
-----
-----
-----

108
-----
numpd Newln
-----
-----
-----
-----

75
InsertHere
-----
-----
-----
-----
-----

76
Remove
-----
-----
-----
-----
-----

79
Left
-----
-----
-----
-----
-----

80
Select
-----
-----
-----
-----
-----

81
Find
-----
-----
-----
-----
-----

83
Up
-----
-----
-----
-----
-----

84
Down
-----
-----
-----
-----
-----

85
PrevScn
-----
-----
-----
-----
-----

86
NextScn
-----
-----
-----
-----
-----

89
Right
-----
-----
-----
-----
-----
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Enhanced Keyboard, Microsoft Natural Keyboard (VT Local
Edit Mode Only)

Note: This keyboard layout does not include Personal Communications local
function (for example, edit copy, edit paste, etc.).

110
ESC
ESC
-----
-----
-----
-----

112
HldScrn
F13
-----
-----
-----
UsrF13

5
4
$
-----
-----
-----
-----

19
e
E
ENQ
-----
-----
-----

33
d
D
EOT
-----
-----
-----

48
c
C
ETX
-----
-----
-----

9
8
*
-----
-----
-----
-----

23
u
U
NAK
-----
-----
-----

37
j
J
LF
-----
-----
-----

52
m
M
CR
-----
-----
-----

13
=
+
-----
-----
-----
-----

27
[
{
ESC
-----
-----
-----

41
'
"
-----
-----
-----
-----

1
`
ansi7e
-----
-----
-----
-----

29
ansi 5c
|
FS
-----
-----
-----

43
Newline/Transmit
Newline/Transmit
-----
-----
-----
-----

57
-----
-----
-----
-----
-----
-----

64
-----
-----
-----
-----
-----
-----

116
Break
F17
-----
-----
-----
UsrF17

120
F9
-----
UsrF9
-----
-----
-----

124
-----
-----
-----
-----
-----
-----

113
Compose
F14
-----
-----
-----
UsrF14

6
5
%
-----
-----
-----
-----

20
r
R
DC2
-----
-----
-----

34
f
F
ACK
-----
-----
-----

49
v
V
SYN
-----
-----
-----

62
-----
-----
-----
-----
-----
-----

10
9
(
-----
-----
-----
-----

24
i
I
HT
-----
-----
-----

38
k
K
VT
-----
-----
-----

53
,
<
-----
-----
-----
-----

28
]
}
GS
-----
-----
-----

2
1
!
-----
-----
-----
-----

16
Tab Field
Backtab
-----
-----
-----
-----

30
-----
-----
-----
-----
-----
-----

44
-----
-----
-----
-----
-----
-----

117
F6
F18
UsrF6
-----
-----
UsrF18

121
F10
-----
UsrF10
-----
-----
-----

125
-----
-----
-----
-----
-----
-----

114
Help
F15
-----
-----
-----
UsrF15

7
6
^
RS
-----
-----
-----

21
t
T
DC4
-----
-----
-----

35
g
G
BEL
-----
-----
-----

50
b
B
STX
-----
-----
-----

60
-----
-----
-----
-----
-----
-----

11
0
)
-----
-----
-----
-----

25
o
O
SI
-----
-----
-----

39
l
L
FF
-----
-----
-----

54
.
>
-----
-----
-----
-----

15
Backspace
Backspace
-----
-----
-----
-----

3
2
@
NULL
-----
-----
-----

17
q
Q
DC1
-----
-----
-----

31
a
A
SOH
-----
-----
-----

46
z
Z
SUB
-----
-----
-----

61
Space
Space
-----
-----
-----
-----

118
F7
F19
UsrF7
-----
-----
UsrF19

122
F11
-----
UsrF11
-----
-----
-----

126
-----
-----
-----
-----
-----
-----

115
Do
F16
-----
-----
-----
UsrF16

8
7
&
-----
-----
-----
-----

22
y
Y
EM
-----
-----
-----

36
h
H
BS
-----
-----
-----

51
n
N
SO
-----
-----
-----

12
-
_
US
-----
-----
-----

26
p
P
DLE
-----
-----
-----

40
;
:
-----
-----
-----
-----

55
/
?
-----
-----
-----
-----

58
-----
-----
-----
-----
-----
-----

4
3
#
-----
-----
-----
-----

18
w
W
ETB
-----
-----
-----

32
s
S
DC3
-----
-----
-----

47
x
X
CAN
-----
-----
-----

119
F8
F20
UsrF8
-----
-----
UsrF20

123
F12
-----
UsrF12
-----
-----
-----

Segment A assignment:

Segment B assignment:

A

B C D
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Segment C assignment: Segment D assignment:

90
BkTab
TabFld
-----
-----
-----
-----

91
Select
numpd 7
-----
-----
-----
-----

92
Left
numpd 4
-----
-----
-----
-----

93
HmeCur
numpd 1
-----
-----
-----
-----

99
Insert/Overstrike
numpd 0
-----
-----
-----
-----

95
-----
InsrtLn
-----
-----
-----
-----

96
Up
numpd 8
-----
-----
-----
-----

97
-----
numpd 5
-----
-----
-----
-----

98
Down
numpd 2
-----
-----
-----
-----

100
-----
DelLn
-----
-----
-----
-----

101
PrvPg
numpd 9
-----
-----
-----
-----

102
Right
numpd 6
-----
-----
-----
-----

103
NxPg
numpd 3
-----
-----
-----
-----

104
ClrFld
numpd .
-----
-----
-----
-----

105
-----
DelChar
-----
-----
-----
-----

106
numpd —
numpd ,
-----
-----
-----
-----

108
-----
Transmit
-----
-----
-----
-----

75
Insrt/Ovstrk
-----
-----
-----
-----
-----

76
ClrFld
ClrPg
-----
-----
-----
-----

79
Left
-----
-----
-----
-----
-----

80
Select
EDIT
-----
-----
-----
-----

81
HomeCur
-----
-----
-----
-----
-----

83
Up
-----
-----
-----
-----
-----

84
Down
-----
-----
-----
-----
-----

85
PrevPg
-----
-----
-----
-----
-----

86
NextPg
-----
-----
-----
-----
-----

89
Right
-----
-----
-----
-----
-----
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Space-Saving Keyboard (3270 Only)

Segment A assignment:

Segment B assignment:

A

B C

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
-----
Doc
Doc
Red

PF2
PF14
-----
WdWrap
WdWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

TabFld
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
BackSp
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
-----
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turq

PF7
PF19
RPause
-----
-----
White

PF8
PF20
-----
APL
APL

PF9
PF21
-----
CurSel
CurSel
-----

PF11
PF23
RTM
AltCur
AltCur
-----

PF12
PF24
-----
+Cr
+Cr
-----

PF10
PF22
-----

-----

CurBlink
CurBlink

FldColor

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment:

Insert
Dup
-----
PA1
PA1
-----

Delete
Delete

Home
FM
Rule
PA2
PA2
-----

Up
Mkup
Mvup
FastUp
FastUp
-----

Down
MkDown
MvDown

-----

Left
MkLeft
MvLeft

-----

Right

-----

FastDn
FastDn

BtbWord
BtbWord

MkRight
MvRight
TabWord
TabWord

ErEOF
ErFld
-----
ErInp
ErInp
-----

-----
PA3
ChgScrn
JmpNext
JmpNext
-----

-----
-----
Test
-----
-----
-----

DelWord
DelWord
DelWord
-----

75

76

80

83

8479 89

81

85

86
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Space-Saving Keyboard (5250 Only)

Segment A assignment:

Segment B assignment:

A

B C

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
-----
Help
-----
-----

PF2
PF14
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

TabFld
BackTb
ReqTab
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

FldExt
NewLin
CarRtn
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
BackSp
ReqBSp
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
-----
-----
-----
-----

Clear
-----
HostPr
TstReq
-----
-----

PF4
PF16
-----
-----
-----
-----

PF5
PF17
Record
-----
-----
-----

PF6
PF18
Play
-----
-----
-----

PF7
PF19
RPause
-----
-----
-----

PF8
PF20
-----
-----
-----
-----

PF9
PF21
-----
-----
-----
-----

PF11
PF23
-----
AltCur
AltCur
-----

PF12
PF24
-----
-----
-----
-----

PF10
PF22
-----

-----

CurBlink
CurBlink

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment:

Insert
Dup
DspTxC
-----
-----
-----

Delete
Delete

Home
FM
Rule
-----
-----
-----

Up
Mkup
Mvup
FastUp
FastUp
-----

Down
MkDown
MvDown

-----

Left
MkLeft
MvLeft

-----

Right

-----

FastDn
FastDn

BtbWord
BtbWord

MkRight
MvRight
TabWord
TabWord

ErEOF
-----
-----
ErInp
ErInp
-----

RolDwn
RolDwn
-----
JmpNxt
JmpNxt
-----

RolUp
RolUp
-----
-----
-----
-----

DelWord
DelWord
DelWord
-----

75

76

80

83

8479 89

81

85

86
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Space-Saving Keyboard (Combined 3270 and 5250)

Segment A assignment:

Segment B assignment:

A

B C

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
-----
Doc
Doc
Red

PF2
PF14
-----
WdWrap
WdWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

TabFld
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
ChrAdv
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
-----
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turq

PF7
PF19
RPause
-----
-----
White

PF8
PF20
-----
APL
APL

PF9
PF21
-----
CurSel
CurSel
-----

PF11
PF23
RTM
AltCur
AltCur
-----

PF12
PF24
-----
+Cr
+Cr
-----

PF10
PF22
-----

-----

CurBlink
CurBlink

FldColor

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment:

Insert
Dup
-----
PA1
PA1
-----

Delete
Delete

Home
FM
Rule
PA2
PA2
-----

Up
Mkup
Mvup
FastUp
FastUp
-----

Down
MkDown
MvDown

-----

Left
MkLeft
MvLeft

-----

Right

-----

FastDn
FastDn

BtbWord
BtbWord

MkRight
MvRight
TabWord
TabWord

ErEOF
ErFld
-----
ErInp
ErInp
-----

RolDwn
PA3
ChgScrn
JmpNxt
JmpNxt
-----

RolUp
-----
Test
-----
-----
-----

DelWord
DelWord
DelWord
-----

75

76

80

83

8479 89

81

85

86
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5576-001 (3270 Only)

Segment A assignment:

112
PF1
PF13
SOSI
Doc

-----
-----

113
PF2
PF14
-----
WordWrap
-----
-----

114
PF3
PF15
AltView
CfgFmt
-----
-----

115
PF4
PF16
-----
-----
-----
-----

116
PF5
PF17
-----
-----
-----
-----

117
PF6
PF18
-----
-----
-----
-----

118
PF7
PF19
-----
-----
-----
-----

119
PF8
PF20
APL
-----
APL
-----

120
PF9
PF21
-----
-----
-----
-----

121
PF10
PF22
-----
-----
-----
-----

122
PF11
PF23
-----
-----
-----
-----

123
PF12
PF24
-----
GrpCsr
-----
-----

-----
-----
-----
-----
-----
-----

CrBrk
-----
-----
AltCr
-----
-----

ErEOF
-----
-----
ErInp
-----
-----

SysAttn
-----
-----
CrSel
-----
-----

PA1
-----
-----
DevCom
-----
-----

PA2
-----
-----
PA3
-----
-----

Segment B assignment:

Reset
Reset
-----
Record
-----
-----

Play
-----
-----
RPause
-----
-----

-----
-----
-----
-----
-----
-----

Clear
Clear
SysReq
-----
-----
-----

-----
-----
-----
-----
-----
-----

1
SysAttn
SysReq
-----
-----
-----
-----

2
-----
-----
-----
-----
-----
-----

3
-----
-----
-----
-----
-----
-----

4
-----
-----
-----
-----
-----
-----

5
-----
-----
-----
-----
-----
-----

6
-----
-----
-----
-----
-----
-----

7
-----
-----
-----
-----
-----
-----

12
-----
-----

US
-----
-----
-----

13
-----
-----

RS
-----
-----
-----

15
BackSp
BackSp
-----
EditUnd
-----
-----

17
-----
-----
DCI

-----
-----
-----

18
-----
-----
ETB

-----
-----
-----

19
-----
-----
ENQ

-----
-----
-----

20
-----
-----
DC2

-----
-----
-----

21
-----
-----
DC4

-----
-----
-----

22
-----
-----
EM

-----
-----
-----

23
-----
-----
NAK

-----
-----
-----

24
-----
-----

HT
-----
-----
-----

25
-----
-----
SI

-----
-----
-----

26
-----
-----
DLE

-----
-----
-----

27
-----
-----
NUL

-----
-----
-----

28
-----
-----
ESC

-----
-----
-----

31
-----
-----
SOH

-----
-----
-----

32
-----
-----
DC3

-----
-----
-----

33
-----
-----
EOT

-----
-----
-----

34
-----
-----
ACK

-----
-----
-----

35
-----
-----
BEL

-----
-----
-----

36
-----
-----

BS
-----
-----
-----

37
-----
-----

LF
-----
-----
-----

38
-----
-----

VT
-----
-----
-----

39
-----
-----

FF
-----
-----
-----

40
-----
-----
-----
-----
-----
-----

41
-----
-----
-----
-----
-----
-----

46
-----
-----
SUB

-----
-----
-----

47
-----
-----
CAN

-----
-----
-----

48
-----
-----
ETX

-----
-----
-----

49
-----
-----
SYN

-----
-----
-----

50
-----
-----
STX

-----
-----
-----

51
-----
-----

SO
-----
-----
-----

52
-----
-----

CR
-----
-----
-----

53
-----
-----
-----
-----
-----
-----

54
-----
-----
-----
-----
-----
-----

55
-----
-----

FS
-----
-----
-----

60
-----
-----
-----
-----
-----
-----

62
-----
-----
-----
-----
-----
-----

16
Tab

BackTab
-----
-----
-----
-----

29
-----
-----
-----
-----
-----
-----

44
-----
-----
-----
-----
-----
-----

30
-----
-----
-----
-----
-----
-----

43
NewLine
NewLine
-----
NewLine
-----
-----

57
-----
-----
-----
-----
-----
-----

58
-----
-----
-----
-----
-----
-----

64
Entr/Ctl
Entr/Ctl

-----
-----
-----
-----

61
-----
-----
-----
-----
-----
-----

BB

A

C D

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

8
-----
-----
-----
-----
-----
-----

9
-----
-----
-----
-----
-----
-----

10
-----
-----
-----
-----
-----
-----

11
-----
-----
-----
-----
-----
-----

14
-----
-----
-----
-----
-----
-----

-----
-----

GS
-----
-----
-----
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Segment C assignment:

75
-----
-----
-----
-----
-----
-----

80
-----
-----
-----
ChngScr
ChngScr
-----

85
JmpNext
JmpNext
-----
-----
-----
-----

90
Dup
Dup

-----
Reverse
-----
-----

95
FldMark
FldMark
-----
Red
-----
Trn0p

100
-----
-----
-----
Pink
Reverse
-----

105
-----
-----
Break
-----
-----
-----

76
Insert
EditPaste
EditCopy
-----
-----
-----

81
DelChar
EditCut
-----
-----
-----
-----

86
-----
-----
-----
-----
-----
-----

83
Up

MarkUp
MoveUp
-----
-----
-----

79
Left

MarkLef
MoveLef
FastLef
-----
-----

84
Home
Home
Rule
-----
-----
-----

89
Right

MarkRig
MoveRig
FastRig
-----
-----

Down
MarkDow
MoveDow
-----
-----
-----

91
-----
-----
-----
-----
-----
-----

96
-----
-----
-----
Green
-----
TrnFldI

101
-----
-----
-----
Yellow
-----
-----

106
-----
-----
-----
-----
-----
-----

92
-----
-----
-----
UnderSc
-----
-----

97
-----
-----
-----
Blue
-----
-----

102
-----
-----
Turquoi
-----
-----
-----

93
-----
-----
-----
FieldHi
-----
-----

98
-----
-----
-----
White
-----
-----

103
ESC_J
-----
-----
-----
-----
-----

108
Enter
Enter
-----
-----
-----
-----

99
-----
-----
-----
-----
-----
-----

104
-----
-----
-----
FldColor
-----
-----

Segment D assignment:
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5576-001 (5250 Only)

Segment A assignment:

112
PF1
PF13
SOSI
-----
-----
-----

113
PF2
PF14
-----
-----
-----
-----

114
PF3
PF15
AltView
-----
-----
-----

115
PF4
PF16
-----
-----
-----
-----

116
PF5
PF17
-----
-----
-----
-----

117
PF6
PF18
-----
-----
-----
-----

118
PF7
PF19
-----
-----
-----
-----

119
PF8
PF20
-----
-----
-----
-----

120
PF9
PF21
-----
-----
-----
-----

121
PF10
PF22
-----
-----
-----
-----

122
PF11
PF23
-----
-----
-----
-----

123
PF12
PF24
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

CrBrk
-----
-----
AltCr
-----
-----

ErEOF
-----
-----
ErInp
-----
-----

SysAttn
-----
-----
TestReq
TestReq
-----

-----
-----
-----
Quit
-----
-----

-----
-----
-----
-----
-----
-----

Segment B assignment:

Reset
Reset
-----
Record
-----
-----

Play
-----
-----
RPause
-----
-----

-----
-----
-----
-----
-----
-----

Clear
Clear
SysReq
-----
-----
-----

-----
-----
-----
-----
-----
-----

1
Newlin
-----
-----
-----
-----
-----

2
-----
-----
-----
-----
-----
-----

3
-----
-----
-----
-----
-----
-----

4
-----
-----
-----
-----
-----
-----

5
-----
-----
-----
-----
-----
-----

6
-----
-----
-----
-----
-----
-----

7
-----
-----
-----
-----
-----
-----

12
-----
-----
Ansi A3
-----
-----
-----

13
-----
-----
-----
-----
-----
-----

15
CharBsp
CharAdv
-----
EditUnd
-----
-----

17
-----
-----
-----
-----
-----
-----

18
-----
-----
-----
-----
-----
-----

19
-----
-----
-----
-----
-----
-----

20
-----
-----
-----
-----
-----
-----

21
-----
-----
-----
-----
-----
-----

22
-----
-----
-----
-----
-----
-----

23
-----
-----
-----
-----
-----
-----

24
-----
-----
-----
-----
-----
-----

25
-----
-----
-----
-----
-----
-----

26
-----
-----
-----
-----
-----
-----

27
-----
-----
-----
Ansi A2
-----
-----

28
-----
-----
-----
-----
-----
-----

31
-----
-----
-----
-----
-----
-----

32
-----
-----
-----
-----
-----
-----

33
-----
-----
-----
-----
-----
-----

34
-----
-----
-----
-----
-----
-----

35
-----
-----
-----
-----
-----
-----

36
-----
-----
-----
-----
-----
-----

37
-----
-----
-----
-----
-----
-----

38
-----
-----
-----
-----
-----
-----

39
-----
-----
-----
-----
-----
-----

40
-----
-----
-----
-----
-----
-----

41
-----
-----
-----
-----
-----
-----

46
-----
-----
-----
-----
-----
-----

47
-----
-----
-----
-----
-----
-----

48
-----
-----
-----
-----
-----
-----

49
-----
-----
-----
-----
-----
-----

50
-----
-----
-----
-----
-----
-----

51
-----
-----
-----
-----
-----
-----

52
-----
-----
-----
-----
-----
-----

53
-----
-----
-----
-----
-----
-----

54
-----
-----
-----
-----
-----
-----

55
-----
-----
-----
-----
-----
-----

60
-----
-----
-----
-----
-----
-----

62
-----
-----
-----
-----
-----
-----

16
Tab

BackTab
-----
-----
-----
-----

29
-----
-----
-----
-----
-----
-----

44
-----
-----
-----
-----
-----
-----

30
-----
-----
-----
-----
-----
-----

43
FieldExt
FieldExt
-----
-----
-----
-----

57
-----
-----
-----
-----
-----
-----

58
-----
-----
-----
-----
-----
-----

64
Entr/Ctl
Entr/Ctl

-----
-----
-----
-----

61
-----
-----
-----
-----
-----
-----

BB

A

C D

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

SOSI
SOSI
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

8
-----
-----
-----
-----
-----
-----

9
-----
-----
-----
-----
-----
-----

10
-----
-----
-----
-----
-----
-----

11
-----
Ansi 7E
-----
-----
-----
-----

14
-----
-----
-----
Ansi AC
-----
-----

Ansi 5C
-----
-----
-----
-----
-----
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Segment C assignment:

75
RollDwn
RollDwn
-----
-----
-----
-----

80
Home
FldMk
Rule
-----
-----
-----

85
RollUp
RollUp
-----
-----
-----
-----

90
Dup
Dup
Dup
Dup
Dup

-----

95
FldMark
FldMark
FldMark
FldMark
FldMark
-----

100
-----
-----
-----
-----
-----
-----

105
Field-
Field-
Field-
Field-
Field-
-----

76
Insert
EditPaste
EditCopy
-----
-----
-----

81
DelChar
-----
-----
-----
-----
-----

86
-----
-----
-----
-----
-----
-----

83
Up

MarkUp
MoveUp
FastUp
-----
-----

79
Left

MarkLef
MoveLef
FastLef
-----
-----

84
Home
Home
Rule
-----
-----
-----

89
Right

MarkRig
MoveRig
FastRig
-----
-----

Down
MarkDow
MoveDow
FastDow
-----
-----

91
-----
-----
-----
-----
-----
-----

96
-----
-----
-----
-----
-----
-----

101
-----
-----
-----
-----
-----
-----

106
Field+
Field+
Field+
Field+
Field+
-----

92
-----
-----
-----
-----
-----
-----

97
-----
-----
-----
-----
-----
-----

102
-----
-----
-----
-----
-----
-----

93
-----
-----
-----
-----
-----
-----

98
-----
-----
-----
-----
-----
-----

103
-----
-----
-----
-----
-----
-----

108
FldExt
FldExt
-----
-----
-----
-----

99
-----
-----
-----
-----
-----
-----

104
-----
-----
-----
-----
-----
-----

Segment D assignment:
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5576-001 (Combined 3270 and 5250)

Segment A assignment:

112
PF1
PF13
SOSI
Doc

-----
-----

113
PF2
PF14
-----
WordWrap
-----
-----

114
PF3
PF15
AltView
CfgFmt
-----
-----

115
PF4
PF16
-----
-----
-----
-----

116
PF5
PF17
-----
-----
-----
-----

117
PF6
PF18
-----
-----
-----
-----

118
PF7
PF19
-----
-----
-----
-----

119
PF8
PF20
APL
-----
APL
-----

120
PF9
PF21
-----
-----
-----
-----

121
PF10
PF22
-----
-----
-----
-----

122
PF11
PF23
-----
-----
-----
-----

123
PF12
PF24
-----
+Cr

-----
-----

-----
-----
-----
-----
-----
-----

CrBnk
-----
-----
AltCur
-----
-----

ErEOF
-----
-----
ErInp
-----
-----

SysAttn
-----
-----
CrSel
-----
-----

PA1
-----
-----
DevCom
-----
-----

PA2
-----
-----
PA3
-----
-----

Segment B assignment:

Reset
Reset
-----
Record
-----
-----

Play
-----
-----
RPause
-----
-----

-----
-----
-----
-----
-----
-----

Clear
Clear
SysReq
SysReq
-----
-----

-----
-----
-----
-----
-----
-----

1
SysAttn
-----
-----
-----
-----
-----

2
-----
-----
-----
-----
-----
-----

3
-----
-----
-----
-----
-----
-----

4
-----
-----
-----
-----
-----
-----

5
-----
-----
-----
-----
-----
-----

6
-----
-----
-----
-----
-----
-----

7
-----
-----
-----
-----
-----
-----

12
-----
-----
US
Ansi A3
-----
-----

13
-----
-----

RS
-----
-----
-----

15
BackSp
CharAdv
-----
-----
-----
-----

17
-----
-----
DCI

-----
-----
-----

18
-----
-----
ETB

-----
-----
-----

19
-----
-----
ENQ

-----
-----
-----

20
-----
-----
DC2

-----
-----
-----

21
-----
-----
DC4

-----
-----
-----

22
-----
-----
EM

-----
-----
-----

23
-----
-----
NAK

-----
-----
-----

24
-----
-----

HT
-----
-----
-----

25
-----
-----

SI
-----
-----
-----

26
-----
-----
DLE

-----
-----
-----

27
-----
-----
NUL
Ansi A2
-----
-----

28
-----
-----
ESC

-----
-----
-----

31
-----
-----
SOH

-----
-----
-----

32
-----
-----
DC3

-----
-----
-----

33
-----
-----
EOT

-----
-----
-----

34
-----
-----
ACK

-----
-----
-----

35
-----
-----
BEL

-----
-----
-----

36
-----
-----

BS
-----
-----
-----

37
-----
-----

LF
-----
-----
-----

38
-----
-----

VT
-----
-----
-----

39
-----
-----

FF
-----
-----
-----

40
-----
-----
-----
-----
-----
-----

41
-----
-----
-----
-----
-----
-----

46
-----
-----

SUB
-----
-----
-----

47
-----
-----
CAN

-----
-----
-----

48
-----
-----
ETX

-----
-----
-----

49
-----
-----
SYN

-----
-----
-----

50
-----
-----
STX

-----
-----
-----

51
-----
-----

SO
-----
-----
-----

52
-----
-----

CR
-----
-----
-----

53
-----
-----
-----
-----
-----
-----

54
-----
-----
-----
-----
-----
-----

55
-----
-----
-----
-----
-----
-----

60
-----
-----
-----
-----
-----
-----

62
-----
-----
-----
-----
-----
-----

16
Tab

BackTab
-----
-----
-----
-----

29
-----
-----
-----
-----
-----
-----

44
-----
-----
-----
-----
-----
-----

30
-----
-----
-----
-----
-----
-----

43
NewLine
NewLine
-----
-----
-----
-----

57
-----
-----
-----
-----
-----
-----

58
-----
-----
-----
-----
-----
-----

64
Entr/Ctl
Entr/Ctl

-----
-----
-----
-----

61
-----
-----
-----
-----
-----
-----

BB

A

C D

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Help
Help
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

SOSI
SOSI
-----
-----
-----
-----

HostPrt
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

8
-----
-----
-----
-----
-----
-----

9
-----
-----
-----
-----
-----
-----

10
-----
-----
-----
-----
-----
-----

11
-----
Ansi 7E
-----
-----
-----
-----

14
-----
-----
-----
Ansi A3
-----
-----

42
-----
-----
GS

-----
-----
-----

Ansi 5C
-----
FS

-----
-----
-----
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Segment C assignment:

75
RollDwn
-----
-----
-----
-----
-----

80
-----
-----
-----
ChgScr
ChgScr
-----

85
RollDwn
JmpNext
-----
-----
-----
-----

90
Dup
Dup

-----
Reverse
-----
-----

95
FldMark
FldMark
-----
Red

-----
Trn0p

100
-----
-----
-----
Pink
-----
-----

105
Field-
Field-
Break
-----
-----
-----

76
Insert
EditPaste
EditCopy
-----
-----
-----

81
DelChar
EditCut
-----
-----
-----
-----

86
-----
-----
-----
-----
-----
-----

83
Up

MarkUp
MoveUp
FastUp
FastUp
-----

79
Left

MarkLef
MoveLef
FastLef
-----
-----

84
Home
Home
Rule
-----
-----
-----

89
Right

MarkRig
MoveRig
FastRig
-----
-----

Down
MarkDow
MoveDow
-----
-----
-----

91
-----
-----
-----
-----
-----
-----

96
-----
-----
-----
Green
-----
FldTrns

101
-----
-----
-----
Yellow
-----
-----

106
Field+
Field+
-----
-----
-----
-----

92
-----
-----
-----
UnderSc
-----
-----

97
-----
-----
-----
Blue
-----
-----

102
-----
-----
-----
Turquoi
-----
-----

93
-----
-----
-----
FieldHi
-----
-----

98
-----
-----
-----
White
-----
-----

103
ESC_J
-----
-----
-----
-----
-----

108
Enter
Enter
-----
-----
-----
-----

99
-----
-----
-----
-----
-----
-----

104
-----
-----
-----
FldCol
-----
-----

Segment D assignment:
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5576-A01 (3270 Only)

Segment A assignment:

Segment B assignment:

A

B C D

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Doc
Doc
Red

PF2
PF14
-----
WordWrap
WordWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Tab
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctl
Enter/Ctl
-----
-----
-----
-----

-----
-----
SUB

-----
-----
-----

-----
-----
CAN

-----
-----
-----

-----
-----
ETX

-----
-----
-----

-----
-----
SYN

-----
-----
-----

-----
-----
STX

-----
-----
-----

-----
-----
SO

-----
-----
-----

-----
-----
CR

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
SOH

-----
-----
-----

-----
-----
DC3

-----
-----
-----

-----
-----
EOT

-----
-----
-----

-----
-----
ACK

-----
-----
-----

-----
-----
BEL

-----
-----
-----

-----
-----
BS

-----
-----
-----

-----
-----
LF

-----
-----
-----

-----
-----
VT

-----
-----
-----

-----
-----
FF

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
DC1

-----
-----
-----

-----
-----
ETB

-----
-----
-----

-----
-----
ENQ

-----
-----
-----

-----
-----
DC2

-----
-----
-----

-----
-----
DC4

-----
-----
-----

-----
-----
EM

-----
-----
-----

-----
-----
NAK

-----
-----
-----

-----
-----
HT

-----
-----
-----

-----
-----
SI

-----
-----
-----

-----
-----
DLE

-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
ESC

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
US

-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
BackSp
-----

-----
-----

EditUnd

-----
-----
-----
-----
-----
-----

PF3
PF15
AltView
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turq

PF7
PF19
RPause
-----
-----
White

PF8
PF20
APL
-----
APL

PF9
PF21
CrSel
-----
CrSel
-----

PF11
PF23
RTM
AltCr
AltCr
-----

PF12
PF24
-----
GrpCsr
GrpCsr
-----

PF10
PF22
CrBnk
-----
CrBnk
-----FldColor

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FldMk
Rule
PA2
PA2
-----

Up
MarkUp
MoveUp
FastUp
FastUp
-----

Down
MarkDow
MoveDow
FastDow
FastDow
-----

Left
MarkLef
MoveLef
BackWd
BackWd
-----

Right
MarkRig
MoveRig
FwdWd
FwdWd
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
TrnOp

-----
-----
-----
-----
-----
-----

-----
-----
-----

Reverse
Reverse
-----

ErEOF
ErFld
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----

MovLeft
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MoveRig
UnderSc
UnderSc
-----

EndFld
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

ESC J
-----
-----

FieldHi
FieldHi
-----

Up
-----
MoveUp
FastUp
FastUp
TrnFldI

Down
-----

MoveDow
FastDow
FastDow
-----

DelWd
DelWd

Enter
Enter
-----
-----
-----
-----

-----
PA3

ChgScn
JmpNext
JmpNext
-----

-----
EditPst
Test
-----
-----
-----

Dup

EditCut

PA1
PA1

EditCop

DelWd
DelWd
-----

EditPst

-----

75

76

80

83

8479 89

90 10595 100

81 91

92 97 102
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5576-A01 Keyboard (5250 Only)

Segment A assignment:

Segment B assignment:

A

B C

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Help
-----
-----

PF2
PF14
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Tab
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctrl
Enter/Ctrl
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

FieldExt
FieldExt
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
Ansi A2
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
Ansi 7E
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
Ansi A3
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
Ansi AC
-----
-----

CharBsp
CharAdv
-----

EditUnd
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
AltView
-----
-----
-----

Clear
-----
HostPr
-----
-----
-----

PF4
PF16
-----
-----
-----
-----

PF5
PF17
Record
-----
-----
-----

PF6
PF18
Play
-----
-----
-----

PF7
PF19
RPause
-----
-----
-----

PF8
PF20
SOSI/G
-----
SOSI/G

PF9
PF21
-----
-----
-----
-----

PF11
PF23
AltCur
-----
AltCur
-----

PF12
PF24
-----
TestReq
TestReq
-----

PF10
PF22
-----
-----
-----
-----FieldCol
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FldMk
Rule
-----
-----
-----

Up
MarkUp
MoveUp
FastUp
FastUp
-----

Down
MarkDow
MoveDow
FastDow
FastDow
-----

Left
MarkLef
MoveLef
BackWd
BackWd
-----

Right
MarkRig
MoveRig
TabWord
TabWord
-----

Ansi 2D
Ansi 2D
Field-
Field-
Field-
-----

FldMk
FldMk
FldMk
FldMk
FldMk
-----

Dup
Dup

-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

ErEOF
-----
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----

MoveLft
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MoveRig
-----
-----
-----

ErEOF
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----
-----

RollDwn
-----
-----
-----
-----
-----

RollUp
-----
-----
-----
-----
-----

Up
-----
MoveUp
FastUp
FastUp
-----

Down
-----

MoveDow
FastDow
FastDow
-----

DelWord
DelWord

Field+
Field+
Field+
Field+
Field+
-----

FldExt
FldExt
-----
-----
-----
-----

RollDwn
RollDwn
-----

JumpNxt
JumpNxt
-----

RollUp
EditPst
-----
-----
-----
-----

Dup

EditCut

-----
-----

EditCop

DelWd
DelWd
-----

EditPst

-----

75

76

80

83

8479 89

90 10595 100
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92 97 102
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5576-A01 Keyboard (Combined 3270 and 5250)

Segment A assignment:

Segment B assignment:

A

B C D

110
Attn

SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Doc
Doc
Red

PF2
PF14
-----
WordWrap
WordWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Tab
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Enter/Ctl
Enter/Ctl
-----
-----
-----
-----

-----
-----
SUB

-----
-----
-----

-----
-----
CAN

-----
-----
-----

-----
-----
ETX

-----
-----
-----

-----
-----
SYN

-----
-----
-----

-----
-----
STX

-----
-----
-----

-----
-----
SO

-----
-----
-----

-----
-----
CR

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
SOH

-----
-----
-----

-----
-----
DC3

-----
-----
-----

-----
-----
EOT

-----
-----
-----

-----
-----
ACK

-----
-----
-----

-----
-----
BEL

-----
-----
-----

-----
-----
BS

-----
-----
-----

-----
-----
LF

-----
-----
-----

-----
-----
VT

-----
-----
-----

-----
-----
FF

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
DC1

-----
-----
-----

-----
-----
ETB

-----
-----
-----

-----
-----
ENQ

-----
-----
-----

-----
-----
DC2

-----
-----
-----

-----
-----
DC4

-----
-----
-----

-----
-----
EM

-----
-----
-----

-----
-----
NAK

-----
-----
-----

-----
-----
HT

-----
-----
-----

-----
-----
SI

-----
-----
-----

-----
-----
DLE

-----
-----
-----

-----
-----
NUL

ANSI A2
-----
-----

-----
-----
ESC

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
ANSI 7E
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
US

ANSI A3
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----

ANSI AC
-----
-----

BackSp
CharAdv
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
AltView
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turquois

PF7
PF19
RPause
-----
-----
White

PF8
PF20
APL
-----
APL
-----

PF9
PF21
-----
CrSel
CrSel
-----

PF11
PF23
AltCur
-----
AltCur
-----

PF12
PF24
-----
+Cr
+Cr
-----

PF10
PF22
CrBnk
-----
CrBnk
-----

112 113
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FieldMk
Rule
PA2
PA2
-----

Up
MarkUp
MoveUp
FastUp
FastUp
-----

Down
MarkDow
MoveDow
FastDow
FastDow
-----

Left
MarkLef
MoveLef
BackWd
BackWd
-----

Right
MarkRig
MoveRig
FwdWd
FwdWd
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
TrnOp

ANSI 2D
ANSI 2D
-----
-----
-----
-----

-----
-----
-----

Reverse
Reverse
-----

ErEOF
ErFld
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----

MoveLet
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MoveRig
UnderSc
UnderSc
-----

EndFld
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----
-----

-----
-----
-----
-----
-----
-----

Field
-----
-----
-----
-----
-----

ESC J
-----
-----

FieldHi
FieldHi
-----

Up
-----
MoveUp
FastUp
FastUp
TrnFldI

Down
-----

MoveDow
FastDow
FastDow
-----

DelWord
DelWord

Enter
Enter
-----
-----
-----
-----

RollDwn
PA3

ChgScn
JumpNxt
JumpNxt
-----

RollUp
EditPst
Test
-----
-----
-----

Dup

EditCut

PA1
PA1

EditCop

DelWord
DelWord
-----

EditPst

-----
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5576-002/003 (3270 Only)

Segment A assignment:

Segment B assignment:

A

B C D

110
Sysattn
SysRq
-----
-----
-----
-----

PF1
PF13
SOSI
Doc
Doc
Red

PF2
PF14
-----
WordWrap
WordWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Tab
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctrl
Reset/Ctrl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Entr/Ctl
Entr/Ctl
-----
-----
-----
-----

-----
-----
SUB

-----
-----
-----

-----
-----
CAN

-----
-----
-----

-----
-----
ETX

-----
-----
-----

-----
-----
SYN

-----
-----
-----

-----
-----
STX

-----
-----
-----

-----
-----
SO

-----
-----
-----

-----
-----
CR

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
SOH

-----
-----
-----

-----
-----
DC3

-----
-----
-----

-----
-----
EOT

-----
-----
-----

-----
-----
ACK

-----
-----
-----

-----
-----
BEL

-----
-----
-----

-----
-----
BS

-----
-----
-----

-----
-----
LF

-----
-----
-----

-----
-----
VT

-----
-----
-----

-----
-----
FF

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
DC1

-----
-----
-----

-----
-----
ETB

-----
-----
-----

-----
-----
ENQ

-----
-----
-----

-----
-----
DC2

-----
-----
-----

-----
-----
DC4

-----
-----
-----

-----
-----
EM

-----
-----
-----

-----
-----
NAK

-----
-----
-----

-----
-----
HT

-----
-----
-----

-----
-----
SI

-----
-----
-----

-----
-----
DLE

-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
ESC

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
US

-----
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----
-----
-----
-----

BackSp
BackSp
-----

EditUnd
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
AltView
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turquois

PF7
PF19
RPause
-----
-----
White

PF8
PF20
APL
-----
APL
FieldCol

PF9
PF21
CrSel
-----
CrSel
-----

PF11
PF23
RTM
AltCr
AltCr
-----

PF12
PF24
-----
GrpCsr
GrpCsr
-----

PF10
PF22
CrBnk
-----
CrBnk
-----

112 113
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FldMk
Rule
PA2
PA2
-----

Up
MarkUp
MoveUp
FastUp
FastUp
-----

Down
MarkDow
MoveDow
FastDow
FastDow
-----

Left
MarkLef
MoveLef
BackWd
BackWd
-----

Right
MarkRig
MoveRig
FwdWd
FwdWd
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
TrnOp

-----
-----
-----
-----
-----
-----

-----
-----
-----

Reverse
Reverse
-----

ErEOF
ErFld
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----

MovLeft
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MoveRig
UnderSc
UnderSc
-----

EndFld
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

ESC J
-----
-----

FieldHi
FieldHi
-----

Up
-----
MoveUp
FastUp
FastUp
TrnFldI

Down
-----

MoveDow
FastDow
FastDow
-----

DelWd
DelWd

Enter
Enter
-----
-----
-----
-----

-----
PA3

ChgScn
JmpNext
JmpNext
-----

-----
EditPst
Test
-----
-----
-----

Dup

EditCut

PA1
PA1

EditCop

DelWd
DelWd
-----

EditPst

-----

75

76

80

83

8479 89

90 10595 100

81 91

92 97 102

93

99 104

96

98

101

103

106

108

85

86
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5576-002/003 Keyboard (5250 Only)

Segment A assignment:

Segment B assignment:

A

B C D

110
SysAttn
SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Help
-----
-----

PF2
PF14
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Tab
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctl
Reset/Ctl
-----
Quit
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Entr/Ctl
Entr/Ctl
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

FieldExt
FieldExt
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----

Ansi A2
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
Ansi 7E
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----

Ansi A3
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----

ANSI AC
-----
-----

CharBsp
CharAdv
-----

EditUnd
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
AltView
-----
-----
-----

Clear
-----
HostPr
-----
-----
-----

PF4
PF16
-----
-----
-----
-----

PF5
PF17
Record
-----
-----
-----

PF6
PF18
Play
-----
-----
-----

PF7
PF19
Pause

-----
-----
-----

PF8
PF20
SOSI/G
-----
SOSI/G
FieldCol

PF9
PF21
-----
-----
-----
-----

PF11
PF23
AltCur
-----
AltCur
-----

PF12
PF24
-----
TestReq
TestReq
-----

PF10
PF22
-----
-----
-----
-----

112 113

125124

1
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44
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FldMk
Rule
-----
-----
-----

Up
MarkUp
MoveUp
FastUp
FastUp
-----

Down
MarkDow
MoveDow
FastDow
FastDow
-----

Left
MarkLef
MoveLef
BackWd
BackWd
-----

Right
MarkRig
MoveRig
TabWord
TabWord
-----

Dup
Dup
Dup
Dup
Dup

-----

ANSI 2D
ANSI 2D
-----
-----
-----
-----

FldMk
FldMk
FldMk
FldMk
FldMk
-----

-----
-----
-----
-----
-----
-----

ErEOF
-----
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----

MoveLft
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MoveRig
-----
-----
-----

ErEOF
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----
-----

RollDwn
-----
-----
-----
-----
-----

RollUp
-----
-----
-----
-----
-----

Up
-----
MoveUp
FastUp
FastUp
-----

Down
-----

MoveDow
FastDow
FastDow
-----

DelWord
DelWord

Field+
Field+
Field+
Field+
Field+
-----

FldExt
FldExt
-----
-----
-----
-----

RollDwn
RollDwn
-----

JumpNxt
JumpNxt
-----

RollUp
EditPst
-----
-----
-----
-----

Dup

EditCut

-----
-----

EditCop

DelWd
DelWd
-----

EditPst

-----

75
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81 91

92 97 102

93

99 104

96

98

101

103

106

108

85

86

294 Personal Communications Administrator’s Guide and Reference



5576-002/003 Keyboard (Combined 3270 and 5250)

Segment A assignment:

Segment B assignment:

A

B C D

110
Attn

SysReq
-----
-----
-----
-----

PF1
PF13
SOSI
Doc
Doc
Red

PF2
PF14
-----
WordWrap
WordWrap
Pink

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Tab
BackTab
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Reset/Ctl
Reset/Ctl
-----
Quit
Quit
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

Entr/Ctl
Entr/Ctl
-----
-----
-----
-----

-----
-----
SUB

-----
-----
-----

-----
-----
CAN

-----
-----
-----

-----
-----
ETX

-----
-----
-----

-----
-----
SYN

-----
-----
-----

-----
-----
STX

-----
-----
-----

-----
-----
SO

-----
-----
-----

-----
-----
CR

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
SOH

-----
-----
-----

-----
-----
DC3

-----
-----
-----

-----
-----
EOT

-----
-----
-----

-----
-----
ACK

-----
-----
-----

-----
-----
BEL

-----
-----
-----

-----
-----
BS

-----
-----
-----

-----
-----
LF

-----
-----
-----

-----
-----
VT

-----
-----
-----

-----
-----
FF

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

NewLine
NewLine
-----
-----
-----
-----

-----
-----
DC1

-----
-----
-----

-----
-----
ETB

-----
-----
-----

-----
-----
ENQ

-----
-----
-----

-----
-----
DC2

-----
-----
-----

-----
-----
DC4

-----
-----
-----

-----
-----
EM

-----
-----
-----

-----
-----
NAK

-----
-----
-----

-----
-----
HT

-----
-----
-----

-----
-----
SI

-----
-----
-----

-----
-----
DLE

-----
-----
-----

-----
-----
NUL

ANSI A2
-----
-----

-----
-----
ESC

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
NUL

-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
ANSI 7E
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

-----
-----
US

ANSI A3
-----
-----

-----
-----
RS

-----
-----
-----

-----
-----
-----

ANSI AC
-----
-----

BackSp
CharAdv
-----
-----
-----
-----

-----
-----
-----
-----
-----
-----

PF3
PF15
AltView
CfgFmt
CfgFmt
Green

Clear
-----
Break
-----
-----
-----

PF4
PF16
-----
-----
-----
Yellow

PF5
PF17
Record
-----
-----
Blue

PF6
PF18
Play
-----
-----
Turquois

PF7
PF19
Pause
-----
-----
White

PF8
PF20
APL

-----
APL

-----

PF9
PF21
----
CrSel
CrSel
-----

PF11
PF23
AltCur
-----
AltCur
-----

PF12
PF24
-----
+Cr
+Cr
-----

PF10
PF22
CrBnk
-----
CrBnk
-----

112 113

125124

1

16

30

44

58 60 61 62 64

46 47 48 49 50 51 52 53 54 55 57

31 32 33 34 35 36 37 38 39 40 41 43

17 18 19 20 21 22 23 24 25 26 27 28 29

2 3 4 5 6 9 111087 12 13 14 15

114

126

115 116 117 118 119 120 123121 122
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Segment C assignment: Segment D assignment:

Insert

Delete

Home
FieldMk
Rule
PA2
PA2
-----

Up
MarkUp
MoveUp
FastUp
FastUp
-----

Down
MarkDow
MoveDow
FastDow
FastDow
-----

Left
MarkLef
MoveLef
BackWd
BackWd
-----

Right
MarkRig
MoveRig
FwdWd
FwdWd
-----

-----
-----
-----
-----
-----
-----

ANSI 2D
ANSI 2D
-----
-----
-----
-----

-----
-----
-----
-----
-----
TrnOp

-----
-----
-----

-----

ErEOF
ErFld
-----
ErInp
ErInp
-----

Home
-----
-----
-----
-----
-----

Left
-----

MoveLef
-----
-----
-----

-----
-----
-----
-----
-----
-----

Right
-----

MoveRig
UnderSc
UnderSc
-----

EndFld
-----
-----
-----
-----
-----

Insert
-----
-----
-----
-----
-----

Delete
-----

-----
-----

-----
-----
-----
-----
-----
-----

Esc J
-----
-----

-----

Up
-----
MoveUp
FastUp
FastUp
TrnFldI

Down
-----

MoveDow
FastDow
FastDow
-----

FieldHi
FieldHi

DelWord
DelWord

Field+
-----
-----
-----
-----
-----

Enter
Enter
-----
-----
-----
-----

RollDwn
PA3

ChgScn
JumpNxt
JumpNxt
-----

RollUp
EditPst
Test
-----
-----
-----

Dup

EditCut

PA1
PA1

EditCop

DelWord
DelWord
-----

Reverse
Reverse

EditPst

-----

75

76

80

83

8479 89

90 10595 100

81 91

92 97 102

93

99 104

96

98

101

103

106

108

85

86

APL Keyboard Layouts (3270 Only)
This section shows the APL keyboard layouts for each country. Only APL
characters are shown in each shift position (up/down/ALT).

Language Type Figure on

Austrian/German 1 page 297

Belgian 2 page 297

Canadian-Bilingual 1 page 297

Denmark 1 page 297

Finnish/Swedish 1 page 297

French AZERTY 2 page 297

Hangeul 4 page 298

Italian 1 page 297

Japanese 4 page 298

Latin American Spanish 1 page 297

Norwegian 1 page 297

Portuguese 1 page 297

Simplified Chinese 4 page 298

Spanish 1 page 297

Swiss-French 1 page 297

Swiss-German 1 page 297

Traditional Chinese 4 page 298

U.K. English 1 page 297

U.S. English 3 page 297
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Figure 26. Type-1 APL Keyboard

Figure 27. Type-2 APL Keyboard

Figure 28. Type-3 APL Keyboard
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Key Map for Home3270
This section shows the position of the following control codes:

NUL (X'00')
ESC (X'1B')
FS (X'1C')
GS (X'1D')
RS (X'1E')
US (X'1F')

The positions of these control codes are fixed and common for all languages
(including U.S. English), regardless of the characters assigned to BASE and UP
SHIFT positions of the keys. These control codes are positioned to the CONTROL
positions of the keys shown in Figure 30 through Figure 31 on page 299.

Figure 29. Type-4 APL Keyboard

NUL RS US

ESC GS FS

Figure 30. Common Control Code of Keyboard Core Segment for Non-Japanese Keyboard
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The positions of other control codes vary for each language. These control codes
are positioned to the CONTROL position of the associated alphabetic key. Those
control codes and the associated alphabetic characters are as follows.

Table 38. Other Control Code Map of Key Segment B

Control Code Associated Letter

SOH (X'01') a

STX (X'02') b

ETX (X'03') c

EOT (X'04') d

ENQ (X'05') e

ACK (X'06') f

BEL (X'07') g

BS (X'08') h

HT (X'09') i

LF (X'0A') j

VT (X'0B') k

FF (X'0C') l

CR (X'0D') m

SO (X'0E') n

SI (X'0F') o

DLE (X'10') p

DC1(XON) (X'11') q

DC2 (X'12') r

DC3(XOF) (X'13') s

DC4 (X'14') t

NAK (X'15') u

SYN (X'16') v

ETB (X'17') w

CAN (X'18') x

EM (X'19') y

NUL RS US RS

NUL

GS

FS

ESC

Figure 31. Common Control Code of Keyboard Core Segment for Japanese Keyboard
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Table 38. Other Control Code Map of Key Segment B (continued)

Control Code Associated Letter

SUB (X'1A') z

Following is an example of control-code mapping for the U.S. Enhanced Keyboard.

NUL RS US

ESC GS FS
DC1

ETB ENQ DC2 DC4 EM NAK HT SI DLE

SOH
DC3

EOT ACK BEL BS LF VT FF

SUB CAN ETX SYN STX SO CR

(XON)

(XOF)

Figure 32. Control-Code Map of Keyboard Core Segment for U.S. Enhanced Keyboard
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Appendix B. iSeries Configuration Examples

To connect to an iSeries system, you need to specify configuration information in
the workstation profile that accurately corresponds to the information specified in
the iSeries system (referred to as the device description).

For example, the LAN attachment via IEEE 802.2 in the following figure shows
how the configuration information specified in the iSeries workstation profile
corresponds to the configuration information in the iSeries system.

AS/400 PC400

Network Attribute
Local Network ID
Local Location Name

Line Description
Local Adapter Address
Source Service Access Point (SSAP)

Controller Description
Controller Category (*APPC)
Remote Network ID
Remote Control Point
LAN Remote Adapter Address
(PC LAN Adapter Address)

LAN DSAP
LAN SSAP

Device Description
Device Category (*APPC)
Remote Location
Remote Network ID Code
APPN available (*YES)

Configure Communication

Session Type
Host Code Page
System Location Name

Field 1
Field 2

PC Location Name
Field 1
Field 2

Workstation ID
Device Description

Device Category (*DSP, *PRT)
Device Type (3197/3477, 3812)
Device Class (*VRT)
Device Format (C1/FC,1)
Keyboard Language Type (USB)
Character Identifier (697 037)

Configure Link
(LAN via IEEE 802.2)

Destination Address
Remote SAP

(Select Advanced)

Local SAP

Figure 33. LAN Attachment via IEEE 802.2
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iSeries Device Description
To configure 5250 display or printer sessions, the following values must be set in
the iSeries device description:

iSeries Device
Description

Display Session

Printer Session24 x 80 27 x 132

Device category *DSP *DSP *PRT

Device class *VRT *VRT *VRT

Device type 3197 3477 3812

Device model C1 FC 1

Keyboard language
type

USB+ USB+ -

Character identify
code

697 037+ 697 037+ -

+ For SBCS, depends on the host code page selection.

The following table applies to DBCS only.

iSeries Device Description

Display Session

Printer Session
Host Code Page

931
Host Code Page

939

Device category *DSP *PRT

Device class *VRT *VRT

Device type 5555 5555

C01 C01

JUB JPB -

Character identify code 101 037 -

DBCS device feature 2424J0 2424J0 2424J0

5250 Sessions through One Link
If you want all your 5250 sessions to connect through one link to an iSeries system,
use the same PC Location Name and the same Link Parameters for all the
sessions.

For example, you can configure two display sessions and one printer session
connected to an iSeries system using APPN.PC5250 as the Location Name.
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Session A : Session Type : Display
(Display) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : (not specified)

Session B : Session Type : Display
(Display) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : (not specified)

Session C : Session Type : Printer
(Printer) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : PCLOCALP1

In this example, the iSeries network attributes are:

Local network ID : APPN
Local location : S7801234

Tip
Enter DSPNETA from a 5250 session to display iSeries network attributes.

iSeries System Mode Description
PC400 initially uses mode description QPCSUPP on the iSeries system. If the PC
Support/400 program or iSeries Access is installed on the iSeries system,
QPCSUPP need not be created. If mode description QPCSUPP does not exist on
the iSeries system, create the mode description:
1. Enter the following command on the command line of the main menu of the

iSeries system:
CRTMODD

The Creating Mode Description panel appears.

Creating Mode Description (CRTMODD)

Type the selected items, and push the Enter key.

Mode Description................. Name
Maximum Session.................. 8 1-512
Maximum number of interaction.... 8 1-512
Number of Local Control Sessions. 4 0-512
Number of Pre-joined Sessions.... 0 0-512
Inbound Pacing Value............. 7 0-63
Outbound Pacing Value............ 7 0-63
Maximum Length of Request Unit... *CALC 241-16384, *CALC
Text Description ................ *BLANK

End
F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key
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2. Type the necessary values in each field, according to the following table.

Field Name Input Value

Mode description QPCSUPP

Maximum session 64

Maximum number of interactions 64

Number of local control sessions 0

Number of pre-joined sessions 0

Inbound pacing value 7

Outbound pacing value 7

Maximum length of request unit *CALC

Text description This field is optional

3. After you type all the values, press the Enter key.
This completes the creation of the mode description QPCSUPP.

iSeries Device Description for Twinaxial Attachments (APPC) Example
If you want to use a twinaxial (TDLC) attachment, the iSeries system requires that
you specify a device description. When the automatic device configuration
indicator (QAUTOCFG) is set to ON in the iSeries system, the device description is
created automatically. When the indicator is set to OFF, create the device
description, as follows:
1. Enter the following command on the command line of the iSeries system main

menu:
CRTDEVDSP

The Creating Device Description (Display) panel appears.

Creating Device Description(Display) (CRTDEVDSP)

Type the selected item, and push Enter key.

Device Description... Name
Device Class.......... *LCL, *RMT, *VRT, *SNPT
Device Type........... 3101, 3151, 3161, 3162...
Device Format........ 0, 1, 2, 4, 11, 12, 23...

End
F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

2. Type the values in each field, according to the following table.

Field Name Input Value

Device description This is an optional field

Device class *LCL
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Field Name Input Value

Device type 5150

Device format 2

3. After you type all values, press the Enter key.
The following screen appears:

Creating Device Description(Display) (CRTDEVDSP)

Type the selected item, and push Enter key.

Device Description..........>TWXP0A1 Name
Device Class................>*LCL *LCL, *RMT, *VRT, *SNPT
Device Type.................>5150 3101, 3151, 3161, 3162...
Device Format...............>2 0, 1, 2, 4, 11, 12, 23...
Port Number................. 0-17
Switch Setting.............. 0, 1, 2, 4, 5, 6
Online when IPL.............>*YES *YES, *NO
Controller to be attached... Name
Keyboard Word Type..........>*SYSVAL *SYSVAL,AGB,AGI,BLI...
Text Description............>*BLANK

F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

4. Type the values for each field, according to the following table.

Field Name Input Value

Port number Number of the port to be attached

Switch setting Device address

Controller to be attached Descriptive name of the controller to be attached

Keyboard word type USB1

1 Depends on the host code page selection.

5. After you enter all the values, press the Enter key.
This completes the creation of the device description for the twinaxial
attachment.

iSeries Device Description for Asynchronous Attachment Example
If you want to use an asynchronous dial attachment, the iSeries system requires
that you specify configuration parameters for the controller/line/devices to be
used.

The following sample is a typical configuration on the iSeries system for an
asynchronous dialed connection through an ASCII Workstation Controller.
1. Enter the following command on the command line of the iSeries system main

menu:
WRKCFGSTS *CTL CTL03

where CTL03 is the name of your controller.

The Work with Configuration Status panel appears.
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Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
8_ CTL03 ACTIVE
__ ADLCTST VARY ON PENDING
__ ASYNC VARY ON PENDING
__ ASYNCD VARY ON PENDING
__ EZASYNC VARY ON PENDING
__ ASYNCP0 VARY ON PENDING
__ ASYNRTR ACTIVE

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

2. Enter 8 in the Opt field to work with the controller description for CTL03.
The Work with Controller Descriptions panel appears.

Work with Controller Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source 12=Print device addresses

Opt Controller Type Text
2_ CTL03 6141 CREATED BY AUTO-CONFIGURATION

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

3. Enter 2 in the Opt field to change the controller description for CTL03.
The Change Controller Description panel appears.
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Change Ctl Desc (local WS) (CHGCTLLWS)

Controller Description . . . . . . : CTL03
Option . . . . . . . . . . . . . . : *BASIC
Category of controller . . . . . . : *LWS

Controller type . . . . . . . . . : 6141
Controller model . . . . . . . . . : 1
Resource name . . . . . . . . . . : CTL03
TDLC line . . . . . . . . . . . . : QTDL429000
Online at IPL . . . . . . . . . . : *YES
Auto-configuration controller . . : *YES
Text . . . . . . . . . . . . . . . : CREATED BY AUTO-CONFIGURATION
Device wait timer . . . . . . . . : 10

Press Enter to continue.
===>

BOTTOM
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

4. Type the values in each field, according to the following table.

Field Name Input Value

Controller description CTL03

Resource name CTL03

Online at IPL *YES

Device wait timer 10

Auto-configuration controller *YES

Text description This field is optional

The Work with Controller Descriptions panel appears.

Work with Controller Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source 12=Print device addresses

Opt Controller Type Text
8_ CTL03 6141 Created by auto-configuration

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

5. Enter 8 in the Opt field to work with the configuration status.
The Work with Configuration Status panel appears.
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Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
__ CTL03 ACTIVE
__ ADLCTST VARY ON PENDING
__ ASYNCPERTH VARY ON PENDING
__ ASYNCD VARY ON PENDING
__ EZASYNC VARY ON PENDING
__ ASYNCP0 VARY ON PENDING
8_ ASYNRTR ACTIVE

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

6. Enter 8 in the Opt field next to ASYNRTR to work with the display device
description.
The Work with Device Descriptions panel appears.

Work with Device Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source

Opt Controller Type Text
2_ ASYNRTR 5150 FOR PC400

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

7. Enter 2 in the Opt field to change the device description.
The Change Device Description panel appears.
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Change Device Desc (Display) (CHGDEVDSP)

Type choices, press Enter.

Device description . . . . . . . . > ASYNRTR Name
Port number . . . . . . . . . . . 4 0-17, *SAME
Switch setting . . . . . . . . . . 0 0-6, *SAME
Online at IPL . . . . . . . . . . *YES *SAME, *YES, *NO
Keyboard language type . . . . . . USI *SAME, *SYSVAL, *NONE, AGB...

Character identifier:
Graphic character set . . . . . *KBDTYPE 1-32767, *KBDTYPE, *SYSVAL...
Code page . . . . . . . . . . . 1-32767

Allow blinking cursor . . . . . . *YES *SAME, *YES, *NO
Print device . . . . . . . . . . . *SYSVAL Name, *SAME, *SYSVAL
Output queue . . . . . . . . . . . *DEV Name, *SAME, *DEV

Library . . . . . . . . . . . . Name, *LIBL, *CURLIB
Printer file . . . . . . . . . . . QSYSPRT Name, *SAME

Library . . . . . . . . . . . . *LIBL Name, *LIBL, *CURLIB
More...

Press Enter to continue.
===>
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

This completes the creation of the controller and display device descriptions for
an asynchronous dial attachment.

iSeries VT Asynchronous Attachment Example
The following sample is a typical configuration on the iSeries system for a VT
asynchronous dialed connection through an ASCII Workstation Controller. For
more details on iSeries for VT asynchronous attachments, refer to AS/400 ASCII
Workstation Reference.
1. Enter the following command on the command line of the iSeries system main

menu:
CRTDEVDSP

The Create Device Description panel appears, in a first and second screen, as
shown for the configuration of a VT100 device in the following screens. When
filling in the panel, make sure that the name of the attached controller
(arbitrarily shown as CTL05 here) matches the name of the twinaxial controller
configured on your iSeries.
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Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Device description . . . . . . . > VT100 Name
Device class . . . . . . . . . . > *LCL *LCL, *RMT, *VRT, *SNPT
Device type . . . . . . . . . . > V100 3101, 3151, 3161, 3162...
Device model . . . . . . . . . . > *ASCII 0, 1, 2, 4, 5, 12, 23 ...
Emulated twinaxial device . . . > *TYPE 3196A2, 3197D2, *TYPE
Port number . . . . . . . . . . > 1 0-17
Emulating ASCII device . . . . . > *NO *NO, *YES
Physical attachment . . . . . . > *MODEM *DIRECT, *PTT, *MODEM...
Online at IPL . . . . . . . . . > *YES *YES, *NO
Attached controller . . . . . . > CTL05 Name
Keyboard language type . . . . . > USB *SYSVAL, AGB, AGI, ALI...
Inactivity timer . . . . . . . . > *NOMAX 1-30, *ATTACH, *NOMAX...
Line speed . . . . . . . . . . . > 19200 *TYPE, *CALC, 150, 300...
Word length . . . . . . . . . . > 8 *TYPE, *CALC, 7, 8
Type of parity . . . . . . . . . > *NONE *TYPE, *CALC, *EVEN, *ODD...
Stop bits . . . . . . . . . . . > 2 *TYPE, 1, 2

More...
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Text ’description’ . . . . . . . > ’dec vt100 device description test’

Additional Parameters
Character identifier:

Graphic character set . . . . > *KBDTYPE 1-32767, *SYSVAL, *KBDTYPE
Code page . . . . . . . . . . 1-32767

Print device . . . . . . . . . . > *SYSVAL Name, *SYSVAL
Output queue . . . . . . . . . . > *DEV Name, *DEV

Library . . . . . . . . . . . Name, *LIBL, *CURLIB
Printer file . . . . . . . . . . > QSYSPRT Name

Library . . . . . . . . . . . > *LIBL Name, *LIBL, *CURLIB

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

2. For a similar configuration for a VT220:
Use the same command, CRTDEVDSP, on the command line of the iSeries
system main menu. Again, the same kind of panels appear. You must make
sure that the name of the attached controller matches the name of the twinaxial
controller configured on your iSeries.
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Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Device description . . . . . . . VT220 Name
Device class . . . . . . . . . . > *LCL *LCL, *RMT, *VRT, *SNPT
Device type . . . . . . . . . . > V220 3101, 3151, 3161, 3162...
Device model . . . . . . . . . . > *ASCII 0, 1, 2, 4, 5, 12, 23
Emulated twinaxial device . . . > *TYPE 3196A2, 3197D2, *TYPE
Port number . . . . . . . . . . > 2 0-17
Emulating ASCII device . . . . . > *NO *NO, *YES
Physical attachment . . . . . . > *MODEM *DIRECT, *PTT, *MODEM...
Online at IPL . . . . . . . . . > *YES *YES, *NO
Attached controller . . . . . . > CTL05 Name
Keyboard language type . . . . . > USB *SYSVAL, AGB, AGI, ALI...
Inactivity timer . . . . . . . . > *NOMAX 1-30, *ATTACH, *NOMAX...
Line speed . . . . . . . . . . . > 19200 *TYPE, *CALC, 150, 300...
Word length . . . . . . . . . . > 8 *TYPE, *CALC, 7, 8
Type of parity . . . . . . . . . > *NONE *TYPE, *CALC, *EVEN, *ODD...
Stop bits . . . . . . . . . . . > 1 *TYPE, 1, 2

More...
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Text ’description’ . . . . . . . > ’dec vt220 device description test’

Additional Parameters

Character identifier:
Graphic character set . . . . > *KBDTYPE 1-32767, *SYSVAL, *KBDTYPE
Code page . . . . . . . . . . 1-32767

Print device . . . . . . . . . . > *SYSVAL Name, *SYSVAL
Output queue . . . . . . . . . . > *DEV Name, *DEV

Library . . . . . . . . . . . Name, *LIBL, *CURLIB
Printer file . . . . . . . . . . > QSYSPRT Name

Library . . . . . . . . . . . > *LIBL Name, *LIBL, *CURLIB

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

iSeries Configuration for SDLC Example
The following examples refer to SDLC and Hayes AutoSync.

Network Attributes
To display the network attributes for the iSeries to which you are connecting, enter
the command dspneta on the iSeries Main Menu.
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MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks

90. Sign off

Selection or command
===> dspneta

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press Enter.

The Display Network Attributes screen is displayed.

Display Network Attributes

System: RALYAS4B
Current system name . . . . . . . . . . . . . . : RALYAS4B

Pending system name . . . . . . . . . . . . . :
Local network ID . . . . . . . . . . . . . . . . : USIBMRA
Local control point name . . . . . . . . . . . . : RALYAS4B
Default local location . . . . . . . . . . . . . : RALYAS4B
Default mode . . . . . . . . . . . . . . . . . . : BLANK
APPN node type . . . . . . . . . . . . . . . . . : *NETNODE
Data compression . . . . . . . . . . . . . . . . : *NONE
Intermediate data compression . . . . . . . . . : *NONE
Maximum number of intermediate sessions . . . . : 200
Route addition resistance . . . . . . . . . . . : 128
Server network ID/control point name . . . . . . : *LCLNETID *ANY

More...
Press Enter to continue.

F3=Exit F12=Cancel

The network attributes include the iSeries Network ID and CP name.

SDLC Leased Configuration
Several descriptions must be created on the iSeries; examples are given in this
section.

Creating an SDLC Line Description
To create an SDLC leased line description, enter the command crtlinsdlc on the
iSeries Main Menu.
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MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks

90. Sign off

Selection or command
===> crtlinsdlc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt).

The Create Line Description panel is displayed. Enter the values for each
parameter on the panel.

Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Line description . . . . . . . . > PCOMMSDLCL Name
Resource names . . . . . . . . . > LIN021 Name

+ for more values
Online at IPL . . . . . . . . . *YES *YES, *NO
Data link role . . . . . . . . . *NEG *NEG, *PRI, *SEC
Physical interface . . . . . . . *RS232V24 *RS232V24, *V35, *X21, ...
Connection type . . . . . . . . *NONSWTPP *NONSWTPP, *SWTPP, *MP, *SHM
Switched network backup . . . . *NO *NO, *YES
Exchange identifier . . . . . . *SYSGEN 05600000-056FFFFF, *SYSGEN
NRZI data encoding . . . . . . . *YES *YES, *NO
Line speed . . . . . . . . . . . 9600 600, 1200, 2400, 4800...
Modem type supported . . . . . . *NORMAL *NORMAL, *V54, *IBMWRAP...
Maximum frame size . . . . . . . 521 265, 521, 1033, 2057
Duplex . . . . . . . . . . . . . *HALF *HALF, *FULL
Inactivity timer . . . . . . . . 300 *NOMAX, 150-4200 (0.1 sec)
Poll response delay . . . . . . 0 0-2048 (0.0001 seconds)

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Nonproductive receive timer . . 320 160-4200 (0.1 seconds)
Idle timer . . . . . . . . . . . 30 5-300 (0.1 seconds)
Connect poll timer . . . . . . . 30 2-300 (0.1 seconds)
Poll cycle pause . . . . . . . . 0 0-2048 (0.0001 seconds)
Frame retry . . . . . . . . . . 7 0-64
Text ’description’ . . . . . . . PCOMM SDLC leased line

Additional Parameters

Attached nonswitched ctls . . . Name
+ for more values

Modem data rate select . . . . . *FULL *FULL, *HALF
Error threshold level . . . . . *OFF *OFF, *MIN, *MED, *MAX
Modulus . . . . . . . . . . . . 8 8, 128
Maximum outstanding frames . . . 7 1-28

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter to save the line description pcommsdlcl.

SDLC Controller Description
To create the SDLC controller description for the line PCOMMSDLCL, enter
crtctlappc on the iSeries Main Menu.

MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks

90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt). The Create Controller Description panel is displayed. Enter
values for each parameter on the following two panels.
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Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

Controller description . . . . . > PCOMMSDLCL Name
Link type . . . . . . . . . . . > *SDLC *ANYNW, *FAX, *FR, *IDLC...
Online at IPL . . . . . . . . . *YES *YES, *NO
Switched connection . . . . . . *NO *NO, *YES
Switched network backup . . . . *NO *NO, *YES
APPN-capable . . . . . . . . . . *YES *YES, *NO
Attached nonswitched line . . . > PCOMMSDLCL Name
Maximum frame size . . . . . . . *LINKTYPE 265-16393, 256, 265, 512...
Remote network identifier . . . > USIBMRA Name, *NETATR, *NONE, *ANY
Remote control point . . . . . . > PCOMMCP Name, *ANY
Exchange identifier . . . . . . 00000000-FFFFFFFF
Data link role . . . . . . . . . *NEG *NEG, *PRI, *SEC
Station address . . . . . . . . C1 00-FE
APPN CP session support . . . . *NO *YES, *NO
APPN node type . . . . . . . . . *LENNODE *ENDNODE, *LENNODE...
APPN transmission group number 1 1-20, *CALC

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

Autocreate device . . . . . . . *ALL *ALL, *NONE
Autodelete device . . . . . . . 1440 1-10000, *NO
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND
Text ’description’ . . . . . . . PCOMM SDLC Leased

Additional Parameters

Attached devices . . . . . . . . Name
+ for more values

Character code . . . . . . . . . *EBCDIC *EBCDIC, *ASCII
SSCP identifier . . . . . . . . 000000000001-FFFFFFFFFFFF
IDLC window size . . . . . . . . *LIND 1-31, *LIND
IDLC frame retry . . . . . . . . *LIND 0-100, *LIND

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter.

The APPC Device Description will create itself automatically.

SDLC Switched Configuration
The following examples contain information about the SDLC switched
configuration on the iSeries.

SDLC Line Description
To create an SDLC switched line definition on the iSeries, enter the command
crtlinsdlc on the iSeries Main Menu.
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MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks

90. Sign off

Selection or command
===> crtlinsdlc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt).

The Create Line Description panel is displayed. Enter values for each parameter on
the panel.

Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Line description . . . . . . . . > PCOMSDLCSW Name
Resource names . . . . . . . . . > LIN051 Name

+ for more values
Online at IPL . . . . . . . . . *YES *YES, *NO
Data link role . . . . . . . . . > *PRI *NEG, *PRI, *SEC
Physical interface . . . . . . . *RS232V24 *RS232V24, *V35, *X21, ...
Connection type . . . . . . . . > *SWTPP *NONSWTPP, *SWTPP, *MP, *SHM
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 (1 second)
Autocall unit . . . . . . . . . *NO *NO, *YES
Exchange identifier . . . . . . *SYSGEN 05600000-056FFFFF, *SYSGEN
NRZI data encoding . . . . . . . *YES *YES, *NO
Line speed . . . . . . . . . . . 9600 600, 1200, 2400, 4800...
Modem type supported . . . . . . *NORMAL *NORMAL, *V54, *IBMWRAP...
Switched connection type . . . . *BOTH *BOTH, *ANS, *DIAL
Autoanswer . . . . . . . . . . . *YES *YES, *NO
Autodial . . . . . . . . . . . . *NO *NO, *YES

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Calling number . . . . . . . . . *NONE
Connect poll retry . . . . . . . 7 0-64
Maximum frame size . . . . . . . 521 265, 521, 1033, 2057
Duplex . . . . . . . . . . . . . *HALF *HALF, *FULL
Nonproductive receive timer . . 320 160-4200 (0.1 seconds)
Idle timer . . . . . . . . . . . 30 5-300 (0.1 seconds)
Connect poll timer . . . . . . . 30 2-300 (0.1 seconds)
Poll cycle pause . . . . . . . . 0 0-2048 (0.0001 seconds)
Frame retry . . . . . . . . . . 7 0-64
Data Set Ready drop timer . . . 6 3-60 (seconds)
Autoanswer type . . . . . . . . *DTR *DTR, *CDSTL
Remote answer timer . . . . . . 60 30, 35, 40, 45 (seconds)...
Text ’description’ . . . . . . . PCOMM SDLC switched line

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter to save the description pcomsdlcsw.

SDLC Controller Description
To create the controller description for the switched SDLC line, enter crtctlappc on
the iSeries Main Menu.

MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks

90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt).

The Create Controller Description panel is displayed. Enter values for each
parameter on the panel.
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Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

Controller description . . . . . > PCOMSDLCSW Name
Link type . . . . . . . . . . . > *SDLC *ANYNW, *FAX, *FR, *IDLC...
Online at IPL . . . . . . . . . *YES *YES, *NO
Switched connection . . . . . . > *YES *NO, *YES
Short hold mode . . . . . . . . *NO *NO, *YES
APPN-capable . . . . . . . . . . *YES *YES, *NO
Switched line list . . . . . . . > PCOMSDLCSW Name

+ for more values
Maximum frame size . . . . . . . *LINKTYPE 265-16393, 256, 265, 512...
Remote network identifier . . . *NETATR Name, *NETATR, *NONE, *ANY
Remote control point . . . . . . > JO Name, *ANY
Exchange identifier . . . . . . > 00000000 00000000-FFFFFFFF
Initial connection . . . . . . . > *ANS *DIAL, *ANS
Connection number . . . . . . . > 123
Data link role . . . . . . . . . > *SEC *NEG, *PRI, *SEC
Station address . . . . . . . . 01 00-FE

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

APPN CP session support . . . . *NO *YES, *NO
APPN node type . . . . . . . . . *LENNODE *ENDNODE, *LENNODE...
APPN transmission group number 1 1-20, *CALC
APPN minimum switched status . . *VRYONPND *VRYONPND, *VRYON
Autocreate device . . . . . . . *ALL *ALL, *NONE
Autodelete device . . . . . . . 1440 1-10000, *NO
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND
Text ’description’ . . . . . . . PCOM SDLC switched line

Additional Parameters

Attached devices . . . . . . . . Name
+ for more values

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter to save the controller description pcomsdlcsw.

The APPC Device Description will create itself automatically once Personal
Communications attaches to the iSeries using the line and controller descriptions
that were just created.

LAN Configuration Example
This example assumes that a line description (token-ring or Ethernet) is already in
place. This is a shared configuration object—all connections on that adapter will
use the same line description. In the configuration example shown, the line
description name is TRN2619.
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LAN Controller Description
The normal method would be to let the APPC controller create itself automatically.
However, if preferred, the following command can be used to manually create the
APPC controller.

To create a LAN controller description, enter crtctlappc on the iSeries Main Menu.

MAIN iSeries Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. iSeries Access tasks

90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt). The Create Controller Description panel will be displayed.

Enter values for each parameter on the panel.

Create Ctl Desc (APPC) (CRTCTLAPPC)

Controller description . . . . . > PCOMMLAN Name
Link type . . . . . . . . . . . > *LAN *ANYNW, *FAX, *FR, *IDLC...
Online at IPL . . . . . . . . . *YES *YES, *NO
APPN-capable . . . . . . . . . . *YES *YES, *NO
Switched line list . . . . . . . > TRN2619 Name

+ for more values
Maximum frame size . . . . . . . *LINKTYPE 265-16393, 256, 265, 512...
Remote network identifier . . . *NETATR Name, *NETATR, *NONE, *ANY
Remote control point . . . . . . > PEPE Name, *ANY
Exchange identifier . . . . . . 00000000-FFFFFFFF
Initial connection . . . . . . . *DIAL *DIAL, *ANS
Dial initiation . . . . . . . . *LINKTYPE *LINKTYPE, *IMMED, *DELAY
LAN remote adapter address . . . 400052005109 000000000001-FFFFFFFFFFFF
APPN CP session support . . . . *NO *YES, *NO
APPN node type . . . . . . . . . *LENNODE *ENDNODE, *LENNODE...
APPN/HPR capable . . . . . . . . *YES *YES, *NO

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

APPN transmission group number 1 1-20, *CALC
APPN minimum switched status . . *VRYONPND *VRYONPND, *VRYON
Autocreate device . . . . . . . *ALL *ALL, *NONE
Autodelete device . . . . . . . 1440 1-10000, *NO
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND
Model controller description . . *NO *NO, *YES
Text ’description’ . . . . . . . PCOMM token-ring

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Press Enter to save the controller description pcommlan.

The APPC Device Description will create itself automatically. Personal
Communications attaches to the iSeries using the controller description that was
just created.
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Appendix C. Host Code Page Tables

The following tables show the host code page for each country.
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Host Code Page 037-1/697-1 Brazil, Canada, Netherlands, Portugal,
U.S., and 037/1175 Traditional Chinese

The column indicates the first digit and the row indicates the second digit.

Brazil, Canada, Netherlands, Portugal, U.S., Trad. Chinese
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Host Code Page 273-1/697-1 Austria, Germany
The column indicates the first digit and the row indicates the second digit.

Austria, Germany
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Host Code Page 275-1/697-1 Brazil
The column indicates the first digit and the row indicates the second digit.

Brazil
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Host Code Page 277-1/697-1 Denmark, Norway
The column indicates the first digit and the row indicates the second digit.

Denmark, Norway
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Host Code Page 278-1/697-1 Finland, Sweden
The column indicates the first digit and the row indicates the second digit.

Finland, Sweden
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Host Code Page 280-1/697-1 Italy
The column indicates the first digit and the row indicates the second digit.

Italy
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Host Code Page 284-1/697-1 Latin America, Spain
The column indicates the first digit and the row indicates the second digit.

Spain, Latin America
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Host Code Page 285-1/697-1 United Kingdom
The column indicates the first digit and the row indicates the second digit.

United Kingdom
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Host Code Page 290 Japan (Katakana) Extended
The column indicates the first digit and the row indicates the second digit.

Japan (Katakana) Extended
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Host Code Page 297-1/697-1 France
The column indicates the first digit and the row indicates the second digit.

France
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Host Code Page 420 Arabic Bilingual
The column indicates the first digit and the row indicates the second digit.

Arabic
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Host Code Page 424/941 Israel (Hebrew - Bulletin Code)
The column indicates the first digit and the row indicates the second digit.

Israel (Hebrew)
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Host Code Page 500-1/697-1 International
The column indicates the first digit and the row indicates the second digit.

International
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Host Code Page 803 Israel (Hebrew - Old Code)
The column indicates the first digit and the row indicates the second digit.

Israel (Hebrew)
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Host Code Page 833/1173 Hangeul
The column indicates the first digit and the row indicates the second digit.

Hangeul
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Host Code Page 836/1174 Simplified Chinese
The column indicates the first digit and the row indicates the second digit.

Simplified Chinese
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Host Code Page 870/959 Latin 2 - EBCDIC Multilingual
The column indicates the first digit and the row indicates the second digit.

Latin 2
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Host Code Page 871-1/697-1 Iceland
The column indicates the first digit and the row indicates the second digit.

Iceland
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Host Code Page 875 Greece
The column indicates the first digit and the row indicates the second digit.

Greece
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Host Code Page 924-1/1353-1 International
The column indicates the first digit and the row indicates the second digit.

International
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Host Code Page 1025/1150 Cyrillic
The column indicates the first digit, and the row indicates the second digit. If this
code page is not used with a Cyrillic host machine, certain characters might not
display properly.

Cyrillic
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Host Code Page 1026/1152 Latin 5 - Turkey
The column indicates the first digit, and the row indicates the second digit.

Latin 5, Turkey
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Host Code Page 1027/1172 Japan (Latin) Extended
The column indicates the first digit and the row indicates the second digit.

Japan (Latin) Extended
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Host Code Page 1047/103 Latin 1 (Open Systems)
The column indicates the first digit and the row indicates the second digit.

Latin 1
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Host Code Page 1112/1035 Latvia, Lithuania
The column indicates the first digit and the row indicates the second digit.

Latvia, Lithuania

346 Personal Communications Administrator’s Guide and Reference



Host Code Page 1122/1037 Estonia
The column indicates the first digit and the row indicates the second digit.

Estonia
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Host Code Page 1123 Ukraine
The column indicates the first digit and the row indicates the second digit.

Ukraine
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Host Code Page 1130 Vietnam
The column indicates the first digit and the row indicates the second digit.

Vietnam
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Host Code Page 1132 Laos
The column indicates the first digit and the row indicates the second digit.

Laos
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Host Code Page 1137 India
The column indicates the first digit and the row indicates the second digit.

India
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Host Code Page 1140-1/695-1 Brazil, Canada, Netherlands, Portugal,
U.S., and 1140/1175 Traditional Chinese

The column indicates the first digit and the row indicates the second digit.

Brazil, Canada, Netherlands, Portugal, U.S., Trad. Chinese
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Host Code Page 1141-1/695-1 Austria, Germany
The column indicates the first digit and the row indicates the second digit.

Austria, Germany
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Host Code Page 1142-1/695-1 Denmark, Norway
The column indicates the first digit and the row indicates the second digit.

Denmark, Norway
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Host Code Page 1143-1/695-1 Finland, Sweden
The column indicates the first digit and the row indicates the second digit.

Finland, Sweden
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Host Code Page 1144-1/695-1 Italy
The column indicates the first digit and the row indicates the second digit.

Italy
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Host Code Page 1145-1/695-1 Latin America, Spain
The column indicates the first digit and the row indicates the second digit.

Spain, Latin America
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Host Code Page 1146-1/695-1 United Kingdom
The column indicates the first digit and the row indicates the second digit.

United Kingdom
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Host Code Page 1147-1/695-1 France
The column indicates the first digit and the row indicates the second digit.

France
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Host Code Page 1148-1/695-1 International
The column indicates the first digit and the row indicates the second digit.

International
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Host Code Page 1149-1/695-1 Iceland
The column indicates the first digit and the row indicates the second digit.

Iceland
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Host Code Page 1153/1375 Latin 2 - EBCDIC Multilingual
The column indicates the first digit and the row indicates the second digit.

Latin 2
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Host Code Page 1154/1381 Cyrillic
The column indicates the first digit, and the row indicates the second digit. If this
code page is not used with a Cyrillic host machine, certain characters might not
display properly.

Cyrillic
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Host Code Page 1155/1378 Latin 5 - Turkey
The column indicates the first digit, and the row indicates the second digit.

Latin 5, Turkey
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Host Code Page 1156/1393 Latvia, Lithuania
The column indicates the first digit and the row indicates the second digit.

Latvia, Lithuania

Appendix C. Host Code Page Tables 365



Host Code Page 1157/1391 Estonia
The column indicates the first digit and the row indicates the second digit.

Estonia
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Host Code Page 1158/1388 Ukraine
The column indicates the first digit and the row indicates the second digit.

Ukraine
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Host Code Page 1160/1395 Thailand
The column indicates the first digit and the row indicates the second digit.

Thailand
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Host Code Page 1164/1397 Vietnam
The column indicates the first digit and the row indicates the second digit.

Vietnam
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Vietnam

370 Personal Communications Administrator’s Guide and Reference



Appendix D. Alerts

Alerts are generated by components of Personal Communications; corresponding
messages are logged in the message log and can be viewed with the Personal
Communications log viewer utility. Refer to the information about log viewer
functions in the User’s Reference for the specific emulator type for more
information.

Note that some alerts can be caused by different situations. Each situation may
generate a different message. Other alerts are informational and do not generate
specific messages in the log, although messages about problems relating to the
situation that generated the alert may be logged.

Alert ID number Messages logged

APPN

X’034A6F0B’ PCS4066E
PCS4068E
PCS4093E

X’0DF28A14’ PCS4065E
PCS4066E
PCS4068E
PCS4069E
PCS4070E

X’170F7710’ No specific message
X’21745F28’ No specific message
X’2313A399’ PCS4364A

PCS4365A
PCS4379A

X’32CDF4E2’ PCS4073E
X’47302521’ No specific message
X’6D27D125’ PCS4066E

PCS4068E
X’7599A7D8’ No specific message
X’769022F0’ PCS4504E
X’9DCD7CCA’ PCS4275E

PCS4280E
PCS4282E
PCS4283A
PCS4284E
PCS4304E
PCS4305E
PCS4310A
PCS4311E
PCS4312E

X’9E452D9C’ PCS4593A
X’A89646AA’ PCS4275E

PCS4280E
PCS4282E
PCS4283A
PCS4284E
PCS4304E
PCS4305E
PCS4310A
PCS4311E
PCS4312E

X’B558D310’ PCS4324E
PCS4342E
PCS4347E

X’C781E91E’ No specific message
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X’EBAA3C4F’ PCS4593A
X’EBEE390E’ PCS4063E

PCS4064E
PCS4066E
PCS4067E
PCS4068E
PCS4071A
PCS4091E
PCS4092E
PCS4094E
PCS4123E
PCS4124E
PCS4125E

X’F52A0C01’ PCS4061E
PCS4062E

X’FE1C42EB’ No specific message
LLC2 SAP

X’016E5F4E’ PCS1066A
PCS1054A

X’3BA03B6D’ PCS1066A
PCS1005E

X’55BF3E1C’ PCS1066A
PCS1054A

X’A676B230’ PCS1066A
PCS1005E

X’CAF3C58A’ PCS1066A
PCS1054A

X’D2E24978’ PCS1066A
PCS1005E

X’D615A61E’ PCS1066A
PCS1054A

X’EB1D6ABB’ PCS1066A
PCS1005E

X’EB61E14F’ PCS1066A
PCS1005E

LLC2 Link Station

X’216D1033’ PCS1065A
PCS1003E

X’25AC0D84’ PCS1065A
PCS1004E

X’28EF2B5D’ PCS1065A
PCS1001E
PCS1004E
PCS1006E

X’5B8F5BA7’ PCS1065A
PCS1050A

X’83D91642’ PCS1065A
PCS1000E

X’87180BF5’ PCS1065A
PCS1000E

X’8A5B2D2C’ PCS1065A
PCS1000E

X’8E9A309B’ PCS1065A
PCS1000E

X’E65B0B7F’ PCS1065A

pDLC

Alert ID number Messages logged Alert type Alert description

X’0E499026’ PCS8607 01 3300
X’0F935B3E’ PCS8603 01 3300
X’21C346F0’ PCS8619 01 3300
X’25025B47’ PCS8620 01 3300
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X’28417D9E’ PCS8617 01 3300
X’2C806029’ PCS8618 01 3300
X’4227687B’ PCS8610 01 3300
X’6C6E2505’ PCS8604 01 8000

PCS8612
X’7EA9C871’ PCS8608 01 3300
X’8CEC6B74’ PCS8609 01 3300
X’AB218ADF’ PCS8700 01 3300
X’BB5C288E’ PCS8600 01 3300
X’C16E9922’ PCS8615 01 3300
X’C5AF8495’ PCS8616 01 3300
X’C8ECA24C’ PCS8613 01 3300
X’CC2DBFFB’ PCS8614 01 3300
X’D3F9C6D8’ PCS8611 01 3300
X’EBB67B65’ PCS8606 01 3300

Twinax DLC

Alert ID number Messages logged Alert type Alert description

X’24077791’ PCS8700 01 3300
X’C91C002A’ PCS8107 01 3300
X’D7D5F953’ PCS8101 01 3300
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Appendix E. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
500 Columbus Avenue
Thornwood, NY 10594
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM documentation or non-IBM Web
sites are provided for convenience only and do not in any manner serve as an
endorsement of those documents or Web sites. The materials for those documents
or Web sites are not part of the materials for this IBM product and use of those
documents or Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
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programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department T01
Building 062
P.O. Box 12195
RTP, NC 27709-2195
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement
or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Trademarks
The following terms are trademarks of the IBM Corporation in the United States or
other countries, or both:

Advanced Peer-to-Peer Networking
AIX
AnyNet
APPN
Client Access
CUA
DB2
DB2 Connect
GDDM
IBM
IBM Global Network
InfoWindow
iSeries
Micro Channel
Netfinity

OfficeVision/400
OfficeVision/MVS
Open Blueprint
OS/2
OS/390
OS/400
RACF
SecureWay
Tivoli
Tivoli Enterprise
VTAM
World Registry
z/OS
zSeries

Lotus and 1–2–3 are trademarks of Lotus Development Corporation in the United
States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are registered
trademarks of Microsoft Corporation in the United States, other countries, or both.

Java, JavaBeans, and all Java-based trademarks and logos are trademarks or
registered trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.
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Other company, product, and service names may be trademarks or service marks
of others.
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E
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files

configuration 19
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update 20

H
Hebrew support 161, 167
Home3270 38
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IBM Global Network - SNA over Async 37
IBM PC720 modem initialization 39
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Information, Where to Find More
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Messages and Alerts xiv

Internet Service utility 11
iSeries

3270 passthru 38
5250 sessions through one link 302
configuration examples 301
device description

for asynchronous attachments 305
for twinaxial attachment 304

error messages 39
system mode description 303
system setup 39

J
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L
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configuring 40
installing 39

LAN via IEEE 802.2 attachment 34
language support

multiple sessions 151
overview 149
Thai 159
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line speed
Home3270 attachment 38
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log viewer 9
Log Viewer Functions 101

Changing Message Log Size and Location 101
Filtering 102
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Searching 102
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Viewing Message and Trace Logs 101

log viewer utility 101

M
machine check 207 33
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merging 101
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viewing 101

message logger device driver 101
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N
node operations 112, 135
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O
ODBC driver

components 92
overview 91
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online help xiv

P
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library xv
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Internet Service 11
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trace facility 10

printer color mixing 183
printer control codes 219
printer data stream support

3270 184
SCS 185

printer definition files
examples 197
field names 208
symbols 214

printer definition table
3270

data stream support 183
delimiting print jobs 186
overview 181
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printer color mixing 183
SCS TAB setting 183
structured fields 187

PC400
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PDF file format 191
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